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1 Introduction

Welcome to the MotiveWave™ User’s Guide! If you are reading this document then you have already
installed MotiveWave™ on your computer and you are ready to start using the application.

If you have not yet installed MotiveWave™ or registered for a trial on our website, please read the
Installation Guide before continuing on with this document.

1.1 MotiveWave™ Editions and Modules

If you are currently working with the trial version of MotiveWave™ (available from our website), then
you most likely have the Ultimate Edition of MotiveWave™. This edition includes all of our features and
functionality (Note: excludes partner modules and studies). If you are currently on a trial and you would
like to try a specific edition/module, please contact sales@motivewave.com.

1.1.1 Editions

There are several editions of MotiveWave™ available to address the different needs and budgets of
traders and market analysts. Detailed information on these editions and the functionality that they
provide can be found on our website: http://www.motivewave.com/purchase/compare-editions.htm

1. Ultimate Edition — This edition includes all of our features and is recommended if you are a
professional trader and you are using advanced features such as Elliott Wave, Gann or Gartley.

2. Professional Edition — This is for professional traders that do not used advanced features such as
Elliott Wave, Gann or Gartley

3. Strategy Edition — Expands on the Trade Edition to provide support for strategy back testing and
optimization.

4. Trade Edition — Expands on the Charts Edition to provide trading capabilities

5. Charts Plus Edition — Expands on the Charts Edition and adds popular features such as Replay
Mode, Chart Templates, Multi-Time Frame studies and more.

6. Charts Edition — This entry level edition contains a full set of studies and basic tools for doing
analysis.

1.1.2 Modules

Modules can be added to editions to extend their capabilities. For a full list of available modules and
their capabilities see: http://www.motivewave.com/purchase/modules.htm

1.2 Starting MotiveWave™

If you are on Mac OSX™, MotiveWave ™ will be found from your Launch Pad or in your Applications
folder. Just click on the MotiveWave™ icon to start the application. If you installed MotiveWave™ on a
Windows™ machine double click on the MotiveWave™ icon on your desktop. Alternatively, choose Start
-> All Programs -> MotiveWave -> MotiveWave.exe

The first screen that you will see when you start MotiveWave is the startup screen. Normally you will
open a workspace from this screen. Select the workspace from the drop down and press the Continue
button.

Version 5.0 ©2019 MotiveWave™ Software Page 6 of 212
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MotiveWave™ Startup Screen

MotiveWave®

Select a workspace from
-Please Select a Workspace- the drop down and press

Continue to open it

x Exit . Options ~

This drop down
contains more options

Embedded Java Virtual
Machine Version/Mode

Choosing Workspace Java: 1.8.0_121 (64-bitj
(c) Copyright 2010-2017 Motive\Wave Software all rights reserved Version: 5.0.0

MotiveWave Version —J

Depending on the broker or data service that you have chosen for the workspace, you may see a dialog
that asks for login information. The example below is a login dialog for a CQG workspace. In this case
enter your User ID and password for your CQG account.

Please Note: there is no user name or password for MotiveWave™, just a license key. If you are being
asked for a login ID and password, then this would be for the broker or data service that you chose for
the workspace.

CQG Login Dialog

CQG Login X

A password is required to access your account. Please enter your
password in the field below and press the Connect button.

r
Username

r
Password

Connection  Demo ~
v'| Remember Password

Need Login ID? Click Here

Work Offine || Quit

Connecting to Service: CQG Java: 1.8.0_121 (64-bit)
(c) Copyright 2010-2017 MotiveWave Software all rights reserved Version: 5.0.0
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When you create a trial for MotiveWave™ from our website, you will be sent an email that contains a
license key. This key will need to be entered as part of the installation process (see the Install Guide).
This license key uniquely identifies your profile and will not change (even when you purchase).

If you think this key has been compromised, you can send a request to our support team
(support@motivewave.com) to request a new key. This key will be sent to the email address that you

registered with.

1.3.1 Changing your License Key

Your license key can be changed from the startup screen in MotiveWave™. From the Options menu

button select the Licence option.

Update License

MotiveWave®

x Exit

Select License from the
Options drop down

Choosing Workspace Jav

(c) Copyright 2010-2017 MotiveWave Software all rights reserved

-
Continue

& Options ~
Workspaces
le‘ ce
Appearance
Auto Update
Log Files
About

' Purchase Updates

Version: 5.0.0

Enter your new licence key into the Licence Key field. Press the Update button to validate this key and
change the licence key that MotiveWave™ will use going forward. Note: to avoid mistyping the licence

key, it is recommended that you copy and paste the key from the email message instead.

Update License Dialog

El Update Licence

If your licence key was recently compromised or updated you may have received a new
key in your email inbox. Type (or copy and paste) this key into the input field below.
(Hint: it will look like: KOO0 OOC-OCK-XXXX) Click Update to continue.

Warning: Do not share this key, it is specific to your account and it will violate your
licence agreement if shared with a third party. If you suspect your licence key may be

X

compromised contact customer support (support@motivewave.

Enter your new
license key here

Licence Key " ¢

J

Update Cancel
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1.3.2 Licence Status

You can easily check which MotiveWave™ Edition and Modules that are assigned to your license by
choosing Help -> About from the top menu bar of the Console. The About dialog will display your
license key, email address, edition, modules and lease/support expiry dates.

Check License Information

motiveulave

MotiveWave - Console (fx2)

(%
File Edit View Study Strategy Format Configure  Window | Help
QII W s~ G |3 12| W~ & 0~ I Users Guide [1day  ~
Gomponents Ll SPX500 1D X | Ll SPX500 15m Ll USQil 1D| Tutorials {
- FAQ '
General SPX500 - 1 day How To i T*
— = SDK F T .T i-l-*
. . Log Files
Price Label Price Label “T"“TTTT Purchase Updates , —l
I Aput l ! T**T
AL l '
Support  Resistance M T
Zone Zone
e T L
About Dialog
(™, About MotiveWave x
/ Motive
Analyze. Trade. Evolve
Licence Key
Licensed To
Licence Type OWN
Support Expires 02/04/2017
Edition Ultimate Edition
Version 5.0.0
Java Version 1.8.0_121 (64-bit)
(c) Copyright 2010-2017 Motive\Wave Software all rights reserved
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2 Console

After you have installed MotiveWave™ and configured your workspace the first window that you will see
when opening that workspace will be the Console. The console provides access to all the features in
MotiveWave™ and it is initially configured with a default layout.

Default Console Layout

) MotiveWave - Console (tradier) = &R
File Edit Wiew Study Strategy Format Configure Window Help
AAPL - o | 5 =@ B lwrQ b+ "B[Z]2~[15mn - e RGCmDE B
Components X [AAPL 15m x |MSFT 156m  + /\ 2.
¥ General AAPL - 15 min ool B £ 110.49] Trade x
[ [e]e] ar "
= - ' +.|.4-. *I L 7 I m Order  Bid/Ask
i i T4 E
Price Label Price Label I ﬁmﬂ [ | ¥ D. Efﬁ-fﬁ t T_Y_lql 110.00 [ sei e |
ﬂ.ﬁ] -
b- b m 1053
Support  Resistance
Zone Zone Trade Panel
09.00 - -
2 1 *l?_r;ﬁ.ml simulated
Time Label Time Label Components Panel ‘IJ_'ID'I.*T N/A N/A
J108.50 | Entry/Exit 4
Horizental Extended 4108.00
Line Horizontal
Line MotiveWave ) ) ) . Birds Eye View | : ; | I
i 1200 1400 16.00 1800 Nov- 11.00 13.00 15.00 7.00
Vertical  Extended [
Line Vertical 1110.00
Line Oct-18 Oct-20 Oct-23 Oct-26 Oct-28 Nov-2016 Nov-03 Nov-0 )
» Basic Components 1min 5min 10min 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week >3 = ey @ |- 8
» Commentary NYSE (36) X | NASDAQ (21)  Aleits  + = Q B 7| |Indices (3) x | + |25 Q [EI
» Markers Symbol Bid Ask  Dividen.. Spread LastTime Open Close Low High  Volume Change + B& 15:4303 %
» Fibonacci AEO 16.41 1642 2.00% 0.01 155803 1619 1655 =y o R o
» Gamn AXP 6697 6698  196% 001 155802 6665  67.33 3.3M = (Tl
» Elliott Wave BTU pages |20 0.00 0.00 0.00 0.00 || 17ssase JEETN 1s20a5
= P IO gmomom  agor  onmm  agon o
> Garlley [ — Status B S
atus bar
Ll Home x Ll Charts 8 Account @ Options (&t Scan  {lj Optimize  + m O

Nov-07 15:58:03

The console is organized into different pages (see screen shot above, please note: pages are only
available in the Professional and Ultimate editions of MotiveWave™). To access a different page, simply
click on the page tab at the bottom of the console window. The default set of pages are as follows:

1. Home — The home page contains a sample layout that has a single chart area and two spots at
the bottom for watch lists.

2. Charts — Sample layout of 6 charts

3. Account — Layout containing information about your account, orders, positions and historical
trades.

4. Options — Sample layout containing Option Chains. Note: this page is only available on brokers
that support options trading.

5. Scan — Layout for using the scanning functionality within MotiveWave™

6. Optimize — Contains a strategy optimizer panel for Back Testing, Optimization and Walk Forward
testing of automated strategies.

7. News — If supported by your Broker/Data service, you may see a page for news

The following screen shots illustrate the default set of pages in the console:

Version 5.0 ©2019 MotiveWave™ Software Page 10 of 212



MotiveWave™
User's Guide

motivelwave

Charts Page

> MotiveWave - Console (tradier) 2 - 2 x
File Edit View Study Strategy Format Configure Window  Help
18M Q. Ll |K 2w~ Q §~+ TEIX~[15mn > | LN CmMODCR
Components X [IBM15m x |+ AXP 15m X | + F15m x | + (e
¥ General IBM - 15 min ?m*l AXP - 15 min n-+u"4-n F -15 min {0 11.62
Volume it Volume i LT Volume -
B = i +l I ) ﬁ' ¥ [:l+ i 1158
I 1 :
Price Label Price Label H "ﬂﬁ? DT I*!ﬂ ¢ H J'iIHTUﬁ[:l
iy |
- *H - oot 1150
N — -1 IDT! - Hﬁ
Support  Resistance
Zone Zone D
U“HWHWLI ] EXT]
T & f )
Time Label Time Label R — ] ~ ul‘ﬁ- =577
Nov-07 1100 1300 1500 1200 12:00  Nov07 11:00 1300 1500 [ 1600 Nov-07 900 1100 1300 1500
— — Smin  10min | 15min_ 52 = v 5min  10min 15 min =52 = v @ |olv B[ 5min 10min [15min >3 = ey @ ¢+ 2
Horizontal Extended  [GE 15m x | + HPQ 15m x | + = .*|[coceL 15m x | + = .
Li Horizontal
e e GE-15min HPQ - 15 min GOOGL - 15 min
i Volume Volume Volume
Vertical Extended . +ulm ﬁl]
Line Vertical 'W f Lnlﬂ
Line -
» Basic Components ~ fe
» Commentary !
"
» Markers "J’ T[J‘*lq?lﬁ
» Fibonacci I I !i
» Gann -
AEIINEDE 16.00 Nov-07 900 11.00 1300 1500 [ 1400 Nov-07 11.00 1300 1500 [ 1200 Nov-07 1100 13.00 1500
» Gartley S5min 10 min  15min *32 = iy @ |4~ B |5min 10 min 15 min =32 = iy @ B+ B |5min 10 min 45 min =32 = v @ |H~ B
Ll Home  |ml Charis X 8 Account oo Options (& Scan  jlf Optimize  + L]
Accounts Page
() MotiveWave - Console (tradier) S P X
File View Configure Window Help
NYSE (36) X | + 3 = 2 . ”|(Accounts (4) x | + = 2
R — mmx Default Account Curre.. Type Cash Unrealized PL Session PL  TotalPL  Status AccountVa.. *
- T : [0
son AT N Simulated usD 100,000.00 99,922 00 5 7
Rsaw [ 095 ] nBox N 6YAO5708  USD cash 39377 32562 75 active 53,070.77
N 6YA05991 USD  margin 100,000.00 active 100,000.00
N 6YAODD05  USD margin 535557 active 535557
Orders(5)x]+ + w7
Account  Ticket Symbol Order.. Expires Action Qua.. Type Price Stopl.. Sto.. Limit Limi.. Fill.. Filled Status Gr. *
6YAOS708 207729 AA 1354841 GTC 1 MKT c
6YADS708 202727  SSRIMG11 1004047 GTC 1 MKT c
6YAD5991 202703  AA 1102921 GTC 1 MKT c
6YAO5708 202724  SSRI 110:40:01 GTC 1 MKT c
6YAD5991 191485  AAP 1124343 GTC 1 MKT c
Rs000 | 000 | RE-000
Positions x | Trades (14)  + + 2.7
Open Positions (3)] Closed Positions
Account Ticket symbol Quantity ~ Entry Price  Stop/Trail  Stop PIL Limit LimitP/L  Unrizd P&L  Market Value = LastPrice  Close 4 *
6YAOS5708 53328 [ole’e} 25 88.80 0 0 2,910.00 116.35 RS
6YA0S708 58329 SPY 225 19831 0 47,956.50 PIEREN  Close
6YAOS708 62804 TWTR 100 19.89 0 1,839.00 18.4 (O
3876.75
lnl Home  Lbl Charts (8 Account X o Options  [@t Scan  {}f Optimize 4 L]
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Options Page
~ MotiveWave - Console (tradier) S I
File View Configure Window Help
AAPL Nov-2516 X | + o L
Underlying Q, Search || Nov-2516 -
Symbol Position Bid Size Bid Ask  Ask Size Last Price
AAPL 2 11037 11041 40 11041
Position  PIL Orders Bid Size  Bid Ask  Ask Size LastPrice Strike Price Last Price Bid Size  Bid Ask  Ask Size Orders PIL Position
suy b3 .33 .38 14 - | 11200 pR-7 149 Z.8b 2490 Z
904 179 185 9 187 111.00 254 268 234 241
10 236 24 55 238 110.00 1.91 421 1.89 1.96 101
6 297 3.05 100 2.99 109.00 1.51 238 1.52 1.58 '
197 365 375 149 4 108.00 1.36 13 1.22 1.27
220 440 450 ] 4.40 107.00 1.02 18 0.98 1.03
simulated v | 1 3|=- | DAY ~ Flatten || Cancel All
GOOG Nov-25 16 X | + L - "
Underlying GOOG Q, Search Nov-25 16 A
Symbol Position Bid Size Bid Ask Ask Size Last Price
GOOG 3 782.53 783.75 2 782.52
Position PIL Orders Bid Size Bid Ask Ask Size Last Price Strike Price Last Price Bid Size Bid Ask Ask Size Orders PIL Position
6 960 10.70 21 950 790.00 2181 8 16.00 17.90
6 10.50 11.90 11 12.20 787.50 21.48 11 14.70 16.60
8 12.10 13.30 17 11.06 785.00 24.90 10 13.60 15.40
6 13.40 14.60 8 12.48 782.50 14.80 8 12.50 14.20
8 14.80 16.20 18 13.55 780.00 12.20 6 11.90 13.10
6 16.10 17.70 7 10.06 777.50 12.11 1 10.60 12.10
simulated v |[ 1 %|=- | DAY ~
lml Charts 8 Account @@ Options X |2 Scan  {lf Optimize  +

Scan Page
~ MotiveWave - Console (tradier) e o B R
File Edit View Sludy Stralegy Formal Configure  Window  Help
CsX o E R s @ IR lw~rQ I~ + W[E Q~|1day - | - r S EORCR -]
Ewwave 2 x | + =ILHE «” ||Harmenic x | + =il ‘W -
v || Pause | NN Loading: WYNN (46 of 57) ~ || Pause | NN Loading: WYNN (46 of 57)
Symbol Bar Size Scan Time A Pattern Score * Symbol Bar Size Scan Time A Pattern Score *
! !
AXP 1 day 16:01°45 Wave 2 Fair @|/csx 1day 16:02:16 Alternate Bat Good e
csx 1 day 16:02:16 Wave 2 Good et TGEy a3 el ool
FCX 1 day 16:02-17 Wave 2 Fair CSX IGE 16:02:16 Shark Excellent
FCX 1 day 16:02:17 Wave 2 Fair DIE D D 3RS Sk [T
Gs 1 day 16:02:18 Wave 2 Fair DE 1day 16:02:16 Ga Very Good
HAI 15 min AR08 Wave 2 Vers Gand DE 1day 16:02:16 Crab Good
AEO 1D X | + = "
: ey
CSX -1day ! T !
| e 751 J40.00
| e |
| e |
i 1 1 I
L : ) :
/ | d , W ! T : as.00
||| i g H||'|I|\”“\|| i I ‘ 1 - e :
. il | || i i "Hu"|||||‘ | B L | !
/ y -
iy e i i, ] i i
!
" ! ‘\”"I I ! “ ‘ ll,ul'w\“ !
! I I | | i g i | |
i I m“ \"“ i Il I| | |
I I e L I
| h 1) |
| L [ | J25.00
i i
| |
| |
1 1
! 2072 !
MotiveWave | tF | 72000
L I L
Sep-2014 __ Nov-2014 __ Jan-2015__ Mar-2015___ May-2015___ Jul-2015 Sep-2015_ Mov-2015__ Jan-2016 _ Mar-2016 __ May-2016___ Jul-2016 Sep-2016_ Mow-2016 __ Jan-2017
p- y p- y p-
1min 5min 10min  15min 20min  30min  45min 1hour 2hour 6hour 1day 1week 2week 1month 3 month = vy @ 4> B
il Home Ll Charts [ Account @ Options [ Scan % (i Optimize +
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Optimize Page
~ MotiveWave - Console (tradier) N — ¢
File View Configure Window Help
MA Cross | + E = o
Symbol Parameters. Start End Net Profit Gross Profit Gross Loss E i C: issi Max Di *
IBM C.EMA 20,C,EMA, 15 (Fast Input F Aug/06/16 Nowv/06/16 0 83 $0.00 $493.0

C.EMA.5.C.EMA, 15 (Fast Input,Fz Aug/06/16 Novi06/16
IBM C.EMA 15,C,EMA, 15 (Fast Input F Aug/06/16 Nov/06/16 0 $0.00 $0.01
IBM C.EMA.20,C,EMA 20 (Fast Input,F Aug/06/16 Novi06/16 0 $0.00 $0.01
IBM C.EMA,20,C,EMA_30 (Fast Input,F Aug/06/16 Nov/i06/16 56 $0.00 $497.0
IBM C.EMA10,C,EMA, 15 (Fast Input F Aug/06/16 Nowv/06/16 107 $0.00 $797.0
IBM C.EMA.5.C.EMA, 20 (Fast Input,Fz Aug/06/16 Novi06/16 125 $0.00 $822.0
n s A AN fCant Land T Ao i e s B P fznn
Chart Reports Periods Trades (153) Executions (154)
Strategy MA Cross Strategy ~ Start Date Aug/06/16
Type Optimize End Date Now/06/16
Symbol IBM Parameters C.EMA,5.C,EMA,15 (Fast Input Fast Method,Fast Period,Slow Input, Slow Method,Slow Period)
Bar Size 5 min
Metric All Trades Long Trades Short Trades +

Total Net Profit (Inc Commissions) £119.00 ($218.00) $337.00
Total Profit (Gross - Loss) $119.00 ($218.00) $337.00
Gross Profit $3,118.00 $1,282.00 $1,836.00
Gross Loss ($2,999.00) ($1,500.00) ($1,499.00)
Commission $0.00 $0.00 $0.00
Profit Factor 1.040 0.855 1.225
Max. Drawdown $876.00 $665.00 $379.00
Max Drawdown (%) 0.88% 0.67% 0.38%
Total # Trades 153 76 7
Percent Profitable 33.99% 30.26% 37.66%
# Winning Trades 52 23 29
Ll Home  |ml Charls 8 Account @ Options (& Scan  jlf Optimize x + L]

Nov-07 16:05:04

News Page

~ MotiveWave - Console (google) T

File View Configure Window Help
News | +
Time Frame: = All ~  Symbol: GOOG Search Text Filter

Symbols Released v Source Headline *
GuuGL 20718-11-UB 1112 ESI 1ecn 1imes p inc's cap 5 n
Profit Confidential

GOOGL 2016-11-04 05:26 EDT Profit Confidential Alphabet Inc: This GOOG Stock Trend Line is all that Matters e
GOOGL 2016-11-03 08:11 EDT Investorplace.com ‘Why You Shouldn't Buy Alphabet Inc (GOOGL) Stock Now

<Back | Foiward > | hitp:/fwww profitconfidential com/stock/google-stock-new-report-great-news-alphabet-inc/ Go

PROFIT HOME EDITORS v COMPANY v TOPICSv HOTSTOCKS v

CONFIDENTIAL

By Stephen Karmazyn

punisne noemeers2oe GOOG Stock: New Report Is Great News for PSSk B
movrmeamon Alphabet Inc

CJ CJ
Eifw]c |7 Jinfm]s

Why Google Stock Is Loving the

Smartphone Market Instantly Predict Daily Lows & Highs >
for ANY Stock or ETF with High Success

Know which stocks to BUY or SELL
in 10 minutes per day!

< Stephen Karmazyn
Read Full Bio Alphabet Inc (NASDAQ:GOOG) and Google stock

may be ready to make a huge splash in the phone

market as a new report shows “Android” phone sales Editors’ Picks
dominating globally.

Would a Trump U.S.
Presidential Election Win Sink
Dow Jones and S&P 500

88% of the 375 million new smartphones shipped

Elon Musk Delivers Blunt worldwide were running the Android operating
Assessment of Donald Trump system, according to a new report from Strategy Analytics. With Apple Inc.'s George Leong, B.Comm.
Facebook Inc: Analyst Issues (NASDAQ:AAPL)"i0S” platform and Android accounting for 97.3% of the worldwide smartphone Take-Two Interactive Software, Inc.:
Dire Warning on FB Stock market share, Google continually looks to place its new smartphone offering, “Pixel,” in opposition TTWO Stock Looking Great

to Apple’s “iPhone.”

Ll Home  Lbl Charts .8 Account  [&¢ Scan  {lf Optimize News X =+
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The Preferences Dialog (choose Configure -> Preferences from the Console menu bar) provides a
centralized location for configuring MotiveWave™. This dialog contains many configuration panels

organized under tabs (and sub tabs).

Preferences
(% MotiveWave - Console (google)
File Edit View Study Strategy Format | Configure | Window  Help
MSFT ~ Q| H B~ 6 # & Workspaces == T | {2 ~]15min -
Components X [AAPL15m |MSFT 15m x i Instruments ¢
B Active Tickers
v General . i \ =
MBEL 15 min ! g Repository
== Choose Configure -> o Prﬂﬁgnces
= savesConfiguration

Preferences from the top
menu bar.

Price Label Price

Commissions
(' Clear All Local Data

TTTqﬂﬂ'

Order Presets |

b= b= [Z] Update License
Support  Resistance &) Choose Language
Zone Zone il Layout

(W

T &

II\H'I

Preferences Dialog

i

o Preferences

Orders Alerts (=

X

mmeme cnarf| Top Level Tabs !Qatios Elliott Wave Gartley Tick Charts OFA®

EEEE] Kkeyboara Mouse Fonts Quick Search _Ticker Tape _Linking Dock _Trading Hours

Simulated Accol =

This panel contains general preferences tonﬁgure for MotiveWave.
v

24 Hour Clock:

Confirm Exit:

Use Native Windows:
News In Browser:

Link Stacked Charts:
Show Bar Size in Tabs:
Show Watch List Count:
Auto Save Enabled:

Auto Save Interval:
Google Poll Interval:

Tick History Limit

Filter Bad Historical Ticks:

v
v
v
v
(Seconds)
(Seconds)
:
v

Apply

Cancel

Feel free to explore the configuration options within MotiveWave™ by looking at the tabs and sub tabs
available in this dialog. More detail on specific configuration options can be found in other parts of this

document.
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2.2 Workspaces

Connections to Brokers and Data Services are managed through workspaces. Each workspace is a
separate instance of MotiveWave™ and contains its own local database. All data, settings and analyses
are separate between each workspace (with the exception of themes and historical data).

Workspaces can be managed from the Console or from the startup screen (click on the Options drop
down and select Workspaces).

Manage Workspaces from Startup Screen

MotiveWav

-Please Select a Workspace-

& options ~

Workspaces
Licen-::ek'
Appearance
Auto Update
Log Files
About
Choosing Workspace Jaye Furchase Updates
{c) Copyright 2010-2017 MotiveWave Software all rights reserved Version: 5.0.0

Manage Workspaces from the Console menu bar

MotiveWave - Console (google)

AL

Strategy  Format | Configure | Window  Help
A & Workspaces = T
L15m |MSFT 15m x s Insfruments

Choose Configure ->

. v | <& Active Tickers 1 Workspaces
T 15 min I | B Repository o= :
e || £¥ Preferences ﬂﬂﬂ H’I dﬁll?*i
| = save Configuration Jm L‘,llD

m Order Presets
Commissions
(' Clear All Local Data
[Z] update License
&) Choose Language
il Layout

PRV PRY LT TP

———

$oH b, b
[Fhoteocty,

J

gy S

The Manage Workspaces dialog enables you to create new workspaces or to edit/modify existing
workspaces. The order in which they appear in the startup workspace drop down can also be modified
from this dialog. Click on the New Workspace button to create a new workspace.
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Manage Workspaces Dialog

& Manage Workspaces x

Workspaces are used to manage connection(s) to brokers and/or data services and to store

information such as analyses, scans, open charts, layouts, instruments or watch lists. The table
below contains existing workspaces.

Name Service *

test Google/Yahoo
rithmic Rithimic
iq These are existing
tk workspaces
igtest2
igtest1 IQFeed
esignal eSignal
GAIN GAIN
amp_test AMP Global Clearing
cQG? Click here to create cQG

a new workspace
goog Google/Yahoo

AV4

New Workspace Close

2.2.1 Professional/Ultimate Editions

Starting with version 4.0 the Professional and Ultimate editions allow multiple broker and/or data
service connections within a single workspace.

Create Workspace Dialog
+ Create Workspace X
General Information

The workspace name uniquely identifies a workspace. All information related to the workspace
(configuration, market data, analysis files etc) are stored in a local database.

Workspace Name | | Eg: 'jsmith123" or 'simulated acct’

Choose a unigue name |
services that are configured for this workspace.

Click Add Connection a new connection or select an existing connection and click
Modify to change its properties.

Connections

Add Connection
A

Service
Click here to add a

connection to the
workspace.

Click "Add Connection™

Cancel
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From the connection dialog (see below) you can choose the broker or data service that you want to add
to the workspace. Connection information will depend on the broker/data service that you choose.

Add Connection Dialog

» Add Connection X

A Connection represents a connection to a specific broker or data service and enapsulates the required
connection information

General Information

The name uniguely identifies the name of the Connection within the workspace. Typically the name is the same
as the name of the Service.

r
Connection:

Connection Information

The name uniguely identifies the name of the Connection within the workspace. Typically the name is the same
as the name of the Service.

Service: | -Select Service- e from the drop down list

Select broker or
data service from
drop down

-Select Service-
GooglerYahoo
CANDA

AMP Global Clearing - Rithmic
AMP Global Clearing
BarChart

|QFeed

QuoteMedia

eSignal

TradeStation

ion' button to test if the
correct and that
MotiveWave can connect successfully

Cancel

The following dialog shows an example of a workspace with three connections (TradeStation, OANDA

and TD Ameritrade).
+ Create Workspace X
General Information
The workspace name uniguely identifies a workspace. All information related to the workspace
(configuration, market data, analysis files etc) are stored in a local database.
r
Workspace Name My Workspace Eg: 'jsmith123" or 'simulated acct'
Connections
The table below contains all of the brokers/data services that are configured for this workspace.
Click Add Connection to add a new connection or select an existing connection and click
Modify to change its properties.
Add Connection
Name Service
TS TradeStation
CANDA CANDA
TDA TD Ameritrade
Create Workspace || Cancel
Version 5.0 ©2019 MotiveWave™ Software Page 17 of 212
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2.2.2 Single Broker Editions

For the other editions of MotiveWave (Charts, Charts Plus, Trade and Strategy) only a single connection
to a broker or data service is allowed within a workspace. The following diagram illustrates the create
workspace dialog for these editions. Simply choose a name for the workspace and choose the
connection type from the service drop down.

Create Workspace Single Broker Editions
+ Create Workspace X

General Information

The workspace name uniguely identifies a workspace. All infermation related to the workspace (configuration,
market data, analysis files etc) are stored in a local database.

r
Workspace Name <Enter Workspace Eq: jsmith123" or 'simulated acct’
Enter workspace name

Connection Information

The name uniquely identifies the name of the Connection within the workspace. Typically the name is the same
as the name of the Service.

-Select Service- Choose your broker/data service from the drop down list

to see specific help.

Service:

-Select Service-

Select Broker/Data Service |itton to test if the

GooglerYahoo
from the drop down and that

OANDA

AMP Global Clearing - Rithmic
AMP Global Clearing
BarChart

IQFeed

QuoteMedia

eSignal
| TradeStation

Cancel

2.3 Changing the Default Layout

The console layout is highly configurable. All pages can have their layouts modified and pages can be
added or removed. The following screen shot illustrates the page area and some of the available
options:

Page Area
i3 “TTantr N TEER T TRaE T far2016 [Mar20  |ApraUi Fep-20 0ct-2016 " 0ct16 - E § =
1min 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 = v @ ¢y B
NYSE (35) X | NASDAQ (21)  Alers  + QB & .|| Indices (10) x | + - E QB = 7
Symbol Exchange LastPr.. LastTime Change % Chan.. Open Close High Low EPS PER* 102000 X 104400 X
AEQ NYSE 85.20 10:44:00 1767 1772 1792 175 1280 Af)
AXP NYSE 70.05 10:4400 [EER 69.97 7001 7034 6975 5630 T |{ocie [om ) meoo || nsosw [0% ] meose
BTU NYSE 47.58 207 207 0.00 0.00 -112.960 ! ||row I wow||ow R Wem|  This button will

Left click on a page

A W .
- 31.69 tab to activate it and 4.21 34.53 34.47 34.06 1.800 14 10:44:00 X 10:44:00 X create .a copy of
[ Shaded tabis 90.21 10:44:00 show its contents  0.47 90.70 90.98 89.69 4.990 1+ || PR P BT | the octive page.
the active page 51.95 10:44:00 412 13.80 14.26 1310 6763 N EEN BN =B

RS:0.00 | 0.00 | RE:0.00 | |Rs:0.00 | 000 | RB:0.00
— E— I's

Click here to add a
new page.

Click this button to
choose a preset layout 4

Ll Home X Ll Charts |8 Account »|l2t Scan  flf Optimize News =+

K}
Click the X' to
remove a page
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2.3.1 Creating a new page

To add a page to the console, click on the New Page button (see above). The New Page dialog will
appear (see below). You will need to specify a name for your page. This name is displayed on the page
tab when it is added to the console.

There are many different layouts available for your page. Just choose the one that most closely matches
what you want to have on the page. Several categories are available in the tabs at the top of the dialog.

The icon matching the category will be displayed on the page tab that you are creating (making it easier

to identify).

New Page Dialog

in New Page X

This dialog allows you to add a%I Enter a name for the page. This Wow, choose a layout (see below) and click on "OK".

F
Page Name: My Charts will be displayed on the page tab.

Lul Chart | Account |5t Scan flf Optimize 5 News

Available layouts are
grouped into categories I}g\

Several preset layouts
are available. Scroll
down to see more.

il

I il

Click OK to add the
page to the console.

/ [T

M( Cancel

2.3.2 Modifying a Page

You can change the name of a page and optionally its layout. To modify the current page, click on the
Edit Page button on the right hand side of the page area.

10:58:00 X

7262 | +26

L

Click here to edit the
active page.

Nov-11 11:00:0%

This will open the Edit Page dialog where you can change the name of the page and optionally select a
new layout for the page.
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At the bottom of the Edit Page dialog you will see a button called Reset Layout. This button can be used
to reset the console layout to the default. This will reset all of the pages including their layouts to be the
same as when you first created the workspace (see Default Console Layout screen shot).

Edit Page Dialog
7] Edit Page be

Optionally change the name of the page below, choose a layout (see below) and click on "OK™ L\\,

Page Name: [Home ]

Enter a new name for the
—| page and optionally
choose a new layout.

Ll Chart | 8 Account [ Scan {lf Optimize News

This will reset all of the
pages and their layouts to
the default layout when the
workspace was first created.

[ \J/ [T
v

OK Reset Layout Cancel

p)

2.3.3 Changing the Page Order

If you would like to change the order of the pages, simply click and drag the page tab to the desired
location:

Change Page Order

Ear =it W N e S
AXP NYSE 4+ 71.02 11:04:00

I ¥
69.97 7011 70.34 69.75 5.630

[ -028]

BTU NYSE #4749 2.07 2.07 0.00 0.00 -112.960
CSX 34.21 34.53 34.47 34.06 1.800
DE Left click and drag the 90.47 90.70 90.98 89.69 4990
e tab to the left or right

14.12 13.80 14.26 13.10 -6.763

Vertical blue bar indicates wherew
the page will be dropped

il Home % Lul Charts 8 Account

& Scan  flf optimize |

2.3.4 Resizing Panels

The size of the panels displayed in a page can be resized by clicking and dragging the area between each
panel. Notice that the mouse cursor will change when you hover over these areas. The following screen
shot illustrates changing the vertical space between the chart area and watch list area in the Home
page:
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Resize Panels
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LTl e, n | T
7 1200 1400 Nov08 1200 1400 Nov09 1200 1400 Nov10 1200 1400 Nov-11 12.00 14:00
% H60.00
$
Mar-2016 Mar20  |Apr-2016  |Sep-20 Oct-2016 Oct-16 No-2016 50.00
i T|day 1 week 2week 1month =4 = v @ |+ /B
Click and drag resize area 1 = 4
I 52 2| (indi
up/down (in this case). I/ = 5 A E & 7| Indices (10) x | + }
- ose  High Low EPS PER+ E A0 :
17.67 1772 1792 1751 1260 1) Click and drag the space
between panels to resize.
69.97 7011 7034 6975 5628 11 || oo
e B 1l 1
207 207 0.00 0.00 -112.960 | |ow R vom || Lo

34.47
90.95
14.26

34.06
§9.69
13.10

1.800 1
4.990 14
-6.763 [

2.3.5 Adding New Panel Tabs

iﬂﬁ 11:10:00 X

Sell Buy [J| sen RSN B
—__ —— gy

New panel tabs can be added to each panel area in the active page. Simply click on the New Tab button
to the right of the existing tabs. The follow screen shots show the sequence to add a new chart to the
main panel of the Home page. In this example, three charts are stacked on top of each other with the

active chart showing with the highlighted tab (in white).

Add New Panel Tab

New Chart Tab Dialog

(Y MotiveWave - Console (go
File  Edit View Study Strat Window  Help
MSFT  [~/Q | i& & s~ | Click+'buttontoadda b + [T |&~[15mn  ~
AR TsSET 15m x | +<k new tab to this panel. J 7‘
MSFT-15min | il Chart =
Volume i = Wish List ror ] Lk ﬁq;*i
i !g _Er].epth O; f'galrket Choose the type from the i
| - OlltEZFB'I?ablea es list of available options +
11 Position Table 5
! ®, Trade History Table ! '
L | i |
M l'r T e Ty []*5*!.,. ¢ 9 Account Table | :
i m News ; i
'L [| [ Scanner | |
+ il Optimizer | i
77 Alert Table | |

m il X
Enter Symbol i
Please select an ose the bar size.
symool: |IERI -] Q
Analysis: | Primary Analysis v
Bar Size: | 15min | Click OK to create
Link: | 32 ~ the new panel tab
OK Cancel
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New Tab Added
Y New Chart Tab MotiveWave - Console (goo
File Edit View Study| added here
INTC ~ Q| S
AAPL 15m MSFT 15m INTC 15m x | +

at  Configure Window  Help
KElerQ i~ + BT/~ [15mn  ~

W

NTC -5 min Dﬂ#‘hﬂ]ﬁl - []
Other chart tabs still exist, but are 'stacked" 'Hj 'LJ’D hw *E +gﬁ é]
behind the active tab. Just click on the tab D +[I i l .ﬂ m
to activate and bring to the front. .EH'U Ti[llj[llj |

if

2.3.6 Creating a Custom Layout

MotiveWave™ includes a number of built-in page layouts which are available when you create or edit
the page. You can organize the panels in the page however you like by left clicking and dragging the tabs
around. As you drag the tab, you will see a highlighted blue area where the panel will be created when
you release the mouse button. This feature provides you the flexibility to create any layout with any
number of panels. The following screen shot illustrates moving the chart tab that we created in the
previous section (MSFT symbol) and creating a new panel area by horizontally dividing the existing panel
into two.

Custom Layout Step 1
~ MotiveWave - Console (google) - A X

File Edit View Study Strategy Format Configure Window Help

MSFT [~ B 5 B =- @ Krlw~r@ §~+ [T &~[15mn ~ sme XS mD S Q
AAPL 15m  |MSFT 15m x | + = .7
MSFT 15 min_| | ]
youme ick and drag this tal 'J’un? !h b 1160.50
Eiinz thl:z Ideftgn::uste ll;utt:m | ‘H“D?TTH?““LWIUFD Tllﬂr']mﬁ F '“Dﬁ * w*[ﬁml
iuww l ﬂ [F
l ﬁ UI §i o Heo.00

5*#ﬂ1#+l [j+ UW;“ D '[l | MSFT 15

il s

Y T

++¢ﬂ.¢+l "
i O []*$+'1U“T¢l+r?*!
+H Cursor changes and

shows the dragged tab in
the background. Release

T I!] the mouse button to
n l "drop” the chart here.

ﬂ "
H Blue highlighted
area illustrates
where the panel
will be created.

’ 0 I-""'"I"||' IETIERILTE LU, H‘l'mhmﬂmﬂlﬂlnulnlﬂlﬂlnﬂmr“ Iulﬂﬂ”IH”UIIHI"l[]IﬂlHﬂIﬂlﬂﬂnﬂln.l.p.n. .
14:00 Nov-03 1200 1400 Nov-04 12:00 14:00 Now-07 1200 14:00 Nov-08 12:00 © 14:00 Now-09 1200 1400 Nov-10 1200 14:00 Nov-11  12:000 14:00 16:00 18:00
imin 5min 10min 15min 20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 3 month S v @ |olv B

et | — ‘n-l'lllln linagesam ---||Uln.nnn| "
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Custom Layout Step 2
v MotiveWave - Console (google) 2. A x

File Edit View Study Strategy Format Configure Window  Help
MSFT ol BN A C KElw~r@ i~ + [T 2~[15mn ~ LEe % SHEDOD
AAPL 15m x | + = 7 MSFT 15m x | + (B
AA 15 min H ' 60.50
UFW Iql .ﬁﬁ* l J111.00 P
b it
]ﬁ D New Fe.mel is ireate? 8000
u QTIJI] 'U oo /Opticnally use ::;ﬁt‘:;ttt::t v:l:lssﬁ
ﬁ Qn ‘Ij U this. di\:ihder to | ” g’l"agied?nd dropped in 459.50
resize e pane Ij 1S position,
‘ J4nann) T! | 1
i b o D 5
HM * 'I XUW*#T[:] T'Tl.,u 10607 HMD 'T* |I][F! ? li lﬂ* 78

45850

! ﬂUT‘ﬁm
1055 5501
HH A e nIilUlIﬂﬂﬂﬂﬂpnn ol gﬂﬂunll”dl Mingucnacagnan |H“|ﬂlﬂ TR gmlylﬂbﬁﬂ”ﬂn'mﬁlhmﬂinﬂﬂ “II Iﬂﬂ Ll ||n|||| [l [T 3;

1400 Nov-09 12:00 14:00 Nov-10 1200 14:00 Now-11 1200 1400 Nov-09 12:00 14:00 Nov-10 1200 1400 Nuvﬁ 12:00 14:00 1600 1800
1min Smin 10min | 15min 20min 30min 45 min g = @~ @ |#~ || 1mn Smin 10min [ 15min 20min 30 min 45 min g s vy @ ¢~ B

2.4 Changing the Look and Feel

MotiveWave™ provides several options for changing the look and feel of the window decorations,
docking framework, table colors and chart colors. Use the Preferences dialog to change these attributes
(as well as many others). This dialog can be opened by pressing the Preferences button at bottom right
of the console window or by choosing Configure -> Preferences from the top menu bar.

Preferences Button
Wwﬂ\ P WP e WP

{ # @ ,”|[indice.. x |___ - Qe
8 General Preferences
Button

Mov-11 16:22:49

If you would like to modify the preferences for the docking framework, click on the General tab then on
the Dock sub tab. Several options are available from this panel (see below):
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Dock Preferences
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x

Preferences

e

IEEEE] theme chat ToolBar Sounds Ratios Eliott Wave Garlley Tick Charts_Orders Alerts _Email

-

General Keyboard Mouse Fonts Quick Search Ticker Tape Linking

B @ Trading Hours Simulated Accol (=

This panel contains preferen(‘.es for the d Location of the
I tab
Tab Location: | Top - panel tabs

BOUOM i Location of the

Page tabs

Page Bar Location:
Show Tab lcons|

V| Confirm Remove Page

OK || Apply || Cancel

Click on the Dock
sub tab of the
General section

The Themes tab provides several options for changing the look and feel of the window decorations as
well as the colors for the chart, tables and buy/sell boxes. Custom Chart and Bar themes can be defined

under the corresponding tabs of this section:
Themes

x

Preferences

o

General [[III0Y Chart Tool Bar Sounds Ratios Eliott Wave Gartley Tick Charts Orders Alerts Email

-

Bar Themes Chart Themes < Custom bar and chart themes can
l be defined under these tabs.

(Chart Theme) and bar colors (Bar

Themes are used to change the look of the Ul corm T

Window Theme: | Light
Chart Theme: | Light -

Bar Theme: | BlackWhite

Theme). Use the drop down options below to configure themes for Motive\Wave. Click OK to apply your changes

Buy/Sell Colors

Red/Blue v Colors to be used when
displaying P/L or Bid/Ask

OK || Apply | Cancel

The following screen shot shows an example of some theme changes:
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@

File View
AAPL ~Q |k
il Home X lnl Charts
Components
¥ General

=1

== =

Price Label Price Label

1 1

"= 1

Support
Zone

Resistance
Zone

Study

Y
X |AAPL

Theme Sample
MotiveWave - Console (google)

Strat Format  Configure  Window

Help
WelerQ v+ BI O2v|15mn -

M News +
BN . Page Bar at the top

ilf optimize

AAFL 15 min

Twilight and Red/Blue
themes for the chart

Dark Window
Theme

motivewave'

Trade
Position  Order Bid/Ask
111.00
Buy Mkt Sell Mkt

Red/Green

Buy/Sell colors

100 00

108.87

1
10843

Entry/Exit
108.00

T &4

Time Label Time Label

simulated

NIA NIA

Horizontal
Line

Extended
Horizontal 107.00
Line

Extended
Vertical
Line

Vertical
Line

Hane nn

533 4K

—— — L B 45 o 2 ho T ;
» Basic Components imin Smin 10min | 15min 20 min 30 min S5min 1hour 2hour 6hour 1day

» Commentary NYSE (35) X | NASDAQ (21)  Alers  +

» Markers Change

% Change
3.22%

0.56%

Symbol Exchange LastPr.. Last Time Open  Close
AEQ NYSI 29
AXP
BTU

roy

» Fibonacci 0.57
0.39
0.00

nnn

17.67
» Gann 69.97
» Elliott Wave
» Gartley

=

A (| | (T —
TRH e e

MNov-11 16:35:04

Fonts and icon sizes can be changed from the Fonts panel. Select the General Font/Icon Size option to

adjust the overall size of the icons and fonts for the windows and dialogs. This option can be particularly
useful on a high resolution screen.

Lo Preferences X
Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts OFA® Orders Alerts =
General Keyboard Mouse Qg8 Quick Search Ticker Tape Linking Dock Trading Hours Simulated Accot =
S Nl Chart Fonts
The fields below allow you to adjust the general fan ation.
General Font/lcon Size: | Default - Fc:nt and icon s.|ze of
Ly | windows and dialogs.
Watch List [EEEER
Small
News Table ) 0 Enabled
IMedium
Quote Sheet Group | ed-Large Enabled
DOM Table | Large Enabled
Time & Sales Taple | 0@ Large Enabled
OK | Apply Cancel

Fonts can also be adjusted for the charts on the Chart Fonts tab:
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Lo Preferences X
== theme Chart ToolBar Sounds Ratios EliottWave Gartley Tick Charts OFA® Orders _Alerls (=

General_Keyboard Mouse [[Ruped Quick Search Ticker Tape Linking Dock Trading Hours _Simulated Accot

System Fonts Eﬁlﬁﬂ

The fields below allow you to adjust the fonts displayed on charts.

Time Axis Arial;13.0 Enabled
Birds Eye View Arial;13.0 Enabled
Vertical Axis Arial;13.0 Enabled
Indicator Arial;13.0 Enabled
Ratio Label Arial;12.0 Enabled
Info Points Arial;12.0 Enabled
Comment Arial;12.0 Enabled
Chart Title Arial Bold;13.0 Enabled
Chart Label Arial Bold;12.0 Enabled
Study Label Arial Bold;12.0 Enabled
Legend Arial;11.0 Enabled

TH Label Arial Bold;11.0 Enabled
TH Info Arial;11.0 Enabled

TH Arrow Arial Bold;11.0 Enabled

OK || Apply || Cancel

2.5 Instruments

Stocks, FOREX pairs, futures contracts, indices etc are generically referred to as Instruments in
MotiveWave™. The available instruments will depend on the broker or data service that you chose for
the workspace. When you initially create a workspace in MotiveWave™ a default set of instruments will
be populated in the local database. Additional instruments can be added by searching for them or
defining them.

All instruments can be centrally managed from the Manage Instruments dialog available from the
Console (Configure -> Instruments from the top menu bar).

Manage Instruments

(™ MotiveWave - Console (google)
File Edit View Swudy Strategy Format | Configure | Window  Help

AAPL > Q| h B e~ @ # & Workspaces == T &~ ] 15min ~

lul Home X Ll Charts 8 Account |2 Scan —] Instruments

AAPL 15m x | MSFT 15m + s AC“% Tickers

Choose Configure ->
Instruments from the

£ Repository
AAPL - 15 min £ Preferences top menu bar
/olume |= save Configuration -

Order Presets

e |
Commissons i
‘ |

o (' Clear All Local Data
| i I * [E] update License |

BT T. I 00se Language
[ ¢|Tf¢"’““"’n, L e G iﬂ
* .

T T
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The Manage Instruments dialog displays all of the instruments that are defined in the local database.
You can filter the list by typing in a symbol (or partial symbol) or choosing a specific instrument type or
exchange.

Manage Instruments Dialog

—]| Manage Instruments x

The following table contains instruments that currently exist in the local database. From this dialog you can add, remove or edit
these instruments. (Hint: use the CTRL key to select multiple rows).

Symbol: Type: | All ~  Exchange: = All -

Underlying a cription Type Expiry Date Currency Exchange +
DJI Type symbol here to  |nes Indus Index usD [ ]
DJT filter the list nesTrans  Index USD
FTSE FTSE FTSE 100 Index usD
HSI HSI HANG SENG Ind Index usD
AN ANX S&P 500 Index Index usD
AXIC AXIC NASDAQ Compo Index usD
N225 N225 MNIKKEI 225 Index usD
NDX NDX NASDAQ 100 Ind Index usD
TWil Twil TSEC Weighted | Index usD

Australian Agricul Stock AUD ASX

Ardent Leisure Gi Stock AUD ASX

Apple Inc Stock usD NASDAQ
Click to search for

Ausenco Limited Stock

instruments

- - Select one or more rows above
available from your Adelaide Brightor Stock and click "Delete” to remove

broker/data service Abacus Property Stock them from the local database

Total Instrumen 5: 459

Q, Search || & Import | Define | Custom Advanced | Cancel

Additional instruments can be added to the local database by either clicking the Search, Import or Define
buttons (Note: the Define and Import buttons are not available for all brokers/data services).

The Search button will utilize the broker/data service’s search capabilities to discover new instruments
that you can add to the local database.

2.5.1 Importing Instruments

For convenience, the Import button will allow you to import a set of instruments from a CSV (comma
separated values) file. This file can be created using a spreadsheet (such as Microsoft Excel) and saving
it as a CSV file. For details on the format of the file, see:

http://www.motivewave.com/data/import instruments.htm
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Import Instruments Dialog

g Import Instruments X

This dialog allows you to import instruments into the local database from a CSV or ASCII file.
Click here for information on the format of the import files.

Data Files

Click here to ~
Add
add a data file J—

Click import to read the
data files and add them
to the local database

N\
V

Cancel

2.5.2 Trading Hours

Trading hours define the days and time of day that an Instrument is traded. For most instruments the
trading hours may be assigned automatically by MotiveWave™. When you create your workspace,
MotiveWave™ will create a default set of Trading Hours. You can create your own trading hours and
override the instrument settings. Trading hours can be created/modified from the Preferences dialog
(Configure -> Preferences from the Console menu bar, click on General then on Trading Hours).

Trading Hour Preferences
e Preferences x

Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email -

Select trading hours below and Lick Search Ticker Tape Linking Dock Trading LRIVl Simulated Accol (=

click here to edit. Note: built-in J

hours cannot be edited. rading hours for historical data retrieved from your data provider. Click on the '+'
To assign trading hours to an instrument, edit the instrument and choose the

approp trading hours from the Trading Hours drop down.

Built In

frue

Click here to add —
custom Trading Hours

frue

oTC frue

CHX frue

Xetra true

ASX true

OK || Apply | Cancel

The Trading Hours dialog will appear when you click the add button (‘+" icon) above. If an exchange is

chosen, then the hours defined in this dialog will be used as the default trading hours for instruments on
that exchange.
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Trading Hours Dialog

+ Trading Hours X

This panel allows you to define trading hours that may be applied to a single instrument or an exchange. Most trading hours
will be defined as a time frame (session) Monday - Friday as regular trading hours. Some instruments such as CME futures
may have two trading sessions within a day (see Start2, End2 below). Optionally, extended hours may be defined for
instruments that have trading hours outside of the regular session. Specifying an exchange below will set these hours as the
default for instruments within that exchange.

Name: [ Custom Hours 1| Note: name must be unigue

Time Zone: | America/New_York -

Exchange:

-Select Exchange- ~_ +
Week Begins On Saturd

Default Trading Hours for Selected Exchange

This will make the Trading
Hours the default for a

+ | specific exchange. ~ End 2 - - Enabled
For some exchanges, 16~ | 30~ Start 2 - ~ End2 - ~ | v/ Enabled
(such as Saudi 16~ | 30~ Start 2 - ~ End 2 - - | |v| Enabled
Arabian) trading
starts on Saturday 16~ | 30« Start 2 - - End2 - ~ | |v/| Enabled
16~ | 30~ Start 2 - - End2 - ~ | |v/| Enabled
Friday: Start| 09 v || 30~ |[End| 16 v | 30 = Start 2 i ~ |End 2 - ~ | |v/ Enabled
Saturday: Start - ~ End - - Start 2 - ~ [End 2 - - Enabled
Extended Hours:
» |End - - Start 2 - « |[End 2 - -
» |End - - Start 2 - « |[End 2 - -
Click this box to define B o o
hours outside of the - e v M S - ~EL - -
regular trading period + |End A - h * |End 2 - -
ursday. Sian v |[End v v v v |[End 2 v v
Friday: Start v v |[End v v - w |[End 2 - v
Saturday: Start v v |[End v v Start 2 - w |[End 2 - v

OK Cancel

The Trading Hours for an instrument can be assigned from the Advanced tab of the Instrument dialog.
This dialog can be accessed from the Manage Instruments dialog (Configure -> Instruments from the
Console menu bar) or from the context menu of a chart (right click on a chart and choose Edit

Instrument).
Edit Instrument

(", MotiveWave - Console (go

File Edit View Study Strategy Format Configure  Window  Help

AAPL ~ Q| k& B Ev @& W wrQ i~ + "5 I &~|15min -
Ll Home % Lul Charts 8 Account |2t Scan  {lf Optimize News =+

AAPL 15m X |MSFT 15m  + 5
AAPL - 15 min “

ivolume ; ; i'r I*I i+ ;

| | o Tyt “i y

; ; ; £} Chart Settings I “

: ; Edit Instrument :

! Right click on the A Bar Size ’ :
ii *IH.“"! chart and choose '|""J'T ; ' Wolume Interval g l T* I' :

i *l” "Edit Instrument’ i Range Interval ’ i! i

i ** : i Renko Interval b i

i | i i Template » i

: +E : Link J :

} | | Add Study , |

: : Tools g :
i i Trade :
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Modify the fields below and press OK to save ya

General Commissions EELENE]

Edit Instrument - AAPL

Click on the
Advanced Tab

Trading Hours: | Custom Hours 1 b

Minimum Tick: | -~S¢elect Trading Hours-
ASX
CHX

Nasdaq

NYSE
oTC
T3X

| Xetra

Point Size:

OK Order Presets

+

Select the Trading
Hours that you defined
from the drop down

Delete C

ancel

2.6 Watch Lists

Watch Lists provide a convenient way to organize a related set of instruments together in one location.
MotiveWave™ will create a default set of Watch Lists when you first create your workspace.

There are two ways to view a Watch List:

1. Table View — In this tabular view, each row displays an instrument. The table view will have a
default set of columns, but these can be configured by the user to show or hide any of the
available instrument values. Optionally, you can sort this table view by any of the columns in

ascending or descending order.

2. Buy/Sell View — This view shows a Buy/Sell box for each instrument. The current Best Bid and
Best Ask values are shown along with the last price, last time, daily high/low and spread. Market
orders can be placed directly by clicking on the Buy or Sell areas.

The following screen shot shows the default set of watch lists displayed on the Home page.

Default Watch Lists

s R h,mﬁwmﬁnqh/—ﬂmﬁw*\ﬂ"ﬂwwmm T T,
H

.’!’ﬁﬂ’;ﬂ‘?"ﬁ‘ﬂlrﬁln ifigiestaapanaanlia T rhhllllﬂl; Langliaal 1I“Ihlllpm| i II"IIl

1400 Mov-07  12:00 14:00 Nov-08 12:00 14:00 Nov-09 12:00 14[]0 Nov-10 12:00 1400 Nov-11  12:00

Use this button to [EnEvE
switch between table f
and Buy/Sell views.

!

14:00

1min S5min 10min [45min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month 3mgatn

o> @ |4~

NYSE (35) X | NASDAQ (21)  Aleis  +

= I = .”

Symbol Exchange LastPr.. LastTime Change % Change Open Close  High
AEO NYSE 18.64 11:24:00 [ 129 1829 8.78
AXP NYSE 72.15 11:25:00 A 080 70,
BTU NYSE $19.95 0.00 000% 207 2

Low
18 26

EPS
1.257

Click on any column to sort.
First click sorts ascending,

second descending and the
third click removes the sort.

P/E Ratio 52 Wee *

1475 1 e
l ? Sell =v Buy
12.77 7 y o SwEwm
0.00 & 2 Buy,"SeII Box
19.35 3 o 25 o

18.37 9

CsX ARLos o 0.00 0.00% 34.72 34.

DE Note: Default Watch 11:2500 9097 91

FCX Lists and contents will 112500 1404 1394 1405
vary depending on the

FDX broker or data service 11:24:00 18450 18369  185.68

GS 11:25:00 20415 20394 21177

KIYRFE & aan 112500 A7 R AR N1 AR RA

13.71
183.46

20415
A7 2Q

6.690
12.461
_R RT71

-6.760

0.00
27.68

16.81
nnn

518204 m Tsurar

Nov-14 11:25:23
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2.6.1 Watch List Tool Bar

Several features are available from the tool bar in the top right area of the watch list panel. These
buttons are as follows:

1. Link With Chart — If this button is on (shaded background), clicking on a row in the watch list will
set the instrument for the active chart on this page.

2. Table/Buy Sell View — Toggles the view of the watch list between the table view and the Buy/Sell
boxes view

3. Search/Add Instrument — Launches the search dialog to search for an instrument and add it to
the watch list.

4. Import Instruments — Click this to import a set of instruments from a CSV file (not available on all
workspaces)

5. Edit Watch List — Edits the watch lists properties

6. Open in Window — Opens this watch list in a separate window

7. Maximize — Maximizes the watch list panel to use all of the available space on the page

The following screen shot shows these buttons in the tool bar:

Watch List Tool Bar
B i e B I I W e T iy i = T e

i ] Entry/E

Table/B
||I"|||II!||nlnp|l|lll| Illlllllll!lllll|Ip|mI|l“JSZ" \f’{e;"

I . |mp0r‘t - ? 16M
' Instruments Open in
ov-09 12:00 1400 Now-10 12:00 14:00 Mow-11 Window
1hour 2hour 6hour 1day 1week 2week 1 month D ||+ B

Maximize
D -10:00 X
O RE)

Edit Watch
List

TWatch List Tool Bar E e

% Change Open Glose High

1829 1829 18.78 18| Link with |} Search/Add
; Chart

70.80 70.50 71.89 70| “"a Instrument (oo | Reso

000% 207 207 0.00 000 -112.960 0.00 8 || o0 m .00

000% 3472 3458 35.06 34.62 1.800 19.35 3

2.6.2 Sorting Options

The table view of the watch list can be either sorted or unsorted. This mode can be toggled by clicking
on the column headers within the table view. Clicking a column header once sorts it by ascending order.
Clicking a second time will sort in descending order. A third click will make the table unsorted returning
it to its natural order.

2.6.2.1 Unsorted View

In the unsorted view, you can arrange the instruments in the list by clicking and dragging them to the
desired location. Alternatively, right click on a row and choose Move Up / Move Down to adjust their
locations.
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Unsorted Watch List
NYSE (35) X | NASDAQ (21)  Alerts  + - Qe = .7
Symbol Exchange LastPrice LastTime Change % Change Open Close  High Low EPS P/ERatio 52We*

AEO NYSE 18.78 18.29 1829 18.80 18.26 1.260 14.96

AXP NYSE 72.63 70.80 70.50 72.58 70.62 5.630 12.89 l

BTU NYSE %3 0.00 0.00 000% 207 207 0.00 000 -112.960 0.00

CSX NYSE 0.0¢ 3472 3458 35.12 3462 1.800 19.45

Click and drag (left
mouse button) to the
desired location

DE NYSE 91.62
NYSE 13.89

9097 9110 92.00 90.97 4.990 18.37
14.04  13.94 14.05 13.55 -6.763 0.00

13:46:00
20948 13:47:00 20415 20394 211797 20415
HAl KV EFE AT A7 -A7- AT A1 AR MM AR RA AT A _R BTN nnn

2.6.3 Buy/Sell Boxes

A Buy/Sell box shows the current Best Bid and Best Ask prices for an instrument and makes it easy to
quickly place a market order to buy or sell the instrument. The following diagram shows the elements of
a Buy/Sell box:

Buy/Sell Box
Instrument Last Trade
Symbol Time Remove

" Box

. Best Ask

Price

10:60:67 X

Best Bid
Price

&= - B
RS-0.05 RE: J Buy/Sell

L:1.37474 ﬁ H:1.37762 |Quantiw

Day Low Spread | Day ngh

The colors of the box will change as the prices change. If the price goes up the label will flash blue (or
green depending on preferences). If the price goes down, the label will flash red.

You can modify the preferences for the Buy/Sell boxes from the Preferences dialog (Configure ->
Preferences from the Console menu bar).
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& Preferences

I ToolBar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email Trade H\stowm_v

x ||

Preferences X

Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email Trade His v

‘See Orders -> Submission panel to configure order options for these boxes

Default size is Tiny. Other
options are: Small, Medium
and Large

/| Show Bid/Ask Sprezo

Box Size: | Tiny -

/| Show Last Price

OK | Apply

Cancel

Use this dialog to configure how buy/sell boxes are displayed in the Instrument Organizer.

Bar Themes  Chart Themes

Themes are used to change the look of the Ul components (Window Theme), chart colors (Chart Theme) and bar colors (Bar
Theme). Use the drop down options below to configure themes for MotiveWave. Click OK to apply your changes

window Theme: | Light =
Chart Theme: | Light -
Bar Theme: | Red/Blue -

Buy/Sell Colors: Use the drap down
to switch between

blue and green

Red/Blue -
5

Red/Green

Red/Blue

OK  Apply Cancel

2.6.4 Create Watch List

Choose File -> New -> New Watch List from the Console menu bar to create a new watch list.

Create New Watch List

[

L

File | Edit

New
Cpen
=
Chart
£ Backup
&' Restore
Disconnect
Shutdown

View

M
He
i~+ 7

News

Stuay window

Q

Strategy ~ Format  Configure

' [E New Page
* | = New Watch List e
il NEW Deskiop
* | Ll New Chart Window
il New DOM Window
) New Time&Sales Window
Custom Instrument

Ctri+N

[

On the first page of the New Watch List wizard, you will be asked for the name of the Watch List. This
name will be displayed on the panel tab.
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New Watch List — Page 1
New Watch List X

New Watch List/Quote Sheet

This Wizard will enable you create a watch list or quote sheet to display a tabular view of instruments (or Buy/Sell box
view)

1. Specify Name of the Watch List

2. Specify Columns to Display

3. Specify Instruments to Display
Click 'Next' to continue.

L .0 Stk This is the name displayed
Quote Sheet in the panel tab.

Quote Sheets allow you
to group the instruments

in a watch list (not
available in all editions).

Click Next to

choose columns

Next > Cancel

On the next page of the wizard, you will be asked to specify the columns. If you would like to add one or
more columns to the list, select them from the Available Columns list (hint: use the Ctrl key or Cmd key
on OSX to select multiple rows) and press the ‘>’ button to move them to the Selected Columns list. If
you would like to remove one or more columns, select them from the Selected Columns list and press
the ‘<’ button.

New Watch List — Select Columns

= New Watch List X
Choose Columns
Select the columns that you wish to display
Available Columns Selected Columns
Account Symbol
Ask E

Click this button to
add the selected
columns

Avg Price

Use these buttons
to change the

\ column order

:f,ozifeRa Click a column to I::;n

select. Hold down Ctrl =
Descriptiol key to select multiple Close
Dividend A (Cmd on O5X) Change
Dividend Yrera % Change
Expiry Date
Change (Inv) Use this button to
% Change (Inv) remove columns
% Off High 52 Week Low
% Off Low
% (A Cwnan
pip| Note: you can also click and

pod drag columns to add/remove
or change the order in the
watch list.

| Click Next to select

instruments

< Back Next = Cancel

The last step is to choose the set of instruments that will be displayed in the Watch List. Type the name
of the symbol in the -Choose Symbol- field and press Enter to add it to the list. Alternatively, select a
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name from the drop down. You can also search for a particular symbol by clicking the Search/Add
button. If supported by your broker/data service you can import a set of symbols by clicking on the

import button (see below).

New Watch List — Choose Instruments

New Watch List

Click here to search

Add Instrumen

Select the instruments

and add a symbol.

-Choose Symbol- > QB
A

pressing the '+' or search buttons below.

ple Inc
rkshire Hathawa Imp
soft Corporatiorr

ort from CSV file I

"Enter” to add it to the
list. Alternatively, select
from the drop down.

Total Instruments: 6

watch list.

—,—

Click to save the

< Back Save

Cancel

2.6.5 Edit Watch List

Click on the Edit Watch List button (pencil icon) on the Watch List tool bar to open the Edit Watch List
dialog. From this dialog you can change the name, available columns or the instruments.

Edit Watch List - Configuration

x

Use this panel to change
the name or columns
displayed in the Watch list

= Edit Watch List
Watch Lists are used to organize related instruments. Use the > and < buttons to add or remove columns. When
you are finished, click OK to save your changes.
Configuration U=
r
Name = NYSE
Available Columns Selected Columns
Account Symbeol
Ask Exchange
Avg Price Last Price
Bid Last Time
Day Range Change
% Day Range % Change
= Open
Descliption Close
Dividend Amount High
Dividend Yield 7> | Low
Expiry Date <=  |EPS
Change (Inv) P/E Ratio
% Change (Inv) 52 Week High
% Off High 52 Week Low
% Off Low Click h h
ick here to save these
% Off Open
3 P columns as the default
Pips for new watch lists.
Position
OK Save Columns Cancel
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Edit Watch List - Instruments

Edit Watch List X

Watch Lists are used to organize related instruments. Use the > and < buttons to add or remove columns. When
you are finished, click OK to save your changes

Configuration Il E!i! HEI:H

hoose SymboH ~| Q) B

AEQ - American Eagle Qutfitters
AXP - American Express

BTU - Peabody Energy

CSX - CSX Corporation

DE - Deere Co

FCX - Freeport-McMoRan Copper & Gold Inc.
FDX - Fed Ex

GS - Goldman Sachs

HAL - Halliburton

HD - Home Depot

HES - Hess Corporation

KO - Coca-Cola, Co.

LOW - Lowes Companies

PER - Petro Brasileiro Petrobas
PHM - Pulte Group

POT - Potash Saskatchewan
RIG - Transocean

UA - Under Armor, Inc.

Total Instruments: 35

OK Save Columns Cancel

For convenience, columns can be modified directly from the Watch List. Click and drag a column header
to change the order. On the right hand side of the column header, there is a button that can be used to
show or hide columns.

Edit Watch List Columns

NYSE (35) NASDAQ(21) Alerts | Top 50 Stocks (10) x | + il TR = 7
Symbol Exchange LastPr.. LastTime  High Low  Open ange % Chan.. . EPS P/ERatio 52W*
AAPL  NASDAQ 105.50 13:56:00  107.81  104.08 107.71 108.43 8310 1268 /‘
BRKA NYSE  236146.00 13:52:00 237100.00 234930.00 36150.00 34860 55.24

MSFT  NASDAQ 57.93 13:56:00  59.08  57.28 59.02 59| Clickand drag column 2.09 Cg;"’s‘i to hidfe or
ORCL NYSE 0.00 3967 3911 39.39 agg| Neadertochangeorder. f o, A0 70 Hns oM
GOODY SAUDI 0.00 0.00 0.00 0.00 000  000% 0.0 :

GOOGL NASDAQ 756567 13:56:00 77178 74359 77176 17175 27.320 2765 I
GOZDE SAUDI 0.00 0.00 0.00 0.00 000  000%  0.000 0.00

IBM  NYSE 158.16 135600 161.86 157.58 16125 16127 12270 12.86

QTR ATY nnn nnn nnn n nin n nn N Nines _NnAnN nnin

2.7 Quote Sheets

A Quote Sheet is a special version of a Watch List that can be divided into sub groups. When creating
Watch List, make sure to select the Quote Sheet option on the first page of the Watch List wizard.

On the first page of the Watch List Wizard, you will be asked to enter a name for the Quote Sheet.
Similar to the Watch List, this will be displayed in the tab of the Quote Sheet Panel. Make sure to check
the “Quote Sheet” option below the Name entry field.
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New Quote Sheet Wizard

New Watch List/Quote Sheet

view).
1. Specify Name of the Watch List
2. Specify Columns to Display
3. $Specify Instruments to Display

Click "Next' to continue.
Name r Key Stocks

/| Quote Sheet

Check this box to make

a Quote Sheet.

New Quote Sheet X

This Wizard will enable you create a watch list or quote sheet to display a tabular view of instruments (or Buy/Sell box

s

Click next to select

the columns.

Next = Cancel

Choosing the columns for the Quote Sheet is the same as you would for a Watch List. Select the
column(s) you would like to add from the Available Columns list and use the ‘>’ button to add them to

the Selected Columns list.

New Quote Sheet — Select Columns

Choose Columns
Select the columns that you wish to dlsplay.

Available Columns

New Watch List X

Selected Columns

Account
Ask
Avg Price

Click a column to
select. Held down Ctrl
Descriptio key to select multiple
Dividend A (€md on O5X)
Dividend 0

Expiry Date

Change (Inv)

% Change (Inv)

% Off High

% Off Low

9 M Nnon

Volume

Neote: you can also click and
drag columns to add/remove

Pip|
Pos

Click this button to
add the selected
columns

avVa

Symbol

Use these buttons
to change the
column order

Low
Open
Close
Change

% Change

Use this button to
remove columns

52 Week Low

| Click Next to select

or change the order in the
watch list.

instruments

Cancel

< Back Next =

Quote Sheets organize instruments into groups.

Click on the New Group button to add one or more

groups to the Quote Sheet. You can add instruments to each group by selecting the group from the
Group drop down and then using the Add Instrument/Search Instrument buttons (see below).
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New Quote Sheet — Add Groups/Instruments

= New Quote Sheet b4
Add Instruments
Instruments are organized into groups. Click on New Group to create a new group. Select the instruments to add to the
watch list by pressing the '+ or search buttons below
Group  -Select Group- * | New Group
v Label Colors
Click here to
create a group
Foreground
] New Group w [Background
Quote Sheets are organized in to groups. Choose a
unigue name for your group and press the OK button.
Name: |'Tech Sector -< Enter a name and
click OK.
OK || Cancel
Total: 0
< Back Save Cancel

The following screen shot shows a sample Quote Sheet. Noticed that there are groups in the Quote

Sheet table that divide the instruments into different categories. Optionally each group can have
different colors for the dividers.

Sample Quote Sheet

Ccsco NASDAG 31.37 16:00:00 3167 3135 3143 3136 [
YHOO NASDAQ 39.30 16:00:00 4039 3387 4036 4042 [JPEEB

2110 14.86
-9.107 0.00

MSFT NASDAQ 58.12 16:0000  59.08  57.28 59.02 59.02 2088 2787
GOOGL  NASDAQ 1 77178 74359 771.76 77175 27.320 2755
Quote Groups. Each
INTC NASDAQ 3473 3420 3456 3461 2130 16.20
group can have a
HPQ NYSE different color. 16.19 1580  15.85 1.880 8.56
ORCL NYSE 39.67  39.11  39.39 2110 1869
AGK ASX 0.00 0.00 0.00 -0.610 0.00
BPT ASX 0.76 11:10:00 0.78 075  0.78 -0.39 0.00
HSE TSE 14.30 15:52:00 1435 1415  14.26 0620  23.18
GDPAQ  OTCMKiS 0.00 Jct-11 10:31:00 0.00 0.00 -5.489 0.00
uPL FRA 6.62 15:00:00 6.63 6.63 0.902 7.35

DAL NYSE A7.47 16:01:00 47.44 46 .61 46.62 6.170 7.69

DLX ASX 6.07 11:10:00 6.16 6.05 6.13 0.340 18.12
p—p— pp— —— P pp— —— —— — .. SV SRSV — —

NYSE (35) NASDAQ(21)  Alerts  Top 50 Stocks (10) | Key Stocks (17) x | + - Qg = "

Symbol Exchange LastPr.. Last Time High Low Open Close Change % Chan... EPS P/E Ratio +
AAPL NAZDAQ 105.74 16:00:00 107.81 10408 107.71 10843 8.310 12.72
AMZN NASDAQ 718.93 16:00:00 746.00 71010 74551 739.01 0 : 4.360 164.72
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2.8 Backup/Restore

motivewave'

The Backup/Restore feature enables you to export settings, analyses, instruments, watch lists, scans and
open windows/positions to a single backup file. This backup file can be archived to be restored later in
case something happens to your computer. Alternatively, you can use this feature to transfer your

workspace to another computer.

2.8.1 Creating a Backup

Choose File -> Backup from the Console menu bar to create a backup file. When you choose this option,

you will see the Backup Workspace dialog.

Create a Backup

' Moti
File | Edit View Study Sirateqy Format Configure Window  Help
New ’ H =~ 6 N elere 01~ + =[]
Open ' : i} Optimize News  +
Chart x ?EIECthB?;-iku:d . .

&' Byckup rom the File Menu i . i'l'“!! i
&' Restore i —— L fanii
i L ! th !

Disconnect o i lul‘r':Tl h.ﬂ i T:
Shutdown Ty ; |
i | i

Backup Dialog
g Backup Workspaca X

This dialog allows you to create a backup of the ¢
used for archive purposes or may be used to mov|

Click the Browse button to select a backup file, th

By default the backup will be
created on the Desktop. Click
Browse to change

e

backup.

Backup File: |' C\Users\Tony\Desktop\google Nov-14 16-33.zip

| Browse

Create Cancel

When you click the Create button, a backup file will be created

on your computer desktop. This backup

file will be named <Workspace Name> <Date>.zip (where <Workspace Name> is the name of your
workspace and <Date> is the current date/time). If you would like to change the name and location,

click on the Browse button.

You can store this file in a safe place (such as Drop Box or Google Drive) or move it to another computer

to restore it into an existing workspace.

2.8.2 Restore From Backup

Choose File -> Restore from the Console menu bar to restore from a previously created backup.

Restore From Backup

(Y Motivel
File | Edit WView Study Strategy Format Configure Window  Help
New vl R B @ N e |~ + B I
Open ¥ | J9 Account |22 Scan 1)} Optimize News  +
Chart | X LE , ! ,
&! Backup Choose Restore | iTl :
1 + i
8 store from the File menu -! 'i*!l ! !I!“H‘*T:
connect wi? :Tll o !
Shutdown '“T'T : I il I
i | 1
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Restore Dialog

£ Restore Workspace X

This dialog allows you to restore a workspace from a recent| ¢Jick Browse to locate

utility will overwrite analysis files that currently existwi| ., _ previously created

Click the Browse button to select a backup file, then click t
the workspace. v

Backup File: | || Browse

v'| Restore Console/\Windows v'| Restore Preferences

v | Restore Watch Lists v'| Restore Scans
v'| Restore Strategy Analyses Delete Existing Analyses
Cancel

Click on the Browse button and locate the backup file that you created previously. The options available
for restore are as follows:

1. Restore Console/Windows — Restores console layout/pages and open windows from the backup
file.

Restore Preferences — These are the settings from the Preferences dialog.

Restore Watch Lists — Watch Lists and Quote Sheets

Restore Scans — Scan criteria saved from the backup

Restore Strategy Analyses — Restore back test/optimization executions.

Delete Existing Analyses — If you check this option, all of the existing analyses in the workspace
will be deleted before importing the analyses from the backup.

oukwnN

Click the Restore button to begin the restore process. You will see a progress indicator that reports the
status of the restore. Depending on your computer and the size of the backup, this could take up to a
minute or two to complete.

Note: The file format for the backup has changed in version 5 (compressed zip format).

2.8.2.1 Restoring to a Different Workspace Service

In the typical case, the workspace service (ie broker or data service) will match the service from the
backup. You can restore from a backup that was created with a different service, but you may
encounter some issues. Each service has a different naming symbology for the instruments that they
support and the target service may not support all of the instruments that are in the backup.

MotiveWave™ will attempt to map the symbols from the backup service to the target service. However,
you may find that some analyses are missing in the new workspace if MotiveWave™ could not find a
mapping.

2.9 Repository

MotiveWave™ maintains a local database for each workspace. This database contains the following
information:

1. Instruments/Exchanges/Trading Hours/Order Presets
2. Preferences/Keyboard Shortcuts

3. Watch Lists/Quote Sheets

4. Historical News
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5. Analysis

6. Alerts

7. Chart Templates
8. Scan Criteria

9. Strategy Analyses
10. Historical Trades

motivewave'

11. Historical Data — Historical data is stored in 1, 5, 30 and daily bars. This is used to reduce load on

the servers and is also available in Offline mode.

Optionally, data that is normally stored in the local database can be stored in the file system. This can
be very useful if you want to synchronize this data (using Google Drive or Drop Box) with other

computers or use as an alternative way to create backups.

Choose Configure -> Repository from the Console menu bar to access the Repository settings.

Repository Settings

File Edit WView Study Strategy Format = Configure | Window Help
AAPL ~ Q| B B~ 6 3 & Workspaces = =

lml Home X bl Charts .8 Account [ Scan s Instruments +
<A Active Tickers

BPT 15m AAPL 15m X | + B Reposjtory
AAPL - 15 min i Lo Preferl%ces :
Voume | : {= save Configuration +“ri+i

i H Order Presets :

<2 ~ | 15 min

: 1 .|'|'+I Commissions H
TR i rn.“"!. +’ a#m ™ C Clear All Local Data l
w ﬂ-lﬂ * h : 1 [Z] Update License !

i *|‘§ &) Choose Language : *T *!

1:‘ i il Layout

Repository Dialog

Choose Repository from
the Configure menu

v

“|

i | h
'\. . .*#i“w"l E\II.H*H*H

) MotiveWave - Console (google)

g Repository

By default, all information within MotiveWave is stored in the local databa
store information externally in the file system for greater flexibility. Additio
can also be specified below.

Repository —

Uncheck to store information
/| Use Local Database in the File System
Directory:

Analysis Sources

Click Browse to select
the root directory where
this information will be

V

v/ | Override Repository

Analysis Sources may be used
to share and view analyses
with other MotiveWave users.

Cancel

Add

Uncheck the Use Local Database option to store information in the File System instead of the database.
You will need to choose the root directory for this information by clicking the Browse button. If you
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would like to share this data using Google Drive or Drop Box, make sure to choose a location inside the
shared folder.

Optionally you can choose to store the following types of information by checking the boxes below:

1. Include Preferences — this is the settings in the Preferences dialog and other configured settings.
2. Include Watch Lists — watch lists and quote sheets

3. Include Chart Templates — any study templates that you have setup in your system

4. Include Windows & Layouts — open window information and locations as well as the Console
layout

Include Scans — scan criteria

6. Include Global Alerts — this applies to price alerts.

o

2.9.1 Sharing using Google Drive or Drop Box

Storing data in the File System provides the flexibility to share this information with other computers
using utilities such as Google Drive or Drop Box. Note: this feature is not limited to these two services.
Any cloud based service that interacts with your local file system should work just as well.

For more information on these services, see their websites:

1. https://www.dropbox.com/
2. https://drive.google.com/

Note: some issues have been found with Google Drive. These issues are related to the behavior of
Google Drive when sharing files. For more information see: http://www.techrepublic.com/blog/google-
in-the-enterprise/steering-around-the-potholes-with-google-drive/

2.9.2 Folder Structure
If you look at the root folder for the repository you will see two folders:

1. analysis — contains analysis files. This directory contains several sub folders that organize
analysis by instrument type and instrument symbol.
2. config — contains configuration files

The following diagram shows an example repository structure for an FXCM workspace.
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Repository Folder Structure

MName : Date modified Type MName . te modified Type
|\ analysis e R IR TR P | casH AKA FOREX. the folders 3/2014 411 PM  File folder
| config 17/03/2014 1:05 PM  File folder | CFO here will depend on the 3/2014 3:43 PM  File folder
| prefwmy | broker or data service 3/2014 411 PM  File folder

This is the root folder. It
contains two sub folders:
analysis and config

This is the analysis folder.
Analyses are organized by
Instrument Type and
Instrument (see below)

< I ] r 4 1 ] b
Name‘r - Date modified T Name W Date modified Type L&)
= alerts 15/04/2014 209 PM XML Docurnent ki AUDCAD ELEIZNISEEN - (Al
<] commissions 15/04/2014 209 PM XML Document i AUDUSD ELEAAEEIIN)  [TACI

< .. EURCAD 13/03/2014 3:10 PM  File folder
=] config jcument L
This is the config folder. It . EURCHF 13/03/2014 339 PM__ File folder E
2| console_layout . . jcument .
contains several files that have || EURDKK This is the CASH folder. Each Ider
| console_settings ; PR . jcument . . P
= configuration information. | EURGEP instrument type folder will contain .,
=| order_presets jcument a folder for each instrument.
- o \ EURJPY Ider
2] scans 15/04/2014 2:03 PM XML Document These sub folders will contain an L
] templates 15/04/2014 209 PM XML Dofyment i EURUSD analysis file for each analysis e
| trading_hours 15/04/2014 209 PM XML Document i GBICAD . i
=] watchlists 15/04/2014 209 PM XML Document b GBHUSD el e L ICES
2] windows 15/04/2014 209 PM XML Document b USHCAD ORI AL B Filefelcer 3
4 1 ] 3 g/ _ L
Namell . odified Type

File name will match the
name of the analysis

411:31...  MWML File
411:31 .. MWMIL File

2] Alternate 1

2] Primary Analysis

Default Analysis

These are the analysis files under
the EURUSD folder. Each
instrument folder will contain a file
for each analysis you created for
the symbol

4 I 2

2.9.3 Analysis Sources

Analysis sources provide a way to share specific analyses or to access analyses from other
MotiveWave™ users. Analysis sources are defined by a folder that exists in your local file system. You
would need to use a service such as Google Drive or Drop Box to perform the sharing and
synchronization.

Analysis sources are defined in the Repository Dialog (Configure -> Repository from the Console menu
bar)
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Repository Dialog — Analysis Sources

g Repository X

By default, all informaticn within MotiveWave is stored in the local database. Use the options below to
store information externally in the file system for greater flexibility. Additional sources for analysis files
can also be specified below.

Repository

v'| Use Local Database

Directory:

Analysis Sources

v/ | Override Repositor
Fa P / rCIick here to add an
N LAnalysis Source Add

If an analysis with the same
name exists in your repository,
it will be overridden by the
analysis source.

Cancel

Click on the Add button to define an analysis source. You can have multiple analysis sources. The

Override Repository option is important if there are naming conflicts between your local repository and
the analysis sources.

For example if you created an analysis called “Wave 3 Intraday” for the EUR/USD pair and one of the
analysis sources also has an analysis called “Wave 3 Intraday” for EUR/USD, MotiveWave™ will need to
determine which one to display. If Override Repository is checked, it will display the one from the
analysis source (instead of the local repository).

The following dialog will appear when you click the Add button. Each analysis source will require a
name. This name can be anything you like, but should reflect the source of the analyses. In the example
below, we chose the name “Trading Analysis” (this is one of our partners). Choose a directory (folder)

for the source by clicking on the Browse button. (Note: this will be a folder that is synchronized using
Google Drive/Drop Box).

The Read Only attribute indicates if you are going to be modifying the analyses or just viewing them.
Uncheck this option if you are intending to publish analyses to this source.

Add Analysis Source Dialog

= Analysis Source X

An analysis source specifies a directory where additional analysis files may be loaded. Enter a name
and choose a directory below (click the Browse button). Check the Read Only option if you are not
intending to modify Analyses from this jocation

r .
Name: Tradlng Anal}’sis Give the source a name ]

Directory: | C:lUsers\Tony\

/| Read Only your analyses to this source.

Select the root
OK || Cancel directory

Uncheck if you intend to share J
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2.9.3.1 Publishing Analyses

If you are planning to share your analyses with other users, then you would create an analysis source
and uncheck the Read Only attribute. Analyses that exist in your repository are not automatically
shared; you will need to explicitly publish each analysis to this new source.

If you would like to publish an analysis to an analysis source, choose File -> Save To -> <Analysis Source
Name> (where <Analysis Source Name> is the name you chose in the Add Analysis Source Dialog) from
the chart menu bar (Note: it is File -> Chart -> Save To -> <Analysis Source Name> from the Console).

This action will save this analysis (make a copy) to a sub folder in the analysis source folder that you
defined earlier.

The file synchronization software that you setup (ie Drop Box etc) will take care of synchronizing that file
with the folders of all your users.

In the following example, we have created an analysis source called My Group. The Read Only attribute
has been unchecked to tell MotiveWave™ that it can publish analyses to this location. This analysis
source will now be available in the Save To menu (see below).

Setup for My Group

= Analysis Source X

An analysis source specifies a directory where additional analysis files may be loaded. Enter a name
and choose a directory below (click the Browse button). Check the Read Only option if you are not
intending to modify Analyses from this location.

Name: | My Group

Directory: | C:\Users\Tony\Desl Browse
This needs to be unchecked
Read Only to enable publishing

OK || Cancel

Publishing to My Group

(4 MotiveWave - Console (google)
File | Edit Vview Study Strategy Format Configure  Win| The Analysis Source My Group was
[ New b i &=~ 6§ Womlwr @ previously setup in the Repository Dialog
Open ' | 8 Account (@ Scan  {l} Optimize above. The Read Only attribute was
- - unchecked to ensure that it is available in
Chart b - the Save To menu below. [
g1 Backup B New Analysis v '
8¢ Restore & Manage Analyses i |
Disconnect ISl Save As !MI | |
Shutdown Save To L I‘ Group I I
-T.',J.T-i*'-ln'r Template " :% ‘(S:hoo-sre F:eh;> ghar‘t -
| &' Import Data ave 1o == My broup
i &' Export Data * ! ot i
| Zh Import Analysis  Ctrl+K s, | i i
| & Export Analysis  Ctri+J +*i + LR '!THLT* T'TJ'!..I'”'ii
i [8] Save As Image : i ﬂ'“ I *' TI
: ; ; LI i

2.10 Email Configuration

MotiveWave™ may be configured to send out email messages as part of alerts or signals generated by
studies. You will need to configure the SMTP (Simple Mail Transfer Protocol) settings in the Preferences
dialog to enable this feature. These settings will be found under the Email tab. Choose Configure ->
Preferences from the Console menu bar to display the Preferences dialog.
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Email Preferences Dialog
[ o] Preferences X

General Theme Chart ToolBar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts gayklll

This dialog allows you configure your SMTP sefpieess — it
Check this box t bl
Allow Outgoing Email eck this box ta enable ‘

Click on the

email messages Email tab

SMTP Server:
SMTP Port:

Username:

Password:
SMTP settings will vary

From Email depending on your email provider.
If this is a corporate email
address, contact your network
Protocol: - administrator for specific

To Email:

The Test Email button will
send a test email to verify

that the settings are working.

Apply Cancel

If you are using a corporate email address, you will need to contact your network administrator to get
the specific SMTP settings.

Settings for public email addresses can be found online, just do a web search. Here are some useful links
for some common email providers:

2.10.1 Gmail

Gmail settings can be found here:
http://email.about.com/od/accessinggmail /f/Gmail SMTP Settings.htm

For some user accounts you may need to create an application specific password in order for this to
work. For more information see: https://support.google.com/mail/answer/1173270?hl=en

2.10.2 Yahoo Mail

Yahoo mail settings can be found here:
http://email.about.com/od/accessingyahoomail/f/Yahoo Mail SMTP Settings.htm

Similar to Gmail you may need to setup an application specific password if you have to bypass the
second sign-in verification: https://help.yahoo.com/kb/yahoo-account/SLN5013.html?impressions=true

2.10.3 Windows Live / Hotmalil

The following link explains the Hotmail SMTP settings:
http://email.about.com/od/accessinghotmail/f/Windows Live Hotmail SMTP Settings.htm

Version 5.0 ©2019 MotiveWave™ Software Page 46 of 212


http://email.about.com/od/accessinggmail/f/Gmail_SMTP_Settings.htm
https://support.google.com/mail/answer/1173270?hl=en
http://email.about.com/od/accessingyahoomail/f/Yahoo_Mail_SMTP_Settings.htm
https://help.yahoo.com/kb/yahoo-account/SLN5013.html?impressions=true
http://email.about.com/od/accessinghotmail/f/Windows_Live_Hotmail_SMTP_Settings.htm

MotiveWave™

User’'s Guide antive ave@.

There is also a two-step verification process for Hotmail as well. For more information see:
http://windows.microsoft.com/en-ca/windows/two-step-verification-faq
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3 Char

MotiveWave™ has perhaps some of the most advanced charting capabilities of any charting application

e

ts

motiveulave

available. In this section we will be exploring some of the basics of working with charts in
MotiveWave™.

You can work with charts within the Console window or you can open separate chart windows to work

with charts independently. The simplest way to open a chart window is to press the Open Chart
Window button from the top right section of a chart panel. Alternatively, choose File -> New -> New
Chart Window from the top menu bar.

This action will open a chart window similar to the one in the screen shot below. Regardless of whether
you choose to work with charts in the console or separate chart windows, the features described in this

Open Chart Window

LW e % G D
]

"
X

section are the same.

open this chart in
its own window.

I Click this button to

1._7

= <
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1o
y 1
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3.1 Settings

3.1.1 Default Chart Settings and Options

Default chart settings can be set from the Preferences dialog (Configure -> Preferences from the Console
menu bar). You will find the settings for charts in the tabs underneath the Chart tab.

Global Chart Settings

motivewave'

Lo

General Theme EehHENS

Preferences

Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charis OFA® Orders Alerts (=

X

(O ENRNBEE Indicators Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for charts

IMax Linear Bars:
IMax Non Linear Bars
Minimum Bars

Default Tool:
Revert to Default Tool:
Bar Type:

Bar Scheme:
Bar Size:

Bar Thickness:
Axis Style:
Shade:

Shift + Click:

Ctrl + Click:

Ctrl + Alt + Click:
Line Method:

Fill Area:

Fill Alpha:

w -
v

[
Normal

15 min -
—1.0 ~
Inside -
None

Text

Price Guide
Time Guide

Time/Price

25 =5

-

-

Popup Delay (seconds) v'| Enabled

Bar Width (Pixels):
Price Axis Spacing
Time Axis Spacing:

Top Inset (pixels) [ 5 =]

Bottom Inset (pixels)

5=

Display Bars %
Study Height (pixels):

Study Layout:

Time Zone:

OK | Apply | Cancel

Horizontal =

v | Use Default

Calendar Days

The following are options that are available from the Chart Settings tab:

1. Default Tool — This is the default tool to use on a chart.
2. Revert to Default Tool - When completing an action with the selected tool, the chart will

automatically switch back to the default tool (see above)
Bar Type — The default type of bar to display when opening a chart

w

4. Bar Scheme — Determines the color scheme for the bars. Normal displays bar color based on if the

close is higher/lower than the open value. Available Bar Schemes include:

a. Normal — Displays a different color if the bar closes higher than open verses lower than open

b. Inside/Outside — Colors change if bar closes higher/lower than open, if the bar has a lower
high/higher low than previous bar (inside) and if the bar has a higher high/lower low than the
previous bar (outside)

c. Day Of Week — Bar color changes based on the day of the week

d. Alternate Day — Bar color alternates each day
e. Alternate Hour — Bar Color alternates each hour

5. Bar Size — default bar size when opening a new chart

6. Bar Thickness — Default thickness for the bar outline (default 1 pixel)

7. Axis Style — Style of the price and time axis

8. Shade — draws a shaded area at time or price intervals on the
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9. Shift + Click — Object to draw when the user holds down on the Shift Key and clicks the left mouse
button on the chart.

10. Ctrl + Click — Object to draw when the user holds down on the Ctrl Key and clicks the left mouse
button on the chart.

11. Shift + Alt + Click — Object to draw when the user holds down on the Ctrl and Alt Keys and clicks the
left mouse button on the chart.

12. Line Method - Calculation method for calculating the lines on a wedge (Time/Price or Angle)

13. Fill Area — If true, the area of a wedge will be filled

14. Fill Alpha — Alpha value for the fill color

15. Max Linear Bars — Maximum number of linear bars to load when opening a chart

16. Max Non Linear Bars — Maximum number of non-linear bars (ie Range, Renko etc) to load when
opening a chart

17. Minimum Bars — Minimum number of bars to load when opening a chart.

18. Bar Width (pixels) — Default spacing for the price bars

19. Price Axis Spacing — Default spacing between the numbers that are displayed on the price axis

20. Time Axis Spacing — Default spacing between the labels that are displayed on the time axis

21. Top Inset (pixels) — Default spacing to add to the top of the price plot when auto scale is enabled

22. Bottom Inset (pixels) - Default spacing to add to the bottom of the price plot when auto scale is
enabled

23. Display Bars — percentage of bars to display when first opening a chart (ie fill 90% of the chart area)

24. Study Height (pixels) — Default height for study plots

25. Study Layout — Layout preference for the study labels displayed in the legend area (horizontal or
vertical)

26. Time Zone — Default time zone for the chart.

27. Calendar Days — If enabled, space will be preserved for non-trading days when displaying daily bars
(normally this space is removed)

Additional chart options can be found under the Options tab of the Chart section in the Preferences
dialog.
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10.
11.
12.
13.
14.
15.

16.
17.
18.
19.

20.

Global Chart Options
o Preferences X

General Theme QehEl@ Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts OFA®  Orders Alerts (=

Chart Seitings Indicators Labels Templates BarSizes Bar Size Selector

The fields below allow you to adjust the default settings for charts

v/| Show Extended Data /| Double Cross Hair V| Expand Status Bar Link
Show Instrument Title Solid Cross Hair v/| Show Bar Size Selector

v'| Snap Open/Close v Auto Scale Show Bird's Eye View
Show Components Panel Auto Scale Price Only V| Show Bird's Eye Lines
Show Trade Panel Semi Log Scale Resolve Trend Lines
Show DOM Panel Lock Scroll Group Studies
Show Grid Lock Studies v'| Show Study Labels

v'| Show Major Times v'| Show Info on Select Study Bar Updates

v/| Show Chart Buttons Show Info /| Study Dock Long Names
Show PJL Ladder v/| Show Range Outline Use Account Position
Show Exchange Show Middle Line Show Values In Legend

v/| Show Symbol v/| Show Menu Bar V| Simple Study Title

v | Show Bar Size v'| Show Tool Bar v'| Overlay Volume

v'| Show Analylsis Name v/| Show Status Bar v/| Draw Candle Outline
Show Cross Hair /| Confirm on Close v/ Auto Load Studies
Global Cross Hair /| Link Minimize/Restore

OK | Apply Cancel

Show Extended Data — If true, after hours data is show by default when opening a chart

Show Instrument Title — Displays the title of the instrument in the top left corner of the chart
Snap Open/Close — If this is enable the mouse tools will automatically snap to open and closing
points on the price bars

Show Components Panel — Displays the components panel by default when opening a new chart.
Show Trade Panel — Displays the Trade panel by default when opening a new chart

Show DOM Panel — Displays the DOM (Depth of Market) panel by default when opening a new chart
Show Grid — Displays horizontal and vertical lines on the chart

Show Major Times — Show vertical dashed lines for major time on the chart

Show Chart Buttons — Enables the display buttons on the chart for adjusting the vertical space and
bar width. This also applies to the remove study button on study plots.

Show P/L Ladder — Displays the profit/loss ladder on the chart.

Show Exchange — Toggles the display of the exchange as part of the title on the chart

Show Symbol — Displays the instrument symbol on the chart.

Show Bar Size — Displays the current bar size on the chart

Show Cross Hair — Toggles the default display of the cross hair feature for the mouse cursor
Global Cross Hair — If enabled, the cross hair (where enabled) will be updated across multiple charts
that display the same instrument

Double Cross Hair — Displays two vertical lines encompassing the bar where the cursor is currently
(instead of a single vertical line)

Solid Cross Hair — Displays a solid line instead of a dashed line for the cross hair

Auto Scale — Default scale setting when opening a new chart

Auto Scale Price Only — If enabled, only the price action will be included in the auto scaling of the
chart (components are excluded)

Semi-Log Scale — displays a chart using semi-log scale by default.
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21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.

32.
33.
34.
35.
36.

37.

38.
39.

40.

41.
42.

43.

Lock Scroll — Default lock scroll state (see Lock Scroll feature)

Lock Studies — Default Lock Studies state (see Lock Studies feature)

Show Info on Select — Turns on the Show Info feature when selecting a component

Show Info — Enables the show info feature when creating a new component

Show Range Outline — Turns on the range outline on the latest bar for Range/Renko bars

Show Middle Line — Turns on the display of the middle line for channel components

Show Menu Bar — Turns on the display of the menu bar for windows

Show Tool Bar — Turns on the display of the tool bar for windows

Show Status Bar — Turns on the display of the status bar at the bottom of the windows

Confirm on Close — If enabled will display a warning message when closing a chart window

Link Minimize/Restore — If enabled, for linked chart windows all windows in the group will be
minimized when one of them is minimized. Likewise when one of them is restored, all windows in
the group will be restored

Expand Status Bar Link — Expanded mode for the color link control in the status bar

Show Bar Size Selector — Toggles the default display of the Bar Size Selector on charts

Show Bird’s Eye View — Toggles the default display of the Bird’s Eye View when opening a chart
Show Bird’s Eye Lines — Display of the vertical lines on the Bird’s Eye plot

Resolve Trend Lines — If enabled, MotiveWave™ will attempt to load enough data to properly display
all trend lines on a chart. By default it will estimate where the starting point of a trend line is based
on the available data. This option will force the loading of data all the way back to the beginning of
trend lines to improve the accuracy of the plot. Warning: this option can cause a lot of data to be
loaded from your broker or data service. It is recommended that you leave this option of and turn it
on where desired from the Chart Settings dialog (see next section).

Group Studies — If enabled, study plots will be grouped together at the bottom of the chart in a
stacked panel.

Show Study Labels — Enables the display of study labels in the legend

Study Bar Updates — Toggles the live updating of studies from level 1 data verses calculating the
most recent study values on the close of a bar.

Show Values in Legend — If enabled, current study values will be displayed next to the study label in
the study legend

Simple Study Title — Simplified display of the title in the legend area

Overlay Volume — Displays the volume information as an overlay on the chart instead of a separate
plot.

Draw Candle Outline — Draws the outline of the candle rectangle.

3.1.2 Chart Specific Settings

Chart settings that apply to the selected chart only can be accessed by right clicking on the chart and
choosing Chart Settings (you can also double click on the chart). The settings configured here can be
saved as default settings by clicking on the Save Defaults button. Descriptions of items below can be
found in the preceding sections.
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Chart Settings Dialog
el Chart Settings

Scaling Bar Settings Theme Display Labels Watermark Trade Elliott Wave OFA®

The fields below allow you to adjust general settings specifically for this chart. Default settings may be changed from the
Preferences Dialog (Configure -> Preferences from the Console Menu Bar).

Mouse Tool: ¥ ~ Bar Width (Pixels):
Shade: Mone - Price Axis Spacing:
Axis Style: | Inside  ~ Time Axis Spacing:
Semi-Log Scale Minimum Bars:
Show Cross Hair Resolve Trend Lines
Solid Cross Hair Calendar Days
/| Double Cross Hair Time Zone: v | |v/| Use Default

Global Cross Hair
Lock Scroll
Group Studies

/| Show Study Labels

Lock Studies
This dialog allows you to configure

preferences specifically for this chart.
Use the "Save Defaults” button below to
apply changes to other charts.

OK Save Defaults Reset Defaults Cancel

3.2 Price Indicators

Price indicators display current price, high low (etc) on the price axis of a chart. By default,
MotiveWave™ will display (where available) the Last Price, Best Bid, Best Ask, Daily High and Daily Low.
Other indicators may be (optionally) displayed in the vertical axis from overlays such as a Moving
Average. If you would like to show a vertical line that moves with the indicator just double click on it

(this will toggle the display of the line).

Price Indicators

A
4.“' _
|

l‘in,l”**ﬁmd i

I
A

Double click on indicator
to toggle the display of the [|129.00
horizontal line
4128.00

[
|'
J127.75

I I I I I
00 13:00 14:00 15:00 Feb-02 11:00

1128.25
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You may change the price indicators that are displayed from the Preferences dialog. Click on Chart, then
on Indicators.

Price Indicator Settings
o] Preferences x

General Theme EeIEUM Tool Bar Sounds Ratios Elliott Wave Gartley Tick Chartls OFA® Orders Alerts =

Chart Seltings Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for indicators displayed on the price axis

Last Price: v Enanﬁclick on the check box

Hest Bid- | Enabled to show/hide indicator
Best Ask: /| Enabled
Bid/Ask Midpoint: Enabled
Daily High: /| Enabled
Daily Low: V| Enabled
Opening Price: Enabled

Closing Price:| Click on the Edit button to

modify colors, show lines

OK | Apply Cancel

3.3 Chart Spacing

There are several options for adjusting the horizontal and vertical spacing on the chart. The simplest
way is to use the mouse to drag either the time axis (horizontal spacing) or the price axis (vertical
spacing). Note: in order to adjust the vertical spacing, you need to click and drag the space between the
price labels and the chart area (see below)
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Chart Spacing

~ MotiveWave - Console (google) Ky -

File Edit Wiew Study Strategy Format Configure Window  Help

AAPL ~ O | K B Er@ W EelwrQ 1~ + "B[IT]&2~|1day -
|MAAF'L1DX||MAAPL15ITI + ;
AAPL - 1iday |
| U
i g
! -LJJ#D m?f
i * i l? i tﬁ’m? In order to adjust the
I vertical space with the
i T*E 3 : a0 ﬁ*ﬂﬁ*ﬁﬁ%ﬂm s, ik nd g b
J,:u -|- +T .L_l_ L i and the chart area.
* :
!DT ot L i UDH ;
= i
Jﬁl If‘] T lﬁ]Fd] : Click and drag from the bottom
I upwards to add space to the
Ij!eﬂ ; bottom of the chart
1 L. T

Click and drag the time axis to +7105.00
adjust the space between bars
MotiveWawe 10250
Oct2016 Ocl-d1 019 Nov-2016 Nov-09 Nov-17 Del2016 Dec-09 Dec-19 Jan-2017 Jan-i1 Jan20  Feb-2017 Feb-10
imin Smin 10min 15min 20min 30min 45min 1hour 2hour 6&hour 1day 1week 2week 1 month 3 month = vy @ |¢|+ B
lul Home » Lul Charts .8 Account [@ Scan  {lf Optimize News  + m O

a8 ® © Feb-21 2017, 105.81 Feb-02 10:45:53

3.4 Bar Sizes

Bar sizes are useful for changing the resolution of a chart based on time, price or volume movements.
MotiveWave™ supports several different types of bars:

1. Linear —time interval based bars (such as 1 minute, 15 minute, 1 day, 2 week etc)
Range — bars are based on price movements of a specific price range
Renko/Hybrid Renko — these are special price range based bars

Tick — these bars are based on a specific number of price ticks (or trades)
Volume — each of these bars will have a fixed trading volume

6. Point & Figure

vk wnN

There are several ways to change the bar size and type. Perhaps the most convenient way is to use the
Bar Size Selector at the bottom of the chart. Alternatively, you can use the bar size drop down from the
tool bar or right click on the chart and select the bar size from the context menu.
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~ MotiveWave - Console (google) 3 I
File Edit View Study Sirategy Format Configure Window Help
AAPL Al & A sy @ K 2w~y b~ + =E[T] &2~ [1day > 25 [ & | >
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20 min | 954
30 min . 512750
You can also click here to Alternatively,
45 min choose the bar size
display a drop down to 3425 00
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the options below (tab 1
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3.4.1 Custom Bar Sizes

MotiveWave™ comes with a default set of bar sizes, but you can create your own bar sizes from the
Preferences Dialog (Configure -> Preferences from the Console menu bar). You can create second based

bars provided you have access to historical tick data.

Custom Bar Sizes

o Preferences

General Theme TOOl Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email &

X

Chart Settings Indicators Labels Templates Options Bar Size Selector

This panel allows you to configure the available bar sizes for each chart.

Add Remove Reset

S 1
\— \\‘
Bar Sizes can also be

Click to add a removed to reduce clutter.
new bar size.

5 min I
10 min +

15 min
20 min
30 min
45 min
1 hour
90 min
2 hour
3 hour
4 hour
5 hour
6 hour
8 hour
10 hour
12 hour
1 day
2 day

New Bar Size X

Please enter the new bar size below by choosing a time interval
(Month, Week, Day, Hour, Minute) and a i

Interval Type: | Minute - Choose the Interval Type
(second, minute, hour, day)

et .
= and select the interval.
DK || Cancel |

OK || Apply

Cancel
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3.4.2 Bar Size Selector

The Bar Size Selector is a convenient way access common bar sizes by simply clicking on one of the tabs
at the bottom of the chart. The Bar Size Selector is visible by default on all charts. If you would like to
hide this, choose View -> Display -> Bar Size Selector from the top menu bar to toggle its visibility. (Note:
the default behavior can modified in the Preferences dialog, click on Chart the on Options, see Show
Bar Size Selector option).

You can configure the tabs available in the Bar Size Selector by right clicking on one of the tabs and
choosing Configure. You can put any type of bar size in the selector. For example you could have
Range(3) or Constant Volume(500).

'|' Configure Bar Size Selector

Right click on a tab and

19 Nov-2016 Nov-09

1 1 1 1
 choose Configure —Qec-19 Jan-2017 Jan-11__ Jan-20
15min 20min 30 min 45 min 1 hour 2hour & hour 1: Canfigure ?th 3m
SDAQ (21) T Alerts  [= Top 50 Stocks (10) x | + >>1 | Rewove Bar Size = Indices
- MNext Bar Size Shitt+— ST
itPr... Last Time High Low Open Close C previous Bar Size Shi1t+<—l 1
o) Preferences b4

General Theme E®\ELM Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders  Alerts  Email bt

Chart Seitings Indicators Labels Templates Options Bar Sizes JsEIgsirRlEulsy

This panel allows you to customize the bar sizes available in the Bar Size Selector.

Add Reset

1 M
S
10
15
20

Use the Add/Remove buttons
to configure the tabs available
in the Bar Size Selector

i + Add Bar Size X
30 min
45 min Select the type of bar size and parameters below.
1 hour Bar Size: | Linear - Choose the Bar Size type
2 hour . and settings. Any bar size
e Interval Type: = Minute  ~ type is allowed.
e mervat:
2 week

1 month
3 month

OK | Apply | Cancel

The Bar Size Selector also has some buttons on the right hand side (configurable in Preferences). These
can be convenient for the following (in order from left to right):

1. Toggle Semi-Log Scale — Toggles semi-log scaling

Choose Study Template — Allows you to choose a study template

Toggle Birds Eye View — Toggles the display of the Birds Eye View

Display Time Frame — Choose a specific time frame to display on the chart (ie 2 week, 1 day etc)
Go To Date — Go to a specific date in history

vk wnN
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1 Week
2 Weeks
This Mon
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This Year
1 Year
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10 Years
15 Years
20 Years

by
B | +

Y

Toggle Birds

Choose Template Eye View

I I
Jul-2016 Sep-2016

Toggle Semi-
r 1week 2week 1 month

Log Scale

Choose Time
Span

3.5 Importing Data

Historical data may be imported into MotiveWave™ by choosing File -> Import Data from the top menu
bar (File -> Chart -> Import Data from the Console menu bar). Two types of data formats are supported:

1.

2.

CSV — Comma Separated Values. This is a very common format for many historical data services.
The format of the data file will be automatically detected when specifying files of this type.
MetaStock™ Database — MetaStock™ Database files containing 1 or more instruments may be
imported into MotiveWave’s historical database.

This dialog has the following elements:

1.

Data Files — Specify one or more data files by clicking on the Add button to left of the Data Files
list.

Time Zone — Choose the time zone for the input file. This is important for resolving the
data/time values for each historical price bar in the input file.

Exchange — Optionally Choose the Exchange for the instrument(s) in the input file(s).

Trading Hours — If a value is chosen for Trading Hours, it will be assigned to the instrument when
it is created from this dialog.

Adjust for Stock Splits — If the file does not contain split adjusted values, this will detect and
adjust historical prices for splits.

Automatically Create Instrument (Do Not Prompt) — If the instrument does not already exist in
the local database, it will be automatically created if this is checked.

Replace Existing Data — Replaces data that is already in the local historical database.

Monitor Input File For Changes — If checked, MotiveWave™ will monitor the timestamp on the
input file to see if it changes in the future. If it does change, the new data will be automatically
loaded into MotiveWave™ when a chart is loaded.
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g Import Data
This dialog allows you to import data from a MetaStock Database, CSV or ASCI! file.
Data Files: -
Click here to add 1
or more data files
Time Zone: | America/New_York - Use Default

Exchange: | -Select Exchange- ~ | +

Trading Hours: | -Select Trading Hours- ~ | +

v/| Adjust for Stock Splits (Stocks Only) Replace Existing Data

Automatically Create Instument (Do Not Prompt) || Monitor Input File for Changes

Add -

3.6 Exporting Data

Historical data may be exported from MotiveWave™ in several different formats. Choose File -> Export
Data from the top menu bar (File -> Chart -> Export Data from the Console menu bar). This dialog has
the following elements:

1. Symbol — Choose the instrument that you would like to export. By default this is the instrument
from the chart where the dialog was launched.
2. Bar Size — Choose the Bar Size for the historical data
3. Bar Count — Number of Bars to Export. Choose All Available to export all available data in the
historical database
4. Regular Trading Hours (RTH) Data — Check this to only include bars that are part of the regular
trading session
5. Data File — Click on the Browse button to the right to choose the data file where the data will be
saved.
6. Format — Choose the Export Format
a. CSV-yyyyMMdd HHmmss,O,H,L,C,V
b. CSV-dd/MM/yyyy HH:mm:ss,O,H,L,C,V
c. Ninja Trader — Start Of Bar Time
d. Ninja Trader — End Of Bar Time
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g Export Data X
Symbol: | - Q
Bar Size: | 1 min -

Bar Count: All Available

v'| Regular Trading Hours (RTH) Data

Chart Data
F
Data File: = C:\Users\Tony\Desklop\AAPL - 1 min - RTH.csv Browse
Format: | CSV - yyyyMMdd HHmmss,O,H,L.C.V v

oK Cancel

3.7 Bird’s Eye View

The Birds Eye View provides a convenient way to view the larger picture of the available historical data.
Choose View -> Display -> Bird’s Eye View from the top menu bar to toggle the display of this feature.

The Bird’s Eye View is displayed at the bottom of the chart. The highlighted area (transparent yellow
area) illustrates the data that is currently visible in the chart. You can click and drag this area to the
left/right to move the visible area. The width of the highlighted area depends on the bar width for the
chart. If you would like to change the width, click and drag the time axis.

b

[Drag the divider up;’down} ‘

Bird’s Eye View
T

[y

Click and drag the time axis
to change the size of the
highlighted area below

105.00

MLl S
[I'Lu i 100.00

95.00

Highlighted area shows

what is visible in the 00
chart. Click an drag to

change the visible data. 00

to change the height

MotiveWave N 7
| L n L L L
Jul-2015 Sep-2015 Nov-2015 Jan-‘AV{E Mar-2016 May-2016 Jul-2046 Sep-2016

Nov-2016  Jan=

100.00
This graph shows closing prices 50.00
for historical data available in

002 00 T 12005 the local database. 9 |2010 2011 2012|201 2016 0.00
1imin 5min 10min 15 min 20 min | 6nour “1week 2week 1month 4 . x @ |+~
Toggles the display of
|l Home X Lul Charts {8 Account |2 Scan  {lj Optimize News  + the Birds Eye view im N O

3.8 Cursor Data

Cursor Data refers to the data points and their values at the current position of the mouse cursor. There
are several different ways to view cursor data.

3.8.1 Cursor Data Window

The Cursor Data Window is a separate window that displays data at the current mouse location. This
window works across all charts. This window may be opened by choosing View -> Display -> Cursor Data
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Window from the top menu bar. For convenience this window is always displayed on top of other

windows.
Cursor Data Window
~ MotiveWave - Console (google) 2 - At X
File Edit View Study Strategy Format Configure  Window  Help
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the cursor is located.
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3.8.2 Cursor Data Panel

The Cursor Data Panel is essentially the same as the Cursor Data Window except that it is a panel inside
of the chart. This panel only works for the enclosing chart. To open this panel, choose View -> Cursor
Data from the top menu bar.

Cursor Data Panel

~ MotiveWave - Console (google) B o A4 =
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3.8.3 Bar Status
Data on the selected price bar can be found in the status bar at the bottom of the window. This reflects
the price bar at the position of the mouse cursor.

Bar Status

| IL'* hﬁ,wﬂ g
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Information for the bar

at the mouse cursor is
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il Home ¥ Ll Charts ® Account ' (@ Scan 1§ Ontimize News +

Mar-27 2016,172.56 0:231.61 H:247.90 L:225.00 C:237.59 V-35.8M R:22.90 _
3.8.4 Hover Popup

A popup will be displayed with information about the price bar if you place the mouse cursor over a
price bar and leave it there for about 2 seconds.

Price Bar Hover Popup

e e VI N PP

B Lo PP

Place the mouse cursor
over a price bar and
leave it for 2 seconds

g T

ime: Apr-25 9:30
Open: 202.00
High: 20592
Low: 201.74
Close: 205.78
Range: 418
Yolume: 294K
e i iy

N “‘H@uﬂ'ﬂﬂ

3.8.5 Cross Hair

The cross hair feature draws thin horizontal and vertical lines at the current mouse cursor location to
indicate the vertical axis and time axis values.
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12:00 14:00 Jan-31 12:00 14:00 Feb-2017Feb-01 X 14:00 Feb-02 12:00
Awesome 0sc(34,5) i IIIIII i i X U3.000
! 1 J
I 1
il IIIIIIIIII-__.,._ ' -] %ﬁ! 0807
II.]I"'lllll- : l'llll"- -1.000
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Feb-02 11:32:53

Feb-01 11:00,253.41 0:250.27 H:251.44 L:250.26 C:251.12 V:102.7K R:1.18

There are several configuration options for the cross hair. These can be found under the Chart ->
Options tab of the Preferences dialog (Configure -> Preferences from the Console menu bar).

Cross Hair Preferences

ke

General Theme QeEGE Tool

Preferences

Bar Sounds Ratios ElliottWave Gartley Tick Charts Orders Alerts Email

X

-

Chart Seitings Indicators Labels Templates Bar Sizes Bar Size Selector

v'| Show Exitended Data

The fields below allow you to adjust the.dafault cattinge far chare

v'| Double Cross Hair

Show Instrument Title

Solid Cross Hair

v'| Snap Open/Close v'| Auto Scale
Show Componenis Panel Auto Scale Price Only
Show Trade Panel Semi Log Scale
Show DOM Panel Lock Scroll
Show Grid Kk Studies

/| Show Major 7| Cross Hair Options B 1ne o select

/| Show Chart Butions |"Show Info
Show PJL Ladder v/| Show Range Outline
Show Exchange Show Middle Line

v'| Show Symbol v'| Show Menu Bar

v/| Show Bar Size v/| Show Tool Bar

v'| Show Analylsis Name v'| Show Status Bar
Show Cross Hair /| Confirm on Close
Global Cross Hair /| Link Minimize/Restore

OK || Apply

v Expand Status Bar Link
v/ Show Bar Size Selector
Show Bird's Eye View
v/ Show Bird's Eye Lines
Resolve Trend Lines
Group Studies
Show Study Labels
Study Bar Updates
Study Dock Long Names
Use Account Position
Show Values In Legend
v
v
v
v Auto Load Studies

Simple Study Title
Overlay Volume

Draw Candle Outline

Cancel
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3.8.5.1 Global Cross Hair

The Global Cross Hair provides a convenient way to locate the mouse cursor position between several
different charts that are displaying the same instrument. This option can be enabled in the Preferences
dialog (see previous section). In the following screen shot you will notice that the current location of
the mouse cursor in one chart adjusts the cross hair location in the other charts that show the same
instrument.

Global Cross Hair

(v MotiveWave - Console (google) 3 L
File Edit View Study Strategy Format Configure Window Help
(EEEN [~ = B =~ 6 Kwler@ i~F[EE|L~-[smn ~ Ai(me % S WD
Ll GOOGL 1m x | + = ”|[lw GOOGL 5m x | + = "
?’ GOOGL - 1inin & GOOGL - 5 min m 82456
lunte: | Volume
w ‘ J | - Ly e
1 U ’i N UTT ‘ ??i?hﬂ 1.,
!’uwj ﬁ' UI U ' +1u | L 5 k. 31537
“ l '[D T+ QTUI MI_ﬁu ?lnni[lj . Je17.50
i “ Cursor placed here is o ‘_u l ?l' HQU‘T
. 3 reflected on the other Hs20.00 *[;“'H[jhﬁmﬂlnl-ll. . mﬁﬁﬂ. . ”% ***T*D.ﬁl |T| H815.00
[ —— | L oy Al il _ N
%Mﬂlnﬁl-“ﬂllnﬂllllﬂm N I | T o B SLI8H7) RS e rsgues bt s I%n tansgmal I H”I”I InaiteRnpasscnzs EilE
Feb-02 1027 10:45 11:00 1115 [ 10 12:00 13:00 14.00 15:00 Feb-02 [Feb-02 10:25-00 12:00
imin 5min 10min 15min 20 min ¥Qmin 45min 1 hour 7 = @b @ |»|> Ep=tmin  Smin 10min  15min 20min  30min  45min 1 hour **7 = iy @ ol 2
lul GOOGL 1h x | + @ *|[lu GOOGL 1D %=k = 7
& GOOGL -1 hour l | § & GOOGL - 1 day i |
Volume ?* ; ! 860.00|| Velume ! ﬂﬁ‘ J8s0.00
P, | 1
gl | i e,
| e UT Y ! 850.00 |y i LT l _______ S
D¢ e v | b D*+ iﬂ Ry | 5J’++I+¢T1+4- ‘+DU iy %ﬂmzug
uh 3 [ 840.00 TM lﬂﬂh Piﬂ t HD | ﬂ lﬂ] a00.00
51"?'!*". ' D[:]I o 0-9 ) : 830 on] +ﬁ ¢'ﬂ,ﬁ *Lﬁ |
nay . | i J | H
e Tt N N U{ﬁ vl ‘;W' ,,,,,,,,,, TR !ﬁﬂ ﬁ] | 775.00
sl 5 el sl 275
mmm%iﬂum;nﬂpln;.ul|.n.;;"[‘|ﬂﬂﬂﬂ‘|ﬂ|.ﬂﬂ|[lnmn”||ﬂﬂﬂ|" ”I..Il |Hunﬂi||n.nﬂ i, it nlnmmwﬂmunlmnﬂnlﬂnll| filim Tntn il il 53 5K
Jan-17 Jan-19 Jan23 Jan26 Jan27 1200 Feb-dFeb-0210.00 0ct-2016 Nov-2016 Dec-2016 Jan-2017 02-Feb-201
1min 5min 10min  15min 20 min 30 min 45min | 1hour **7 = @v @ |+~ #([15min 20min 30min 45min 1hour 2hour 6&hour 1day >>7 s @y @ ¢~ &
Ll Home il Charis X .8 Account  [&f Scan  {lf Optimize News  + O

10:27,822.00 O:821.75 H:821.84 :821.35 C:821.35 V.2 6K R:0.49 Feb-02 11:45:40

3.9 Time & Sales

The Time & Sales panel shows historical ticks for the selected instrument. The data and columns
available in this panel will depend on the broker or data service that you have chosen. The following
example shows the Time & Sales panel for the e-Mini S&P contract:
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MotiveWave - Console (CQG2)
wfigure  Window  Help
W~ Q i~ + "5 IT|&2~|15min -

xA A
ey - o X

Click here to show/hide
the time&sales panel )

'

|
'*i* T o

& &

B = = »

Rows: | 100 2| CEL O X

Boannn | Time Price Bid Ask  Volume AskT.a #
;M’ 11:49:26 227350 227350 227375 1 N
] 11:49:26 227350 227350 227375 2 N
Oo275.00 | 11:49:26 227350 227350 227375 13 N
] 11:49:26 227375 227350 227375 1 Y
] 11:49:26  2273.50 1227350 227375 15 N
Historical Ticks E.DD 11:49:26 227375 427350 2273.75 1 Y
: 11:49:26 227350 207350 227375 2 N
] 11:49:25 22735 s oo 1 N
225458 | 114925 227375 Red/Blue colors 1Y
:2273-50 B — indicate if the tick was = -

B 1 Aill at the Ask (blue) or

127200 11:49:25 227350 at the Bid (red) 2 N
] 11:49:25 22735 1 N
11:49:24 227350 2273500 227375 13 N
_3 o7000 | 114924 227375 227350 \2273.75 1 Y
] 11:49:24 227350 227350 227375 19 N
11:49:24 227350 227350 227375 1 N
Hooss00 | 11:4924 227350 227350 227375 3 N

For convenience, a button is available on the tool bar to toggle the display of this panel. Alternatively
choose View -> Display -> Time & Sales Panel from the top menu bar.

3.10 Depth Of Market (DOM) Panel
The Depth Of Market (DOM) panel shows a tabular view of the current bid and ask sizes. Choose View -
> Display -> DOM Panel from the top menu bar to show or hide this panel on a chart. For convenience a
toggle button is also available on the tool bar. For details on how to use the DOM panel see Depth Of

Market section.
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ormat Configure

MotiveWave - Console (CQG2)

KA A
Ky - [ X

Click here to toggle the

]ﬁsmfb

|‘g\\ ﬁ-|'-@\ lj' + == E display of the DOM @a
E = = <
1 | Limit Order - 12|= @ [« B¢
1 12 35 10 15 20
__ﬁ’ PIL  Orders Bid Price Ask  Orders Volume +
] 112.50 227475 10908 ELAEIC 8572
H2o78.00 | 100.00 2274.50 1073 13.2K
] 87.50 2274.25 122.2K
1 75.00 2274.00 1208 4K
J2276.00 62.50 2273.75 1132 16.8K
] 50.00 2273.50 1169 14.4K
37.50 2273.25 1157 14.5K
q2mM00 1 9500 2273.00 1141 132K
1 12.50 2272.75 1028 161K
@ 2272.50 258 314K
d2272.00
] -12.50 680 213K
-25.00 1131 2272.00 216K
I - Hoo70.00 | -37-50 1269 227175 Last Trade 19.0K
] -50.00 1072 2271.50 18.1K
* 6250 964 227125 9973
] Hozes00 | 7500 985 227100 10 6K
] -87.50 a75 227075 11.4K
] -100.00 998  2270.50 8220
J2266.00 | -112.50 1118 2270.25 9247
] 10.5K 20 105K
HQIHHI..I (402K 1@2272.50 Flatten
e ‘ B  [cneal
8:00 —
ymin 45 min 1 hour v @ |ov B2 025 SiMmwaveapi - Reverse

Feb-02 11:54:25

3.11 Chart Labels

Chart labels display information on the Price Plot of the chart. These labels can appear in any of the 4
corners. The following example shows some chart labels:
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Lol SPX500 - Primary Analysis - 15 min b3 IV
File Edit View Study Strategy Format  Window  Help

SPX500 |~ | Q| B e~ G [3 W~ B w~>Q v M~ + B[T|&2~[15mn ~ | >

SPX500i- 15 min H:2283.3 L:2268.0 Bar: 14:11
| H2288.0

Daily High/Low Time Remaining

in Last Bar r2286.0
H2284.0
2283,
l H2282.0

I
| P

12278.0

* the 4 corners of the chart. The
¢'nﬂ ' [j' order, color, font etc can also be
W

I customized. ﬂ

TR __
b Date/Time
NP e B g '

02/02/2017 1:30 PM

ﬂ 'L] n ITH_I Labels may be displayed in any of OU i

12274.0

1 1 1 1 1 1 T 1 1 T 1 1 T 1 1 1 1
Feb-2017 3:00 500 700 500 12:00 1400 1600 20:00 22:00 Feb-02 2:00 4:00 6:00 8:00 10:00 12:00 71400

1min Smin 10min [ 15min 20min 30min 45min 1 hour 2hour Ghour 1day 1week 2week 1month >4 = @y @ = B
[ ] 6:30,2274 5 02272 1 H2273.1 L 9C22719V40R12 Feb-02 13:30:48

You can configure the labels displayed on a chart from the Chart Settings dialog (double click on the
chart). You will find the labels under the Labels tab:

Chart Label Settings

e Chart Settings x
General Scaling Bar Settings Theme Display BELEERN Watermark Trade Elliott Wave
The list below shows the labels that are displayed on the price graph (such as Spread, Day Range eic).
Available Labels Labels
13 Week High Buy Button |
13 Week Low Sell Button Adjust the order here
26 Week High Day High to change the order
26 Week Low Day Low displayed on the chart.
52 Week High Bar Countdown
52 Week Low Date/Time
ATR ProfitlLoss
Account
Ask Price
Bid Price Chart Label: Bar Countdown 52
Change . _ 1+
The fields below allow you to adjust the settings for the chart label.
Change % 3
cursor Close Label Prefix:  Bar
Cursor High Location: ~Top Right -
Cursor Low o .
= T Outline:  None - Specific properties of the
ursor Open label can be configured in
Cursor Price Border: this dialog. (Double click on
Cursor Time Text Color /| Use Derg label or select and press the
Cusor Volume Edit button on the right).
Date Fill Color:
Day Close Font: Arial Bold;12.0 /| Use Default
Day Open
Day Range Cancel
Day Range % ‘ |
Nividend Data
OK Save Defaults Reset Defaulis Cancel
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Double click on one of the labels in the right hand box (or select and press the edit button, ie pencil icon)
to edit the properties of the label (see embedded dialog above). From there you can choose which
corner to display the label and adjust the color, font etc. The order in which the labels are displayed is
determined using the up/down arrow buttons in the Chart Settings dialog (see above).

3.12 News

If supported by your Broker/Data Service, news articles specific to the instrument can be displayed on
the chart by showing the News Headlines panel. Choose View -> Display -> News Headlines from the
top menu bar.

News Headlines Panel

~ MotiveWave - Console (goog) cy - o X

File Edit View | Study Stralegy Format Configure Window Help

MSFT | Link > & i~ + BT 2~|15min - LW XSmO ER
r—— % Display »| 3% components AltC B & =
x 4 Components Alt+C <& Trade Panel Alt+T |
MCS‘UF\TE 15 = semiLog Scale |
Volum
£3 Replay Mode iii DOM Panel |
£ Cursor Data Alt+D Q) Time & Sales Panel . ) ., 6550
¥ Snap Wave Points F5 | v =\ News Heprdlines Choose View -> Display -> News Headlines -
#{ Auto Analyze F6 News Vielter !
Lock Scroll v Bar Size Selector -'i !
14 Lock Studies @ Bird's Eye View !
10T et H465.00
[ Group Studies & Cursor Data Window TLQ I |
v Il Show Volume B Study Log |
@ Increase Hide Below Degree  Cirk+1 & Object Viewer Alt+V |
@ Decrease Hide Below Degree Clil*| | = Aleit History Window ] . wﬂlﬂ?} Hsa50
17 Reset Vertical Spacing v 12 Show Alert History HD 'D.ﬁ‘ .
v ik Show Extended Data v 4% Show Analysis | }[
(' Clear Local Data + W Show Commentary |
v = Show Tabs v & Show Trend Lines ! +! rje4.00
w«x Compact . F7 1 MenuBar | 'T o
. Dﬁ!lﬂhiq**’*li 3‘ T!ﬂ*u v Tool Bar ! Iﬁﬂh '* I
it 4y 1 1 l;Ill’,]; v Status Bar i t !Jr D*
I *Ti | :
n¢$$u ' |
! I
! o
¢D+ : ! ‘ | ] U‘ ﬁl‘
| J‘ | ” n" ﬂl re
| | i :
T B I . . | ;
i ;TIII oangnannanspranil ;TI'Iﬂlnlnnﬂlﬁmlllan"lllﬂI ﬂ”””“‘ I1T Ll ‘,IHIII JILLT paatl 'FI [aadiy |Fﬂh|nlplﬂﬂnulmﬂll il MHﬂlﬂnnll

14:00 Jan-25 1200 14:00 Jan-26 1200 14:00 Jan-27 12200 14:00 Jan-30 12:00 14:00 Jan-31 12:00 Feb-2017  12:00 14:00 Feb-02 1200 14:00 1600
1min 5min 10min 15min  20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 3month = v @ ol M2

x lﬁ:w‘ herel to hide Released v Source - - - +
mb e A 017-02-02 11:50 EST Sports Perspectives Microsoft Corporation (MSFT) Rating Increas :f"':zu”r"vlcsb"rzw;:”ul"ew es []
MSFTJAMZN 2017-02-02 11:30 EST Investorplace.com 3 Big Stock Charts for Thursday: Microsoft C{ s Viewer.  Inc ...

MSFT 2017-02-01 13:45 EST Seeking Alpha Watch Microsoft In 2017
MSFT 2017-01-31 12:03 EST Investorplace.com Is Microsoft Corporation (MSFT) Resurrecting the Cursed Windows RT?

w | MSFT 2017-01-30 05:34 EST Seeking Alpha Microsoft Is Very Likely To Fall Now

E MSFT 2017-01-29 10:15 EST Library For Smart Investors Published Patent Suggests Microsoft Corporation (NASDAQ:MSFT) Might Be ...

lul Home % Lul Charts 8 Account [ Scan  {}f Optimize News  + O

Feb-02 13:42:01

If you click on a headline in the news headlines panel, it will display the news article in the internal news
viewer by default. If you right click on the headline, you can optionally display the news article in your
web browser.

Show News Article

| | | | | T
‘ I q [T | ﬂ y
| {?I“ Mlasny wapmentbHis A Nannng [ Hannnsl ”lllﬂ' ﬂ”””“‘ I-n LI 'rlﬂll-l Mlnny i 'ﬂ Manflanry "I'Il!'l‘"llnlvlﬂﬂnull‘ﬂl‘“l ﬂﬂnﬂl!nnll .
Jan25 1200 1400 Jan26 _ 12:00 1400 Jan-27 1200 14:00 Jan30 _ 12:00 1400 Jan-31 1200 Feb-2017 _12:00 _14:00 Feh T 1200 1400 1600 1E00

imin 5min 10min [ 15min  20min 30 min 45min 1hour 2hour 6&hour 1day 1week 2week 1month 3 month = @iy @ ¢+

x Symbols Released v Source Headline -
MSFT 2017-02-02 11:50 EST Sports P&l cJick to show in Microsoft Corpg Right click to choose to open in - Neutral at Atlantic Securities [ ]
MSFTIAMZN 2017-02-02 11:30 EST Investorp| News Viewer a| Browserorthe News Viewer  Lgon (msFT), Amazon.com, Inc ..

MSFT 2017-02-01 13:45 EST Watch Microsoft In 20

2017-01-31 12:03 EST Investorplace.com Is Microsoft CEINENNELe el esurrecting the Cursed Windows RT?
» |MSFT 2017-01-30 05:34 EST Seeking Alpha Microsoft Is | SNOW In VIEWer oy
E MSFT 2017-01-29 10:15 EST Library For Smart Investors Published Patent Suggests Microsoft Corporation (NASDAQ:MSFT) Might Be ...
Ll Home X lul Charts {8 Account [ Scan  {lf Optimize News  + [ K]

Feb-02 13:45:09

The following screen shot shows an example of displaying a news article in the News Viewer:
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S\ News Viewer - Is Microsoft Corporation (MSFT) Resurrecting the Cursed Windows RT? - L X
Forward > http:/finvestorplace.com/2017/01/microsoft-windows-10-cloud/ Go
Protect Your Business Now Q)E> =
Cost Effective Protection it &
Other Zero-Day Exploita. Go to buy malwershytes com
InvestorPlace Menu ¥

dinwlc-|=!

Is Microsoft Corporation (MSFT) Resurrecting the

Cursed Windows RT?

Don’t look now, but Windows RT just might be back as Windows 10 Cloud

By Brad Moon, InvestorPlace Contributor | Jan 31, 2017, 12:10 pm EST

Don’t look now, but Microsoft Corporation (NASDAQ:MSFT) looks fo be taking another run at

Alphabet Inc’s (NASDAQ:GOOGL, NASDAQ:GOOQG) Chrome operating system. References

have begun popping up in builds of the Windows 10 Creators Update (which is due to arrive in

April) to Windows 10 Cloud.

Speculation is growing that Windows 10 Cloud is in = Seures: Mizroselt

fact a new simplified version of Microsoft’s operating = |

system, designed to run on devices powered by

|

3.13 Watermark

The Watermark feature in MotiveWave™ enables you to display a semi-transparent label with the
instrument’s symbol and/or description. You can also choose the location and font of this label. The
watermark can be configured from the Chart Settings dialog, see Watermark tab.

Watermark Settings

Chart Settings
[Settings Theme Display Labels BUEIEIENE Trade Elliott Wave

Click here to enable
the Watermark

ions below allow you to configure the symbol to be shown as a watermark on the price chart.
v/| Show Watermark

Opacity determines
how transparent the

HEEEEEEN .
mom m m m m wom| watermark is.
EEEEEEEEENEE

Opacity:

Center - Choose tl:we location
on the price plot.
Color: v/| Use De

Location:
Symbol Font: Arlal I v/| Enabled

Description Font: Arjal Bold;2...

These options allow you to
choose to display the

Enabled Symbol and/or Description

OK || Save Defaults Reset Defaults Cancel

The following screen shot shows the watermark description for Microsoft:
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Jan27 1200 1400 Jan30 1200 1400 Jan31 1200 Feb2017 1200 1400 Feb02 1200 1400 1600 18:00
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Ll Home % Ll Charts 8 Account |2 Scan i Optimize News  + m by o
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3.14 Scaling

Several different scaling options are available for scaling the price/time range of the price plot. By
default the chart price range is automatically scaled from the visible data and components (Auto Scale).
The following are the available scaling options:

1. Auto Scale — Price range is adjusted according to visible data and visible components (optionally,
only the data range can be considered). This option will lock the vertical movement of the chart.

2. Price Range — This option keeps the price range constant and enables you to manually move the
graph up/down.

3. Square — This option will set a fixed number of points per bar width. If the bar width is expanded
(or contracted) the price range will be updated to reflect.

Scaling options can be found under the Scaling tab of the Chart Settings dialog.
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Scaling Options
o Chart Settings X

Genera\ElarSettings Theme Display Labels Watermark Trade Elliott Wave

Choose the scaling type and settings below. This y it chart
Scale Type: | Auto Scale - Choose t-he Scale Type: Auto
Scale, Price Range, Square
Auto Scale Price Only
Top Inset (pixels): \#‘ Options available will
Bottom Inset (pixels): depend on the Scale Type

Save Defaulis Reset Defaults Cancel

3.15 Analyses

MotiveWave™ employs the concept of an Analysis to encapsulate the work that you have done in a
chart to analyze price movement. An analysis will contain the following types of information:

1. Components —any components that you have added to the chart including: trend lines, Elliott
Waves, Gann components, Gartley patterns, commentary etc

2. Studies — Any studies that you have added to the chart

3. Time/Price Guides — These are guides that you have added to the horizontal or vertical axes.

It is important to understand that an analysis is a separate entity from a chart. A chartis a view or an
analysis file. This is an important distinction and is fundamental to the underlying design of
MotiveWave™. While this concept may seem a little confusing at first, it has numerous advantages:

1. View in Multiple Time Frames — A single analysis can be viewed at multiple time frames
simultaneously. You can have several open charts that reference the same analysis and edit
them from each chart.

2. Alternate Analyses — Each instrument can have any number of analyses. The name of an analysis

is scoped to the instrument so it does not have to be unique across symbols.

Saved in Repository — You can save an analysis and load it later after the chart has been closed

4. Share with other People — Analyses can be exported in XML format and shared with your friends.
You can also share analyses using the Analysis Sources feature.

w

The following diagram illustrates the relationship between charts and analyses. Each instrument may
have multiple analyses which are saved in the local database (repository). When you open a chart, you
are opening an analysis. MotiveWave™ allows you to open an analysis from more than one chart at the
same time. Changes made in either chart are synchronized between the two so you do not have to
worry about overwriting you modifications.
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Instrument 1 / Instrument2 -~

Alternate Alternate Primary Allernale e

1 Analysis 1
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) scoped to the L mot currertly cpen )
instrument (names -~ Analysls Files

may be reused
across instruments)

Local Database

Import ! Export
(xml format)

3.15.1 Creating a New Analysis

The default analysis for any instrument is called the Primary Analysis. Whenever you open a chart for
the first time, it will open the Primary Analysis. The net effect of this behavior is that all changes
between the open charts for that instrument will be synchronized between them.

If you do not want these changes to be synchronized, you can create one or more Alternate Analyses.
There are several ways to do this; perhaps the most convenient is to use the New Analysis button on the
tool bar.
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Lail MSFT - Primary Analysis - 15 min™
File Edit View Study Strategy Format Window  Help
MSFT QR R s @ NElerQ o1~ +°

New Analysis

g

Click this button to
create a new analysis.

LT T T
L g *I'DU

B e et 3

The following dialog will appear when you create a new analysis. Enter a name for the analysis. By
default, analyses are named Alternate 1, Alternate 2 etc. You can however choose any name you like for
the analysis. A new analysis may be empty (just price bars) or you can base an analysis on an existing
analysis by choosing one from the Based On drop down.

New Analysis Dialog

]

This dialog allgws you to create a n
Corporation. 1you select an existi
down, the contents of that analysis
Click the Empty check box to cre

New Analysis - Microsoft Corporation

By default analyses are named
'Alternate 1', 'Alternate 2" etc,
but you can choose whatever
name you like.

Name: | |alternate 1
Empty | Use these options to copy
Based On: | Primary Analysis _gr | an existing analysis as a

‘ starting point.

OK || cancel |

Once you have created the new analysis, the chart will display a set of tabs at the top where the active
tab is named with the new analysis.

Chart with New Analysis

il MSFT - Primary Analysis - 15 min o3+ SRS
File Edit View Study Strategy Format Window  Help
MSFT ~O|h & H =& Welere i~ + E[IZ]2~[15mn  ~ L
Primary Analysis 15m  |Alternate 1 15m x | &5
. | ! 1
MSFT (Alternate 1)i- 15 min i ! H66.00
I
m+u* Newly created analysis is I 3
bt i i |
u ! displayed in a separate tab ! ]
Analysis name is ! 1165.50
displayed as part } q
of the title T. ! E
i |
i | ]
I
] | !
+ L E
' 'ﬁﬁl ey el o450
TR U +i ]
|
| 4
|
! U N fs4.00
| * ]
| ++'
| W0y
|
|
l U‘ ﬁl*
|
w TR ¥
1 b
i I
MotllveWave ) ) ) ‘ ‘ ) ‘ ‘ ) ‘
14:00 Jan-30 12:00 14:00 Jan-31 12:00 Feb-2017  12:00 14:00 Feb-02 12:00 14:00 16:00
imin 5min 10min 15min 20min 30min 45min 1hour 2hour 6hour 1day *g4 = @iy @ ¢l B

Feb-02 14.06:24
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3.15.2 Open Existing Analysis

If you want to quickly open an analysis, just click on the small black triangle next to the open button on
the tool bar. Alternatively, choose File -> Open/Manage Analyses from the top menu bar (File -> Chart -
> Open/Manage Analyses from the Console menu bar).

Open Analysis

sl M a sis - 15 min el -
Fle Edit View Siudy Strategy Chckontheblack |

triangle here. _
MSFT QA E R s ~Q i~ + [T/ &2~ [15mn  ~

FT - 15 min Aliernate 1 !

umfm!ﬁmméﬁﬂ”nﬂ ‘ n v Phinary Analysis

I New Analysis Select the analysis
ala Import Analysis  Cir+K you want to open

1
1
1
1
:
= g
& Manage Analyses : from the drop down.
|
1
1
1
1
1
1

I*T?mTIiITﬁTM#TIIDH‘

Wi |

3.15.3 Manage Analyses

The Manage Analyses dialog allows you to open, export, rename, delete or create new analyses for the
given instrument. This dialog can be access from the menu bar: File -> Open/Manage Analyses from the
top menu bar (File -> Chart -> Open/Manage Analyses from the Console menu bar).

Manage Analyses Dialog

= Analyses - MSFT X

The list below contains the available analyses for this instrument. From here,
you can create, rename and remove analyses using the buttons below.

Name Last Updated *
Alternate 1 Feb-02 14:06
Primary Analysis l,\\s Feb-02 14:06

Click on an analysis and
use the buttons below.

New Analysis Cpen Export Rename Delete Close

3.15.4 Import/Export Analyses
Import and export are very valuable tools for sharing your analysis with another MotiveWave™ user.

When you export an analysis file, the file will contain all of the information related to your analysis as
well as information about the instrument. The exported file will be in JSON format and will have an
extension of . mwml (MotiveWave Markup Language).

Choose File -> Export Analysis from the top menu bar (File -> Chart -> Export Analysis from the Console)
to open the Export Analysis dialog. By default the analysis file will be saved on your computer desktop in
the form <Symbol> — <Analysis Name>.mwml. You may change this name and location if you like. Click
on the Save button to export the analysis to the selected file.
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Export Analysis *
4 I » ThisPC » Desktop » v | @ Search Desktop x
Organize - Mew folder = - 0
[ Documents # *  Name By default the file is saved Date modified Type -
Download to your Desktop
¥ Downloads anal 12/22/2016 452 PM  File folder
&=] Pictures ” Archive 12/30/201512:42 ... File folder
CUrsors Certs 12/8/2016 12:05 PM  File folder
EXCM Test docs 1 File folder
install FXCM Test 1117 : File folder
GIMP 31272012 4:57 PM File fold
MativeWave - e felder
iStock Photos 3/22/2012 1:29 PM File folder
¢@ OneDrive G 016 1:51 PM File folder
Default name for 135015 1135 A File fald
[ This PC the Analysis File /ebie e Al e felder
— 4/23/2016 11:00 AM  File folder w
[ Desktop >
Click Save to
File name: | MSFT.NASDAQ - Alternate 1 create the —
analysis file
Save as type: | Analysis Files ¥ ~
A Hide Folders Cancel

Similarly, to import an analysis file, choose File -> Import Analysis from the top menu bar (File -> Chart ->
Import Analysis from the Console) to display the Import Analysis dialog. Locate the analysis file, select it
and press the Open button. If the chart you are currently using has the same instrument as the imported
analysis file, it will be opened in another analysis tab. If the instrument does not match the chart, a
message dialog will be displayed indicating that the import was successful and how to open the

imported file.

Import Analysis Dialog

Select an Analysis File to Import x
A Wl » ThisPC » Desktop » « O Search Desktop e
Organize = Mew folder =~ [ @
~
[ Desktop # * Name Date modified Type "
[£| Documents process explorer 6/24/2016 10:43 AM  File folder
; Downloads o Receipts 114 12:39 ... Filefolder
| Pictures - repo 10/19/2016 1:36 PM  File folder
cursors repository 2/1/201511:01 AM  File folder
2/28/2012 2:32 PN 1
FXCM Test Stock Images ! 1 PM File folder
. TA Analyses 1171472016 &57 PM  File folder
install . I .
Taxes Select the file /29/2016 11:52 AM  File folder
MotiveWave Transact to import File folder
@ OneDrive ,$ Downloads Shorteut
D MSFT.NASDAQ - Alternate 1.mwml /2 MWML File
I This PC a1 My Scans - Documents /31 Shortcut
[ Desktop | My Scans - Pictures 6/12/201511:39 AM  Shorteut o
[Z Documents v < >
File name: | MSFT.NASDAC - A Analysis Files ~
Click Open to
import the analysis Cancel
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Many different types of components can be added to a chart as part of your analysis. Examples of
components include Trend Lines, Price Labels, Channels, Commentary, Elliott Waves, and Markers.
Components can be added to a chart from the Components Panel or by using the Mouse Tools
(available from the tool bar).

3.16.1 Components Panel

The Components Panel organizes the available components in MotiveWave™.
on the left hand side of the chart area and is organized into folders. You can hide this panel by clicking
on the ‘X’ in the top right corner of the panel. A toggle button is available on the right hand side of the
tool bar to show/hide this panel as well. Alternatively, choose View -> Display -> Components from the

top menu bar.

Components Panel

This panel is displayed

Ll

BRK.B
Components
¥ General

= 43

e e

Zone

&

Zone

T

Line
Line

Vertical
Line

Line

» Basic

» Commentary
» Markers

» Fibonacci

» Gann

» Elliott Wave

» Gartley

Price Label Price Label

Support  Resistance

Time Label Time Label

Horizontal Extended

Horizontal

Vertical ~ Extended

Click X' to hide.

*i

File Edit View Study Strategy Format Window
Q|
X HRK.B - 15min

LA ] g

ume

BRK.B - Primary Analysis - 15 min
Help

- Q

I~ + "I &~ |15min

AL A SR T OG-

This button
shows/hides
the panel

KA n
P4 I

X

H165.20

=165.00

H164.80

116460

164.40

H164.20

H164.00

H163.80

+163.60

~163.40

163.31
H163.20

+163.00

‘ |
I
| | | U ‘ —
H | Additional Component | | u U!IU @.}
: i
I ! 'l 162560
|
|[F— I | | il
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3.16.2 Adding a Component

To add a component from the Components Panel, simply click and drag (using the left mouse button)
the component onto the chart area (see below). Alternatively, you can double click on a component, or
right click and choose Add To -> <Graph> to add it to the center of the chart.

Feb-02 14:22:57
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Components b4
v General
= —1=
Price Label [BiESIEEEE] .

Click and drag
the chart are

T &

Time Label Time Label

Horizontal Extended
Line Horizontal
Line
| I
Vertical Extended
Line Vertical

BRK.B - 15 min

Volume

to
a

Release the mouse
button where you
want to place it

motivewave'

[S—
——
— —

Mouse Tools are available for some of the more common components. In some case these tools can be
more convenient than using the Components Panel. These mouse tools can be found under the Tools
dropdown on the tool bar. You can customize the tool bar to make certain mouse tools more
convenient to access. Short-cut keys are also available to quickly select tools. These keys typically take
the form of Ctrl + Shift + <Key> (see tool menu for key combinations, Note: on Mac OS X use Cmd

instead of Ctrl.)

Tools Dropdown

il BRK.B - Primary Analysis - 15 min*
File Edit View Siudy Strategy Format Window  Help
BRK.B MY BRIk WElerQ 0~ + " T &~ |15min - K K== A O~ 7~ El
Components X BRK.B - 15 min i k Select Clrl+Shift+S i
¥ General Volume ¥ Drag Ctri+Shitt+D 1
This is the tools drop C:)\ Zoom Cr+Shiite2 i
1
== —= down. Click on the arrow % No Tool Cir+Shift+Y H
Price Label [PHGeIiEEE] to show available tools T Text Ctr|+Sh.Ht+T Keyboard shortcuts
Ruler Ctri+Shift+U for quick access
T'lfi +U \ Line Cirl+Shift+L 4 - .
- - l + ¥ Eraser Ctrl+Shift+E |
B T T Regression g |
S;ppolt Reszlstance T Eibonacci ’ !
one one Ellictt Wave vof ! Jﬁ‘ .L +
Gartley [ ' M Auto Gartley Ctri+Shift+G
I?I é 4 Channel Ctri+Shift+C \,\ Auto ABCD *IH
Time Label Time Label % Fork Ctrl+Shift+F M Gartley
L Time Label M Bat
—= Price Label M Alternate Bat
— — [P £ Data Edit M, Butterfly Ctri+Shift+B
Horizontal ~ Extended l Markers \ ﬁ grab Crab t
Line  Horizontal Commentary v eep Cral
Line 163.4 i I ![:]"‘T“‘ TI TTUI \I\ AB=CD Ctr+Shift+=
| W, Alternate AB=CD
I i w/ 3 Drives Clrk+Shilt+3
Vertical — Extended E w 50 Ctr+Shift+5
Line Vertical H ! 1
Line | i h'
= Racir 1 "

The following example shows the usage of the Channel Tool to create a channel. This particular tool
requires three clicks to define the channel. Also the channel is drawn as you click the mouse.
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CSCO ~ Q|
Components X
* General

= -4
Price Label [BRcEIEEES]

R

Support  Resistance
Zone Zone

T &

Time Label Time Label

Horizontal Extended
Line Horizontal
Line
|
Vertical ~ Extended
Line Vertical
Line
» Basic
» Commentary

» Markers

» Fibonacci

B s~

CSCO -15 min
Volume

CSCO - Primary Analysis - 15 min

File Edit View Study Strategy Format Window  Help
WM 4va i+ "=[T &~|15min -

Shows Active Teol

irst Click

S =

umii n”

o ﬁl[:]’il lﬁu

Channel Tool
ﬂ Three clicks are need to create
4‘ the channel. The first two define
the first line. The third places the
second channel line.

3.16.3 Selecting Components

Third click will
create the

You can select components on a chart by simply clicking on them with the left mouse button. When a
component is selected, you will typically see green resize points that indicate areas that you can move to

modify the component.

OR

L - 15 min

Select Component

s

are d

Green resize points

isplayed.

.

Left click on a
component to select it. 18

If you want to select multiple components, simply hold down on the Shift key while clicking on other
components. The first component selected will have green resize points (primary component) and the
other components will display blue resize points (secondary components).
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Select Multiple Components
1

I
1

4030 Primary cum;{unent ! H40.40
+H has green points. !
l|' |

H ‘Wﬂ | diosn

T o Seleciand type [ |
m 'U 7 toedi {3t E 40.20
mm Jao10
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\ﬂﬂ have blue points. 3959
||!'|l I
; UTW n TI 0 %

H39.80

H39.70
3968
H39.60

H39.50

Motive\Wave

Selecting multiple components can be useful if you want to move them as a group or delete them.
Some components such as trend lines have options from the right click menu (right mouse click) that
apply to the group. In the following example, you can make two (or more) lines parallel by selecting
them and choosing the “Make Lines Parallel” option from the right click menu. (Note: lines will be
drawn parallel to the primary component, ie the one selected first):

Make Lines Parallel

4040

Right click on the
selected component
to show menu.

lﬂﬂMIIU ”lmuﬂl = : Heazn

H40.30

Format
Visibility

,
HJ‘ Hl [] 72 Create Alert
4 iD Show Info Ctri+l
Show Angle Fre.r
p Relative End Point 4 :

+ Extend Ctrl+E Tl
W =
Ratios v
Y } Line ’ =¥ Show Midpoint
Properties Circle Radius
n ) 'H‘T.u‘“' Tlﬁ Circle Diameter
! A\ Flip Line —
! (* Rotate 90 Degrees This option will make
[ e N |

all selected lines
parallel to the primary
line (green points).

| ('Roiate 45 Degrees
! O Make Lgs Parallel

3.16.4 Deleting a Component

Deleting (removing) a component from a chart is straight forward. Simply click on the component to
select it and then press the ‘Delete’ key on the keyboard. Alternatively, right click on it and choose Edit
-> Delete.

If you want to delete all components from a chart, choose Edit -> Delete All from the top menu bar.
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3.16.5 Component Properties

Components may be modified from the Component Properties dialog and (in many cases) by using the
right click menu that is available via right click on a component. You can open the Properties dialog by
double clicking on a component or right click and choose Properties.

Accessing Component Properties

Right click on

m+ l \Eﬁe component. E
' *lmﬁ*?liu Hlu uﬁ\ |
* o

W
!

+* Show Fil

4, Show Middle Line Ctri+M can be changed from

7 ;

4k Flip Channel these menu options. m
Extend Ctri+E
Extend Left é]— ma ﬂ ! 'IIJ *

[ .
m‘nﬂ e '¢ﬁﬂ

9.8 o\

W

Properties

—_

The following screen shot shows the Component Properties dialog for the Channel component. The
options available in this dialog will vary depending on what component you are editing.

Channel Properties Dialog
Channel Properties X

Format Visibility Ratios

Use the options below to change the display of the component.

Lines: | 2 Lines v
Show Info
Show Angle
Show Middle Line
Extend
Extend Leit

OK | Apply || Save Defaults Cancel

3.16.5.1 Formatting

Formatting options such as color, font, line width/style, shading etc can be found under the Format tab
of the Properties dialog (double click on the component). For convenience several formatting options
are available on the tool bar for changing the component format. These buttons are context sensitive
and will apply to the selected component (see below). These buttons will appear inactive (greyed out) if
no component is selected.
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3.16.6 Working with Trend Lines

Trend lines are an important element of most all forms of market analysis. Several features are built
into MotiveWave™ to make working with trend lines easier.

Jal TSLA - Primary Analysis - 15 min* 2o X
File Edit View Study Strategy Format  Win
. o L These context sensitive ~ — ., _
TSLA Al EE @D | buttons case be used to = 35mio A IS~ = Av O~ S~ |luwm | 5§ »
, - ;
TSLRA -15 min change the format of the ! ' !
Valunje selected component. ! :
||I 1 | H255.00
| i
MT*{ Price Label Properties x
[] General Visibility 00
U l! Selected Component Use the options below to change the display of the component.
li 00
$ Uf [: ‘ Font Arial12.0 B
2 42|
+ : lmT m] b Line: | I ~ [ — 10 - - pi2
.00
u T Fill Color: -
Wod &
I ﬂ x + ? q]l Formatting options for any
compenent can be found 00
; ﬁ ' %]w under the Format tab
X ? b.00
.00
H &
I nﬂlnﬂ-‘l-nlnnpﬂ.ﬁﬂlill 18 e e I ﬂn”].n-lnnn!nnﬁi'iﬂlﬂm 2K)
Jan-26 12:00 14:00 Jan-27 12:00 14:00 Jan-30 12:00 14:00 Jan-3| ||
imn Smin 10min 15min 20min  30min 45min 1 hour 2 hour 6 OK | Apply Save Defaults cancel 2]

Trend Lines can be created by using the Line Tool that is available from the tools drop down.

Velume

!
Tuﬂhlw?ﬁmu

quU

Jatil.

File Edit View Siudy Sirategy Format Wi
AMZN QK B erE

AMZN - 1 day

Click here to see
the tools drop down

K lwvrQ v+ BIT|2-|1day

Selecting the Line Tool
AMZN - Primary Analysis - 1 day

indow  Help

k Select Cirl+Shift+S
v W Drag Ctri+Shift+D
@, Zoom Ctri+Shift+Z
¥ No Tool Ctrl+Shift+Y
T Text Cirl+Shift+T
Ruler Ctri+Shift+U
~N Li? Ctri+Shift+L Select the 'Line’ too
Hﬂl & Erdser Ctri+Shift+E Alternatively press
Regression 4 Ctrl + Shift + L keys
Fibonacci »
Elliott Wave 8 + l |
Gartley » T !
4 Channel Ctr+Shift+C * |
o Fork CArl+Shift+F l. -T e]T+ D ’ |
L, Time Label l ' w ! i!ﬁ * i
—= Price Label
¥ Data Edit D U
Markers 4 *
Commentary »

F

800.00

780.00

760.00

740.00

720.00

Creating a trend line requires two left mouse clicks. The first click defines the starting point for the line
and the second defines the end point. Once you have created the Trend Line, you can press the Space
bar to switch the tool back to the default Time Drag tool.
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Creating a Trend Line

Cursor changes to
the Line Tool cursor

i

Two left mouse clicks
will create a trend line.

)

|
l |
When a trend line is selected it will display basic information about that trend line (such as the price
range and time span). You can adjust the line by moving the end points (green resize points). These
points will snap to key locations such as the top or bottom of price bars (hold down on the ‘Alt’ key to
disable this feature).

Adjusting a Trend Line

! i —fseo_oo

su.zirl i i :340 73

Price Range i HL{]T [ﬁ E 873-76'

ﬂ and Time Span ! T I+i i —:820.00
| — N |

Ik | Dhu Fl

éf i f780.00

End price points are shown
when line is selected.

' 760,00

t Drag end point to i ]

: change its location : ]
: | J740.00

End point will _:?20_0[)

i automatically snap to ]

! i i i bar low and highs (see | ]
i i | E H o i - red box outline) i r700.00
‘.'.'..'nn.-,.i.uﬂ|n|ﬂl|H”l‘nnﬂnIn”n”ﬁlﬂli.lnﬂlllulnﬂlll Tl ”I”Hﬂlﬂll.||||Iﬂﬂﬂli|H|I|nnnu.nll M MhaaRnalTaleln i EXL

Common angles (such as horizontal, vertical, 45 degree etc) can be set by holding down on the Shift key
while moving one of the end points. Hold down on the Ctrl key while moving one of the end points to
maintain the current slope (angle) of the trend line.
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Detailed information about the trend line can be found if you place the mouse cursor over the trend line
and leave it there for 2 seconds.

Trend Line Hover Popup

A e et Ao hh

Place curso
over line for 2

seconds

Star‘tjEnd Prices

T+ tart: 303 46
d] nd: 295.99 Range/Percent Move —J
747 (-2.4616%)
_ 18 hour
Time Span and 76.6 hars
Price Bars May-14 7:44 - May-16 13:23 |

Wﬁ N ==

B e A A I R e A P b

yul J]-

Several operations for working on trend lines can be found by right mouse clicking on the line to show
its context menu.

1.

Create Alert — Create an alert when the price crosses the trend line (see Component Alerts
section)

Show Info — Shows information about the trend line

Show Angle — Displays the angle of the trend line (in degrees)

Relative End Point — Calculates the end point relative to the start point instead of using a specific
time/value for the end point

Extend — Extends the Trend Line to the Right

Extend Left — Extends the Trend Line to the Left

Show Midpoint — displays the midpoint on the line

Flip Line — Flips the values on the start and end points

Circle Radius — Draws a circle using the trend line as the radius

. Circle Diameter — Draw a circle using the trend line as the diameter

. Rotate 90 Degrees — Rotates the trend line 90 degrees clock wise

. Rotate 45 Degrees — Rotates the trend line 45 degrees clock wise

. Make Lines Parallel — If you select multiple trend lines this will make them all parallel to the

primary line (the one with the green resize points)
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14. Make Lines Parallel and Equidistant — If you select multiple trend lines this will make them all
parallel to the primary line (the one with the green resize points) and equidistant between the
top and bottom lines.

Trend Lme Operatlons

Right click to show
context menu
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3.16.7 Custom Tools

Custom tools are based on existing mouse tools. A custom tool allows you to configure the default
properties of the component that is drawn using the tool. For example, you could create a custom trend
line tool that draws a blue dashed line (instead of a black solid line).

Custom tools can be created from the Preferences Dialog (Configure -> Preferences from the Console
menu bar). Click on Tool Bar, then on Custom Tools.
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General Theme Chart Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email b
Custom tools can be created based on existing tools. Click the add button below to create a new custom tool.
+

4

Click here to create

a new Custom Tool

OK | Apply Cancel

From the Custom Tools section, click on the add button (plus sign) to open the Add Custom Tool dialog.
The tool must be based on an existing tool, select this from the Base Tool drop down (Line tool in this
case). Optionally, you can change the color(s) for the tool icon (to make it more distinguishable). For
the purposes of this example we will choose blue as the primary icon color.

+ Add Custom Tool X

Custom tools are based on an existing tool. Icon colors can be customized by
choosing new colors below. Click on the properties button below to customize
the settings for the component that will be created from using this tool.

r
Name: Blue Dashed Line

Base Tool: ﬁ Choose the base
I -

lcon Color 1:
Optionally, change
lcon Color 2: P . ¥ g
the icon colors.
lcon Color 3:

Customize Click on Customize to change
the properties of the
OK || can component that will be created

Click the Customize button to open the Component Properties dialog and adjust the default settings. In
this case we would like to create a blue dashed line. This can be adjusted from the Format tab.
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Use the options below to change the display of the component.
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Line:

Fill Color:

In our case, we want to
make a blue dashed line.

OK Cancel

motivelave’

After clicking the OK button in the two previous dialogs, you will see the custom tool added to the list

below:

Lo Preferences X
General Theme Chart Sounds Ratios ElliottWave Gartley TickCharts Orders Alerts Emall (v
Custom tools can be created based on existing tools. Click the add button below to create a new custom tool.
+
Blue Dashed Line
by Here is the custom
tool we just created
We changed the
primary color of the
icon to blue
-
--J— L . o il Y P Ul g e

The next step in using the custom tool is to add it to a tool bar so it can be accessed using the mouse.
Click on the Tool Bar tab to customize the tool bar. In this case we are going to customize the Top Tool
Bar to add our Blue Dashed Line tool to the left of our tools drop down.
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o]

Preferences

X

General Theme Chart Sounds Ratios ElliottWave Gartley TickCharts Orders Alerts Emal =

Custom Tools Tool Groups

Use this panel to configure the actions available on the toolbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: | Top v | |v/| Enabled
Available Actions: Tool Bar Actions:
4+ Arrow Up Q, Quick Search
W, Auto ABCD Q_ Search for Instrument
M Auto Gartley i - Separator --
A Auto Wave B New Analysis
8 Balloon Callout = Save
§:: Bar Settings I3, Save As
M Bat s Open/Manage Analyses
Blue Dashed Line I8 Save As Image L
B Bold i — Separator — 4
[ Box k ) Undo
= Box Callout + (™ Redo

Select the custom tool above and
click the right arrow button to add
it to the tool bar.

(Alternatively, just drag and drop
the tool from the Available Actions

! — Separator
# Auto Analyze
W/ My Group
73 Create Alert

{ — Separator --

Tools

list to the Tool Bar Actions list) €, Zoom Out
l 0l Bar Type
B Circle Al Bar Data
Reset Reset All
ok || apply || cancel

After making the modifications above, the Blue Dashed Line tool will be added to the top tool bar (see
below). Click on the button to activate the custom mouse tool. Note: the tool tip for this button will
display the name of the tool.

i Y e e

~ MotiveWave - Console (fx2) R o i
File Edit View Siudy Sirategy Format Configure  Window  Help
uUsOil ~QEE R s @ [ W~ B\ w~Q v M+ T T|2v[15mn  ~ =- Zv A~ »
|l EUR/GBP 1h Ll USOil 15m » | 4+ l/} : B = = A~
- - | Blue Dashed Line Tool tip shows the name z
USOIil - 15 min — . Hs320
Custom tool icon i of the custom tool + i
added here | l‘i‘ HT ‘ 23.07
i | ﬂ I Iyt 5302
i j‘l‘ huimy iH!

The screen shot below illustrates the new tool in action creating a blue dashed line:
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~ MotiveWave - Console (fx2) ey - ¢ X
File FEdit View Study Stategy Format Configure Window  Help
Usoil QN SR s 6 KW~ 2INI\~Q i~ m~v[+]F[T|2~[15mn ~ =- =v A~ 2
Ll EUR/GBP 1h [ Lul USOIl 15m x | + B =+~
USOil - 15 min Hs3.20
/5308
' .l I mﬂ .h* _53.03'
| b U52.84)|
+“'T“T+“ *i* e /\ 1
it 4-!* ’,-"” Custom tool creates a blue 2.60
*“ *".TT L ’,/” dashed line using the changes
l * l i‘|'+l+' *“*l“ PP that we applied in the
| L ies di 24
'I “ 1.“ 4 L Component Properties dialog. B38|
ey Hs2.20
e Hs2.00
. h - Hs1.80
P g - e el ™ Mt " B i o VR

3.16.8 Tool Groups

Tool Groups may be used to create a custom drop down button for organizing existing and custom tools.
This can help to optimize the available space on the tool bar(s). Tool Groups can be created from the
Preferences Dialog (Configure -> Preferences from the Console menu bar). Click on Tool Bar, then on
Tool Groups. Click on the add button (plus icon) to create a new Tool Group.

o

Tool Bar Custom Tools [RElIRElflle}

Tool groups are used to organize tools under a dropi

Preferences

General Theme Chart EEbE==8 SPunds Ratios  Elliott Wave  Gartles

Click on Tool Bar,
then on Tool Groups

X

Tick Chaits  Orders  Alerts  Emalil

-

+

Click here to create

a new Tool Group

OK

Apply

Cancel
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Choose a name for the tool group and add the desired tools from the Available Actions list to the Tool
Group Actions list. Click on the OK button to create the tool group. Note: the name identifies the tool
group and will also be used as the tool tip.

+ Add Tool Group X

Tool groups enable you to organize several tools into a single drop down. Use the form below to

add/remove/re-order the too
B v Tool Choose a name for
ame: y Tools the Tool Group
Available Actions: Tool Group Actions:

£ Data Edit ™\ Blue Dashed Line
M, Deep Crab % Fork
4 Diamond O Ellipse
M T
¥ Ending Diagonal M Auto Gartley
¥ Eraser A Auto Wave
/< Expansion
~ Extension - L}
- Fan 4
M, Gartley *
A Impulse
A Leading Diagonal Drag and drop the desired tools
\ Line from the Available Actions list to
A Line the Tool Group Actions list.
= Line Callout
% No Tool
@ Note
@ Octogon
OK Cancel

The newly created Tool Group will be added to the Tool Groups list in the Preferences dialog. The icon
for the first tool in the tool group will be used for the tool group.

fe Preferences *

General Theme Chart Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email -

Tool Bar Custom Tools aEshReilie

Tool groups are used to organize tools under a drop down menu on a tool bar.
+
. My Tools

The first tool in the

list will be the icon
for the tool group

) VR

The next step is to add the tool group to a tool bar so it can be used. Click on the Tool Bar tab in the
Preferences dialog and select the Top tool bar from the Tool Bar drop down. In this case we will add the
My Tools tool group just after the Blue Dashed Line tool that we created in the previous section.

o,

e
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[} Preferences x

General Theme CnartSoumds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email >

Custom Tools  Teol Groups

Use this panel to configure the actions available on the toelbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: | Top ~ | |V/| Enabled
Awailable Actions: Tool Bar Actions:
= o wmomy -
N Q, Quick Search
W Line Q, Search for Instrument

f — Separator --
B New Analysis
= Save

7 Line Callout
[ Load Extensions
Marker Tools

# Move To Back LSRR
", Move To Front & Open/Manage Analyses

1
My Tools Iii Save As Image

Mews Hezdlines -» £ -- Separator -- 3
¥% No Tool = ) Undo
@ Mote ("' Redo
oL Object Viewer - Separator -- [
# Auto Analyze
Select the tool group above and 73 Create Alert

click the right arrow button to add £ — Separator -
it to the tool bar. *\ Blue Dashed Line

(Altematively, just drag and drop

the tool from the Available Actions &, Zoom Out
list to the Tool Bar Actions list) il Bar Type
Al Bar Data

Reset Reset All

OK || Apply Cancel

The screen shot below shows the new tool group added to the top tool bar. When you click on the drop
down you will see the tools that were added in this tool group.

sl US Index - Primary Analysis - 1 day ey - ¢ X
File Edit View Study Sirategy Format Window Help

Usindex |~|Q|B & & &~ @| E AN \"ki'@\ i My + T
US Index - 1 day ! . Blue Dashed Line

Volume & Fork Ctrl+Shift+F “ilTn*I 103.00
O Ellipse
X |I|Tx 102.00

Here is the new tool group that 4 Channel Cirl+Shift+C '
: : i
the drop down, you will see the A Auto Wave Ctri+Shift+W | f 1
tools that we added. 3 Ih' T“II I : ' | ii 101.00
1 il I -
. I ‘ | ! i I ! II Lyl 100,65

we created. When clicking on M Auto Gartley Cirl+Shilt+G |
3.16.9 Visibility

Visibility is a very useful feature in MotiveWave™ that enables you to specify the bar sizes where a
component is visible. This can be very useful to avoid clutter when switching bar sizes on a chart.
Visibility setting can be set from the Properties dialog or via the right click menu on the component.
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T
i
component. :
861.72 i
¢ . ‘
Edit ' !
Huﬁmf"m H. ) Format vl i
I H 'ﬂ. i Visibility » | v AllIntervals i
72 Create Alert 15 min only !
’*U Show Info ctiel | = 15min i
Show Angle == 15 min |
Relative End Point <15 min |
Extend Cirl+E <= 15[}in !
Extend Left | !
Ratios ’ ! I
Line ’

3.16.10

Visibility Menu

Right click on the

This option will make this
component only visible on
intervals at or below 15
minutes

Properties

Jmn il
i . wathgenl
I Wi ™ Pt

JE Y

Visibility Dialog

motivewave'

H865.00
+860.00
H855.00

H850.00

1845.00

Trend Line Properties

Batins

General Format

J

Select visibility option from
the drop down ("All' to be
visible on all bar sizes)

Use the drop down below to ponent will be visible.

== -

Visibility:

Bar Size: | 15 min R

Choose Bar Size

(defaults to current
bar size on the chart)

OK Save Defaults Cancel

Apply

Object Viewer

The Object Viewer is a convenient dialog for managing components on a chart from a single location.
Components can be deleted from the chart and you can adjust the visibility and draw order. The Object
Viewer can be displayed from the top menu bar: View -> Display -> Object Viewer
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Object Viewer: TSLA - Primary Analysis - 15 min

The following table contains all objects that are in this analysis.
Type:  All

Filter:
X @ % @

| Visible:

1

Price Graph

These buttons affect

4 the draw order.

1

7 Price Graph true
8 Price Graph frue
58 Price Graph true
64 Price Graph frue
85 Price Graph true

Type
Study

Study

Impulse
Impulse

ABC Correction
Impulse

ABC Correction

[:gro perties
isibility

BB(20,20,2.0,2.0)
Volume

Minor: 11/14/2016 12:45 - 03/15/2017 08:30

I Filter View using
these fields.

Minute: 11/14/2016 12:45 - 12/28/2016 09:30
Minute: 12/28/2016 09:30 - 01/03/2017 09:30
Minute: 01/03/2017 09:30 - 01/25/2017 09:30
Minute: 01/25/2017 09:30 - 01/30/2017 10:45

2017 10:45 - 03/15/2017 08:30

Visibility

>=15 min
All
All
All
All
All
All

*

9 Price Graph trug, Right click to show 4/2016 12:45 -
10 Price Graph true| o ient menu {:g:: g;ocf:(t 11/14/2016 | Double click a row to All
14 Price Graph frue Delete 11/18/2016 | edit the properties All
19 Price Graph true Impulse Subminuette: 11/22/2016 09:30 - 11/23/2016 11:15 All
21 Price Graph true  ABC Correction Subminuette: 11/23/2016 11:15 - 11/23/2016 15:00 All
23 Price Graph true  Impulse Subminuette: 11/23/2016 15:00 - 11/28/2016 10:30 All
25 Price Graph true  Impulse Subminuette: 11/28/2016 10:30 - 12/01/2016 09:30 All
Close
3.17 Ratios

MotiveWave™ provides many different options for identifying time and price ratios. Fibonacci ratios are
perhaps the most commonly used ratios for analysis. Available components for Fibonacci analysis can

be found under the Fibonacci tab of the Components panel (not available in all editions):

Components
» General

Basic

>
»
» Markers
v

Fibonacci

-

Retrace

A
Expansion

Circle

Commentary

Extension

Retrace

e

Extension Expansion

VE

Fan

Fibonacci Components

X TSLA_I_- 5 min

Click and drag a
component on to
the price plot

The screen shot below shows an example of a Fibonacci Retracement. Yellow resize points can be used
to change the position of the labels and length of the ratio lines.
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—
———
———
I
e
—
——
5
—mm
... S

o

il TSLA - Primary Analysis - 15 min* b1 |
File Edit View Siudy Strategy Format Window Help
TSLA QR & E s &9 KBlerQ §~+ "I &2~]15min - = =Ev O~ £~ a = 8|3 5
TSLA - 15 min
H255.00
54.00
Click and drag yellow
points left/right
53.00
252.42 ¢ 0.0%(252.421)

14 6%(25173)

252 1?]'
251.46

23.6%(251.31)

l i I Fibonacci Retracement H251.00
r;l ! a7t Ratio Label
i by ob *ﬁ‘ — b
*H SLE%ESET) (120D
N ;
e H249.00
I 88.7%(248.24)
F H248.00
MotivieWave ‘ . . . 247.71 i . " N m
Jan-31 12:00 14:00 Feb-2017 12:00 14:00 Feb-02 12:00 14:00 Feb-03 12:00
1min Smin 10min ' 15min 20min 30min 45min 1hour 2hour &hour 1day 1week 2week 1 month 3 month =E ey @ |+ &

Feb-03 11:00:51

MotiveWave™ provides a lot of flexibility for working with ratios. If you would like to modify the ratio
properties for a particular component, right click on a ratio label and choose Ratio Settings (or just

double click

|
- —+-¢H

on the label).

Ratio Settings

Right click on a label and
choose Ratio Settings

——{14.6%(251 73

0.0%(252.42])

X Remove Ratio

Ratio Lf}(:ttings
Ratio Preset
@ Preferences

50.0%(250.07)

(61 8%(249.51))

]

L]

253.00

(252.18)
251.61

251.00

H250.00

[ 249.68)

The Ratio Settings option will open the Properties dialog for the component and switch to the Ratios ->

Ratios tab.
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Ratio Settings Dialog

Retrace Properties X

General _Format _Visibilty [

Ratio Type [EGeg) Display

SR NN NS

0.0

382

786

114.6

138.2

178.6

261.8

f 2 F R FE LR E R

146

50.0

88.7

123.6

150.0

188.7

LU LN NN L

4236

- - - - - - - -

For convenience, presets
can be saved and applied
to other components Save Preset

OK

Apply || Save Defaults

236

61.8

100.0

127.2

161.8

200.0

v
v
v
v
v
v
v

- - -

686.0

Check to enable/disable specific
ratios. Click the edit button for
advanced display options.

Cancel

3.17.1 Customized Ratios

For each ratio, use the check box to the left to enable/disable. The input field can be used to enter the
ratio (in percent). Click on the edit button (pencil icon) to the right to specify how the ratio should be

formatted.

Ratio Settings Dialog

Ratio Settings

This dialog allows you to choose the specific ratios and set display

Custom formatting can be
defined below by
unchecking Use Defoults

preferences.
Ratio: [ 38.2 %

Use Defaults:
Cutline: | None -

Line: | - — 1.0

Text Color: |G ~
Fill Color: -
Font: Arial;14.0

v || ————— - Use Default

Use Default

Cancel

The custom settings chosen above for this ratio will look like the following:
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14.6%(251.73)

23.6%(251.31)

This is the
modified ratio

T!**ﬁm+ +.¢H

38.2%(250.62)
(50.0%(250.07))
(61.8%(249.51))

78 6%(248.72)

3.17.2 Ratio Display Preferences

The Display tab allows you to change how the ratios are displayed. The settings on this tab apply to all
ratio labels/lines in the component (unless explicitly adjusted for each ratio, see previous section).

Ratio Preferences
Retrace Properties x

General Format _ visibity e
Ratio Type Ratios WBS0EN

Use Defaults

These option affect all of
the ratio labels/lines

Label Align: = Right - (unless explicitly changed
on the Ratios tab)

Ratio Origin: | End -

Label Outline: | Rounded -

Label Color: Enabled
Linee | —10 ~ || — ~ | N ~ Alternating Colors
Fill Alpha: Fill Ratios
v'| Show Ratio Labels |v/| Show Ratio Price Show Source Lines
Extend Leit Extend Right

Save Preset

OK | Apply | Save Defaults Cancel

3.17.3 Ratio Presets

Ratio Presets can be very useful save a ratio configuration and apply it to another component. This can
help to avoid a lot of duplicate work. Use the Save Preset button to save the current ratio configuration
for later use.
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Retrace Properties

General Format Visibility m

Ratio Type m Display

0.0 %
38.2 %
786 %

114.6
138.2

178.6

b LS LN LS LS
LU LSS LS L

251.8

EE - S

OK | Apply

146 % v 236 %
50.0 % v 61.8 %
887 % v 100.0 (%
1236 |% v 1272 %
150.0 (% v 161.8 |%
188.7 % v 200.0 %
4236 % v 686.0 %
Ratio presets contain all o
of the ratios and display
properties for the labels Yo
and lines
Save Preset
Save Defaults Cancel

When you save the preset, you will need to choose a name. Enter the name in the Save Ratio Preset
dialog (see below) and click the Save button.

Save Ratio Preset Dialog

Save Ratio Preset

This dialog allows you to save ratios settings to access quickly as a preset.
Choose a name for your preset below and press 'OK' to save these settings.

Name: | My Ratios| Enter a logical name for
Fibonacci Blue the preset and press the
- - Save button below.
Fibonacci Green

Fibonacci Red
Fibonacci Alt Colors
Gann Blue

Gann Green

Gann Red

Gann Alt Colors

Existing presets
(MaotiveWave comes
with several built in)

Save Cancel

Right click on a ratio label and choose Ratio Preset -> <Preset Name> to quickly apply a preset to a
component. In the example below, we are going to choose My Ratios that we defined above:
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Apply Ratio Preset

choose:

Ratio Preset -> <Preset Name>

+

3.17.4 Global Ratio Preferences

Global ratio preferences can be configured in the Preferences dialog from the Ratios tab. This section
has two sub tabs, Presets and Defaults:

Right click on a ratio label and _W
- X Remove Ratio
Ratio Settings
Ratfio Preset  » | py Rwos
23.6%|—_ ___F_’[eferences Fibonacci Blue
Fibonacci Green
Fibonacci Red
38.2%(250.62) Fibonacci Alt Colors
Gann Blue
50.0%(250.07) Gann Green
Gann Red
61.8%(249.51) Gann Alt Colors
{70 goLidan 70

Global Ratio Preferences

o

General Theme Chart Tool Bar Sounds

Preferences

Elliott Wave Gartley Tick Charts Orders  Alerts  Email -

X

Defaults

Choose the
This panel allows you to manage Ratio Preset% Ratios tab. Fuﬂon to define a new preset.

=+

Name A
Fibonacci Alt Colors
Fibonacci Blue
Fibonacci Green
Fibonacci Red
Gann Alt Colors
Gann Blue
Gann Green
Gann Red
My Ratios

Built In
true
true

true
true
true
true
true

These are all of the available Ratio

Presets. Double click on one of the

non built-in presets to edit. Click on
the Add button ('+') to create a new
Ratio Preset.

true
false

OK || Apply Cancel

d253.00
{252.1%‘

{25099

250.00
{24968

H249.00

The Defaults section enables you to assign the default presets to each type of ratio component. Ratio
components consist of retracements, fans, circles, Elliott Waves etc.
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e

General Theme Chart Tool Bar SoundsmElllottWave Gartley Tick Charts Orders Alerts Email

Preferences

X

-

_presers [N

Ratios may be configured using presets.

Use the options below to specify the default preset to,

Compenent: \ -Choose Component-

Preset My Ratios -

The follow attributes apply to the ratio tools (ie: Fibor|

Choose a component to assign a
specific preset as the default
when creating a new instance of
the component.

v/ Show Ratio Source Lines
v Show Ratio Range Lines

Allow Vertical Resize

Allow vertical adjustments

of ratio height to quickly
hide/expose ratios.

OK

Apply Cancel

3.18 Time/Price Guides

Guides can be added to the vertical and time axes. A guide is essentially a vertical (or horizontal) line

that has an attached indicator to show its value. There are two types of guides:

1. Price/Value Guide — Displays a horizontal line with an attached indicator in the vertical axis
2. Time Guide — Displays a horizontal line (across plots) with an attached indicator in the time axis

Guides can be added to a chart from the right click menu of the axis (choose Add Guide). This menu can
also be used to edit the guide or remove it. The location of the guide can be changed by clicking and

dragging it.
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Guides
il EUR/USD - Primary Analysis - 15 min™

File Edit View Study Strategy Folmall Window Help _ Price Guide. Click and drag
EURUSD |~ Q|K = & =~ 6|9 Wwr 2w Q i~ M + "E[T &2~ |15min - indicator up/down to adjust

EUFIUSD-15 min \
il
ot

location. Double click to edit.

higfts by
" !

ol

s

Right click on Price Axis,
choose Add Guide

i

Tl Trade »
172 Create Alert

AT e

move All Guides

=

by ,J,l?*rﬂlnhw?ﬁmfm I
or Toton K
k] h‘m_

!i*?'m i d1.07400
Click and drag indicator H_ *
to adjust location.
Double click to edit. +1.07200

et I TR L Tt (T [T rr Ty re— et g -Bineesfanmesznpananangan ; 0 ﬂl[ﬂmliunn,..n'.ﬂﬁ(.. 4017
Feb02 2:00 400 600 800 1{Feb-02 1132]140| Time Guide. Guide  |2200 Feb-03 2:00 400 600 800 10:00 12:00 14:00
RSiE.14) spans multiple plots. +X ana
v 43_70
% H1.08000
1.07000
Jan-19 Jan-22 Jan-24 Jan-25 Jan-26 Jan-29 Jan-31 Feb-2017 Feb-03| {1-08000

1min Smin 10min _15min 20min  30min 45min 1hour 2hour Ghour 1day 1week 2week 1month =,

i~ (@ |v~ B2
Feb-03 14:44:37

Guide Properties Dialog

Guide Properties x
CELE \—IH'DSO% v Double click on a
Line Width: | — 1.0 ~ guide to edit its
properties.
Style:

Label Color: v'| Use Line Color

Text Color:

—
Line color: | NG ~

OK Save Defaults Cancel

3.19 Percent Change Charts

Normally the price plot shows the historical prices. Percent change charts are an alternate view that
shows the change in the price between each bar as a percentage movement. A percent change chart
can be displayed by changing the bar type from the drop down on the tool bar to Percent Change.
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Ll
File  Edit

EUR/MUSD
EU

View  Study  Strategy

Q| E R R s B

RIUSD (Close) - 15 min

Format  Window

EUR/USD - Primary Analysis - 15 min*
Help

[3 W~ 2w~ @ ~v M~y + BT
OHLC Bars

[ HLC Bars

I Candlesticks

§ Candlesticks (Trend)
I 3D Candlesticks

0 Candlesticks (Hollow)
I Candlesticks (Flat)
[+ Heikin-Ashi (OHLC)
- Heikin-Ashi (Candle)
¥+ Heikin-Ashi (Trend)

&2 | 15 min

Click to show
drop down

MotiveWave

0.300%

0.200%

0.100%

[l Heikin-Ashi (Hollow)
<= Percent Change
- Line

Choose Percent
Change

£ Line (Shaded)
£ Line (Gradient)
I Bars
1 Bars (Flat)
I 3D Bars
¥ No Bars

—

VA

Price Axis is now
based on percent

700

T00 600 800 1000

1200 1400 1600 1800 2000 2200 Feb03 200 400 600 800

1000 1200 14:00

1 min

5 min

10 min | 15 min 20 min

30 min 45 min

1hour 2hour 6hour 1day 1week 2week 1month =4

o~ @ |+~
Feb-03 14:59:51

By default, percent change charts are calculated from the left most point of the chart.

This can be

changed to a specific bar by right clicking on the chart where you would like the calculation to begin.

Percent Change from a Specific Bar

Lt EUR/USD - Primary Analysis - 15 min* - 0 X
File Edit View Study Strategy Format Window Help
EURUSD |~ |O |l W& B &~ Gl TR W~ 2w~y & v My + T[T |2~ |[15mn ~ I
EUR/MSD (Close) - 15 min
Right click where you 3 Ch.art Settings
| /V want to calculate from | Edit Instrument I
\_/ Percent Change »  Calculate From First Bar
'l/‘ Bar Size ' | Calculate le{}This Bar Choose "Caleulate
Tick Interval * | calculate From Last Bar From This Bar"
Volume Interval  » |
Range Interval g
Renko Interval d
Template g
Link ’
Add Study y
Tools J
Edit d
View J
(' Clear Local Data
MotiveWave
2:00 400 6:00 800 10:00 12:00 14:00 A1e:00 18:00 20:00 22:00 Feb-03 2:00 4:00 6:00 800 10:00 12:00 14:00
1min 5min 10min | 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month == = By @ ¢~ B

Feb-03 15:02:17

Two dashed lines will be displayed to visually indicate where the charts are being calculated (see below).
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Percent Change from a Specific Bar

Lol EUR/USD - Primary Analysis - 15 min* b3 IV
File Edit View Study Strategy Format Window Help

EURUSD |~ |Q |l | W S~ @ [ W~ @ |#w~> Q o~ M~y + "E[T &2~ [15min ~ | »
EUR/USD (Close) - 15 min N :U.UUD%
J-0.100%

Percent change is now ]

calculated from here. ]
J-0.200%
[\ 3-0.300%

MativeWave
L L L ! | L L | | L ! L L ! L L L |
2:00 400 6:00  8:00 10:00 12:00 14:00 16:00 1800 20:00 22:00 Feb-03 2:00 4:00 6:00 8:00 10:00 12:00 14:00
Amin 5min 10min ' 15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month == = @y @ = B

Feb-03 15:04:07

When combined with the Instrument Overlay, you can compare relative moves between instruments
directly on one chart:

Percent Change — Multiple Instruments

il EUR/USD - Primary Analysis - 16 min* - " X
Fle Edit View Study Strategy Format Window Help

EURWUSD |~ |Q | W B =@ IR W ey @ aAy M- + TE|2[15min - LI N b
EUR/USD (Close) - 15 min 311.000%

USDVCAD (Close)SPX500 (Close)

J0.800%
i

10.600%

Jo.400%

J0.200%
7 T USDICAD -
¢.0.163%

Calculated from

this location.
e V\/\’\/JW
MotiveWave

200 400 600 800 10:00 1200 1400 1600 18:00 20:00 2200 F=b03 200 400 600 600 10:00 1200 1400  Feb05 17.00 19.00
imin 5min 10min [ 15min  20min  30min 45min  1hour 2hour Ghour 1day 1week 2week 1month 3 month = iy @ o> B

Feb-03 15:38:08

-0.400%

33190%

3.20 Studies

MotiveWave™ has over 275 built in studies that can be used to display information on the price plot or
separately in a plot below the price.

There are essentially two types of studies:

1. Overlays — display information that is drawn on top of an existing plot (most typically the price
plot)
2. Study Plots — display information that is displayed in a plot that is separate from the price plot.
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A study may be added to a chart by choosing one of the available studies can be found under the Study
menu from the top menu bar. This menu organizes some (not all) of the studies into logical groups
(based on author or function). The Add Study option enables you to search for a study instead of trying
to find it in a sub-menu. For convenience, a Recent menu is available to access recently used studies.

Study Menu
Lol EUR/USD - Primary Analysis - 15 min - X
File Edit View | Study | Strategy Format Window  Help
EURUSD ~ Q| B Jad Add Study CrieT K W~ 2| #w~ Q i~ M~ + "8 T 2| 15min v >
EUR Recent ' Relative Strength Index (RSI) {10797
Click here to Instrilgent » | Stochastic (Full) 1
search for a study | MOVINg Average » | Commodity Channel Index (CCl) ~1.07900
Overiays » | Simple Moving Average (SMA) ]
Astrological * | Exponential Moving Average (EMA) ]
Bar Patterns " | Moving Average Conv/Div (MACD) @1_07301
General * | Moving Average of Oscillator (QSMA) ]
Volume Based » | Bollinger Bands ]
Welles Wilder » | Ichimoku Kinko Hyo d1.07700
T Bill williams » | Parabolic SAR ]
Tushar Chande » | Absolute Price Oscillator 1
T* T Iarc Chaikin " | Dynamic Momentum Index J1.07600
? T ﬂﬁ Custom ’ o
D Alexander Elder v ]
Bands Many studies are T4 07500
Bill Mars v [ erouped here by author I
John Ehlers g or category ]
Oscillators » 11 07400
Performance g D 1
William Blau d ]
i H- J1.07300
J1 07200
MotiveW; | g_ 5
olivetiave 1 : I 1 1 1 1 1 1 1 I 1 1 1-0710
22:00 Feb-03 2:00 300 400 500 600 700 800 900 1000 12:00 14:00 Feb-05
1min 5min 10min ' 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month =4 = vy @ |wv B8

Feb-04 10:17:07

If you choose Add Study, you will see the following dialog. This is a convenient way to search for a study
by typing it in into the Filter input (see below):

Add Study Dialog

[ Add Study X
The following table contains all available studies. Select the desired study below and choose OK to configure the settings.
Filter: | | Type: | All -
AN
Name A Overlay Signal *
Enter text here to
AGGZ search for a study false true ]
ATR true false
ATR Trailing Stops true true
Absolute Price Oscillator false false
Acceleration Bands true true
Acceleration Oscillator false false
Accelerator Decelerator Oscillator false true
Accumulation/Distribution Line false false
Accumulative Swing Index false false
Adaptive Smoothing Indicator T3 true false
Alligator true false
Aroon false false
Aroon Oscillator false false
Auto Trend Line You .can import third party true false
studies from here.
Average Directional Index (ADX) false false
- - \/ - -
Import Cancel
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When you add or edit a study you will see the study dialog similar to the one displayed below. Each
study will have different settings and configuration options. The available tabs will depend on the study,
but all study dialogs will have an Options tab and a Signals tab (if it generates signals).

Study Dialog - SMA

Simple Moving Average (SMA)

the mean of the previous 10 days' closing prices.

Advanced Signals Options '<Click here for general 1

SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is

x

“ Lstudy options J

Inputs

If the study generates
signals, you can
configure them here

Input:

Period (bars): - ~ 0%
Fill Forward: |v
Display
Lne: D - | — 1 This button will save the
settings from this study as
Indicator: - the default the next time you PlaY

create this study.

Save Defaults Help

Cancel

Adjust the settings for the study and click on the Create button to add the study to the chart. For
convenience, you can click on the Save Defaults button to save the study settings for the next time you

create this study.

The following screenshot shows the Simple Moving Average (SMA) study from the Study dialog above.

Also shown is a Study Plot for the MACD study.

Chart Studies

Wil EUR/JSD - Primary Analysis - 15 min*
File Edit View Siudy Strategy Format
EURUSD ~ Q| i@ & &~ G|

Window  Help
w2 wrQ v My + 8T &2v|15min -

EUR/USD - 15 min

Study Legend

Simple Moving
Average Overlay

MotiveWave

KA

s

1

K
o

X

»

7200
1.07765

Study Indicator for
the SMA Overlay

: . . . . . . . — ) - . .
00 7000 1200 1400 1600 1800 20:00 2200 Feb03 200 | tudy Plotfor the =g m—ar—7 60
MACD study
ACD(C,EMA,12,26,9)

S ———
AEEREE AR

1 T
Feb-05 17:00 19:00

4+ % H0.001000
0.00032

A-0.001000

imin 5min 10min  15min 20min 30min 45min 1hour 2Zhour 6hour 1day 1week 2week

1 month ==

=iv o v @

Feb-03 16:52:42
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3.20.2 Editing a Study
If you would like to edit the settings on a study simply double click or right click and choose Edit Study.

Edit Study
Ll EUR/USD - Primary Analysis - 15 min* T T
File Edit View Study Sirategy Format Window Help
EURUSD ~ Q| @ & s~ @™ K W~ @@~ Q i~ my + BT 2v[15mn ~ = =~ mp »
EUR/USD - 15 min

SMA(C,20)

71.08200

You can also right
click or double click on
the legend

Right click on the
study and choose Edit

!H"ml Visibility 4
I

+ Show Legend

!t. E%te
IWHW’H?HW

H1.07600

H1.07400

H1.07200

0:00 12:00 14:00 Feb-05 17:00 19:00
4+ X H0.001000

H-0.001000
1min 5min 10min  15min  20min 30min 45min 1 hour 2hour 6hour 1day 1week 2week 1month =4 = v @ |»|v M

Feb-03 16:55:34

Double click or right click
on the study plot to edit.

MotiveWave
I 1 1 1 1 1 1 1
8:00 10:00 12:00 14:00 16:00 18:00 20:00 22:00 Feb-03
ACD{C,EMA,12,26,9)

S ———
AEEREEAAR

T TETTERTE LT
KU1 L

3.20.3 Study Options
All studies will have an Options tab as the last tab when you create or modify its settings. This tab will
contain different values if it is an overlay or a study plot.

Study Options - Overlay
Simple Moving Average (SMA) x

SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is
the mean of the previous 10 days' closing prices.

General Advanced Signals

Graph: | Price Graph h Graph/Plot where
Visibiity: | Al - this study is drawn

Bar Size: ~ |v'| Use Chart Bar Siz By default, the chart bar size

7| Show L ; e is used. You can specify a
CAEEgE NOEMEY | Gifferent bar size if you like.

Show Values In Legend Use Real VaIEs

Bar Updates

Check this to update the
study from live ticks vs
the close of the bar

Update Remove Save Defaults || Help | Cancel
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Study Options — Plot

Moving Average Conv/Div (MACD) X

Shows the difference between a fast and slow moving average of prices. MACD is often used to indicate
changes in market trends. Created by Gerald Appel in the 1960s.

General Display Advanced Signals

Graph: | MACD(C.EMA 12,269) ~ Optionally you can
overlay a study plot on

Visibility: | A~ v another plot.
Bar Size: ~ | |W/| Use Chart Bar Size
Instrument: - v'| Use Chart Instrument
Show Values In Legend Inverted
Bar Updates Use Real Values

the top/bottom of the plot.

Top Inset:
Bottom Inset ~— Space (in pixels) to add to J

Update Remove Save Defaults Help Cancel

3.20.3.1 Overlay Plot

ave'

When you create an overlay study, by default it will use the Price Plot. Optionally, you can choose one
of the existing plots to display the study. When you change the graph for the study, it will change the
input options. For example, if you want to display a simple moving average (SMA) on an RSI study plot,
you would choose the RSI(C,14) plot from the Options tab. When you choose this, the Input field (under
the General tab) will be updated to reflect the inputs available from the RSI plot.

Simple Moving Average (SMA) x Simple Moving Average (SMA) x
SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is
the mean of the previous 10 days' closing prices. the mean of the previous 10 days' closing prices.
General Advanced Signals m Advanced Signals Options
Graph: | RSI(C14)  ~ Choose RSl plot. This plot must Inputs - -
o already exist on the chart prior Available inputs are updated
Visibility: | All to creating/editing this study. Input- | RSI(C,14) - heraltzglreﬂec: the fluis .
available in the study plot that
: - Use g a 3
Bar Size: v T oar Size Period (bars): Shift: - you chose under Options
V| Show Legend Underlay Fill Forward: v/
Show Values In Legend Use Real Values Display
Bar Updates Line: | DD ~| — 10~ — ~
Indicator: ~ || I - Line /| Display
Update | Apply Remove Save Defaults Help Cancel Update | Apply Remove Save Defaulis Help Cancel

MotiveWave

R Y A
BN '\J\'_M

l++” *

RSIC,14)

W .n e T Yy,

—

1.07400

1.07200

f-—ﬁ’
500 1000 12 SMA Overlayon |B:00 2000 2200 Feb03 200 400 600 800 1000 1200 1400  Febd5 17.00 18.00

RSl Plot

PR \/ i 2 il

B i e s e o

1min 5 min

10min  15min  20min  30min 45min 1 hour 2hour &hour 1day 1week 2week 1month 4 = @iy @ ¢~ M

Feb-03 17:07:05

3.20.3.2 Study Bar Size

By default when you create a study, it will use the bar size of the chart. When the chart bar size

changes, the study will be automatically updated to reflect the new bar size. MotiveWave™ does allow
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you to choose a specific bar size for the study. This allows you to, for example, display a 1 day SMA
(Simple Moving Average) on a 15 minute chart. This feature also applies to study plots so you could
display a 10 minute RSl on a 15 minute chart (see example below):

Relative Strength Index (RSI) X
. : RSl is a momentum oscillator that measures ihe velocity and magnitude of directional price movement by
X
SimplelNoying/averag=l(ShUE) comparing upward and downward movements. Developed by J Welles Wilder in 1978.
SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is n
the mean of the previous 10 days' closing prices. CencaAGvancedmsionals m
General Advanced Signals Graph: = RSI(C.14) -
Graph: | Price Graph - Visibility: | Al ~ B
Visibilty: | Al v = Bar Size: Use Chart Bar Size
Bar Size: | 1 day - Use Chart Bar Size Uncheck "Use Chart Bar Instrument: -
Size" and select 1 day
V| Show Legend Underiay| from the drop down. Show Values In Legend Inverted
Show Values In Legend Use Real Values Bar Updates Use Real Values
Bar Updates Top Inset.
Bottom Inset
Update Remove Save Defaults Help Cancel Update Apply Remove Save Defaults Help Cancel
sl EUR/USD - Primary Analysis - 15 min* R S

File Edit View Situdy Strategy Format Window Help

EURUSD ~ O |l @ R s~ @[ KW w~Q v mvy + "E[IT| &~ 15min -
EUR/USD - 15 min
'ﬁ\‘ﬁ ©,20) [5 min]SMA(C,20) [1 day]

b
I

Bar sizes displayed
in the legend

Pty
Mt

iﬁl[]---’

A

ML

ol

¥

e

otropnbget fiots e
Rk T L i *-?mLHTT[JI]' q]l*‘\u!

This is a 5 min EMA
displayed on a 15 min chart

This is a daily SMA
displayed on a 15 min chart

i
1200 1600 7800 2000 2200 Feb03 200 400 600 800 10:00 1200 7400 Feb05 1700 19:00
RSKC,14) [10 min’

Plot title shows
bar size

W /“\_/J AT

1min 5min 10min ' 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month =4

Feb-03 17:13:32

3.20.3.3 Study Plot Overlay

Study plots may be overlaid on other plots. You may have noticed this feature already with the Volume
overlay on the default layout of the Console:

Volume Overlay

{ o

Volume Overlay

e T T IR i Y P A e A Ay

|
e

(with Moving Average)

. T 00!
= H’lH'lH'lnl‘llﬂH‘nHIﬁl"En_M-lln;_-:_n_T:llrﬁmrr' ﬂﬂH'ﬁlIﬂﬂ“l|niﬂi1nn-.-P.n_n__'::q:n-.n—.nwnnHUIhllml III:II;I . §
35 4:00 2:00 1200 Apr-27 0 18:00 Apr-28  4:00 200 1200 1600 20000 Apr-29 400 2:00 1200 1600

e P i a PN I P S = 5
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You can change the overlay plot for a study from the Options tab. A study plot can be overlaid on the
Price Plot or other study plots. The following examples show a CCl plot on the Price Plot and an RSI plot
on a Stochastic plot:

Plot Overlay
il EUR/USD - Primary Analysis - 15 min* - X
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q |l & B &=~ @[ w2 ew~Q v M~ + "B[IT|2~[15mn  ~

EUR/USD - 415 min
CCl{20)

]uﬁ**“*ﬁ*mﬂ“m'“

CCl displayed
on Price Plot

i
ivelave |

Fob03 100 200 300 400 500 600 700 800 900 70:00 7200 RSl displayed on Feb-05 700

Stochastic Plot

STO Fullj14 3.3} - P

S NS N NN

=== N
- N AN Z
‘w T—
imin Smin 10min  15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 = ey @ |w|v B

Feb-03 17:20:13

3.20.3.4 Study Visibility

For convenience, you can specify that a study is only visible on certain bar sizes. This is similar to the
visibility feature for components. By default a study is visible on all bar sizes. You can change this from
the Options tab:
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Study Visibility
Commodity Channel Index (CCl) X

CCl was designed to identify cyclical turns in commodities. CCI assumes that commodities move in cycles, with
highs and lows coming at periodic intervals. It is recommended to use 1/3 of a complete cycle as a time frame
(ie: for a 60 day cycle use 20 day CCI).

General Advanced Signals

Graph: | Price Graph v

Select the

visibility: | <=~ |[ 30 min - |
applicable bar size

Bar Size- v/| Use Chart Bar Size
Choose the
Instrume - v | Use Chart Instrument
operation here
d Underlay
Show Values In Legend Inverted
Bar Updates Use Real Values
Top Inset: In this case the CCl study
i will only be visible on
Bottom Inset:
ljl the charts display 30 min
Cverlay: | Bottom - or smaller bar sizes
Heignt
Update | Apply | Remove || Save Defaulis || Help || Cancel
3.20.4 Signals

Some studies generate signals. Signals occur when a specific event occurs with the study. For example,
a signal may be generated in a CCl study where the CCl value crosses above the top guide. These signals
can be used to show alerts, play sounds or even send an email notification. Note: if you want to send
emails, you will need to configure your email (SMTP) settings in the Preferences dialog (Configure ->
Preferences from the Console menu bar). You will find these options under the Email tab.

Study Signals
Commodity Channel Index (CCI) X

CCl was designed to identify cyclical turns in commodities. CCl assumes that commodities move in cycles, with
highs and lows coming at periedic intervals. It is recommended to use 1/3 of a complete cycle as a time frame
(ie: for a 60 day cycle use 20 day CCl).

General Advanced Options

Signal: | CCI Above Top Guide - All

Enabled:
This can be used to specify that
All Bar Sizes: |V > this signal will only be
triggered for a specific bar size.

Show Alert: | Yes b

Play Sound: | Yes ~ |V Use Preset Sound
Sound File:

Send Email: | No -

BT e T Note: In order to send an email you

will need to configure your SMTP
settings in the Preferences Dialog.

Update | Apply | Remove | Save Defaults | Help || Cancel
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3.20.5 Instrument Overlay

An instrument can be overlaid on top of the price plot by choosing Study -> Instrument -> Instrument
Overlay from the top menu bar. This action will open the dialog displayed below. Type (or select from
the drop down) the instrument that you would like to overlay in the Instrument field. Click on the
Create button to add this overlay to the price plot. This dialog has the following elements:

1. Instrument — Type or select the instrument.

2. Bar Type — Choose the type of bar you would like to display for the overlay (default is a line
chart)

3. Line Source — If a line chart is chosen, this option allows you to choose the input source for that
line (ie closing price, opening price etc)

4. Shift — the number of bars to shift the study forward (negative value for backward). Uncheck

Lock Shift to enable dragging of the overlay backward or forward using the mouse.

Style — For line charts, choose the color, thickness and style of the line.

Show Axis — displays the axis for the instrument on the left hand side of the price plot

Inverted — Click to display the overlay upside down

Bar Updates — Click to enable live updates to the overlay instead of updates on the close of the

bar

9. Show Legend — Shows the overlay in the study legend area

10. Show Label — Displays a label at the end of the overlay for the Instrument symbol

© N w

Instrument Overlay Dialog

Instrument Overlay x

This dialog allows you to overlay an instrument on the price graph. Click
on the search or add existing instrument button to specify the
instrument. Click Create to create the study.

Instrument: | TE v| &

Bar Type: | ~ - Type or select the
Line Source: | Close Z‘::;]bzl:sm this
Shift v/ Lock shit
Style: DD -~ | — 10~ | — ~
v'| Show Axis v'| Show Legend
Inverted v'| Show Label
v/ Bar Updates
Cancel

The example below shows an instrument overlay for the USD/CAD pair on top of the price plot for the
EUR/USD pair. The axis for the USD/CAD pair is displayed on the left hand side and has indicators for the
current prices. With Auto Scale enabled, dragging the chart left or right will automatically scale the
values for the overlay.
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Instrument Overlay Example

il EUR/USD - Primary Analysis - 15 min* - X
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q |l B B s~ @™ w2 wrQ i~ M~ + "BE[T]2~15min - »
1.30550 1 EUR/USD - 15 min |
USDICAD (Clbse
1.30500{ it /_/’ | EE _
Legend / ‘ + l H 1.07844)
1304500 / | T +|:|l J1.07800
S [ Q ]
1.30400 Hﬂ ]
\ % J1.07700
1303500 |\ Al ] 1
130300040 A Lj. J1.07600
el Wi .* lj* T+ IR ]
1.30250 D T l J ]
- / SDICAD =1.07500
1.302001 |j |_J'] i ]
(130185 ﬁrlay s i " [Label 3 a0
1.30150f * H * 1"
130100 +‘~> ;1_07300
1.30050F / ]
/ H1.07200
1.30000 - 1
MotiveWave N 1
. . ! ! ! ! ! . . . . . . .
Feb-03 1:00 2:00 3:00 4:00 500 600 7:00 800 9:00 10:00 12:00 14:00 16:00 Feb-05
imin 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 =E oy @ |#~ B

Feb-03 17:29:54

The vertical scale of the overlay can be adjusted by clicking and dragging the space between the overlay
axis and the price plot. Dragging from the top or bottom will add more top/bottom space. Drag from
the middle to adjust both at the same time.

Instrument Overlay — Vertical Space

Ll EUR/USD - Primary Analysis - 15 min* 2 o- O X
File Edit View Study Strategy Format Window Help

EURUSD ~|Q K I B s~ @9 w2 ewrQ o~ My + "B[T|&2~]15min - »

130550y EUR/USD - 15 min | |

[l USDICAD (Clbse |
1.30500; - vy Auto scale applies to

F Vertical space can be / | both the main 1.07844)
130450 adjusted by dragging the / | instrument as well as T4 07800

axis up/down P g | the overlay instrument i
130400 ]

Eo _/ | HA1.07700
1.303501 [ i | ]
130300 H1.07600
1.302582 |

[ | \ ]
1.30250 | 1 . ]

[ Y L USDICAD d1 07500

F | j
1.30200
1.30185 ]

1.07400
-._.-__.__

If auto scale is disabled, you can click and drag the overlay up or down to adjust the location of the
overlay relative to the main instrument axis.

Version 5.0

©2019 MotiveWave™ Software Page 110 of 212



MotiveWave™

User’s Guide

Instrument Overlay — Adjust vertical location

motivewave'

an
File Edit View

H EUR/USD -
[| USD/CAD (Cl

1.30600
1.30550F

1.30500}

130450

1.30400F

1.30350?—1’ ﬂﬂl-

130300+

(130282}
1.30250}

1.30200F

EUR/USD - Primary Analysis - 15 min™
Study Strategy Format Window Help

EURUSD ~|Q |l B & =~ G5 KWW~ 2 ewvQ i~ My + ™ T 2~|15min -

5 min
ISE
Make sure Auto

Scale is off

Click and drag the
overlay up/down to
adjust vertical

position.

!1.30186E

oo S x
{14 07800

—21.0??00

—51.0?600

—51.0?500

SDICAD — 1.07400
—:1.0?300

The horizontal location of the overlay can be adjusted by changing the value of the Shift field in the
Instrument Overlay dialog. A positive value will shift the overlay into the future and a negative value
will shift it into the past. If you uncheck the Lock Shift option you will be able to adjust the shift by
dragging the overlay to the left or right with the mouse.

Instrument Overlay Dialog — Disable Lock Shift

Instrument Overlay

Modify the properties below and click Update to apply your changes.
Instrument: | USDI/CAD - Q

Bar Type:  ~ ~

Line Source: | Close -
Uncheck to allow

Shift: D Lock S horizontal drag of
stye: | N -~ | — 10 +| theoverlay.

v'| Show Axis v/| Show Legend

Inverted v'| Show Label
v'| Bar Updates

Update | Remove | Cancel
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11:02:43, 1.07595

3.21 Strategies

A strategy is a special type of study that may be used to automate or partially automate trading. In
addition to displaying the study information, a Control Box is made available that allows the user to
activate/deactivate a strategy and view important runtime information.

MotiveWave™ supports two modes for strategies:

il EUR/USD - Primary Analysis - 15 min* - X
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q| E B s~ m|YD KW R ew-Q 0~ My + " T 2~|15min - =- =~ O~ >
1.30600F EURIUSD - 45 min
USDICAD (Clbse H i
1.30550 ¢
i Toil. /Y T
1.305007 Click and drag to the left/right +|:|l 71-07800
to adjust the shift. Make sure Q )
1.30450; to uncheck "Lock Shift" in the Hﬂ
Instrument Overlay dialog. 11 07700
1.30400 \/ | i 1
1.30350F, t, T!Hj ~1.07600
| Vel
1303000
11.30282 41.07500
1.302500 USDICAD In .this c.as.e we have
1 302000 shlfted. it |ntt.3 the past 14 07400
[1:30185 (negative shift)
1301500 J1.07300
130100
=1.07200
1.30050
MaotivelWave o
L L L L L L L : L L L L L L
Feb-03 1:00 2:00 3:00 4:00 500 600 7:00 800 9:00 10:00 12:00 14:00 16:00 Feb-05
imin 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 =E oy @ |#~ B

Feb-03 17:37:32

1. Automatic — Once the user activates the strategy, it will automatically buy and sell based on the
internal logic.
2. Manual - In this mode, the user tells the strategy when it is OK to enter.

MotiveWave™ comes with around 30 built-in strategies. These can be found under the Strategy menu
(from the top menu bar).
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Strategy Menu
[atal EUR/USD - Primary Analysis - 15 min
File Edit View Study | Strategy | Format  Window —Hale.
EURUSD |~ Q| B | Add Strategy Choose Add Strategyto - ™% T 2+ | 15min -
EURIUSD . 14— Recent b search for a strategy
Click on the Bill Williams »
Strategy Menu Gdqeral ¥ | BUTf Average Strategy Eﬁi
Tushar Chande * | Centre of Gravity Strategy ﬁ
Welles Wilder  » ' Coppock Strategy +TL
William Blau * | D Three Ten Strategy

DEMA Strategy l
Detrended Price Osc Strategy
Div Bars Allg Filt Strategy

Ease Of Movement Strategy +T* gju

Elder Ray Index Strategy

oty g M)
D ﬁf l MA Cross Strategy
. Mass Index Strategy

— -

Price Zone Strategy
; latility |

The following screen shot illustrates the Moving Average Cross strategy. This strategy will buy when the
Fast MA crosses above the Slow MA and sell when it crosses below (see triangle markers below). Each
strategy will have a control box (bottom left corner). This will enable you to edit the strategy and
activate it. The control box also displays status information.

MA Cross Strategy
[ EUR/USD - Primary Analysis - 15 min 62 - X
File Edit View Study Strategy Format  Window  Help
EURUSD ~| Q| h B er@ Wow B w>Q v Mv + ™ T 2v[15mn  ~ »

EUR/USD - 15 min

{1.07978

J1.07900

'
%‘1\_ D
| | ﬁ * 1.07700

11 07600

Strategy
Control Box

J1.07500

MA Cross strategy C' This is an example of an automated ]
- - - strategy. Buys and sells will be 71.07400
Activate Activate/Deactivate automatically placed when the fast 4
! Button MA crosses the slow MA. i
Position: NIA =1.07300
Entry Price: NIA ]
Unrealized PL: NIA q--j-JStatus Labels 11 07200
Realized P/L: MN/A 1"
Total PL: NA ]
MotiveW: ]|
otverave i ! L L L L L L L ! L L g—ﬂiﬂﬂﬂ
22:00 Feb-03 2:00 3:00 4:00 500 6:00 7:00 800 900 A10:00 12:00 14:00 Feb-05
1min 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month *=4 =S gy @ |4 &

Feb-04 10:20:35

3.21.1 Manual Strategies

MotiveWave™ allows you to create strategies that respond to user input to enter or exit a position. This
can be very useful as a way to help direct and manage exit points for user initiated trades. For an
example of how this works, see the Trade Manager strategy.
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The following screen shots show the configuration options for Trade Manager. On the first tab
(Entry/Exit) you can setup the entry order and up to 3 exit orders. The Stop Loss tab provides options

for the stop loss order.

Trade Manager

This simple trading strategy allows you to setup an entry point and automatically create exit orders with break
even and an ATR stop. Market entry occurs when the latest bar closes up (if long) or the latest bar closes down

X Trade Manager X
This simple trading strategy allows you to setup an entry point and automatically create exit orders with break

even and an ATR stop. Market entry occurs when the latest bar closes up (if long) or the latest bar closes down

Save Defaults

Cancel

(if short). (if short).

S)YIS08 Stop Loss  Strategy Panel Entry/Exit Strategy Panel

Entry Break Even

Trade Lots: Time In Force: | GTC  ~ Max Loss:

Exit This strategy enables you to Break Even (Pips): Cover (Pips): Enabled: v/

setup an entry order withupto 3 | ATR Stop
o = . - exit points. Click on the Stop
TStEXT: Pips: LD (e Loss tab to setup a stop loss. AREET [
2nd Exit: Pips: 20 3| Lots: v/| Enabled X
ATR Period: 20 3| ATR Multiplier: 253

3rd EXit: Pips: 30 2| Lots: V| Enabled [ 252

Create || Save Defaults || Cancel

From the Trade Manager Control Box, you can choose Long (buy) or Short (sell). When you click the
Activate button, the strategy will enter on the close of the bar.

RN r—\r':_v'\-\u\_._.-—r*\m_,_‘m,-r'--'—\ ‘H_/—'—'—D‘rﬁw
Trade Manager C X T
and Click Activate to
Activate enable this strategy
Position: NIA m*
. | el T #
Entry Price: NfA ‘I‘ I d] * T
Unrealized PL: N/A I O ‘D ot
Target P/L: NIA -
51 Reward/Risk: N/A I
Realized P/L: NIA D
al 2
Total PL: NfA
. g O
MotiveWave all !
1 1 1 1 1 1 1 1 1 1 1 1
21:00 Feb-03 2:00 300 4:00 500 600 7:00 800 900 10:00 12:[f
in ip 10min 15 min in_,30 min ur hour _1 1 week 2 week

Once the strategy is active, the title bar will flash (indicates an active strategy) and the Activate button
will be replaced by Cancel (deactivates the strategy) and Enter Now (creates a market order to enter the

position).
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motiveiliave
N e i T e i TV S WIS
Title Bar flashes ﬁl
when active |:|
Trade Manager C X T E]
Cancel Enter Now Cancel/Enter Now
provides manual L
Paosition: NIA control on the strategy h *ﬁi*i_‘ ee
Entry Price: N/A 10 I = D T
Unrealized PL: N/A 0 ‘D ot
Target P/L: NfA Q
Stop P/L: NIA +|:|
5] Reward/Risk: N/A
Realized P/L: NIA D
T s aT-+
otal PL: NIA
— r—T—
MotiveWave .ﬁﬁu '
1 1 1 1 1 1 1 1 1 1 1
21:00 Feb-03 2:00 300 400 500 600 7:00 800 900 710:00
! in in i ho, 6 hour 1 d

When a position is entered in the strategy, the labels in the control box will display the open position,
current unrealized P/L (profit or loss), target P/L, stop P/L among other information.

I i e S L POvY
s v 10221+ IR
i q23200
Trade Manager (& X
123100
Close Now Exits position and ‘ These orders were ™% ]
- . deactivates strategy | created by the e  LMT-RP 1@2301.5 [SIRRIE
Position: 3 strategy —~2300.0
Entry Price: 22918 ]
Unrealized PL: 6.00 h 22941
RE Target PIL: [ 60.00 == L
€ g Status labels reflect a] mi 2290.0
Stop PIL: Exm i |8 J
i position, target P/L 2287 4]
Reward/Risk: 2.00 ]
and stop loss E
Realized P/L: NiA | L 1
Total PL: 12280.0
- =T ]
ngm‘;la+* 1 1 1 1 1 1 1 1 1 1 1 1 1
Feb-03 200 300 400 500 600 700 800 900 1000 12:00 14:00 Feb-05 17-00
1min _5min,_10min 15min__20min _ 30min_45min 1hour 2hour 6hour 1day 1week 2week 1month =4

3.21.2 Strategy Configuration

The configuration options for a strategy will vary, but there are some settings that apply to many

strategies.

The first panel is the Trading Options panel. This panel enables you to configure the following:

Trading Options:
1. Trade Lots — This determines the quantity on the orders that are used to entry and exit positions.
The Trade Lot is multiplied by the default quantity to determine the actual quantity.
2. Position Type — Use this option to indicate if the strategy can have long and/or short positions
3. Use Account Position — Use the existing position that exists in the selected account.
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4. Enter On Activate — If enabled the strategy will create an initial position when you activate the
strategy

5. Close On Deactivate — If a position is open when the strategy is deactivated, it will be closed at
market price.

6. Bar Updates — If enabled, the strategy will respond to live bar updates instead of waiting until
the close of the bar.

7. Underlay — If enabled, the strategy will be drawn behind the price bars.

Trading Sessions:

The Trading Sessions section enables you to define sessions where the strategy may be active. In
between trading sessions, the strategy will be automatically deactivated.

1. Session 1 - defines the first trading session with a start and end time

2. Session 2 — defines the second trading session

3. Time Zone — optionally specify the time zone for the hours defined in Session 1&2
4. Close On Session End — Closes an open position when the session ends

Trading Options Panel
MA Cross Strategy x

The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses
the slow moving average.

General Display Trading (ol W Strategy Panel Signals

Trading Options

Trade Lots: Number of lots to

trade in each order

Position Type: | Both  ~
Use Account Position /| Close On Deactivate Underlay
Enter On Activate Bar Updates

Trading Sessions

Session 1: Start: @| End: (0] Enabled Valid Trading
Session 2: Start: ® Ena: 0] Enabled times

Time Zone: b

Create | Save Defaults || Help | Cancel

Strategy Panel

The Strategy Panel tab allows you to choose what labels are displayed on the control box. The available
labels will depend on the strategy.

1. Show Position — displays the current open position

Show Entry Price — shows the average entry price for the open position

Show Unrealized P/L — shows the current unrealized profit/loss for the open position
Show Realized P/L — shows the current realized P/L

Show Stop P/L — shows what the profit/loss would be if the stop loss level is reached
Show Target P/L —shows that the profit/loss would be if the target level is reached
Show Risk Ratio — shows the risk level (target p/I divided by stop p/I)

Show Total P/L — current total profit/loss since this strategy was activated

NV A WN
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Strategy Panel Options
MA Cross Strategy x

The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses
the slow moving average.

General Display Trading Options ESiEiCslsEUEE Signals

v/ Show Position

Show Entry Price These are labels to
Show Unrealized PIL display in the control box.

Show Realized P/L

<K

Show Total PIL

Create Save Defaults Help Cancel

3.22 Software Development Kit (SDK)

Custom studies and strategies can be programmed using our Software Development Kit. For more
information on this, please visit our website: http://www.motivewave.com/support/sdk.htm

3.23 Tool Bar

A tool bar is available from the Console or from a Chart Window and contains a convenient set of
buttons for performing common operations on a chart. This tool bar may be configured from the
Preferences dialog (Configure -> Preferences from the Console menu bar). Additional tool bars may be
added to the bottom or sides of the window.

Actions can be added or removed from a tool bar by selecting them on the right side (to add) or left side
(to remove or re-order) and use the left and right arrow buttons in the center. You can re-order the
buttons and add separators (or spacing) by selecting the action on the right and side and using the
buttons to the far right.
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Tool Bar Preferences
Preferences

o

General Theme CI'IEII'[SOUI'IGS Ratios Elliott Wave Gartley Tick Charts Orders  Alerts Email

Custom Tools Tool Groups

Use this panel to configure the actions available on the toolbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: /| Enabled

Available 4 -Choose Tool Bar-

x

-

ar Actions:

Bar Size Selector
W, Altereae ro=cor

Wy 3 Drivi More than one tool k Search

w50 |Top2 bar may be added to  |ich for Instrument Use these buttons to

A AB=C| Bottom the window parator — change the order of the
= . buttons or add

[ AdD S | ot New Analysis separators and spacing

i Add Right = Save

I Alert i3 save As

& Open/Manage Analyses

M Alternate Bat I8 Save As Image

A= Annotation - Separator -

72 AIC ) Undo -
A Arrow (™ Redo d
4 Arrow Down I\ Separator |1
4 Arrow Up K Al Analyze

A\, Auto AH Choose 1 or more actions W/ My Grou

M Auto Gg from the left side and use 7 Creq select an action from the right

A Auto Wi the right arrow button to i 54 side and press the left arrow

add them to the tool bar

& Balloon
4 Bar Settings

W Tool| button to remove them from
&, Zoo the tool bar

] i Bar Type
Alternatively, drag and BT
| drop items from Available
and Tool Bar Actions. Reset | Reset All
OK | Apply Cancel

Additional tool bars can be added to the windows by selecting the desired tool bar from the drop down

and checking the Enabled box to the right.

Top2 and Left Tool Bars Enabled

[l SPX500 - Primary Analysis - 15 min T T
File Edit View Siudy Sirategy Format Window Help
SPX500 v Q| SRS o ]l | W~ R w~Q 0~ M~ + ™ T &2~|15min - |=~ =~ A~ O~ >
®E R TIENZ Rl My fiv iy av B~ I e BB 80 &
L | SPX500 - 15 min *
@:‘ %ﬂ ﬁ.{.ﬁ-rﬂ-* | ! +D+ﬁ1 ! 229
T 'EJ J22950
In this case, both top tool bars have T 7
N been enabled as well as the left side :2292'5
% tool bar. Optionally a bottom and right b
RS hand side tool bar could be displayed U 12290.0
- il |
pred 22875
W ]
av 2285.0
|- . g ]
iy e * D T 122825
o ] B8 ]
u i
+D 2280.0
Ul This is the Bar Size Selector
1—'| ! 0 Tool Bar. It can also be P277.5
= +-0T figured in Pref
iz ,?l D“*’*‘:‘:‘-D configured in Preferences.
g Motivelr M |
i Feb-03 2:00 300 4:00 500 600 7:00 8:00 900 10:00 12:00
L] 1min 5min 10min 15min 20 min 30min 45min  1hour 2hour 6hour 1day 1week 2week =3 = v @ ¢+ M

Feb-04 11:05:51
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The Lock Studies feature is a convenient way to keep the current set of studies on a chart when you
change the instrument. Choose View -> Lock Studies from the top menu bar to enable this feature on
the selected chart. To change the instrument on a chart, type the new symbol into the Quick Search

box on the left side of the tool bar and press the Enter key.

The following two screen shots illustrate the usage of the Lock Studies feature

Enable Lock Studies

Latal INTC - Primary Analysis - 15 min*® 2o X
File Edit View Siudy Strategy Format Window  Help
INTC - Link v~ @ i~ |+ "B T &2~ ] 15min - | P L L a5
INTC - 15 min Display ' 8
Pivot Points(1 dal Z Components Alt+C 2.0
E Semi-Log Scale Alternatively, click this
E’ EEP\&Y glmtde A+D button on the tool bar
ursor Data +

¥ Snap Wave Points F5 T

#{ Auto Analyze F6

% Lock Scroll .

v 4 Lock Studies = Choose View -> Lock

?EI Group Sthities Studies from the top

il Show Volume menu bar .

@ Increase Hide Below Degree  Ctri+1 F_L Ilel

@ Decrease Hide Below Degree Ctri+| T T

17 Reset Vertical Spacing

v i Show Extended Data

(' Clear Local Data

&2 Compact F7
ﬁM tiveWave

11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 168:00 17:00 18:00 19:00
' + X\
20) ~0.4000
~0.2000
i jU.UUESE}UD

1min 5min 10min [15min  20min 30min 45min 1hour 2Zhour 6hour 1day 1week 2week 1month 3 month

Lock Studies — Change Instrument

> @ |4~ £
Feb-04 11:13:09

il GOOGL - Primary Analysis - 15 min*
File Edit View Siudy Strategy Format Window  Help
EEl ~jQkE R s G IR e ey & 8- [FE[I] 2 15mn - |

1 Daily Volume Profile

Enter new symbol
in the Quick
Search Box

fngh!

Existing set of studies remain

on the chart when the
instrument is changed.

'$+$¥5¢H*%I

Hﬁ d]l ' 1e16.00
LR N
Ha14.00
MotiveWave ) ) ‘ ‘ ) ) ‘ ‘ ] : ; : p— 812.00
1500  Feb02 11-00 1200 1300 1400 1500 | Feb-03 1100 1200 1300 1400 1500 1600  17:00
Chaikin Money Flow(20) et +X

v \ o

1u.uuuu
£-0.078)
-0.2000

1week 2 week

1min 5min 10min [15min 20min 30min 45min 1hour 2hour 6hour 1 day

1 month 3 month

i~ @ ||~ [
Feb-04 11:15:13
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3.25 Lock Scroll

Lock scroll is a convenient way to maintain the same position across multiple charts when using the
scrolling feature to move forward or backward on the historical price axis. Choose View -> Lock Scroll
(from the top menu bar) or use the button available on the tool bar to enable this feature.

motivewave'

When this feature is enabled all charts that are part of the same Link Group will scroll to the same
position when one of the charts is scrolled. If the chart is not part of a link group, but rather on a
Console page. All charts that are on the same page will scroll with chart.

Enable Lock Scroll

MotiveWave |
Jan-26
1min  5min| v

||_IMSFT1I’IX|T

Ll Show Volume

(et

i i

@ Increase Hide Below Degree Ctrl+1 ﬂ m¢++-+.,¢u.. i
@ Decrease Hide Below Degree Ctrl+| *

'~ MotiveWave - Console (google)
File  Edit | View | Study Sirategy Format Configure Window  Help
AAPL - Link » Wy @ v+ "I |2~ 5min -
Ll GOOGL 15 Display b )
G00GH 15 m ?z( Components Alt+C :
DJ,.?..|.I,'.I*ll = Semi-Log Scale Alternatively, !
I ﬁlT"-. <+ Replay Mode click this button !
" @ Cursor Data Alt+D !
¥ Snap Wave Points F5 !
3 Auto Analyze F& |
v ™I Lock Scroll Choose View -> Lock Scroll i
14 Lock L\eudies from the top menu bar |
[ Group Studies !
1
1
1
"
1

17 Reset Vertical Spacing i i .

il Show Extended Data I ‘ X X ! ! h ’I'”’"’"
(' Clear Local Data 12:00 14:00 Jan-31 1200 Feb-2017 1200 14}
m. Show Tabs 1hour 2hour Ghour 1day 1week 2week 1 montna
%2 compact F7 i

= "

MSFT - 1 hour
Wolume

Lock Scroll Enabled

Ll AAPL 5m X
AAPL -5min|

TR ®

Feb-02 11:15,836.99 0:820.85 H:821.46 L:820.35 C:820.35 V.14 4K R:1.11

~ MotiveWave - Console (google) B o A4 =
File Edit View Study Strategy Format Configure Window Help
GOOGL |~ |Q W 15 B &~ @ ¢|K ©|w~ & I~[F[=T &~[15mn  ~ L(me X SmDOR
Ll GOOGL 15m x | + & "
GOOGL - 15 min ] 860.00
o8 Lock Scroll is
e
m“ﬁhn”nﬁ b [IH-. enabled
IU‘***'-., . 850,00
o ]
i Lo !
Dragging the chart left or
' right will move the charts
T DI‘??' below in sync.
T .
I "84 4oy, 1 f ., +Hm"u”‘”"”"""“"-r-
A T ' LN N
f+¢u | f!ﬁ! s i 1
Wotive\Wave el OD h
L . . " " . . . " .
12:00 14:00 Jan-27  12:00 14:00 Jan-30 12:00 14:00 Jan-31 12:00 Feb- 2017 12 00 14 00 FelFeb-02 170 ‘ 14 00 Feb-03 1200 14:00 16:00
1min 5min 10min [ 15min 20 min 30 min  45min 1 hour 2hour 6hour/1day 1week 2week 1month 3month =E @y @ ¢~ &
Ll MSFT 1h x | + @ . *|[lu AAPL Bm x | + = "
T
- - i 1291
lfSFT 1 hour ﬁ’flﬂlTT ! AAPL -5 min
Volume 1
ﬁ I ! l{- 12905
L * ! | ﬁi U[F
I
| o I'.ll ik
EI iinl +' Iﬂ'lﬂ | [IU 122.80
I
e ‘ | ﬁlﬁ'
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|
‘ ¢, ! i
| * ! Mg i o
| h I TT " b 12840
n.u ™ I I otweviave | , , ‘ ‘ ‘
Jan-30 Feb-2017 Feb 03 Feb-06 Feb-07 Feb-08 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00
1 min 5m|n 10 min  15min 20 min 30 min  45min | 1 hour >y = vy @ |=|~ | 1min Smin 10min 15min 20min 30min 45min 1 hour =7 =E ey @ |« B2
LWl Home  Lul Charts X [8 Account [& Scan i Optimize News  + m O

Feb-04 11:26:36

3.26 Study Templates

For convenience, studies can be organized into templates. A template contains one or more studies
with specific settings. To create a template, simply add and configure all of the studies you want to
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include on a chart. When you are satisfied with the studies and their settings, choose File -> Template ->
Save As Template (from the top menu bar, Note: File -> Chart -> Template -> Save As Template from the

Console).
Create Template (Step 1)
il MSFT - Primary Analysis - 15 min® 2o ¢ X
File | Edit View Study Strategy Format Window Help
Ll New Chart Window CtieN ™) (| | w~ & 0~ [+ "8 T &~ | 15min - ML S
il New DOM Window -
) New Time&Sales Window
Ll New Chart Tab - 63.68
B New Analysis £ Df? Hess0
& Manage Analyses ﬁ- :
= Save Cirl+S [ 0618 63 50
i Save All Cirl+L w051
IS, Save As ] 6343
Template * &, Sqwe As Template !
&' Import Data = Mahage Templates Hea30
€' Export Data I .
ala Import Analysis Cir+K - | \ |
& Export Analysis Ctri+J dd/conti ot th " 6320
i Save As Image A. fcon. igure all 0 the studies you BP
D wish to include in the template on a
isconnect ) 6307
Exit chart. Choose File -> Template -> Save
| !u ‘ As Template to create the template 63.00
=l 16290
62.80
MotiveWave 0.5
; r : : r : : I : : : :
15:00 Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14
: Alternatively, click on this x
WM x ] drop down and choose ,,@
A & AT A
Save As Template
H-400.0K
N H-800.0K
imin 5min 10min 15min  20min  30min 45min 1 hour 2hour Ghour 1day 1week 2week 1 month 3 month = gy @ |#lv B

Feb-04 11:30:40

Save As Template Dialog (Step 2)

Save As Template

Template Name: [ My Template]
7S

Enter a name for the template and click the Save As button. To overwrite an
existing template, select the template from the table below.

Choose a name for the
template

MNo content in table

Click Save As

Last Updated

Save As Cancel

A study template can be applied to another chart by choosing File -> Templates -> <Template Name>
from the top menu bar (Note: File -> Chart -> Templates -> <Template Name> from the Console). Short
cut keys are available to make this more convenient. Short cut keys are Alt + 1, Alt + 2 etc where the
number key applies the template in the order they were created.
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Apply Template
il AAPL - Primary Analysis - 15 min 2. X
File = Edit View Study Strategy Format  Window  Help
[ Ll New Chart window cieN | I &lwre i~ @ e~ (15mn ~ | 0w %3
iii New DOM Window N
) New Time&Sales Window
Ll New Chart Tab 13025
I New Analysis
& Manage Analyses 143000
Ctri+L
412975
Template * & Manage Templates
&' Import Data My Template Alt+1 Select the template from 712950
s; IEXPE"I‘ Ea‘i’ P [ the menu (note keyboard
= mport Analysis e short cut is Alt + 1) 1
< Export Analysis Cirl+J 129.1
I[85 Save As Image
Disconnect - s
Exit J:, §
I T T * & l D Y1288
i |j 12850
; m' 1 *W*h@mﬁ*
| . ]
| + 4 I + m J12825
| T Template is also 128.16]
‘ D available from the H128.00
" Q drop down
MotiveWave :
" i " — " "
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Template
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name of the template

w

This is the template
after it has been applied
to this chart.

Format  Window
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3.26.1 Removing a Template

To remove a template from a chart (including any associated plots). Right click on the template name (in

the study legend).

Remove Template

Lak
File  Edit = = Y
AAPL Right click on the 3 |3
template name
AAPL -15
My Tegmniats i
Edit » | “)undo Ctri+z
(™ Redo  Clrl+
26 Cut  Ctr+X
‘ B copy  Ctri+C
[f) Paste Ct

Format  Window

X Delet& [-lélete Choose Delete

AAPL - Primary Analysis - 16 min™
Help
wler& i ~ETE

&2~ | 15 min

=

L3 n
L3} - [ 3

L
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3.26.2 Managing Templates

Your existing templates can be managed from the Manage Templates dialog. Choose File -> Templates -
> Manage Templates (from the top menu bar). From this dialog you can rename, delete or change the
order of the templates. The template order affects the short cut keys (Alt + 1, Alt + 2 etc). Changing the
order will affect which template applies to each short cut key sequence.

Manage Templates Dialog
& Manage Templates £

The list below contains the available templates. From here, you can rename
and remove templates using the buttons below.

Name Last Updated *
My Template
Moving Averages 1
Trade Setup 1

Exit Strategy 1 The order of these templates affects
the short cut keys (Alt+1, Alt+2 etc).
To change the order select and use
the up/down buttons below.

Rename Delete up down Import Export Close

3.26.3 Import/Export Templates

For convenience study templates can be exported and imported into a workspace. This can be useful for
sharing templates or moving them between workspaces. Both of these operations can be done from the

Manage Templates dialog (see previous section). The Import/Export buttons can be found at the
bottom of the dialog.

=1

Manage Templates X

The list below contains the available templates. From here, you can rename
and remove templates using the buttons below.

Name Last Updated *
My Template
Moving Averages 1
Trade Setup 1
Exit Strategy 1

Select a template above
and click Export to save it
to an external file

Click the Import
button to import an
existing template.

AV

Rename Delete up down Import Export Close

3.26.4 Template Preferences

Preferences for study templates can be found in the Preferences dialog. Click on Chart then on

Templates. A default template can be configured (check the Use Default option). This will be displayed
whenever you create a new chart.
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The Link Templates option will apply a template to all charts that are part of the link group (if
configured, see the Chart Linking section).

Template Preferences

Preferences X

&

General Theme EeGEN

-

Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

Chart Seftings Indicators Labels JEEnEIESN Options Bar Sizes Bar Size Selector

The settings below enable you to change the behavior of chart templates. The default template (if enabled) will be added to

all charts.
Default Template

Template Title: | Name Only

/| Link Templates

should work in conjun
with Chart Linking

v/ Confirm Overwrite Studis

This indicates that templates

This option enables you

Use Default

-

to setup a default
template for all new
analyses

This option affects
what is displayed in
the Study Legend

ction

OK

Apply | Cancel

3.27 Linking Charts

Chart linking is a powerful feature that enables you to apply an action to a set of charts (instead of a
single chart at a time). By default charts are unlinked (no link group assigned). There are a few different
ways to assign a link group to a chart. The simplest is to choose the link group from the status bar at the
bottom of the window (Note: this also works for DOM and Time/Sales windows).

————a -

Link Chooser
o~

Select the link color group
Motivd from the color options

—\ /Ferrz 1100

"

)

"

1300

12Feb02 14.45

1min  5Mn 10 min

ARS o e
There are three modes for linking charts:

1.

the link group to the same symbol
the same bar size

charts are part of a replay group)

15min | 20 min 30 min 45 min 1 hour

€b-02 14:45,129.05 0:128.13 H:128.22 L:127.96

2 hour

6
C128.2+

Instrument (Symbol) — In this mode, changing the symbol on one chart will change all charts in
Time (Bar Size) — If the bar size is changed on a chart in this mode, all linked charts will change to

None (Replay Mode) — This mode is for linking charts together for use in replay mode (linked
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Link modes can be chosen for each link color individually. These options can be found in the
Preferences dialog (Configure -> Preferences from the console menu bar).

Link Mode

Preferences X

e

Tneme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email (=

General Keyboard Mouse Fonts _Quick Search _Ticker Tape |JNIGRY Dock Trading Hours _Simulated Accol (=

This panel defines the type of linking to be used in MotiveWave. Linking may be tied to the selected instrument (default), bar
size or none (used for replay mode)

v'| Use Default

Default Link Type: | Instrument

é‘) Link All: Instrument

Type of link can be chosen

@ Red Link Bar Size for each link color
None (Replay) individually.

@ Green Link: [FIRSTamen -
@ Blue Link -
Yellow Link: >
@ Orange Link: v
@ Purple Link: -
@ Maroon Link: -
@ Navy Link: -
Pink Link: -
@ Dark Green Link: -
@ Brown Link: -

OK Cancel

Apply

Other windows such as the DOM and Time/Sales windows can also be given a link group. In the example
below, two charts and a DOM Window have been assigned the same link color. Choosing a new symbol
from the quick search box from one of the windows will automatically change the symbol for all
windows in the link group.

Linked Example Step 1

[} INTC - Primary Analysis - 15 min® 2 - S x|e DOM (simulated - INTC) - 2 X
File Edit View Study Strategy Format Window Help File Options Window Help
INTC] QR EE sr@O IR B e i+ [T e~[15min ~ | » [INTC ~ || Limit Order ~ [ 100 2]=- EIE -
;;L o 68| 10 20 30 50 100 150 200
PIL  Orders Bid Price = Ask  Orders Volume *
GDPAQ
Choosing a new symbol - 36.64
from the drop dewn will 3663
switch the symbal in all of _|_ 3662
GGG the "Green" linked windows e
GLD LR owd QFM-. "
GLYHO ']_" 'LTE] *tl"'u 3660
* 3659
GMG
aNe 36.58
|» ; ; ; L ; L 36.57
OGNS gy 7200 1300 1400 1500 Feb03 1700 1200 1300 1400 1500 1600 2556
1min 5min 10min  15mMin  20min 30min 45min 1 hour 2hour 6&hour 1day =4 = vy @ ¢ B2 2655
2 36.54
L} INTC - Primary Analysis - 15 min* 5 - S 3653
File Edit View Study Strategy Format Window Help
INTC alh EE sy IR eleyQ -+ T[I]ev[15mn - | 36.51
® INTC - 15 min 36.50
36.49
36.48
36.47
l 36.46
TP T
# ? 4 J.t] bt Ll B %44
4 Ll T Ty PR I —
N/A Buy Mkt
ol
, . . : . , : ‘ : : . . N < i |
1200 1300 1400 1500 Feb03 1100 1200 1300 1400 1500 1600 1700  18:00
imin 5min 10min  15min  20min 30 min 45min  1hour 2hour 6hour 1day >4 =E ey @ |4 B 0.04 | simulated

Feb-06 9:07:55
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[ ] GE - Primary Analysis - 15 min - X|e DOM (simulated - GE) =
File Edit View Study Strategy Format Window Help File  Options  Window Help
GE ok SR Er@ KElere i~ + T/ ®~[15mn  ~ » | GE ~ | Limit Order ~|[ 100 2|= CIE-]
® GE -15min o .80l 10 20 30 50 100 150 200
volume PIL  Orders  Bid Price Ask | Orders Volume *
o Wnﬂlnﬁm-,lm--llmlﬂ Iﬂi “ﬂlﬂii“jﬂﬂﬂ-l‘lﬂ.‘ﬂ.'ﬂl
11:.00 12:00 13:00 14.00 1500 Feb-03 11:00 12:00 1300 14:00 15:00 1600 17:00
imin 5min 10min ' 15min  20min 30min 45min 1hour 2hour 6hour 1day =4 = iy @ 9>
- 29.70
[ ] GE - Primary Analysis - 15 min 2 - J B %
File Edit View Study Strategy Format Window Help 2068
INTC ~O|E E & sr & Keleve ov[+][=T[Z]®~[15mn ~ 2967
® GE -15min = 2966
Volume
2965
2964
J_ H * - 2963
AN T AU
EJ T Ij] 2961
2960
+¢f 0 0 0
-D i NiA Buy Mkt
i [l mml mEEE ] ﬂ e N |
11:00 12:00 13:00 14:00 15:00 Feb-03 11: DO 12:00 1300 14:00 15:00 1600 17:00
imin 5min 10min  15min 20 min  30min 45min  1hour 2hour 6hour 1day *~4 E @y @ |¢v 8 004 e U

=T oR (]

Feb-06 9:13:27

Feb-06 9:13:27

3.27.1 Linking With Templates

As discussed in the Study Templates section the linking feature can be used in conjunction with the

Study Templates. If enabled (see Preferences dialog, Chart -> Templates tab), applying a template to
one chart in the link group will apply the template to all charts in the link group.

3.27.2 Link All

If you are working with the Console window (or a Desktop), you will notice an additional linking option,
Link All. This option will link all charts that are on the current page. This provides a convenient way to
link all the charts on a page with one click (instead of choosing a link for each chart).
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~ MotiveWave - Console (google) MR o &
File Edit View Study Stralegy Format Configure Window  Help
MSFT ~OE A s CR Wy i [F]T L[15mn - L P 2 [T}
Ll AAPL 15m X | + ¢? No Group ISFT 15m* X | +
o . i H Choose Link All from (§’ ink All [
& AAPL 215 min . uniunlnr be link drop down ed Link ‘Sﬂlgﬂlﬁ“i -
__ ey H . - o C Green Link r'll’ b
e B TR @ Biue Link H +
Charts show the " Yellow Link ! +
link group to the @ Orange Link ! “
left of the title @ Purple Link i *lﬁ ﬁH"
@ MMaroon Link | *T *!u'lﬂm '
! @ Navy Link ! ' ﬂll] t
1 Pink Link 1 *
i @ Dark Green Link i ' ﬂl‘ DH,T “ﬁﬁ!mhﬂi.rﬂﬁ'#
: @ Brown Link ! .&ﬁ] i u*uﬁd-ln‘?T
=" | 4!
"mu»é\ﬁlav' MotiveWave :
; ! ; ! ; ! : 1 ; ! ; ! ! ! :
Feb- 2017 1200 14:00 Feb-02 1200 14:00 Feb-03 1200 14:00 16:00 Feb-2017  12:00 14:00 Feb-02 1200 14:00 Feb-03 12:00 14:00 16:00
1min Smin 10min  15min 20min  30min  45min 1hour =7 = v @ |#|~ | 1mn Smin 10min 15min 20min  30min  45min  1hour =7 = e~
lul GOOGL 15m x | + = .7 \_lBMﬂsmxH
& GOOGLI - 15 min 825.13 | (£ IBM - 45 min
| + 1825.00|| $oiume ! U+
i m' | [|+l! A gﬁD-T !'
i 10 ' He2250 ! 1 Wi
| i+ -“ iDD 11[] ﬁT'j'llqll]l! D Il ¥
fl]l ! | * 21820.13 ! ‘ iy
! ! i [ o T.ﬁui | a1| A
%D*IJﬁT i ﬂ“ﬁ* Jf i Herrse| 07 b *H ”
! '5' ) ]élm ! D! fiu lnll
| i ‘ I
| i Ja15.00 i | ﬁ!-’:l -“"I |
|
o . 1181250 i n.‘ nn.n.nmnIﬂnﬂﬂMlnlﬂmnpnn}n.’ﬁmnﬂ“ htanguuasaranl]
Feb-02 1200 14:00 Feb-03 1200 14:00 16:00 Feb-2017  12:00 14:00 Feb-02 12:00  14:00 Feb-03 12:00 14 00 16 00
1 min II /ﬁin 10min | 45min 20 min 30 min 45min 1 hour *>7 = v @ |=|> 2 ([1min 5min 10min  15min  20min 30 min 45min 1 hour **7 = vy @ =+ A
|l Hom' |l Chars X @ Account [ Scan  {lf Optimize News  + m N O

Feb-06 9:17:29

3.28 Working with Chart Windows

3.28.1 Compact Mode

Compact mode strips away the tool bar, menu bar and status bars to maximize the chart area on a chart
window. Use the compact/uncompact button on the right hand side of the title bar to switch between

regular and compact modes.

Compact Button

%Primaw Analysis - 15 min
t Window Help

&2« | 15 min

Click here to switch to
compact mode

The screen shot below illustrates a chart window in compact mode. Notice that the chart area fills the
entire window to optimize the use of screen space. Click on the uncompact button on the tool bar to

return to normal mode.
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Compact Mode

lant GE - Primary Analysis - 15 min
GE - 15 min 0
Volume

Click here to return
to normal mode

| i i :
1,
W@ﬂm-iﬂim;ﬁ.‘.,un‘.iiﬁ-ﬂﬂﬂ 'Iﬂllllﬂlﬂ'll'lﬂmmn.'n"m'.lﬂ'[l |

11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 16:00
1mn 5Smin 10min  13min  20min  30min  45min  1hour 2hour 6Ghour 1day 1week **3 = @y @ ¢ B

The behavior of compact mode can be configured in the Preferences dialog (Configure -> Preferences
from the console menu bar). This allows you to specify what elements should be displayed in Compact
Mode.

[ o Preferences X
Theme Chart Tool Bar Sounds Ratios ElliottWave Gartley Tick Chaits Orders Alerts Email >

arch  Ticker Tape Linking Dock Trading Hours Simulated Account Watermark Auto Update Eedpi=le@libbiy =

Select the features below that you would like to show or hide when viewing a Chart window, Chart Group or the Console
while in Compact Mode.

Show Tabs l

These apply to the
Show Page Bar Console and Desktops

Show Menu Bar
Show Tool Bar

Show Status Bar

OK || Apply || Cancel
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The Tile Windows feature is useful to arrange your charts on a single monitor without having to position
the windows manually. Start by arranging the chart windows roughly where you would like to place
them. Once you have done this, right click on the title bar of one of the chart windows and choose Tile
Windows (alternatively, press Ctrl + W). Note: on Mac OS X choose Window -> Tile Windows from the

top menu bar.

Tile Windows Before

Ll MSFT - Primary Analysis - 16 min* F | al TSLA - Primary Analysls - 16 min I
MSFT - 15 min : 63.70 TSIA 48 phid
il ; T A | 4252.00
I Always On Top
GF - 15mi Right click on the title bar [Jile Windows  Cirsw
foume and choose Tile Windows or Cascade Windows 251.54)
] press Ctrl + W Restore Windows %
Window Size ’ l T HJ
- i HZ9.ru
H; ﬁ l u* : r eﬁ J251.00
LJ'] T 2963
2961 H250.00
29.60
Motive\Wave 29,59
. . . . .
11:00 12:00 13:00 14:00 15:00 1 1!00 12‘00 13500 14500 15‘00 Feb-06 I
1min 5min  10min  15min 20 min =g 1' I i : b I5min 20min 30min 45min =g = gy @ |4|v @
- T T - 813.2)
AN Hﬂﬂnnmllﬂ.lﬂ i <00k LLD T— &'l
T100 1200 1300 1400 1500 Feb-06 T . _L
1min 5min 10min [15mMin | 20 min  *3g = v @ |-~ oo -
I : [ | n r]245500.00
% ‘ ‘ FI DI : + 245378.00)
* l u *D'ﬂ]THF-*D. 822.00 1245000 00
HT *+Q LPE e ] !
820.00
D +244500.00
?+m 8193
_ 818.03—‘ I = om _I e R
lntivlew.ave ) ) ‘ ) MotweWav‘e . . ) . ! | .l_|T||_| —F.—..-—*-’_‘
15:00 Feb-03 11-:00 12:00 13:00 14 11:00 12:00 13:00 14:00 15:00 Feb-06 00 12:00 13:00 14:00 15:00 Feb-06
1min 5min 10min _15min_ 20min  30min 45mij 1m0 Smin  10min 743 min_ 20 min =*1p = v @ |ol~ | [15min 20min  30min g = v @ |4y 8
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il MSFT - Primary Analysis - 15 min* oo X GE - Primary Analysis - 15 min oo T X TSLA - Primary Analysis - 15 min SV
MSFT - 15 min {6370 GE -15min 1] TSLA - 15 min 1253 50
Volume
463.60
- H29.70 H253.00
16350 D 2968 ] <;
. 252 60)
I 29.66)
463.40 29,65
2 Has2.00
- gaa.aal
HH Uag.60 Jﬁ+ H25150
Js320 f€l+$T* TTT EFI
*Hﬁ? J251.00
] - . e 8132
Mot Wave 63.07 . . ﬂﬂﬂ-ﬂm.iﬂ.l <0.0b4] MulweWave
. L . .
1200 1300 1400 1500 Feb06 1200 1300 1400 1500 Feb-06 A TR R R
1min 5min  10min |45 min ¥4 = v @ =~ g4 1min 5min  10min | 15min >34 = l@giv @ =~ 2| 1min 5min  10min  15min  *>q4 = vy @ |¢|v B
ul  AAPL - Primary Analysis - 15 min o~ 0 X | GOOGL - Primary Analysis - 15 min o _ 7 X |w  BRKA-Primary Analysis -15min 3 - " X
AAPL - 15 min = 129.77 \GoocL 15 min BRK.A - 15 min 7/246200.0
3824.00 volume
—129.50
éIDI 246000.00
J129.40 D * IjTEg-+D. J822 00
* J245800.00
12919
3820.00 ‘ _
.L D 7129.00 819.38) 245600.00
g i qree0 Js18.00
D | o 3245400.00
* - _l_|j G - 31643
J816.00
#51 ***ﬁ-ﬂﬁ Ji2s.40) I Il £45200.00
Motivelyave ) ; MotlveWavle ‘ ) ‘ . ._-.ﬂ I130.00
1200 1300 1400 1500 Feb06 1200 1300 1400 1500 Feb06 1200 1300 14:00 15:00 Feb-06
1min Smin 10min 15 min == 19 = v @ =~ 2] 1mn Smin 10min  15min >y = ey @ ¢+ [‘""I 1min 5min  10min  15min =19 = @y @ |¢|> &

3.28.3 Cascade Windows

Similar to the Tile Windows feature, Cascade Windows arranges the windows that are on the screen on
top of each other offset from the top left corner. Choose Window -> Cascade Windows from the top
menu bar to arrange the windows in this fashion.

Cascaded Windows

MotiveWave - Console (gooale) 2.t x|
o Lt AAPL - Primarv Analvsis - 15 min = ol
o GE - Primary Analvsis - 15 min FIE |
M f L BRK.A - Primarv Analvsis - 15 min 52 x|
i A1 MSET - Primary Analvsis - 15 min* L2
QU G of GOOGL - Primarv Analvsis - 15 min 2 L x|
II-J* G(B ul A il TSLA - Primary Analysis - 15 min* 2 - T x
v B
Jd Wl Fle Edit  View Swdy Stategy Format  Window  Help
™ c| TsLA OB E s~y@E© IR ewrQ v+ "I 2~ 15min - | a4
TSLA i 15 min
M tl 75300
1]
E * l i iear:
“ Ly IO Y |
T?T ?*qﬁj+¢| + T T -D H251.00
250.63)
]J ¢m H H2s50.00
1| m EE
i Ha49.00
il
1
= M
L l 24800
1 | mee\«'?la e
- , . . , . , . . . , .
= 1 Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 Feb-06
| 1min 5min  10min  15min 20 min 30 min 45min 1hour 2hour Ghour 1day 1week 2week **3 = @b @ o] M

Feb-06 947:48
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For convenience, the window size can be set from the Window menu (Window -> Window Size ->
<Size>). This can be a useful feature for taking a screen shot or video. Choose Custom to specify a size

that is not one of the presets.

Window Sizes
[l TSLA - Primary Analysis - 15 min I
File Edit View Study Strategy Format Window | Help
TSLA ~ Q| B s @ #  Bring Al to Front M a4 >
TSLA 215 min Tile Windows CiriW :
Cascade Windows i
Restore Windows 253.45
Always On Top 5E300)
Window Size 3 Cuslom Choose this option :
MotiveWa_\fe - Console_(google). 425x344 to specify a custom ]
AAPL - Primary Analysis - 15 min 480x385 width/height 1
L GE - Primary Analysis - 15 min 530%530 H252.00
-i- % —f; BRK.A - Primary Analysis - 15 min 640x430 ]
MSFT - Primary Analysis - 15 min* 640%505 T If;l ]
GOOGL - Primary Analysis - 15 min 800X600 -I--D ]
TSLA - Primary Analysis - 15 min 960x540 [251.00
Fr ! 9E0XTA5 (250.6
1024x768 ]
1200x840 H250.00
L 1280x720 ]
1280x768
1280x800 ]
1280x1024 =249.00
1440x900 ]
1920x1080 ]
. H248.00
Motiveb’?’a e
L L L L L L ! L L L L
Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 Feb-06
1min &5min 10min  15min  20min 30min 45min 1 hour 2hour 6hour 1day 1week 2week *; = e @ |4~ B

Feb-06 9:52:29

3.29 Replay Mode

Replay mode is a very useful feature that enables you to go back in time and replay market data. This
can be very useful to practice your trading or to test your custom studies and/or strategies. The replay
mode control can be accessed from the chart menu bar: View -> Replay Mode (Note: there is also a
button on the right hand side of the tool bar). When you click this menu item you will see the Replay
Mode bar appear at the bottom of the chart.

Displaying Replay Mode

il BRK.B - Primary Analysis - 15 min oo X
File  Edit | View | Siudy Sirategy Format Window Help
BRK.B - Link » W~ Q 1~ 4+ "B[T|&2+|15min - 45 W8 W E g D »
HK B - 15 mil Display ’
-y Components Alt+C 116425
= Semi-Log Scale . .
Al tively, click
v 5 Ref'gy Mode Choose View -> ! th:g‘: I':E xmc d': ic‘:’;
E_‘ Cursor Data Alt+D Replay Mode (from -L on theioo‘: bar 164.00
¥ Snap Wave Points F5 the top menu bar) L m *m l . 163.89)
#{ Auto Analyze F6 * + - \J_'I * + 163.79
Lock Scroll iqm
a2 Lock Studies
[ Group Studies ¢ H163.50
J L Show Volume
@ Increase Hide Below Degree  Cirl+1 163.2!
@ Decrease Hide Below Degree Ctrl+|
1% Reset Vertical Spacing H163.00
v ik Show Exiended Data
C‘ Clear Local Data
ot Cnmpact TT H162.75
i HI J162.50
JD-=- T = e —— ] T1.3K]
W‘.’llﬂlﬂ LT I—u—ﬂl—_-r—ﬂ-I-Il_l ﬂﬂll-mll-mm—\-qmmﬁ]l | . K
400 1500 Febd2 1100 1200 1300 1400 1500 1§ ReplayBar 990g 1200 1300 1400 1500 Feb-0B 11:00
imin 5min 10min _15min  20min  30min 45min 1hour 2hour 6 nour‘-\/av—mek 2week 1month 3 month = v @ |[Hv B
I0) stat: |2/62017  |@|[9:30Am |@] BRKB 15m BarDala ¢ £ X

Feb-06 9:55:50
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Replay mode can be started by choosing a start date and pressing the power button.

Turn On Replay Mode

Use the 'Power’ button

H’“‘Q—“TT? meﬁﬂ

Use these controls to !

b | | W m  Stat 26017  |E||9:30AM |©

to turn replay mode ———— | calect a start date/time. .- — —_ M | Click here for advanced
on/off sl | =nl | ﬂ.l-mll-m.m-qv—n—m‘l I configuration options
13:00 14:00 3 . T1-00 12:00 13:00 14:00 15:00 Feb-0_
1 A A 5Smin 10min (15min 20min 30min 4% min 1hoyr 2hour 6hour 1day 1week 2week >3 = vy @
BRK.B 15m Bar Data (¢ ## X

Feb-06 9:58:53

Use the play, fast forward, reverse and stop buttons to step forward through the data. These buttons

work as follows:

1. Rewind — This will restart the replay mode from the beginning

2. Play - Step forward in time by 1 tick

3. Forward — Play ticks until the next bar is reached

4. Fast Forward — Play ticks continuously

5. Stop — Stop playing ticks. This is only active if forward or fast forward buttons have been clicked

above.

Replay Buttons
A et e

LI L A
-|- i 163.25
Step forward P——
bvftick Stop Repl '_”_"_‘m.H .'_| 1 1 1 1 1 1 1 K
- op heplay 15:00  Feb-2017 11:00 12:00 13:00 14:00 15:00 16:00 17:00
1min  Smin\ A0 min = 15 min 2W45 min  1hour 2hour 6hour 1day 1week 2week >*> = vy @ ||~
> | om o B4 start [212017  [EB|[9:30 A |®] Feb-019:30 BRK.B 15m BarData o £ X

Feb-06 10:04:53

Play to
next bar

Restart from
beginning

Play

Current replay
date/time

continuously

When you are working in replay mode will work as if you are trading live back in that time frame. A
special replay account is created to manage orders, positions and historical trades.

3.29.1 Replay Settings

Replay settings can be accessed by clicking the gear icon on the right hand side of the Replay Mode bar.
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Replay Settings Dialog
o Replay Settings X

Replay Mode enables you to replay market movements using historical data. This may be useful for testing a
strategy or practici liott Wawve Counts).

Choose from Bar Data,
Minute Data and Historical
Tick Data (if available)

If supported by yol
minute bars.

other wise MotiveWave will r

Use the replay

account to
practice trades

Replay mode may (either in a Chart Group or C

Source Data: | Bar Data - Generate Ticks Replay Accoun

Real Delay
Account ID: | REPLAY-1
v/| Step Until Price Change
Base Currency: | USD
Speed Factor:

Cash Balance: 100000.00 3
Tick Delay (ms): [ 0 2]
¥ }. _ v'| Include Commissions
Bar Delay (ms): Linking allows you to

Replay Link: | ¢ Page ~ replay several charts

together in sync.

Cancel

Replay Data Settings:
The following settings apply to the playback of data in replay mode:

1. Source Data — Options for source data include:
a. Bar Data - Each bar is used to generate 4 ticks: open, high, low and close

ave

b. Minute Data — Minute data will be loaded from the data service to generate ticks (each

minute bar will have 4 ticks: open, high, low and close

c. Tick Data — If your broker/data service provides historical tick data, then this may be used
2. Generate Ticks — If this is enabled MotiveWave will generate a set of ticks to (beyond OHLC) for

playback. This option does not apply to the Tick Data option
3. Step Until Price Change — If enabled it will keep playing ticks until the price changes when
pressing the play button (instead of a single tick at a time).

4. Real Delay — If this option is checked, MotiveWave will simulate the delay between ticks by using
the tick timestamps. Use this if you would like to simulate the actual playback of ticks in real

time

5. Speed Factor — Applies to Real Delay option above. Allows you to speed up (or slow down) the

play back of ticks in real time
6. Tick Delay — this is the delay to add between the play of each tick.
7. Bar Delay — this is the delay to wait between the playback of each bar.
8. Replay Link — Use these options to link the replay mode across multiple charts.

Replay Account:

The replay account is useful if you intend to place trades in replay mode. If this is enabled, a special
account will be created (see Account page in the Console) to track all orders, positions and historical

trades for the replay session.

1. Account ID — This is the name of the account ID that will track trades

2. Base Currency — This will default to your base currency, but you can change it if you like

3. Cash Balance — Opening cash balance when you enable replay mode

4. Include Commissions — Check if you want trade commissions to be included in the P/L
calculations.
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3.29.2 Linking in Replay Mode

The linking feature in MotiveWave™ enables you to use replay mode across several different charts at
the same time. The following steps explain how to include multiple charts in the same replay session:

1. Select the charts that you want to include and choose the instruments and bar sizes
2. Choose the same link color for each chart (make sure the link type is “Replay”)

3. Edit the Replay Settings

4. Choose the link and press the “Update” button

Replay Linked Settings

o Replay Settings X

Replay Mode enables you to replay market movements using historical data. This may be useful for testing a
strategy or practicing analysis techniques (such as Elliott Wave Counts).

If supported by your broker, tick data may be used, other wise MotiveWave will reconstruct the movement using
minute bars.

Replay mode may be linked with other open charts (either in a Chart Group or Console or set of linked charts).

Source Data: | Bar Data v Generate Ticks Replay Account

Real Dela
Y Account ID: | REPLAY-1

v'| Step Until Price Change
Base Currency: | USD  ~
Speed Factor:

Cash Balance: 100000.00 5
Tick Delay (ms): _‘E
v (ms) v'| Include Commissions
Bar Delay (ms):

Replay Link: | (&’ Page ~
)

&’ Page
® Red Link Cancel
® Green Link
@ Blue Link
Yellow Link
® Orange Link
@ Furple Link
@® Maroon Link
@ Navy Link
Pink Link
@ Dark Green Link
® Brown Link

Note: if choosing a
color link, make sure the
link type is "Replay”

The following screen shot shows 4 charts that are part of the Red group and using the same replay
session:
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° EPH?7 - Primary Analysis - 15 min =+ O ox|e CLEH?7 - Primary Analysis - § min &+ R
@ EPHT - 15 min | @ CLEH7 -5 min
vol | Volume
. Ja284.00 ¢ 5335
Red link chosen for ? 8333
each chart that s part Inthis example, all charts that are part of e
of the replay session. ;
the Red group will be part of the replay o
! session. When playing a tick from this 2281.75) Hs325
| T window, ticks will also play in the other
| | chart windows (regardless of bar size). I ] Hs320
! J2280.00 MJ
| u 1H ‘!HT T | s
1 u & Preferences X i
! i
: U ? 5378.00 Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Aleits Email = Hs3.10
i D?W General Keyboard Mouse Fonts Quick Search Ticker Tape Dock Trading Hours Simulated Accot ~
5305
|
H UR" ! This panel defines the type of linking to be used in MotiveWave. Linking may be tied to the selected instrument (default), bar
””ih Elwﬁuﬁ” | H2276 00 size or none (used for replay mode). 5300
156K
'0 1 Defautt Link Type: < || use Deraut
! This replay bar controls 50 95
I | all 4 charts that are 200 & LK AIL | Instrument
| t of the repl AT Link type should be
1 O N—— 8yl ﬂ”'”” : ; : : padf. N © replay group 6563 ® RedLink | None (Replay) ~ None (Replay)
7900 2100 Feba017 200 400 600 800 1000 1200 1400 60| (red link) 02200
imin 5min 10min [15min  20min  30min 45min 1hour 2nhour Ghour 1day 1weeR /3 = iy @ o> @ e ® Green Link. | Instrument -
G | W > n om | W sart|212017  [m|9:30AM |©] Feb-019:30 EPH7 15m TickData @ & X | tmin | 5n] @ Blue Link | Instrument -
° YMH7 - Primary Analysis - 30 min >® _ O x|e Yellow Link: | Instrument - B
'YMHT - 30 min @ NGEH P -
*Dgl e Velume @ Orange Link: | Instrument 3400
19880 @ Purple Link: | Instrument -
l 19871
X p @ Maroon Link: | Instrument v
J19860 q
n’ q @ NavyLink | Instrument - 3350
'W J19ea0 I PinkLink: | Instrument -
I l @ Dark Green Link:  Instrument - 3300
J19820 l .
@ Brown Link: | Instrument -
519800 H3.250
H19780
3200
H19760
oK || Apply || Cancel
! b i
|
i w&!hl»ﬂl ) T.I‘W"n‘
\ o o I
| MOURYaYe . oy mammanlgal |I n _ F— . . . — . g [— ﬂp(rlr. gt ||| (R | . . . .
a3t A0 B0D 1200 7600 Feb-2017__5.00 1200 _16.00 Feb-02 400 600 1200 To.01 00 Jan-29 1200 Jan31 1200 Feb-2017 1200 _ Feb02 _ 1200 _ Feb03 Feb05
Tmn 5min 10min 15min 20min |80min  45min 1hour 2hour Ghour 1day 1week >3 Tmin 5min 10min 15min 20min 30min 45min | Ahour| 2hour Ghour 1day 1week >3 = i@ - &

Using replay mode inside of the Console (or a Desktop) can be much more convenient when Page linking

is used (default).

All charts that are part of the page will be included in the replay session.
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~ MotiveWave - Console (CQG2) B = o3
File Edit View Study Strategy Format Configure Window  Help
EPH7 MLl BN Al K 2w~ Q o~ + B[F|&2~[15min  ~ | L2 NEND @&
EPHT 15m X [+ A @ *|[YMH7 5m x | + [E1
EPHT - 15 min i 00| YMHT - 5 min
Volume ! Active Chart. When playing 2284.00|| Volume 19890
i| next bar, the bar size of this 50 £.19886
| chart will be used. H19880
‘ | -
I
i huL 71586
: | il
! When using Replay Mode inside of i 119860
| Lt !IJT a Console (or Desktop) all charts h
| h nl;l i%* [Ilj that are part of the page are
| U !lil included in the replay group. ﬂ 1119850
1.
H D?? 4 -—ngJI [{]1 J’ Dél J19840
it H i yit
j ‘ Mlﬁuﬁ”u ! hhs um t I]T IU t 119830
i 2
MOJLLNBA@ ! - - — MotiveWave Tl ST R— 1
= —— e e | . . . | e ——r—r : " " : :
Feb-2017 300 500 700 9:00 12:00 14:00 16:00 20:00 22:00 6:00 7:00 8:00 9:00 10:00 11:00 12:00 13:00 14:00
1min Smin 10min  15min 20min  30min  45min 1 hour 2hour **g = @~ @ |« #| 1mn Smn 10min 15min 20min 30min 45min  1hour 2hour =g = v @ ¢~ B
NGEH7 45m x | + & ™|[cLEHT 1h x | + = "
EHT7 - 45 min | CLEHT -1 hour |
? 'mma 1 Volume 1
| |
ﬂul ! \ * ! 5347
: D, ! 5320
i i J; 5316
i | | 1l
Jr fJ l ! H 53.00
r T’ Y b w | ﬂ T
! ! 5280
i ' lj.ﬂ'l |
1 e
i b W
! 5260
lﬁl f '
' i ™ n + H i 465K
[P ' ! ’DI D 't ﬁ ! an Link type is -
_ - — - — " T "Page" (all charts 37K
R | - - ! ; Current Replay Time i e a1 - ol : . on the page)
Jan-31 12:00 Feb-2017 12:00 Feb-02 | 12:00 Jan-31 12:00 3 12:00 i!
imin 5min 10min 15min 20min 30 min [45min| 1hour 2hour =g\ / = l#iv @ ||~ ] 1min Smin 10min 15min 2¢ Active Chart [chartto which [ '3 nour »=4 B ANVARE:
— the controls ie play, play Y,
O W > [0 m | B stat|ziz07  [@]|os0am @ Feb-019:44:59 next bar etc apply) > EPHT15m TickData @ & X
Ll Home Ll Replay X + s i Ny O

3.30 Alerts

Feb-06 11:02:30

Alerts are a useful way to receive a notification when a particular event has occurred. This could be as
simple as a price for a particular instrument has been reached or a trend line has been crossed. More
advanced examples include comparing values from different studies.

Active alerts can be managed centrally from the Alerts panel in the Console. By default, this is included
on the Home page. You can add an alerts panel anywhere in the console from the Add Tab button to

the right of any panel tab.

Alerts Panel

i, HNWWW‘#NM At ]
.
| ﬁﬂf'j '#ﬂ.'HG*H + , i simulated -
| o il ﬁ.
1 H o NIA  N/A
! D*l&ﬁnl*i . ﬁ*ln‘?TuH”f m*“‘!ﬂ““**m’ ¥ -
. : i : Active alert 6300 | Entry/Exit »
Motive! - - . ! , . . i : : on a chart
Jar| This tab_shows activated 1200 Feb-2017  12:0 Feb-02  12:00 14:00 Feb-03  12:00 14:00 Feb-06
1 min | 2lerts (history) min_ 30min  45min 1 hour| an Alerts panel can be |1 Week  2week 1month =4 = @ @ |4 B2
=nysEd / = NASDAQ(21) [T Alerts x | + E‘sdEd E”V‘“;"E'E from RN
Aleits (4) | History (1) Ll Charl : the New Tab button
= Watch List
Symbol 4 Replay Nan o= Depth OF Market Last Value Order Expires Activated Chart
AAPL N Price Crosses 127.15 D Time and Sales 130.21 e |
W, Order Table —
GE N Price Crosses Tenkan-Sen(s o o=l S0 2966 Click the Chart button [
BRK.B N Price Crosses 163.03 ®, Trade History Table 163.66 to show the chart that c|
MSFT N Price Crosses EMA(C,100) | -& Account Table 6344 Optionally, orders contains this alert |
& Si:wsner can be triggered
t} Optimizer The 'C' button will
7 Alert Tab[} cancel (delete) this alert
lml Home X il Charts  f8 Account  [& Scan  {lf Optimize News  + m O

Feb-06 11:26:29
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The simplest type of alert is a Price Alert. A price alert does not require a chart in order to execute. It
will triggered by the bid/ask or last price of an instrument. Price Alerts can be created directly from the

Alerts panel or from the Price Axis of a chart.

Create Price Alert — Alerts Panel

T, fud P e S o B e N I S VR
Feb-2017 %00 1400 Feb02  12:00 14:00 Feb03  12bo~ 1400 Feb06 4200 ifyoe—"""
1min 5min 10min  15min 20min 30 min 45min 1 hour =7 = v @ o~ #
= NYSE (35) = NASDAQ (21) [*% Alerts x | + Bl o

Alerts (3) | History (2)

Create Alert |

Symbol 4 Replay Name Last Value Order Expires rt
Click here to create S
AAPL N Price Crosses 127.15 130.12 a Price Alert e
BRK.B N  Price Crosses 163.04 16355 le|
MSFT N Price Crosses EMA(C,1 63.50 le|
Create Price Alert — Price Axis
Trade B 4
Order Bid/Ask

et e TR
E QD.ﬁD+I
I

£ Right click on the price axis
i “““““““““““““ 14 and choose Create Alert 8 Create Alert
o b v Cancel Alerts
| ] Add Guide

= T ]

% i Jd128 00 simulated -
: : i ! . N/A N/A
12:00 14:00 Feb-06 12:00 -
~—I5¢ 4 | Entry/Exit [ 2
i i NI NN VLS

I £

» 10 3=

Trade

The following dialog is shown when an alert is created from the Alerts panel. Alerts created from the
Price Axis are similar except for the ability to choose an instrument (this is assumed from the chart).

Create Alert Dialog

= Create Alert b e
et IR
Ch Symbol
Instrument 058 Symbe J
Symbol: | AAPL >
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 0 130.02 130.06 0 130.04
Parameters
Condition: | Price ~ || Crosses - 130.05 % Indicator
Trigger Multiple
e Label and comments will
Comments: | £ this is not checked, the be included if an email
alert will disappear after notification is sent
the first time it is triggered
Notificatiol
Show Alert: | Yes This section defines how a
notification is sent when
Play Sound: | Yes ~ [V Use Preset Sound the alert is triggered.
Sound File:
Send Email: | No >
CK || Save Defaults || Delete || Cancel
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Settings available in this panel are as follows:

1. Parameters
a. Condition — This defines the criteria for triggering the alert. The first field (input) can be
any of the ticker inputs (last price, bid/ask high/low etc). The last field can be an absolute
price. Alternatively, it could be a relative value (click the Indicator box) such as Last Price,
Best Bid or Best Ask. In the case of a Price Alert, this will be an absolute value in most
cases. Three types of operators are available for comparison:
i. Crosses — Input crosses above or below the second input
ii. Crosses Above — Triggers the alert only if it crosses above the second input
iii. Crosses Below — Triggers the alert only if it crosses below the second input
iv. Touches — Triggers an alert if the target value is touched or crossed
b. Trigger Multiple — If this option is checked, the alert will still be valid after it is first
triggered. In this case this alert will be triggered indefinitely until it is explicitly cancelled.
c. Label / Comments — These fields enable you to add your own text to an email notification
that is sent when the alert is triggered
2. Notification
a. Show Alert — If true the Alert History window will be displayed when the alert is triggered
b. Play Sound — A sound will be played when the alert is triggered. This can either be the
preset sound or a specific sound file that you can specify.
c. Send Email — If enabled (and email sending has been configured), an email will be sent to
the given email address when the alert is triggered.

3.30.2 Study Alerts

Alerts can be based on values that are generated as part of a study. These types of alerts execute in the
context of a chart and require the chart to be open in order to be active. Similar to a price alert, you can
create a study alert by right clicking on the vertical axis (of the Price Plot or a Study Plot) and choosing
Create Alert.

Create Study Alert
Atk A e e e, .
{M * T (63.14
E H63.00
ﬂ H6275

I 1 i I I i I 1 i I I I
;2:00' 14:00 Feb-02 12:00 14:00 Feb-03 12:00 14:00 Feb-06 12:00 14:00 16:00
1] Right click on the vertical
1| axis (of the price graph or

; i| a study plot) and choose

____________________________________________________________________

| Create Alert

i‘|‘|‘|‘l'"JJ"JJJ""JJJ'E"I'I'|'|'|'|""J"""""JJJJJJJJJJJJ

~ ﬁ Create Alert
£ Cancel Alerts
Add Guide
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Create Alert

fo:
m Advanced Trade

Parameters

Condition: | MACD(C,EMA,12,26) v || Crosses

Label: Contains available

study inputs from the
selected study plot

Comments:

Notification

Indicator

v 011714 3

If Indicator is checked, the
same set of study inputs
will be available for a
relative comparison

Show Alert: | Yes

Play Sound: | Yes ~ | |V/| Use Preset Sound
Sound File:

Send Email: | No v

Save Defaults

Delete

Cancel

Two types of comparisons can be made with a study alert:

1.
example)

Click on the Indicator field to enable a relative comparison.

Relative Comparison

Absolute Comparison — A study value is compared to a specific value (ie -0.1174 in the above

Relative Comparison — A study value is compared against another study value (in the same plot).

fc: Create Alert X
Advanced Trade
m Check Indicator Box
Parameters ;\
v
Condition: | MACD(C,EMA,12,26) *  Crosses - ’ MACD Signal(9) - ] v Indicator
Trigger Multiple MACD(C.EMA12,26)
Label: These are the values MACH Signal(9)
i from all studies within MACD Hist(12,26,9)
Comments:
the same plot. EMA(MACD(C,EMA.12,26),20)
Notification
Show Alert: | Yes =
Play Sound: | Yes ~ /| Use Preset Sound
Sound File:
Send Email: | No -
OK | Save Defaults = Delete | Cancel

The example below illustrates a study alert where the value of one study KAMA(C,20) crosses the value
of another study (Tenkan-Sen(9)). The alert is displayed where the intersection point would be between

these two values.
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Study Alert — Relative Comparison

st A b
T 1

Alert is aligned where
the intersection point
would be

Orange Line is

G line i
reen fing 1 Tenkan-Sen(9)

KAMA(20)

Double click to
edit the alert

3.30.3 Component Alerts

Some components can be used to generate alerts. For example, you could create an alert for when a
moving average crosses a trend line. If you would like to create this type of alert, right click on a trend

line and choose Create Alert.

Create Component Alert

Right click and choose :
Create Alert Edit

Format
Visibility

T2 Create Al
Show Infoet&
Show Angle
Relative End Point
Extend Cir+E
Extend Left
Ratios
Line

Properties
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Create Alert

73
m Advanced Trade

Parameters
Condition: Crosses * | Trend Line ~
Price
Bid
Label: Some components (such

S OTImen as Fork, Channel) have
Day High multiple options here.
Day Low

Notification Day Open
Day Close

Show Alert: 52 Week High

Play Sound: | 52 Week Low Preset Sound

Sound File: | KAMA(C.20) Study values can be

used here as well
Send Email: | No v

OK Save Defaults Delete Cancel

In the example below the study value KAMA(C,20) was chosen to cross the trend line. The alert label
shows the current crossing value. Press the ‘C’ button to cancel the alert. The alert may be edited by

double clicking the alert label or via right click and choosing Edit Alert.

Trend Line Alert

Y A W B

LI

Dotted line shows where
the current intersection

Al A AP P e,

Current crossing
value displayed here

i
[=1]
el
(5]
=

point would be

In this case a study
value was chosen.

i T

3.30.4 Trading From Alerts

Click here to
the alert

cancel

| I
P
o
=
(=]

Double click
label to edit

163.00

Trades can be placed when an alert triggers. Click on the Trade tab of the alert dialog to define an order

that will be placed when the alert is activated.
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Alert - Trade Options
o Edit Alert X

Alert  Advanced

v/| Place Trade on Alert Activated

Alternatively, choose a
different instrument

ymbol: | MSFT - || Q

Check this box to

Symbol Position Bid Size
place an order when

Size Last Price
FT 0 63.47 63.91 0 63.49

the alert is activated

| Buy || sen

Account: | simulated b

Quantity: =-

Type: Choose the order type _]

Expires: | MKT
LMT
Limit
Stop sTP Optionally, you can attach a limit
MIT (profit) and/or stop/trail order.
Trail | TRAIL

oK Save Defaults Delete Cancel

Orders can be placed on a different instrument from where the alert was triggered. Market, Limit and
stop orders are supported as order types. Optionally, you can attach a limit (profit) order and/or
stop/trail order.

3.30.5 Advanced Alert Settings
Additional options on an alert can be specified from the Advanced tab. This tab enables to you adjust
time times when the alert is applicable (or expires) and the display properties.

Alert — Advanced Settings
(o Edit Alert x

Alert Rl VElle="E Trade

Time In Force

Time Zone: ~ |V Use Defa
:! Sets an expiration date/time 1
Expires: 2/7/2017 ® (2:00PM |(©| V| Enabl

Session 1: Start: 9:00 AM ©| End: 4:00 PM ®| |V Enabled

Session 2: Start: @ End: 0] Enabled
Display [\

Alert Align: | Right  ~

Use these to specify
/| Show Cancel Btn times of the day when

the alert is active.
v'| Show Label

v'| Show Line

OK Save Defaults Delete Cancel

Time In Force

The Time In Force section allows you to set an expiry date/time for an alert and optionally define times
of the day when the alert is active.
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1. Time Zone — The dates and times specified in this section will use the same time zone defined for
the chart. This may optionally be overridden by unchecking the Use Default box.
2. Expires — Check the Enabled field to the right to specify a date/time when the alert will expire

and be removed.

3. Session 1 - Defines a time of the day when the alert will be active
4. Session 2 — Define a secondary time of the day when the alert will be active.

Display

The Display section allows you to override default display attributes for the alert.

3.30.6 Alert History

The Alert History window displays alerts that have been triggered in the past. Choose View -> Display ->
Alert History Window from the top menu bar. If the chart where they were activated is still available, a
Chart button will be available to view the chart that they originated from.

Show Alert History Window

~ MotiveWave - Console (google) o T 2
File Edit | View | Study Strategy Format Configure Window  Help
AAPL M Link W @ v 4+ ™ I &2~ |15min - LI
Ll AAPL 15m » Display ’ 3¢ Components Alt+C @ 4= = ¢
: Components Alt+C <& Trade Panel Alt+T ! )
- o ! 130.4
AAPL - 15 mig = Semi-Log Scale i D 'l'!
= _ :
73 Replay Mode iii DOM Panel ! + - 130.19
£ Cursor Data Alt+D ) Time & Sales Panel i s e 1 130'0[):]'
[ _\E in?pA\?‘u’are Points Eg News Headlines i H Note: The Alert History Window will | [17
v - L‘:l:c?( S:?o:;ze News.\.f'lewer display when an alert is triggered,
' . v Eljr;lr Size Se'_e':tor provided "Show Alert” is set to Yes b
44 Lock Studies Vv @ Bird's Eye View 4129.50
* - Gmu? Studies £ Cursor Data Window ]
‘ I AL Show Volume B study Log 5
@ Increase Hide Below Degree  Cirl+t o Object Viewer Alt+V ]
@ Decrease Hide Below Degree Ctri+] ™ Alert History Window Choose View -> Display H129.00
T Reset Vertical Spacing B Show Alert Hist&y -> Alert History Window £128.90)
v il Show Extended Data v 4% Show Analysis DD : 1
C' Clear Local Data W Show Commentary q i H128.50
v - Show Tabs V .4 Show Trend Lines i 1
wy Compact Frly Menu Bar i
e ALl N G . Do Py S SN VPSP S
Alert History Window
s Alert History x
The following alert(s) have been triggered. Press Close to cancel this dialog
Symbol Bar Size Replay Signal Name Last Value Order Activatedv Chart +
BRK.B 15 min N Trend Line  Price Crosses 163.12 13:18:43
GE 15 min N Price Crosses 29.65 1126237
MSFT 15 min N Price Crosses 63.41 11:25:03

This will clear all alert
history from the workspace

This button will show
the chart where the
alert was triggered

\/
A4
Clear History

Historical alerts are also visible directly on the chart. Icons are displayed when and where (what price)
and alert occurred. If you place the mouse cursor over one of the alarm clock icons, you can view

detailed information.

Version 5.0 ©2019 MotiveWave™ Software

Page 143 of 212



MotiveWave™

User’'s Guide antive aveﬁ

Historical Alerts on the Chart

A

These icons
indicate where
an alert occurred

‘l}
:
|
!

[ -)| Price Crosses 163.14

k Activated: 13:15:43
Last Value: 163.12
Bar Size: 15 min
Signal: Trend Line

um]U'iT

ilnaanfin]

Hover of the alert to show
detailed information

ol T o T

A-00

Alert history can also be found under the History tab of the Alerts panel (in the Console):

Click on History tab

A e,

At iy,

o a i rCt s

= NYSE (35) |/ = NASDAQ (21)  [F Alerts x | + (Bl & o 7
Alerts (1) | History (3) |
Symbol & Bar Size Replay Signal Name Last Value Order Activated Chart

BRK.B 15 min N Trend Line Price Crosses 163.14 163.12 13:18:43
GE 15 min N Price Crosses Tenkan-Sen(9 29.65 11:26:37
MSFT 15 min N Price Crosses EMA(C,20) 63.41 11.25:03

lml Home % Ll Charts 8 Account |20 Scan  {}f Optimize News =+

i N

Feb-06 14:32:36

3.30.7 Alert Preferences

Global alert preferences can be configured in the Preferences dialog (Configure -> Preferences from the

Console menu bar). The alert preferences will be found under the Alerts tab (see below).

Alert Preferences

{3 Preferences

General Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Email

X

-

The following fields allow you to configure preferences for Alerts.

Display

AleitAlign: | Right =
v'| Show Buttons |v/'| Show Labels v Show Lines

v/| Show Alert |v/| Play Sound Send Email |v/| Attach Image Default
notifications
Other

Show a triggerad
Max Alert History: (Days)” alert on the chart.

v'| Show Alert History (on Chart)

V| Alert Order Warning Show a warning if closing a

V| Alert Deactivate Waming chart that has active alerts.

v'| Show Warning on Clear Alert History
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3.31 Ticker Tape

Ticker tape displays a rolling set of prices for a selected set of instruments across the top of the Console,

Desktop or Chart Window. This option can be turned on by choosing View -> Display -> Ticker Tape from
the top menu bar.

Show/Hide Ticker Tape

motivewave'

&~ MotiveWave - Console (google) 2 - S X
File Edit | View | Study Strategy Format Configure  Window  Help
BRK.B v Link » WY @ I~ + [T T | R |[15mn ¥ 44 >
BAC 2311 44 % Display ’ 2£ Components Alt+C  1.02% DIS 109.46 4-0.76% EBAY 32.01 4-0.19% F 12.48 $-0.64
y Components Alt+C ¢& Trade Panel Alt+T [ E
&l AAPL 15 A Ed
I—'—m_ = Semi-Log Scale /\ =N
BRK.B-15mil & Replay Mode il DOM Panel Ticker Tape 165.00
velume & Cursor Data Alt+D D Time & Sales Panel : ]
¥ Snap Wave Points F5 News Headlines i 1
#{ Auto Analyze Fé News Viewer :
v " Lock Scroll v Bar Size Selector | soann
. ) ; 163.93)
¢D ¢ Lock Studies @ Bird's Eye View T*iﬂ“"miﬂ ﬁ++[|+ 4
4 []‘ [JI]“"Tl [ Group Studies . o TI M
54 Hl’I]THJ & Cursor Data Window 4 ™, e
v Il Show Volume B study Log I 1
@& Increase Hide Below Degree  Ciri+1 & Object Viewer AltsV : 12213]
@& Decrease Hide Below Degree Ctrl+] ™ Alert History Window H
o T Reset Vertical Spacing v £ Show Alert History i I : ]
mw@nnﬂﬂ V ik Show Extended Data v &% Show Analysis |ﬂ”|l|[|ll.nln|pnnﬁll BT — , 125K
1200 1 (' Clear Local Data / W Show Commentary 1200 1400 Feb-06 1200 1400 16:00 1800
1min 5min| v M Show Tabs V .4 Show Trend Lines 1week 2week 1 month =4 = v @ |¢|> B
- &% Compact F7 |/ MenuBar i : 3
= NYSE (35) = NASUAW(ZT) [FETARIS X T 7 ool Bar in [ "
Alerts (1) | History (3) | 4 Status Bar Cl:wose Vle\nfr ->
) Display -> Ticker Tape
Symbol a Bar Size Replay Signal v Tlckerh‘rape J  Activated Chart
R R i P G e P T e Rt i e A

The instruments and display of the ticker tape can be configured from the Preferences dialog (Configure
-> Preferences from the Console menu bar). Click on the General tab, then on the Ticker Tape sub tab.
This panel has the following options:

1. Instruments — Instruments may be added or removed by using the tool bar at the top of the list
box on the left

o Uk wnN

Font — Font size for the instruments displayed on the ticker tape section
Scroll Speed — Relative speed for scrolling the instruments

Show Ticker Tape — Default for displaying the ticker tape in a chart window
Show Change — Shows the change since the day open
Show Change % - Shows the change since the day open as a percent
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o

EEEEE] treme Chart ToolBar Sounds Ratios Ellott Wave Gartley Tick Charts_Orders _Alerts Email (=

Preferences

X

General Keyboard Mouse Fonts Quick Search [EEeCI@EWEE Linking Dock Trading Hours Simulated Accol (=

This panel allows you to configure the instruments that are displayed in the ticker tape panel as well as other display settings.

-Choase Symbol- > Q! B

AAPL - Apple Inc

AEOQ - American Eagle Outfitters
AMZN - Amazon.com Inc

AXP - American Express

BAC - Bank Of America Corp

Use these buttons to
add/remove instruments

BTU - Peabody Energy

C - Citigroup Inc

CAT - Caterpillar Inc

CSX - CSX Corporation

DE - Deere Co.

DIS - Walt Disney Company
EBAY - eBay Inc

F - Ford Motor Company

FDX - Fed Ex

GE - General Electric

GS - Goldman Sachs

HAL - Halliburton

HD - Home Depot

HMC - Honda Motor Co Ltd

HPQ - Hewlett-Packard Co

IBM - International Business Machines

FCX - Freeport-MchoRan Copper & Gold Inc.

Total Instruments: 37

OK

Apply

Cancel

Font:

Scroll Speed:

Arial;14.0
Medium -
| Show Ticker Tape
Show Change
v Show Change %

3.32 Short Cuts

MotiveWave™ provides a number of convenient ways to do common tasks quicker. This section
explores some of these options.

3.32.1 Menu Short Cut Keys

You may have noticed already that when displaying a menu, a key combination is displayed on the right
hand side for some of the items in that menu. This key combination may be used as a short cut to
access that item without using the mouse to show the menu and select the item.

In the example displayed below, the short cut keystroke for accessing the Line tool is: Ctrl + Shirt + L.
This means that you can hold down on the Ctrl (Control key), Shift and press the L key on the keyboard
(all at the same time) to switch your mouse tool to the line tool. You may find this to be much faster
than using the mouse to select the tools drop down and choose the line tool menu item.
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(Y MotiveWave - Console (google)

File Edit View Study Strategy Format Configure Window Help

AAPL ~QE &R @ K& i~ + [T 2~[15mn -

sl AAPL 15m X | Ll MSFT 15m* [l BRK.B 15m* i k- Select Cirl+Shift+5

AAPL - 15 i ; v ¥ Drag Cirl+Shift+D ; n
; @_ Zoom Ctrl+ShiftsZ ; Dl D ]
| % No Tool Ctri+Shift+Y ; Q ‘[]“'. It LB
i T Text Cirl+Shift+T i T

Q D ! | Ruler Ctri+Shift+U H

| *\, Line Ctrl+Shift+L
| & Eraser Ciri+Shift+E Short Cut Keystroke

* _I_ Regression N

‘ Fibonacci N

: Elliott Wave 8
i Gartley 8 J‘*D

44 channe Cil+ShiftzC 1

I
|
L e

Please Note: by convention tool short cuts all have the sequence Ctrl + Shift + <key>. This makes it

easier to remember them.

3.32.1.1 Custom Keyboard Sh

ort Cuts

Keyboard short cuts can be customized in the Preferences dialog (Configure -> Preferences from the
Console menu bar). Start by unchecking the Use Default option. With this option unchecked, you can
double click on any of the actions (or select and press the edit button) to assign a keyboard short cut.

Custom Keyboard Short Cuts

o]

Preferences

EEEEE] meme Chant ToolBar Sounds Ratios Elliott Wave Gartiey Tick Charts _Orders _Alerts _Email

X

-

General IGLEGN Mouse Fonts Quick Search Ticker Tape Linking Dock Trading Hours  Simulated Accol (=

This panel allows you to configure ¢
to assign/remove a keyboard short

v/ Use Defaults

5 for commonly used features.

Uncheck to modify
keyboard short cuts

Action Shortcut
W/ 3 Drives Mouse Tool Ctri+Shift+3 [ ]
W/ 5-0 Mouse Tool Ctri+Shift+5
\/\ AB=CD Mouse Tool Ctri+Shift+=
<& Active Tickers
|4 Add Strategy
[4a Add Study Ctri+T
I Alert History Window
A, Alternate AB=CD Mouse Tool
M Alternate Bat Mouse Tool Double click on an
Always On Top action to assign a
/E Annotation Mouse Tool keyboard short cut
|&#+ Apply Template 1 Alt+1
|& Apply Template 2 Alt+2
[#: Apply Template 3 Alt+3
|& Apply Template 4 Alt+4
|&#+ Apply Template 5 Alt+5
[## Apply Template 6 Alt+6
|&#+ Apply Template 7 Alt+7
l# Apnlv Temnlate & Alt+8
OK || Apply || Cancel

Double click on an action below

From the Edit Shortcut dialog, simply press down on the key sequence that you would like to assign to
the action. The key sequence will appear in the grey box (see below).
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Edit Shortcut Dialog
' Edit Shortcut X

Type the keyboard shortcut or press the delete button to clear
the current shortcut for the selected action.

A Annotation Mouse Tool: Cirl+Shifi+L X

OK Cancel

Press down on
keyboard keys to
assign a short cut

3.32.2 Mouse Wheel

If your mouse has a wheel, you can use this to perform the following actions on the chart:

1. Time Shift — Move the graph to the left or right (depending on wheel direction)

2. Adjust Bar Width — This will effectively zoom the graph in or out
3. Adjust Vertical Space — Changes the space available at the top or bottom of the graph

The default action for the mouse wheel is to time shift when it is moved back or forward. If you hold
down on the Alt key and move the mouse wheel, it will adjust the bar width (ie zoom in or out).

This behavior can be adjusted from the Preferences dialog (Configure -> Preferences from the Console
menu bar). Click on the General tab, then on the Mouse sub tab.

Mouse Wheel Preferences

[ o) Preferences X

Tneme Chart ToolBar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email >

General Keynoardmlfonts Quick Search Ticker Tape Linking Dock Trading Hours Simulated Accol (=

You can configure the mouse wheel to do one of the following (Note: Alt Wheel Action is the using the mouse wheel while
pressing the Alt key):

- Time Shift - Moves the time period. (Hint: use the Ctrl & Shift keys to change the scrolling speed)
- Bar Width - Changes the width of the price bars.

- Vertical Spacing - Adds/removes space from the top and bottom of the graph.

Wheel Action”  Time Shift - Invert Reverse the behavior based
on the wheel direction
Alt Wheel Action:  Bar Width - Invert

Disable Mouse [{heel

This is the action
performed when the Alt

key is pressed while
moving the wheel.

OK || Apply Cancel

3.32.3 Mouse Click Options

Keyboard modifiers: Shift, Ctrl and Ctrl + Alt when used with a left mouse click can be configured to do
specific actions. The default behavior is as follows:
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Shift + Click — Creates Text Comment. When you perform this short cut an entry box will appear
for you to enter text. Just type your comment and press Enter (or Esc) to create it.

Ctrl + Click — Creates a Price Guide at the location of the mouse.

Ctrl + Alt + Click — Creates a Time Guide at the location of the mouse.

These actions may be configured from the Preferences dialog (Configure -> Preferences from the
Console menu bar). Click on the Chart tab then on the Chart Settings sub tab. The following actions are
available to choose from for each click shortcut:

=

©oNOUAWN

Price Guide — Creates a price guide at the mouse location

Horizontal Line — Creates a horizontal line at the mouse location (extended left and right)

Time Guide — Creates a time guide at the mouse location

Vertical Line — Creates a vertical line (extended up and down) at the mouse location

Text — Creates a text box to enter text

Note — Creates a Note component

Box Callout — Creates a Box Callout component
Balloon Callout — Creates a Balloon Callout component
Line Callout — Creates a Line Callout component

10 Annotation — Creates an Annotation component
11. Curly Annotation — Creates a Curly Annotation component

Mouse Click Shortcuts

o] Preferences

General Theme EeEGM Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts  Orders  Alerts  Email

X

-

(eEhasicinhvil Indicators Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for charts.

Vertical Line
Text

Note

Box Callout

Balloon Callout

OK || Apply Cancel

Line Callout

Default Tool: | & ~ Max Linear Bars: 25000
Revert to Default Tool: v/ Max Non Linear Bars: 15000 &
BarType: | 0 ~ Minimum Bars:
Bar Scheme: | Normal - Popup Delay (seconds): v/ Enabled
BarSize: 15min  ~ Bar Width (Pixels):
Bar Thickness: | — 10 ~ Price Axis Spacing:
Axis Style: | Inside v Time Axis Spacing:
Shade: | None - Top Inset (pixels): 5%
Shift + Click: | Text o Bottom Inset (pixels): 5%
Ctrl + Click: | Price Guide > Mouse Click Bars: %
Cirl + Alt + Click: Short Cuts — feyg).
Line Method: | NO ACtiOn Study Layout: | Horizontal —~
Price Guide
Fill Area: Time Zone:
Harizontal Line
v/| Use Default

Calendar Days

3.32.4 Other Shortcuts

The following are some other shortcuts that you may find useful.

Ctrl + Mouse Drag (Copy)
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Hold down on the Ctrl key and drag a component to create a copy of it. This can be very useful for
example to create a line that is parallel to another line. The mouse cursor will change to the following to

+§+
indicate that you are creating a copy:

-
—
=
—
—o

T VWV Y SNV S

.

Copy Line

15.08
1005 min

15.08 |

I R R I P P

Hold down on the Ctrl 1
key and drag the line o wl h HTJ’“ ‘L
to make a copy \m‘uﬂu *[Jl] ‘ *

U'“]ﬁﬂ

M&ﬁ

[
T**$,1D

£

Revert To Default Tool (Space Bar)

When switching to a mouse tool, you can quickly switch back to the default mouse tool (Time Drag Tool)
by pressing the Space Bar. This can be more convenient than pressing Ctrl + Shift + D. Alternatively,
you can change the behavior of the mouse tools to automatically revert to the default tool when an
action is completed. This can be adjusted from the Preferences Dialog. Click on the Chart tab then on
the Chart Settings tab.

Default Mouse Tool

&3 Preferences

General_Tneme [JEEIH] ToolBar Sounds Ratios Elliott Wave Gartiey Tick Charts _Orders _Aleits _Email

X

(¢ELRTINIEN Indicators Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default seftings for charts
Default Tool. = ¥ ~ DE{abUIt mta;:se tool X Linear Bars: 25000 3
can be se ere
Revert to Default Tool | V' ~ axTvon Linear Bars: 15000 3

Bar Type I Check this option to imum Bars:
revert to the default
Bar Scheme:  Normal mouse tool after an v (seconds): | Enabled
Barsize. 15min - | ctionis completed gy opergy
Bar Thickness: — 10 - Price Axis Spacing:
Axis Style: | Inside  ~ Time Axis Spacing:
Shade: None - Top Inset (pixels)
Shift + Click. | Text - Bottom Inset (pixels)
Cirl + Click: | Price Guide - Display Bars %
Cirl + Al + Click. | Time Guide - Study Height (pixels)

Line Method: = Time/Price v Study Layout: | Horizontal

Fill Area: Time Zone:

Fill Alpha; 25 ¢ V| Use Default

Calendar Days

OK || Apply | Cancel
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4 Trading

There are lots of ways to place and manage trades within MotiveWave™. In this section will explore
some of the convenient features for dealing with orders, positions and trades. Some of the trading
features such as supported order types may vary depending on the broker you have chosen for the
workspace.

4.1 Account Management

The Account page in the console provides a convenient view of current account information as well as
open orders, positions and historical trades. The columns displayed in each section will vary depending
on the broker or data service that you chose for your workspace.

Account Page

~ MotiveWave - Console (fx2) 2 - S x

File View Configure Window Help Active Accounts

=>4 |25 QF B » |8 Accounts (2) x,|4/ Z e
d Default Account Curre... Balance Equity Unrealized PL  Session PL Total PL Day PIL Usd Mr Usbl Mr Usbl Mr¥e GpissPIL  *
N Simulated usD 99,640 41 i

N 05434250  AUD 5,364.64 6,384.77 120.00 626477 9842% i

B

Rs:-082 | 101 | RE:027

oss0z7 035631

Use these buttons to
manually refresh the

g L") Red data from the broker
Open Orders
o N ]

-~

™ Orders (4) X | + + %,

£

Rs-032 [ 013 | RE:0.08 Account Ticket Symbol Order Date  Expires Action Quantity Type Price Stop/Trail Stop PIL Limit  Limit P/L Fill Price\ Filled Status Grouj *
05434250 70419087 SPX500 154613 GTC 1T 22893 c

05434250 70419088 USDICAD 154626  GTC 10K LMT 131085 c

05434250 70419100  EURUSD 154818  GTC 10K LMT 107742 100 100 RS c

0543425070419094  AUDIUSD 154743  GTC 10K LMT 076546 ETXY X 13.05] 10.0 c

Attached Orders
Historical Trades
[y,

11 Positions X | ® Trades (88)  + +z .

Open Positions (8)| Summary Closed Positions

¢ ount Ticket Symbol Quantity Entry Price StopiTrail Stop PIL Limit Limit PIL Unrizd P&L Pips Roll Last Price Open Time Close & +
. -2 EUR/JPY 10K 128 362 - -8278 0.000 25-Jan-16 10:41:44
Open Positions
-7 SPX500 1 22768 13.8 0.0 Feb-02 13:29:32

05434250 24732295 USD/CAD 10K 1.28506 2344 726 0.00000 04-Jul-16 15:55:29
05434250 25025990 SPX500 1 21296 161.0 -31.39 0.0 13-Sep-16 10:58:13
05434250 25025991 1 21296 161.0 -31.39 0.0 13-Sep-16 10:58:13
05434250 25025992 | Click here to show the 1 21296 161.0 -31.39 0.0 13-Sep-16 10:58:13
05434250 24948889 Account page 1 21856 105.0 -35.15 0.0 23-Aug-16 22:42:58
05434250 28092818 1 22763 143 112 0.0 Feb-02 13:30:20
\ 292.85 1232
Ll Home il Charts @ Account X [ Scan  {lf Optimize ~ + m N O

Feb-06 15:51:05

This is the default layout for the Account page. You can add these panels anywhere within the Console
or Desktop. Simply click on the Add Tab button (Plus Icon) next to the existing tab where you want to
add the panel.
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Add Account Panel

S NYSE (35) S NASDAQ(21) ™% Alerts| ik add —+ }
Account Ticket 0| Tab Button L \(,:Vh?”h Lt Time Action Quantity Avg Price

= wvalcn LIS

Simulated SiM-12 SIM-13 DICAL [ Depth Of Market 16-Jun-16 9:11:02 SLD 30K 1.30

Simulated SIM-T SIM-11 USD/CAp={D-Tima-and.Salas £ lundg 440007 10 20K 1.28!
| |

Simulated SiM-12 SIM-11 uSDICAf| T OrderTable [, Choose one of these to add 10K 1.28
11 Position Table QOrder, Positions, Trades or an

Simulated SIM-7 SIM-8 USD/CA ®, Trade History Table Accou’ntPanel ’ 10K 1.2

Simulated SiM-4 SIM-7 USDICA!] -4 Account Table 10K 1.32

Simulated SIn-4 SIM-6 USD/CAC o= 09-Mar-16 15:41:03 BOT 10K 1.32
|&2 Scanner

Simulated SiM-4 SIM-5 USDICAL 4t optimizer 08-Mar-16 14:41:48 SLD 10K 1.33

Simulated SiIM-2 SIM-3 EUR/JPY T3 Alert Table 02-Feb-16 14:43.05 SLD 10K 131,

Simulated Sin-2 Sim-1 EUR/JPY 25-Jan-16 10:41:44 BOT 10K 128

05434250 24732295 64278443 USDICAD 04-Jul-16 15:55:29 BOT 10K 1.28

e A

4.1.1 Account Panel

The Account panel displays information about each available account in your workspace. The columns
displayed will differ depending on the broker that you chose for your workspace. The Unrealized PL
column is common to all brokers and displays the current unrealized profit/loss for all positions that
belong to each account.

Accounts Panel

2 Accounts (2) X | + =
Default Account Curre... Balance Equity Unrealized PL Total PL Day PIL Usd Mr Usbl Mr Usbl Mr#t  Gross PIL Hedging & *

-T28.62 -359.59

1,025.96

Y Simulated usD 99,640.41

e Set As Default Account

120.00 98.12% 1,0
Click here to choose

columns to display

6,390.60 6,270.60

Summary of unrealized
profit/loss for open
positions for each account

Right click and choose
Set As Default Account

Available columns will depend
on the broker(s) chosen for
the workspace.

The Default column indicates which account is the default for placing orders. You can change the
primary account by right clicking on the desired account and choosing Set As Default Account. This
setting is important to avoid accidentally placing orders on the wrong account.

Default Account

5 - - -
!5 EUR/USD - Primary Analysis - 15 min B P
Format  Window  Help
| [ W 2w~ & v My + "8 T 2~][15min - | »
Trade x
} --------------------------------------------------------- -STP 10k@-10.0 (S gl m Order BidiAsk
i H1.07800
] Buy Mkt
_______________________________________________________ T — | sei wic |
—:1.0??00 ="
2— ————————————————————————————————————————————————————————— LMT 10K@10.0 St | Eancel AN |
i 1.07600
{ ; simulated
{ _I_ Default account is the
i * default in all account drop 4 B
i Jf'+ T downs for placing orders | ER FXCM - 05434250 »
4
orerd ()
! by T
A g o e o Pl

Version 5.0 ©2019 MotiveWave™ Software Page 152 of 212



MotiveWave ™ mOtive Ja ve@.

User's Guide

4.1.2 Orders Panel

The Orders panel displays the currently active orders in one convenient location. The Group column
indicates orders that are linked as either OCO (One Cancels Other) or OSO (One Submits Other). The
Status column displays the current order status (green for active). Click on the ‘C’ to cancel an active
order.

Orders Panel

Click here to refresh
orders from the broker

W, Orders (4) % | + Click here to

create an order
Acco... Ticket Symbol Order Date Expires Action Quan... Type Price  Stop/Tr... Stop.. Limit Limit
0543425(70419087 ~ SPX500 1546713 GIC 1 LMT 22893 -
Group color indicates
0543425(70419088  USDICAD  15:46:26 GTC 10K LMT  1.31085 linked orders
0543425(70419100  EURIUSD 1548118  GTC 10K LMT 107742 -100 100 [l
0543425(70419094  AUDIUSD  15:47:43  GTC 10K LMT 076546  -10.0 10.0 [ Click 'C' to

cancel an order

Click on a
cell to edit

Color indicates order
status. Hover over
for explanation

Orders can be edited from here directly by clicking on the appropriate table cell (see below). If an order
has outstanding changes, the status column will change to show a ‘T" and a ‘D’. Click on the ‘T’ to
transmit (submit) the changes to the broker or on ‘D’ to discard the changes.

Edit Order

W, Orders (4) x | +
Acco... Ticket Symbol Order Date Expires Action Quan... Type Price  Stop/Tr.. Stop.. Limit Limit..

0543425(70419087  SPX500 1546113  GTC 1 LMT 22893
0543425(70419088  USDICAD  15:4626  GTC 1.31085
0543425(70419100 1.07742
0543425(70419094 0.76546

Click on these cells
to edit the values

Alternatively, right click an order to see additional options. Double clicking on an order will show the
Order Ticket dialog.

Fill Pr.. Filled Status Groug*

Click on a
 cell to edit

Press 'T' to transmit order,
'D' to discard changes

Orders Panel Options

= Orders (4) X | +
Acco..  Ticket Symbol Order Date Expires Action Quan.. Type  Price Stop/Tr.. Stop.. Limit  Limit...

- LMT 2289.3
1.31085
1.07742
0.76546

Fill Pr... Filled Status Groug*
C

05434251 701002 r
0543425(7( Right click 3ncel Order
0543425(7( °" °Ter Cancel Al SELL
0543425(70419094 AUDIU Cancel All for Instrument

Open Chart Tab

Open Chart Window

Open DOM Window

Edit Instrument

- -** Order Ticket

This option will
cancel all
active orders

Double click on an
order row to show the
Order Ticket Dialog

(eI e T ]
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4.1.3 Positions Panel

The Positions panel shows the currently open positions (and closed for some brokers). Individual
positions can be closed (at market price) by clicking on the Close button (right hand side). If you would

like to close all positions, right click on a position and choose Close All Positions.
Click here to
refresh positions :
+ A

~ v
Click here to add
positions that are outside
Account Ticket symbol  Quantity ~Entry Price  Stop/Trail  Stop PIL Limit LimitPIL  UnfizdP&L  Pips  Roll  Las| o the broker account

EURIPY 10K 128.382 -829.4

SPX Edit Position
%2 X Delete Position 26506
+ Add Position 21296
Close Now 21296

Close All Positions

05434250 25025992 SPX501 Open Chart Tab 21296

05434250 24948889 SPX501 Open Chart Window 2185.6

05434250 28092818 spxsoi  Open DOM Window 2575 3
Edit Instrument

Positions Panel

11 Posilions x | ® Trades (68)  +
Open Posilions (8)| Summary Closed Positions

Close 4 *

Simulated SiM-2

SIM-7

Simulated

2297 726
31.39
31.29
1615 -31.39
1055 -3515
14.8 -1.12

Actual columns available will
depend on the broker(s)
configured for the workspace

Click on "Close" to close
individual positions at
market price

Total unrealized P/L
for all positions

- 290.94 -123.2

If you have enabled the simulated account, you can add positions manually by clicking the Add Position
(Plus Icon) button on the top right corner of the panel. This is a useful feature if you would like to track
positions that are managed outside of the broker or data service that you are using. The following
diagram shows the Add Position dialog. It has the following fields:

1. Instrument — select the symbol for the instrument

Opened Date — This is when the position was originally opened
Quantity — Number of shares, contracts etc

Avg Price — Average entry price for the position

Commission — Optionally enter a commission to track fees.

vk wnN

Add Position Dialog

+ Add Position 4

Use this dialog to aq Choose an
Account. This feat| Instrument

sition to the Simulated
I to monitor existing

positions that you h nal broker.
Instrument: | [E[SlelElN - Q
Opened Date: 2017-02-06 17:14 ]

quanty: 10 5]= X
Avg Price: 82162 = Enter quantity
. and average
Commission: :
purchase price

OK Cancel

For some brokers (such as FXCM) they provide a bit more information on position such as the recently
closed positions. Specifically for FXCM hedging accounts, a summary tab is included to roll up individual
position totals.
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Current Open
Positions

Recently Closed

Open Positions

motiveulave

Note: Available columns and options
ilable will depend on the broker(s) that

X TTades (72) + Positions you have chosen for your workspace. + 2.
Open Positions (10) | Summary Closed Positions (1)41—

Account  Ticke Entry Price  Stop/Trail | Stop PIL Limit LimitP/L  Unrizd PE&L  Pips  Roll  LastPrice Open Time Close a *
Simulated  SIM-2| Summary of Positions K 128.382 0.000 25-Jan-16 10:41:44 Close
Simulated  SIM-7| (if multiple per 1 2276.8 00 Feb-0213:29:32 OGS
05431250 zs10a| nStrumentis allowed) ) 131085 0.00000 0:10:11 (el
05434250 24732295 USDICAD 10K 1.28506 3217 7.30 0.00000 04-Jul-16 15:55:29 [EEIRES
05434250 25025990 SPX500 1 21296 167.2 3162 0.0 13-5ep-16 10:558:13 (IO
05434250 25025991 SPX500 1 21296 Double click on these cells 167.2 3162 0.0 13-Sep-16 10:58:13 [JSINES
05434250 25025992 SPX500 1 21296 to add stop and/or limit 1672 3162 0.0 13-5ep-16 10:56:13 [IENEE
05434250 24948889 SPX500 1 21856 orders to these positions 1112 35.38 0.0 23-Aug-16 22:42:58 (WAL

37038 1243

Summary Positions

If multiple positions per
instruments are allowed, this tab
will roll them up into a single
summary row for each instrument

11 Positions x | ® Trades (72)  + + 2.7
Open Positions (10) | Summary | Closed Positions (1)

Account Symbol SellP/IL Sell Pips Sell Amt Avg Sell Close Buy Close Sell AvgBuy Buy Amt BuyPIL Buy Pips PIL Pips Roll  Closea *
Simulated EUR/JPY 0 0.000 0.000 120.023  128.382
Simulated SPX500 0.0 0.0 2297.3 2276.8
05434250 USDICAD -56.8 10K 1.31085 1.31659 1.31640 1.28506
05434250 SPX500 nn 0.0 22973 21899

-57.34 434.81 377.47 -124.3
Closed Positions
1) Positions x | ® Trades (72)  + + Z .7
Open Positions (10) Summary | Closed Positions (1) |
Account Ticket Symbol Quantity  Open Price Close Price PIL Pips Open Time Close Time Roll  Commission 4 *
05434250 28103128 AUD/USD 10K 0.76546 0.76431 SERE] -11.5 Feb-06 18:03:32 Feb-06 19:04:30 0
Realized P/L
15.05 0.0

4.1.4 Trades Panel

The Trades panel displays historical trades (ie filled orders). Columns displayed on this page will vary
depending on the broker chosen for the workspace. Some brokers only report a limited number of
historical trades. For this reason, you should rely on the account management tools provided by your
broker to ensure accurate reporting of historical trades.

Trades Panel

11 Positions | ® Trades (72) x | + R
Account Ticket Order ID Symbol Time Action Quantity .ﬁ\'g Price PIL Commissiona *
Simulated  SIM-12 SIM-13 USDICAD 16-Jun-16 9:11:02 SLD 30K 1.30305 0
Simulated  SIM-T SIM-11 USDICAD 15-Jun-16 11:28:27 SLD 20K 1.28998 0
Simulated  SIM-12 SIM-11 USDICAD 15.Iun-16 112827 SLD 10K 128998 0
simulated  SIM-T SIM-53 USDICA] Columns displayed here will 126 SLD 10K 1.29099 0
Simulated SIM-4 SIM-7 USD/CAl vary depending on the broker Ba:56 SLD 10K 1.32151 0
Simulated  SIM-4 SIM-6 usDica chosen for the workspace. 41:03 BOT 10K 1.32447 0
Simulated  SIM-4 SIM-5 USDICAD 08-Mar-16 14.41:43 SLD 10K 1.33993 0
Simulated  SIM-2 SIM-3 EURIPY 02-Feb-16 14:43.05 SLD 10K 131.121 0
Simulated  SIM-2 SIM-1 EURIJPY 25-Jan-16 10:41:44 BOT 10K 128.382 0
05434250 28103125 70419088 USD/CAD Feb-07 0:10:11 SLD 10K 1.31085 0
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4.2 Simulated Account

For convenience, MotiveWave™ has a built in simulated account that you can use to practice your
trading. If you chose a data service for your workspace, then this account will be enabled by default. If
you are using a broker, it is recommended that you use a demo account if provided by your broker
instead. Broker demo accounts will provide a better simulation of their trading environment and
supported order types and behaviors.

The simulated account can be configured from the Preferences dialog (Configure -> Preferences from
the Console menu bar). Click on the General tab then on the Simulated Account tab. This panel has the

following fields:

1. Enabled -

Check this box to enable or disable this account

2. Base Currency — Base currency for the account

3. Case Balance — Initial Cash Balance

4. Fill Immediate — If checked market orders will be filled immediately at the current bid/ask value
instead of waiting for the next trade

b

Include Commission — If checked, commissions will be included when placing trades.

6. Reset Account — Click this button to reset the account back to the initial cash balance.

Simulated Account Preferences

Lo Preferences X

Tneme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts  Email =

mneral Keyboard Mouse Fonts Quick Search Ticker Tape Linking Dock Trading Hours BSInUEIGHETGIILIE

The Simulated Account is 7 :
When placing orders agaill check this box to |
Enabled: v enable this account

Base Cumency: USD -

Cash Balance: 9964041 5

v Fill Immediate

hat locally tracks orders, positions and trades against a virtual 'account’.
| information is transmitted to your broker.

/| Include Commission

Reset Account

OK || Apply Cancel

If you have the simulated account enabled, you will see an entry in the Accounts panel for this account.
The account id will be ‘Simulated’.
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Simulated Account

(&}
K

8 Accounts (1) x | +

Default Account Currency Balance Unrealized PL Session PL Total PL & *
hd Simulated usD 100,000.00

Simulated Account

4.3 Commissions

Commissions can be calculated by MotiveWave™ using the simulated account, in replay mode or as part
of Strategy Back Testing. If you would like to include commissions, these can be configured from the
Commissions dialog (Configure -> Commissions from the Console menu bar).

1. Base Cost — This is the base cost of a trade. Some brokers offer flat rates for commissions. If this
is the case, just enter the cost here.

2. Unit Cost — Some brokers charge based on the number of units (ie quantity) that are part of an
order (ie shares, contracts etc).

3. Unit Size — If a unit cost has been specified this is the lot size.

Commissions Dialog

& Commissions b 4

The following tabs allow you to set the default commission structures for each
type of instrument.

Cash (Forex)

Base cost for a trade

cese ot [ 500 5~
Unit Cost: Use these fields to define a
Unit Size: E cost per number of units

traded. lgnore if your broker
has a flat rate per trade

Update | Can

The above dialog enables you to define a commission structure that applies to each type of instrument.
Some instruments may have their own specific commission structure. If this is the case, you can
override this from the Instrument dialog (right click on the chart and choose Edit Instrument, click on the
Commissions tab).
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Edit Instrument - AAPL X

Modify the fields below and press OK to save your changes.

Base Cost:
Unit Cost:
Unit Size:

v'| Use Default Commission

Uncheck this to

override the default
commission structure

OK Order Presets Delete Cancel

4.4 Order Presets

Order presets are convenient for defining default order attributes. Defaults can be defined generically
by the type of instrument or specific to an instrument. General order presets can be accessed by
choosing Configure -> Order Presets from the Console menu bar.

This dialog has a tab for each type of instrument. Each panel will have the following fields:

1.
2.

LN U R W

Order Type — Default type of order to be placed

Time In Force — Defines the expiration time of the order. Available types will depend on the
broker.

Trigger OTH — If checked, the order can be triggered outside of regular trading hours

Offset — Default offset (in pips) from the current price when placing an order

Limit Offset — Default offset (in pips) from the current price when placing a limit order

Stop Offset — Default offset (in pips) from the current price when placing a stop order

Trail Offset — Default offset (in pips) from the current price when placing a trail order
Default Quantity — Default quantity when creating a new order

Increment — Increment (or decrement) size when adjusting the order quantity

. Preset Quantities — The quantities in the list box will be available from a drop down menu next

to each quantity field. These values are also available from Quantity Selector in the DOM.
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General Order Presets Dialog
w General Order Presets X

The following tabs allow you to set the default values when placing a new order per type of instrument. Order
presets can be tailored for a specific instrument by right clicking on the instrument and from the popup menu

click: Edit -» Order Presets.
A tab will exist f h f
Pl index Cash (Forex) < ab will exist for each type o
instrument supported by your
Settings broker(s) or data service(s)

Order Type: | LMT - Offset: (Ticks)
- _ o

e IEor Limit Offset: (Ticks)

Stop Offset: (Ticks)

Default order quantity Trail Offset: (Ticks)
Order Sizes

v
Default Quantity: Increment:

Add
Increment for

10 adjusting the order
20 quantity
30
50 Preset quantities

available from the
100 drop down next to
150 the quantity field
200 T

Update || Cancel

If you would like to change the order presets for a specific instrument, edit the instrument (right click on
a chart and choose Edit Instrument) and click on the Order Presets button at the bottom of the dialog.

Edit Instrument Dialog
Edit Instrument - AAPL X

Modify the fields below and press QK to save your changes.

e Ccll Commissions  Advanced

Type: | Stock -
Symbol: [ AAPL]
Historical Instrument: - Enabled

Symbol Display: = AAPL
Title: = Apple Inc

Exchange: = NASDAQ -~ || +
Description:  apple Ip

Click here to adjust
the Order Presets
for this instrument

OK Crder Presets Delete Cancel
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Order Presets - Instrument

Order Presets: Apple Inc X

This form sets the default values when placing a new order for this instrument. These values
override the values that are set in General Order Presets (from the top menu: Configure -> Order
Presets).

Settings

Order Type: | LMT - Offset (Ticks)
e Limit Offset: (Ticks)
Stop Offset: (Ticks)

Trail Offset: (Ticks)

Order Sizes

Default Quantity: Increment:

Add

10
20
30
50
100
150
200

Update || Cancel

4.5 Chart Trading

Perhaps the most convenient way to create orders in MotiveWave™ is by using the tools available from
a chart. There are several ways to do this:

1. Price Axis — Trades can be placed directly from the price axis

Buy/Sell buttons — The Buy/Sell button labels can be optionally added to a chart

Context Menu — Use the trade items available in the context menu of the chart (right click)
Trade Panel — Use the trade panel that may be displayed on the right hand side of the chart
DOM Panel — The Depth of Market panel can be displayed on the right hand side
Strategies — As explained in the section: Strategies

oukwnN

45.1 Chart Orders

Active and filled orders may be displayed and adjusted directly on the chart. Click on the Show Orders
button on the tool bar to toggle the display of orders on the chart.
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Chart Orders
(> MotiveWave - Console (google) 3 o- 7 X

File Edit View Study Sirategy Format Configure Window Help

BRK.B ~ Q| B s @l IKElw-Q o~ +"WIT|&2~|15mn  ~ 2 (me ¥ o gD
Ll AAPL 15m Ll MSFT 15m  [Lul BRKB 15m X |l GE15m  + A E
BRK.B - 15 inin i —

Click here to

'I AH 3 show/hide orders

Click and drag
label to adjust

!
..TJ l\ M, j{j
HFM 'lh Click X' to

W T}ai“*'hi#.mﬂ I

|
Lk ! 12

remove These orders are configured as a . H. *“.+ I i*h Click 'C' to
l Bracket Order. The parent Buy Limit + +H- ’ li l ' cancel order
TR S TTO0EA T [l Order has an attached limit and stop = T * 'Fti
7:1]-—" M ﬂ" 1: order. Green arrow lines visually | N iﬂj B
H TT I indicate that they are connected. : 6
[ Fited orcer ] iyt .
STP-SIM 100@162.09 [F
MotiveWave Order Label
L L | L | L | L
14:00 Jan-31 12:00 Feb-2017  12:00 14:00 Feb-02 12:00 14:00 Feb-03 12:00 14:00 Feb-06 12 00 14 [JD Feb!-u-v—n_-eu—t'd 00 16 00 18 00
1min 5min 10min  15min 20min 30min 45min 1hour 2hour 6&hour 1day 1week 2week 1month 3month = v @ |#|~ B
|l Home X il Charts 8 Account  [&t Scan  {lf Optimize News 4+ im N O

Feb-07 15:56:28

The price of an order can be adjusted by clicking and dragging the order label up or down. By default
the order will automatically be submitted with the modified price. This default can be changed in the
Preferences dialog (see Order Preferences section). If “Auto Submit Modified Orders” is turned off,

then you will need to press the ‘T’ button to transmit the modified order to the broker.

Adjust Chart Order Price
iy iy

A L,

E_"ﬂ':-\m H e e
} i 1450
E l E Click and drag label i r]164.00
J_ * up/down to adjust : 163.85
T e ¥ Lur-su 100152 50 (GIAME
i i * i 5 J163.50
‘- LT f l i
O h e, e
o By default order will be submitted | | K828
i when releasing the mouse button. '
{0 . '| K1625
I B e
oo b ]
f l : i ; J162.00
i I I i I 1 I I i ]
i -

Double click on the order label to display the Order Ticket dialog. A context menu can also be accessed
by right clicking on the order label.
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Order Context Menu

S i —

TII I Right click on the dit Order Tl‘cl(et H1s3.50
4T ]
order label to show ancel Order 1

the context menu Cancel All

H164.00
{163.85)

i -

1 —

[

[

|

[

2

-

| -

1 m

[ =

=

| —

| ———

- ——— - -

————

Aca.n

; ‘ | - P| 162,93
| il | ‘
| | ; 162.5[8)1
--------- R R L5 cc012.+2 O) R
--------- e~ 202 2 g WO
i i i

1 1 1 1 1
00 14[]0 Feb-06  12:00 1400 Feb-07  12:00 14:00 16:00 1800

4.5.2 Trade History

Historical trades can be displayed directly on the chart by clicking the Show Trades button on the tool
bar. Detailed information on each trade can be displayed by placing the mouse cursor over one of the
trade arrows.

Trade History
USD/CAD - Primary Analysis - 15 min™ e o o

View Study Strategy Format  Window  Help
Q‘ELEJE!.B'EQ Hwr®R w~rQ v My + "E[T]2~|15mn -

. 10K
min PL:-4.47 l
| Pips:-5.5 *
! .
. Click here to toggle

Down arrow indicates sell, * the display of

up arrows indicate buys. historical trades
T
B TJ’”
| ! H1.30700
|
|
! H1.30600
! 10K i
i ! * PL:-4.47 ‘ _12323;.
! Pips:-5.5 +r The arrow indicates the 10K
! ! lT average price for the trade PL:156.33
| Historical Trade Pips:20.2 {30400
| 1DK 10K ]
; PL:-26.19 I PLi26AS 3130311
| Pips:-34.5 H Pips:-34.5
|
I
! T + i‘l‘ m 41.30200
|
| T *
1 T';w* I 130100
1 Account REPLAY-1
1 Place the mouse cursor BOT 10K@1.30109 d4.30000
! over the trade to show o 2R
i detailed information. ips:20 PL18.33
1 Pips:20.2 11.29900
I
! "
} | | , | . . . . . ) | | . . . . a8

“eb-2017 3:00 5:00 7:00 9:00 12:00 14:00 16:00 18:00 20:00 22:00 Feb-02 2:00 4:00 6:00 8:00 10:00 12:00 14:00 1&:00

4.5.3 Price Axis Trading

Orders can be created directly from the price axis by simply clicking where you want to place a limit
order. If you move the mouse over the price axis, you will notice that the mouse cursor will change to a
blue/red target (depending if you are above or below the current price). You will also notice that there
is a label that shows the price.

Version 5.0 ©2019 MotiveWave™ Software Page 162 of 212



MotiveWave™

M (R
User’'s Guide antlve ave
Price Axis Trading — Limit Buy Order
il USDI/CAD - Primary Analysis - 15 min™ B o Y63
File Edit View Study Stralegy Format Window  Help
(T -|Q ki m e s-@ C W B e (- My + "B[T]2~[15mn ~ AW e
USDICAD -15 min i -
If the cursor is above the

current price, a sell limit
order will be created.

ity "

This is the limit price
that will be chosen
for the order

i“rﬁ*'r.
[

ﬂ!
I,
| *|i++v¢|

|
I

I!

I

“‘*wrlw' [ +ql'l!-

| "n,T_ s imlw*'
l#";.*+"l+,+l! ,

I.T”' o

i Y

Place the cursor where you want
to create a limit order. Notice
the cursor is a blue target with
'LMT" in the bottom right.

F R

Press the left mouse button once to create a limit order at that price using the default quantity for the
Instrument (see Order Presets). Note: place the cursor above the current price to create a Limit Sell
order, and below to place a Limit Buy order.

By default, this order will just be created (not submitted to the broker). You can optionally modify this
order and click the ‘T’ (transmit) button to submit the order to the broker.

Price Axis Trading — Adjust Order

ahl USDICAD - Primary Analysis - 15 min™ e - " ox
File Edit View Study Strategy Format Window Help
USDICAD |~ O |l I B =~ @G| WA W2 wrQ I~ mv + "B[T]|2~[15mn - [ e 3 5
USDICAD - 15 min ek and d . der lobel 1.32135]
Click and drag the order labe
up/down to change the limit price. [{1 32000
Double click to show the Order Ticket aana)
dialog or right click to show options. _%gﬁ%]
T e
! lh'_“i T . LMT-SIM 10K@1.31568_ T :[}}———71 31600
1.31400
I+ Limit order created (but not Press 'T' to transmit the
l T submitted). Default quantity order to the broker or
l ! I!- used (10K) and the price is set 'D' to discard {remove) 1.31200
!H T+ gl where the cursor was clicked.
'J. o 131000
] —h-'rl 1 r* .
i i ni HHT

L, PR 1 P, e P e b P Pl b bl e P

4.5.3.1 Price Axis Order Types

You can place different types of orders from the price axis by holding down on the following keys while

clicking the left mouse button. The quantity for all of these orders will be the default quantity assigned
to the instrument.

1. No Key — Limit Order, the limit price will be the value at the current mouse location

Caal
[, o]

a. WT Limit Buy — cursor is below the current price

[ 1
[k, o]

b. wT Limit Sell — cursor is above the current price
2. Ctrl Key — Stop Order, the stop price will be the value at the current mouse location

Ll

[k, o]
a. ste Stop Buy — cursor is above the current price
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Taal
[k, o)

b. st¢ Stop Sell — cursor is below the current price
3. Shift Key — Market Order, sell or buy at the current market price (best bid/best ask)

[ ]

[k,
a. mir Buy Market — cursor is below the current price.

Taal

b. T Sell Market — cursor is above the current price
4. Ctrl + Shift Key — Limit Order + Attached Limit & Stop orders. A limit order will be placed with
the limit price equal to the current mouse location. A limit and stop loss order will be attached
to the limit (parent) order.
a. WTsL Buy Limit + Sell Stop/Limit

[

[&, ]
b. wTsLSell Limit + Buy Stop/Limit

The mouse cursor will change depending on which modifier key you are pressing when moving the
cursor over the price axis.

4.5.3.2 Price Axis Context Menu

The context menu (right click on the price axis) also has a menu for creating orders (see diagram below).

Price Axis Trade Menu

{ —————————————————————————————— SRS 7 ‘érad? o ¥ | Limit Order
- - 131 T Create Aler Stop Order

¢ P At o Shows B e | Mkt Ore

§ ] Add Guide Trail Order

{ the context menu —:1_31200 Limit+Stop

[ : Limit+Trail

) 4131000 Stop+Stop

H 5 Stop+Trail

i ] Limit+Stop/Limit
A1.30800 Limit+Trail/Limit
130730 Stop+Stop/Limit
] Stop+Trail/Limit

3 130600 OCO Limit+Stop

I ] OCO Limit

; 130400 OCO Stop

?\'__ i R LAV S S

4.5.4 Buy/Sell Buttons

For convenience, buy and sell buttons can be added to the chart. These buttons are available as Chart
Labels. Double click on the chart (or right click and choose Chart Settings) to open the Chart Settings
dialog. You will find the Buy Button and Sell Button labels under the Label tab.
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motivelwave

o)

Chart Settings

General Scaling Bar Settings Theme Display JEBEEH

Watermark Trade Elliott Wave

The list below shows the labels that are displayed on the price graph (such as Spread, Day Range etc).

Available Labels

Darer 1ime
Day Close

Day High

Day Low

Day Open

Day Range

Day Range %

Dividend Rate

Earnings Per Share

Extended Data

Last Bar Close

Last Bar Diff

Last Bar Time

Last Price

Last Time

Open Intergst

P/E Ratio| Look for the Buy/Sell
Pip Cost Button options in the
o | A
Profit/Losg

section
Roll Buy
Roll Sell
Sell Button

Spread
Volume

A &K

=<

Labels

Buy Button

OK || Save Defaults

Reset Defaults

Cancel

If you would like to create a buy or sell order, click on the Buy or Sell buttons that are directly on the
chart. This will open an Order Ticket dialog that you may use to create your order.

Buy Sell Buttons

[sl
File Edit WView  Study

USDICAD - 15 min ED

Strategy
usbicAD (YO IE B s~ @

Click either of these

buttons to show the
order ticket dialog

Format

USDI/CAD - Primary A
Window

[ wi~ 22| W

™ A

The Order Ticket dialog may look different depending on the broker you are using. The following dialog
is from a workspace configured for CQG:
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o New Order: EPH7 X
Symbol Position Bid Size Bid Ask Ask Size Last Price
EPHT 587 228175 22820 211 #22815
Buy Sell
Account: | SIMmwaveapi v Current Price
Quantity: =5 Available options will
Type:  LMT - depend on the broker(s)
that you have chosen for
Limit Price: 22885 & your workspace.
Expires: | GTC -
Limit
Use this section to
Stop attach orders
Trail
m Discard Presets

455 Context Menu

The context menu (right click on the chart area) has options for placing orders and adjusting trading

settings.
Context Menu — Trading Options
EPH7 15m x | + (L1
EPHT - 15 min 2292.00
Volume
71291.2%
+H.* H2290.00
Right click on <I} Chat Settings +i H2289 00
chart area Edit Instrument T
Bar Size
Tick Interval ‘|‘ 7J2288.00
Volume Interval »
Range Interval 228700
L Renko Interval
[ | | Template
i “ —f * lll Link -2286.00
ﬁ Tll i! Add Study
Tool ’
! T‘:;dse ] 228500
de [y suy
View Cancel All +2284.00

45.6 Trade Panel

V i Show Extended Data
( Clear Local Data

£ Refresh Orders
© Refresh Trade History

I H2283.00

The trade panel is a convenient tool for managing orders and positions from the chart. This panel can be
displayed by choosing View -> Display -> Trade Panel from the top menu bar (or press Alt + T). There is
also a button available on the tool bar that toggles the display of this panel.

The Trade Panel has three tabs that provide different trading options.

4.5.6.1 PositionTab

The Position tab may be used to manage your current position for the chart instrument. It has the
following elements:

1. Buy Market Button — Creates a market order to buy the given quantity at the market price
2. Sell Market Button - Creates a market order to sell the given quantity at the market price
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3. Quantity — This is the quantity for the market orders. It will default the value in order presets

4. Flatten Button — If you currently have an open position, this button will close the position at
market price

5. Cancel All — If you have open orders for the chart instrument, this will cancel these orders

Break Even — Creates an exit order at the break even price.

7. Reverse Button — If you have an open position this will close that position and open a position in
the opposite direction. For example, if you were currently long 10K, this would close the long
position and open a short position for 10K

8. Account Choice — Enables you to choose the account for the orders

9. Position Label — Displays the current position (N/A for no position). If the label background is
blue, then the position is long. Short positions will have a red background as well as a negative
number for the quantity.

10. P/L Label — Displays the current unrealized profit/loss for the open position. A loss will be
displayed with a red background (and a negative sign). A profit will be displayed with a blue
background. If there is no open position, this label will display N/A.

o

Trade Panel — Positions Tab

§eWave - Console (CQG) g2 - " X
Toggles the display
? ¢ ~ | 15 min ~ {of the Trade Panel & &
| :e
£ 2291 __25 Trade x
1 I E Order Bid/Ask
g n 2290.00
; ol - I I
‘ _‘_ Order Quantity =2
U2283.00 Flatten | | Cancel All
] Break Even | Reverse
+2287.00
Account Choice SIMmwaveapi v
-12.50
Current Position (Blue I hd
background indicates Long) byt
—EREEEE ] | | 13)= oc <[ %
H2283.00
228250
2787
. . R e A i

4.5.6.2 OrderTab

The Order tab is used to create or modify existing orders. New orders can be created by clicking on the
Buy or Sell buttons. An existing order can be modified by selecting it on the chart (left click on the label).

1. Buy Button — Indicates if the order is a buy or sell. If no order is selected on the chart, you may
click on this button to create a buy order.

2. Sell Button — Indicates if the order is a buy or sell. If no order is selected on the chart, you may
click on this button to create a sell order.

3. Quantity — quantity for the selected order. This will default to the order preset if it is a new
order.

4. Order Type — list of available order types (broker dependent). The selected choice will influence
the visible fields below (ie limit price, stop price etc).
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Limit/Stop Price — Depending on the type of order these fields may be visible underneath the

Order Type field.

Time In Force - effective time for the order. Day orders will expire at the end of the day. GTC
orders last until they are cancelled (Good Till Cancelled). The options available in this field will
vary depending on the broker.

7. Limit — Use this option to attach a limit (profit) order. This order will be activated when the

primary order is filled

8. Stop — Use this option to attach a stop order. This order will be activated when the primary
order is filled and will be an OCO (one cancels other) order with the limit order above.
9. Trail — Use this option to attach a trailing stop order (instead of the stop order above).

10.

have a red background for sell orders and a blue background for buy orders
11. Discard/Cancel — Discards (for new orders) or cancels the order
12. Account Choice — Account for the order. For new orders, this will default to the Primary account
(set in the Accounts panel).

Trade Panel — Order Tab

Submit/Modify Button — Click this button to submit the order to the broker. This button will

%\ﬂotiveWave - Console (CQG) - X
Ip
T &~[15mn - 28N S WO SR
{
H =
{ 2291.25 Trade X
{ I Click Buy or Sell sition m Bid/Ask
to create an order
} i a: Buy sell
il e ﬂ ; P00 auany =
1 Type:  LMT -
rI * _____________________ M1 1@2207.75 T L1 2288.00 P
4 | . @2287.75 T Rol ] Limit Price: 228775 3
g —:2237"-00 Expires: = GTC -
i ]
S S —— LT 1@2286.00 (IR, TN Limit
1 Stop
H2285.00 Trail
To modify an existing
order, click on the label to m Discard
f select. Order form will Use these options -
show the order attributes. to attach orders SRV s
j - 1@2283.50
‘ —2282.00 | Ent il
] Account Choice
K2781.00) | | Breemom >
1 1 1 1 1 1 1 1 -

4.5.6.3 Bid/Ask Tab

The Bid/Ask tab shows a Buy/Sell box (with best bid and best ask prices). This tab is convenient for
placing buy and sell orders at market and monitoring the spread between the bid/ask prices. You can
double click on either the Sell or Buy boxes to submit a market order.
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Trade Panel — Bid/Ask Tab

motivelave’

et

MotiveWave - Console (CQG) Yy - x x

w  Help %
+ T/ &@~[15mn - Lme XSmO o
= .7
Double click to X

Y

£2291.25 Trade

Position

EPH7

if the bid/ask goes up
or down.

{This will flash blue/fred

LMT 1@2287.75 T D

22 8500

Order

Buy at Market

10:17:07

22 8525

VT VI e S

S

Double click to
| Sell at market

Buy/Sell Quantity pi v
Bid/Ask Spread
Entry/Exit -

Breakout

4.5.6.4 Entry/Exit Strategies

Entry/Exit strategies provide a convenient way to place combinations of orders in a single click. The
entry/exit section can be found on the Trade Panel as well as the DOM (Depth of Market, hidden by

default).

The following screen shot shows the Entry/Exit section of the Trade Panel. Strategies can be created,
modified or removed by clicking on the edit button located in the top right corner of the section.

If you would like to execute a strategy, select it from the available strategies drop down and press the
execute button. Parameters such as Lot Size, Time In Force and Offset Size can be adjusted in the fields

below.
Entry/Exit Setups
[ MotiveWave - Console (CQG) b I
i He\p
§+ [T~ [15min ~ AW 0K G mD OB
? Bl
£2291.25 Trade %
+I ] Order Bid/Ask
H2290.00
§ i : O3 E1
g b H Tossoo — 9=
-‘-* H2288.00
__ Edit/Manage
2287.00 Click here to execute Strategies
+ 1 the strategy
H2286.00
{ (2785 25) | Entry/Exit \\-\ ad
Available Strategies Breakout I
2264.00 ¢ =- GTC v
g _ Lot Size I Order Time O{'Fset size
12282 00 In Force (in ticks)
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MotiveWave™ comes with several built-in strategies that you use or modify to suit your needs:

1. Breakout — Creates buy/sell stop OCO (one cancels other) orders above and below the current
market price. This can be useful if you are expecting the price to shoot up or down in the near
future and you want to get in on the trend.

2. Fade — Creates limit OCO orders above and below the current market price.

3. Brk Up/Fade Down — Creates a Buy Stop Order (above the current price) and a Buy Limit Order
(below the current price) (OCO Orders) to enter the market long.

4. Brk Dn/Fade Up — Creates a Sell Stop Order (below the current price) and a Sell Limit Order
(below the current price) (OCO Orders) to enter the market short.

5. Bracket Exit — Creates a limit order to exit a position and a stop order as a stop loss. Both of
these orders are OCO orders.

6. Scale Out — 2 — Creates two limit exit orders and two stop loss orders to scale out of a position.

7. Scale Out — 3 — Creates three limit exit orders and three stop loss orders to scale out of a
position.

Entry/Exit strategies can be managed by clicking on the edit button to show the dialog below.

Manage Entry/Exit Strategies Dialog

- Entry/Exit Strategies X

The list below contains the available Entry/Exit Strategies. These
strategies make it easy to quickly setup entry and exit orders.

Breakout
Fade

Brk Dn/Fade Up
Bracket Exit
Scale Out - 2
Scale Qut -3

Select one of the
strategies to activate

Click here to create the buttons below.
a new strategy

I \/
L

New | Edit | Remove | up || down || Close

Click on the New button to create a new strategy or select an existing strategy and click on the Edit
button. The Entry/Exit Strategy dialog will be displayed to allow you to configure Entry and/or Exit
orders for this strategy. If it has both types of orders, the exit orders will be created when the entry
orders are filled. The following fields apply to this dialog:

1. Name - This is the name of the entry/exit strategy and will be displayed in the drop down

2. Absolute Offset — By default the offset will be multiplied by the Offset Size in the Entry/Exit
panel. If you specify an absolute offset the offset (ticks) will be used as is.

3. Offset — This is the distance (in ticks) from the current price. If the absolute offset is not checked,
this value will be multiplied by the offset size in the Entry/Exit panel.

4. Lots — This is the number of trade lots that will be setup as the quantity for the order. This
number will be multiplied by the Lot Size field in the Entry/Exit panel.

Entry Orders
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You can specify up to five entry orders for the strategy. Each entry may have one or two orders. If two
orders are specified, then these orders will be submitted as an OCO (One Cancels Other) pair.

Exit Orders

Entry/Exit Strategy Dialog

(> Entry/Exit Strategy x

This dialog allows you to define a custom entry and/or exit strategy. Relative (vs absolute) offsets may be used
to have different offset values per instrument. In this case the actual offset will be a multipier of the Offset field
in the Order Presets.

=
Name: | Trade Setup 1 Absolute Offset

[SjEeln =l Exit Orders

Select the entry orders below. Each entry may consist of 1 or 2 orders. If two orders are specified, they will be
submitied as an OCO order (One Cancels Other). The Offset and Lots fields are relative to the Order Presets
for the instrument.

Entry 1| LMT = || SELL | Offset | 1 2] Lots | 1 2]
- ~ Offset Enabled
Optionally setup entry
Entv2 CLEE] s orders for this strategy.
v ~ | Dffset Each entry may have up to
two orders which will be
Entry 3 hd - Offset Lots configured as OCO orders.
- ¥ | QOffset
Entry 4 h ¥ | Offset Lots
- ~ | Offset
Entry 5 b ¥ Offset Lots
- ~ | Offset
OK Cancel

Similar to the entry orders, you can specify up to 5 exit orders. If this strategy has entry orders, then
these orders will be created after the corresponding entry order has been filled. Each exit can have a
limit (profit taking order) and a stop/trail order (stop loss order). These orders will be submitted as an
OCO (One Cancels Other) pair. If Auto Adjust Size is checked, the lot size will be adjusted to match the
currently open position.

Entry/Exit Strategy Dialog — Exit Orders

(W Entry/Exit Strategy X

This dialog allows you to define a custom entry and/or exit strategy. Relative (vs absolute) offsets may be used
to have different offset values per instrument. In this case the actual offset will be a multipier of the Offset field
in the Order Presets.

r
Name: | Trade Setup 1 Absolute Offset

Entry Orders Iﬂl!z@

Select the exit orders below. Each exit consists of a Limit and an optional Stop/Trail order. If two orders are
specified, they will be submitted as an OCO order (One Cancels Other).

Auto Adjust Size
Exit 1 - =] [v/| Enabled Optionally setup exit
L CEE] Lots 1= orders for this strategy.
~ | Offset Enabled =1 Each exit may have up to
) o two orders which will be
Exit2 - Limit Offset configured as OCO orders.
Lots
¥ | Offset
Exit3  Limit Offset
Lots
| Offset
Exit4  Limit Offset
Lots
| Offset
Exit5  Limit Ofrset
Lots
| Offset
oK Cancel
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4.5.7

Preferences

The behavior and appearance of orders can be modified from the Preferences dialog (Configure ->
Preferences from the Console menu bar). Click on the Orders tab

1.
2.
3.

10.
11.
12.
13.

Price Axis Trading — Enables or disables the ability to trade from the price axis
Buy/Sell Box Trading — Enables or disables the ability to trade from the Buy/Sell boxes
Use Pips for Attached Orders — Indicates if pips vs price should be used when determining the
offset from the parent order.
Confirm Closing Positions — Displays a confirmation dialog when clicking on the close button for
a position.
Auto Submit Modified Orders — If this option is enabled, dragging an order on a chart will
automatically submit the price change to the broker (instead of requiring an extra step to
transmit the change by clicking on the ‘T’ button)
Send Email on Filled Order — Sends an email to the configured email address when an order is
filled. Note: you must configure your email settings (see Email tab)
Send Email on Rejected Order — Sends an email to the configured email address when an order is
rejected. Note: you must configure your email settings (see Email tab)
Show Client OCO Warning — Display a warning when placing a client OCO order. Some brokers
do not support server side OCO orders. In these cases MotiveWave™ will simulate the OCO
order on the client side.
Show Client Attach Warning — Similar to the option above, MotiveWave™ will display a warning
to remind you that the attached order is a client order (not submitted to the server initially).
Create Order — Mouse click to create (but not submit) an order
Show Order Ticket — If checked, the Order Ticket dialog will be displayed when creating an order.
Auto Submit — Mouse click to create and submit an order (double click by default)
Price Axis Key Modifiers — This section may be used to customize what types of orders may be
created from the price axis.

a. Default (No Key) — defines the type of order created when the mouse is clicked with no

modifier key

b. Shift Key — defines the type of order created when the mouse is clicked while pressing the
Shift Key

c. Ctrl Key — defines the type of order created when the mouse is clicked while pressing the
Ctrl Key

d. Ctrl + Shift Key — defines the type of order created when the mouse is clicked while
pressing the Ctrl and Shift Keys
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Order Preferences

[ o] Preferences

General Theme Chart ToolBar Sounds Ratios Elliott Wave Gartley TicKChaltsAlelts Email

Limit, stop and market orders can be created (and submitted) directly from the price axis.

Submit will save time by creating the order and automatically submitting the order to your broker.

Order quantities can be configured in Order Presets. Keyboard modifiers (Ctrl, Shift and Ctri+Shift) may be configured to
place different order types from the price axis. Hint: if you are above a price indicator, hold the Alt key to place an order.

Options

V| Price Axis Trading v'| Buy/Sell Box Trading

v/| Confirm Closing/Reversing Positions v/ Auto Submit Modified Orders

Send Email On Filled Order Send Email On Rejected Order

v/| Show Client OCO Warning v'| Show Client Attach Warning

Create Order: | Single Click Show Order Ticket

Auto Submit: | Double Click =

Price Axis Key Modifiers

Default (No Key): | Limit Order -
Shilt Key: | Market Order - These fields may be
Cirl Key: | Stop Order - used to change the
price axis behavior
Ctri+Shift Key: | OCO Limit b

OK || Apply Cancel

Create Order will create the order on the graph giving you the opportunity to transmit the order (clicking the 'T' button). Auto

The Display tab provides options for displaying orders on charts:

o

General Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Alelts Email =

Preferences X

Submission EEJENY

Use this ﬂ\ﬂ|Og to conﬁgure how orders are: displayed on charts
Order Align:  Right  ~

v'| Show Buttons

Use these options to
change how orders are
displayed on charts.

v/ Show Lines

v'| Show Filled Orders

v'| Show Filled Lines

Filled Order Align: = Leit -

OK | Apply || Cancel
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4.6 Depth Of Market (DOM)

MotiveWave™ provides a Depth of Market (DOM) feature that allows you to see bid and ask prices/sizes
beyond the best bid and best ask provided this is supported and permissioned from your broker/data
service. Depth of Market can be accessed as a panel on a chart, a panel in the console or from a
separate DOM window (File -> New -> New DOM Window from the Console menu bar).

The following screen shot shows an example of a DOM window. Current position information can be
found at the bottom of the window. The table area contains several different columns which are
configurable from the Preferences dialog.

1.

P/L - Displays what the profit/loss would be for your open position at each price interval. Profit
levels are displayed with a light blue background, losses show in pink.

Orders — Shows active orders. Sell orders are in the left Orders column, buy orders are in the
right Orders column. The example below shows a limit sell order for 1 contract on the right hand
side. You can click and drag the label to adjust the limit price or cancel the order by clicking on
the ‘'C’.

Bid — shows the current bid sizes at each price level. For convenience a histogram is displayed in
the background to show the size of the bid relative to the other prices.

Price — This is the price ladder. It shows prices in increments of 1 tick. The last price has a dark
blue background and shows the last traded size. Best bid and best ask prices have yellow and
green backgrounds. Day high and day low have blue and red backgrounds.

Ask — shows the current ask sizes at each price level. For convenience a histogram is displayed in
the background to show the size of the offer relative to the other prices.

Volume — Displays historical price action at each price level. This column will update as live
trades are made.
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DOM Window
i DOM (16857688 - EPHT) - L X
File  Options Window Help
EPH7 ~ | Limit Order - =- .§4 Fo
1.2 35 10 15 20 A
PIL Orders Bid Price Ask Orders Volu *
2291.50
Order Quantity — Lock_f"Unlock
Selector This column 2291.25 Trading
C displays active 229/\00
buy orders
137.50 Y Day High
125.00 9o oU 1346
112.50 2290.25 1079
100.00 2290.00 1382
87.50 Profit/Loss 2289.75 1374
75.00 Ladder 2289.50 1247
6250 2289.25 1218 This column
50.00 2289.00 1162 displays active
sell orders
37 2288.75 1395

Last trade price and

23! quantity (currently

12| covering best offer]
400
-12.50 1105
-25.00 1334
-37.50 1274
-50.00 1440
-62.50 7T
1181

2265.50 1146

Histogram 15.3K

7327

6720

2286.75 8721
2286.50 10.5K

Account Choice

Position:

SiMmwaveapi

-

4.6.1 Trading From the DOM

By default the DOM is locked, this prevents trades from being placed directly from the table. Click on
the Lock/Unlock button on the tool bar to enable trading from the DOM table. Limit and stop orders
can be placed by clicking on the Bid and Ask columns. You will notice the mouse cursor changes when

you move it over the bid and ask columns:

Tl

511 11.8K
PiL: NfA Spread

Flatten |Gan|::el All | Reverse

- 0.25

[ouy e | senom ]

Feb-08 11:39:47

1. BuyLimit w7 -This cursor will display over the Bid column and below the current best bid price.
A limit order will be placed with the given quantity when a row is clicked with the left mouse

button.
L
2. BuyStop =™ -This cursor will display over the Bid column and above the current best ask price.
A stop order will be placed with the given quantity when a row is clicked with the left mouse
button.
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3. Sell Limit i This cursor will display over the Ask column and above the current best ask
price. A limit order will be placed with the given quantity when a row is clicked with the left
mouse button.

¥

4. Sell Stop s - This cursor will display over the Ask column and below the current best bid price.

A stop order will be placed with the given quantity when a row is clicked with the left mouse

button.
DOM Orders
im DOM (16857688 - EPH7) = X
File  Options  Window  Help Preset Quantities
EPHT ~ | Limit Order - 1 2] =-Jcanalso be o o' T3
ENEEE 5 10 15 20 accessed from here A
PIL Orders | Order Quantity I Ask Orders |Indicates that
Quantity Selector 2989 75 E:To[zkoeh; Is
75.00 228950
62.50 228925
20.00 2289.00 19.9K
37.50 2288.75 1150 10.5K
25.00 2288.50 1061 179K
12.50 2288.25 1145 16.4K
2288.00 1084 26 2K
-12.50 2287.75 1193 24 0K
-25.00 2287.50 1093 174K
Mouse cursor changes to 2287.25 1020 11.5K
show what type of order 2287.00 1020 15.7K
will be placed. Left click 15.2K
with mouse button to
create and submit order. - 121K
3 813 2286.25 7051
-100.00 {*]—553 2286.00 11.0K
tr
e 0 6K nnn%?;i_ 10.0K -
Position: i@kessii] P/l EERiy] Spread: 0.25
SiMmwaveapi ~ || Flatten | Cancel All | Reverse m
Feb-08 11:55:18
Order Combinations

Other types of order combinations can be created by choosing a different option from the order type
drop down on the tool bar. The following example shows the Limit + Stop/Limit option. A limit order
will be placed and a stop/limit order will be appended as a bracket order.
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DOM Order Types

m DOM (16857688 - EPH7) - X
File  Options  Window Help
EPHT w | Limit Order - 1 2= @ 3
2 55
PIL | Stop Order Price Ask Orders Volume *
g7.50 | Irail Order 228975 c 17.2K
7500 |Limit+Stop 2289.50 1068 28.7K
g250 | Limit+Trail 2289.25 1154 26.4K
50.00 Stop+Stop 2289.00 1307 15.9K

37 50 Stop+Trail

00 [T
1250 | LimitsTraifLiit

| Stop+Stop/Limit |

-12.50

2288.75 1119 10.5K
2288.90 1102 17.9K
2288.25 1135 16.4K
2288.00 1120 26.2K
2287.75 1131 24 0K

In the example below, the Limit + Stop/Limit option has chosen. The cursor will display LMT SL when
hovering over the Bid/Ask columns. One left mouse click will create a limit order at that price and
attach a stop and limit order above and below the current price.

Placing a Limit + Stop/Limit Order

i DOM (16857688 - EPH7) - X
File Options Window Help
| EPH7 ~ | Limit+Stop/Limit ~ 1 2|= v Lo
12 35 10 15 20

PIL  Quimit + Stop/Limit Price | AsK Orders | Volume |*
2500  [type chosen 228850 1182 c 17.9K
12.50 2288.25 1108 16.4K
26.3K
12,50 369 228775 25 1K
-25.00 1246 2287.50 18.2K
-37.50 1135  2287.25 13.2K
-50.00 989 2287.00 17.3K
62,50 992 228675 19.6K
75.00 951 228650 141K
-87.50 1120 228 o " 7135
-112.50 o 2288 reated when clicking here 11.4K
-125.00 1068 2284 9581
137.50 2285.25 8154
-150.00 2285.00 17.4K
162.50 228475 16.5K
175.00 228450 19.1K
187.50 228425 21.5K
-200.00 2284.00 215K
212,50 228375 33.4K
-225.00 228350 -sTP1 |8 337K
-237.50 2283.25 21.0K

102K 1193 11.3K
Position: ul@ketnys] P/L: gybEsh] Spread: 0.25
S'mea\’eapi b Flatten Cancel All | Reverse m

Feb-08 12:01:15
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Adjusting Orders

The price of a stop or limit order can be adjusted by dragging the order label up or down. The order
ticket dialog can be displayed by double clicking on the order label. From this dialog you can change
other attribute such as the Time In Force or the order quantity. An order may be cancelled by clicking
on the ‘C’ button to the right of the order label.

Adjusting Orders from the DOM
L i TN W WL W

e N s L] Pty —ra,
112.50 229025 1237 11.3K
100.00 2290.00 1391 14 5K
87.50 72 172K
Double click on an
75.00 order label to see the 15 287K
62.50 Order Ticket dialog. 39
50.00 TTET 44 Click "C" to Cancel
37.50 2288 75 264 \V4 10.6K
25.00 PO 2@2288 50 c 19.3K
12.50 1069 2288.25 174K
Ll 2208 Click and drag the S
-12.50 1060 2287| order Iabel up/down 26.6K
25.00 1054 2287/ to adjust the price. 18.4K
-37.50 1042 2287.25 13.2K
-50.00 996 2287.00 173K
g R N RO ———— — T L

4.6.2 Position Panel

The panel at the bottom of the DOM displays information on your current position and provides
management options. It has the following elements:

1. Position — Current open position. This is displayed as quantity@average entry price. A blue
background indicates a long position (red for short)

P/L — Current profit/loss. Blue background for profit, red for loss.

Spread — Difference between the bid and ask price

Account — account to use for placing orders

Flatten Button — Closes the open position at market price

Cancel All Button — Cancels all active orders for this instrument

Reverse Button — Reverses the currently open position at market price

Buy Mkt Button — Buys at market price using the quantity at the top of the DOM

Sell Mkt Button — Buys at market price using the quantity at the top of the DOM

LN UEWN

Position Panel

-75.00 LEE 2286 501 141K
Current open position }g o Current unrealized 7135
for selected account 6 profit/loss 110K

Account for
placing orders

104K/  -484 10.9K
Position: l@kethang Pl Spread: 0.25

SiMmwaveapi = || Flatten | Cancel All | Reverse Buy Mkt m

Feb-08 12:07:22
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4.6.3 Centering

In an active market, bid and ask prices may change quite rapidly. In some cases these values may
appear above or below the current price ladder. The price ladder will automatically center itselfin 5
second intervals, but you can manually re-center the DOM prices by clicking on the Re-Center button.

4.6.4 Preferences

DOM preference can be adjusted by choosing Options -> DOM Preferences from the top menu bar.
Alternatively, click on the Preferences button on the tool bar. This dialog has the following fields:

1.
2.
3.

N

Rows — number of rows to display in the DOM table

Time In Force — expiration for orders placed through the DOM

Show Quantity Selector — toggles the display of the bar that allows you to quickly choose a
preset quantity

Show Order Ticket Window — if enabled the order ticket dialog will be displayed when creating
an order from the DOM

Double Click to Place Order — if enabled a double click (instead of a single left click) will be
required to create an order from the DOM

Show Grid — shows the outline around each cell in the DOM table

Show Totals — displays the totals bar at the bottom of the table

Show Entry/Exit — toggles the display of the Entry/Exit strategies panel at the bottom of the
DOM

DOM Preferences

o] DOM Preferences X
Rows:
Time In Force: | DAY -

v/| Show Quantity Selector
Show Order Ticket Window
Double Click to Place Order
Show Grid

v/| Show Totals
Show Entry/Exit

Save Defaults Cancel

The columns displayed in the DOM table can be chosen from the plus button on the right hand side of
the column header:

Display Columns

1] DOM (16857688 - EPH7) - P &

File Optons Window Help

EPHT v || Limit+Stop/Limit ~ [ 1 2|=- o &

12 3 5 10 15 20
PIL Orders Bid Price Ask Orders  Volume
75.00 2289.50 1162 287K v PIL
62.50 2289.25 1062 26.7K j g’i;‘jem
50.00 2289.00 1142 214K price
37.50 2288.75 1066 29.0K v Ask
25.00 2288.50 1128 -LMT1 T 33.91c| ¥ Orders
1250 2288.25 1167 28.7K Jl Volume
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4.7 Option Chains

Groups of options (Stock and Future Options) can be managed from the Option Chain panel in the
Console. If your broker supports options, you will see an “Options” page at the bottom of the Console
window.

An option chain panel enables you to see the available options organized by strike price for a given
expiry date. In the example below we are showing available options for AAPL that expire on Feb 24,
2017. By default 20 options (configurable) are displayed that are nearest the money. For convenience,
a black divider line shows where the current price is trading for the underlying symbols.

Buy and sell orders can be placed directly from the option table by clicking on the Buy/Sell buttons that
are next to each Put/Call pair. Current positions and profit/loss are also visible on the table for each
option.

Option Chain
~ MotiveWave - Console (tradier) e
File  View Configu = "
AAPL Feb-2417 x | + Underlying Syméol | -
Underlying Q, Search | Feb-24 17 + =< Available Expiry Dates
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 9 13165 13166 8 13 65% Underlying Price
Position PIL Orders Bid Size Bid Ask Ask Size LastPrice Strike Price LastPrice Bid Size Bid Ask Ask S... Orders PIL Position
1@0.10 277 0.10 0.11 234 0.10 138.00 83 6.90 T.20 6651 =N Sell
336 0.14 0.15 215 0.15 137.00 112 5.95 6.20 612 =11 | Sell
219 021 0.22 261 0.20 136.00 510 1,030 5.00 5.20 650 +1(?_t}4.9li
515 0.31 0.32 150 0.31 135.00 4.37 1,039 4.10 4.25 169 PP | Sell
146 0.48 0.48 142 0.47 134.00 3.70 534 3.30 3.40 472 | Sell
117 072 0.74 80 072 133.00 264 31 2.59 262 36 | Sell
120 1.07 1.10 186 1.08 132.00 1.98 99 1.93 1.98 66 Sell
86 1.54 1.56 82 1.52 131.00 1.43 118 40 4 68 Sep
66 212 215 50 214 130.00 1.06 101 179
84 2.82 2.86 46 275 129.00 0.69 120 U068 U70 143 —
885 3.65 3.75 33 3.57 128.00 0.50 343 0.47 0.46 133 | Sell
1,196 4.50 475 547 4.91 127.00 0.34 167 0.33 0.34 |
-1@5.40 673 5.50 575 154 5.58 126.00 0.25 297 0.24 0.25 194
1,151 6.50 6.75 647 6.54 125.00 0.19 215 0.19 0.20 374
038 7.95 175 673 7.60 124.00 0.16 418 0.15 0.16 2256
Clickonthe  B.50 | Target Account ]a Order Quantity ] 123.00 0.14 328 013 0.14 227
TN OptionsPage hos 7\ /975 61 \/ 960 122.00 0.12 200 0.12 0.13 937
simualed  ~ = DAY v =<_ Order Time Flatten |Cancel All
il Home LWl Charts 9 Account @& Op{lcns X [ scan  {lf Optimize  + Lln Force J m Ny O

Feb-08 13:27:19

4.7.1 Placing and Managing Orders

The easiest way to place a limit or stop order is to click on the Buy or Sell button next to the call or put
option that you would like to trade. When you click on this button an Order Ticket dialog will appear
that will enable you to adjust the order. Defaults such as Account, Quantity and Time In Force can be set
at the bottom of the panel.
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Option Chain - Placing Orders

~ MotiveWave - Console (tradier) R A
File View Configure Window Help
AAPL Fep-24 17 x | + T I
Underlying | AAPL Q, Search Feb-24 17 -
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 14 131.62 13163 2 131.62
Position P/L Orders Bid Size Bid Ask Ask Size LastPrice Strike Price LastPrice Bid Size Bid Ask Ask S... Orders PIL Position
1@0.10 1.00 Buy Sell 215 0.11 0.12 353 0.10 138.00 424 6.90 T7.20
Buy 217 0.15 0.16 221 0.15 137.00 88 5.95 6.20
< 207 021 02 234 020 13800 510 529 505 520
(<] Options Order: AAPL
Symbol Current prices for the ize Bid Ask Ask Size Last Price
AAPL underlying as well as the 14 1318 13163 2 13162
AAPL170224P00134000 option are shown here 190 Adjust the properties of your 52 370
order and click the Submit
Account:  simulated - Custom button below to submit the
) } order to the broker.
Spread Side Qty Exp Strike rder Type TIF
single ~ | BUY ~ = Feb2417 | 13400 ~ [ Put ~ 325 2| LMT ~ | DAY ~
Close Click Buy/Sell button
-1@5.40 to open Order Ticket
1,130 6.50 6.70 614 6.54 125.00 019 253 0.19 0.20 Dialog
602 7.55 7.70 526 7.60 124.00 0.16 2135 0.16 017 1,040
1,051 8.50 8.70 488 8.63 123.00 0.14 272 0.14 015 1,432
584 9.55 a7s 702 aRAR 122 00 0.17 2 1,261
. — Use these fields to set
simulated - =- | DAY - Flatten |Cancel All
Ijl < default for orders (Account, 7‘
Ll Home Ll Charts ’# Account @@ Options X can  {ij Optimize + Quantity and Time In Force) o3

Open orders can be canceled by clicking on the ‘C’ button next to the order. All open orders in the
option chain can be cancelled by clicking on the Cancel All button in the bottom right corner.

Market orders can be placed by using the buttons in the bottom left corner. These orders will be placed
on the put/call option that is selected in the table above.

If you have open positions, these can all be closed by clicking on the Flatten button in the bottom right
corner.

Option Chain — Managing Orders

~ MotiveWave - Console (tradier) Bo- WX
File  View Configure Window Help
AAPL Feb-24 17 % | + 0 I = = R
Underlying = AAPL Q_ Search || Feb-24 17 -
Symbol Position Bid Size  Bid Ask  Ask Size Last Price
AAPL 13 13167 13168 18 413168

Position PIL Orders Bid Size Bid Ask Ask S... Last Pri... Strike Price LastPri... Bid Size Bid Ask Ask S... Orders PIL Position

263 0.08 0.09 210 0.08 139.00 569 7.80

1@0.10 202 0.11 0.12 232 0.10 138.00 375 6.85

200 0.16 017 314 0.15 137.00 322 -

172 023 024 193 oI sv0 Double click order

163 034 035 186 033 135.00 437 725 4 130! to medify.

144 051 053 337 051 134.00 370 11 335 340 Press 'C' to

176 077 079 124 075 133.00 264 38 259 264 cancel this order
7 1.12 1.14 69 112 132.00 197 &1 195 %197
96 158 160 54 160 131.00 143 66 141 144
50 217 219 76 2.16 130.00 1.02 26 100 %102

13 2.86 2.89 32 250 129.00 0.70 128 071 072
404 365 3.80 315 3.67 128.00 0.48 186 0.48 0.50
460 475 401 4.69 127.00 0.34 188 0.34 0.35
5.60 59.75 545 5.61 126.00 0.26 242 025 0.26

Market orders can be placed
here directly. These button
apply to the selected row.

6.60 6.75 529 6.66 125.00 0.20 239 0.19 021
m 672 7.60 775 554 7.60 124.00 0.186 200 0.16 017

Sell Call Mkt | Buy Put Mkt w simulated -

Charts Account @ Options X & Scan  {}f Optimize

Cancels all open
orders for this
option chain

-1@5.40

Closes all open
positions at
market price.

=- | DAY -

Buy Call Mkt

Flatten || Cancel All|
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4.7.2 Option Spread Strategies

MotiveWave™ supports several common spread strategies:

1. Vertical

2. Calendar

3. Diagonal

4. Straddle

5. Strangle

6. Back Ratio

7. Synthetic

8. Butterfly

9. Condor

10. Iron Condor

11. Vertical Roll

12. Double Diagonal
13. Double Calendar

motivewave'

The spread strategy can be chosen when creating an option order (click on the Buy/Sell buttons on the

option chain table).

(=] Options Order: AAPL X
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 4 131.73 131.74 9 +131.74
AAPL170224P00133000 Options that are part 34 256 258 52 264
of the strategy will be
AAPL170224P00134000 displayed in this table 777 3.30 3.35 562 3.70
Account: | simulated - Custom
Spread Side Qty Exp Strike Type Price Order Type TIF
| Vertical ~| Buy [ 12]= Fep2417 ~| 13300 ~ | Put ~ LMT ~ | DAY ~
Single SELL 1 Feb-24 17 13400 = | Put
.
Submit Close
| | Calendar
Diagonal
Stradd] Available Spread Strategies.
Taddie Choose Single to place a
Strangle single option order (no
Back Ratio spread strategy).
Synthetic
Butterfly

Condor

4.7.3 Preferences

Preferences for the Option Chain can be modified by clicking on the Preferences button (gear icon) in
the top right corner. This dialog has the following elements:

1. Max Rows — Maximum number of rows to display for the option chain. Click on Show All Options

to display all available options

2. Show Calls/Puts — By default both calls and puts are displayed in the table. This drop down
allows you to choose Calls or Puts or both.
3. Table Font — Font and size for the text displayed in the table
4. Show Grid — Displays a border around each cell in the table
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5. Sort Descending — Sorts descending by strike price

6. Show Order Ticket — Shows the order ticket dialog when placing a market order

7. Show Order Panel — Shows the section at the bottom of the option chain for managing orders
8. Show Quote Panel — Shows the quotes for the underlying symbol at the top of the panel

9. Update Button — Applies these changes and closes the dialog

10. Call Columns Button — Click on this button to choose the columns displayed for Call Options
11. Put Columns Button — Click on this button to choose columns displayed for Put Options

12. Save Defaults Button — Saves these settings as the default for other Option Chain panels

13. Cancel Button — Cancels changes and closes the dialog.

Option Chain Preferences Dialog

o] Option Chain Preferences X
Max Rows: 20 & Show All Options
Show Calls/Puts: | Calls and Puts =
Table Font: Arial:13.0
Show Grid
v'| Sort Descending
Show Order Ticket

v/ | Show Order Panel Click here to choose
Call and Put columns.

v'| Show Quote Pans!

Update Call Columns Put Columns Save Defaults Cancel

Call and Put columns can be adjusted by clicking on the Call Columns or Put Columns button (see dialog
above). The columns available will depend on what is supported by your broker. The dialog below
shows available columns for Tradier Brokerage.

Choosing Call/Put Columns

Choose Call Columns X

‘You can customize the columns displayed for the Call table by selecting the column below and
using the "' and "=' buttons to add or remove displayed columns.

Available Columns Selected Columns
Change Position
% Change PIL
Delta Select columns on the Orders
Gamma !eft Oi’drig!ﬁ:ﬁ) El:td USf the DU SIS
=" and '<' buttons to
Implied \Vol add or remove them. Bid
Intrinsic Value Ask
Rho Ask Size
Spread Last Price
Symbol
Theta =
Time Value =33
Vega Use these buttons
Volume to change the
column order.

Available columns will

depend on what is

supported by your broker.

|

Cancel

Version 5.0 ©2019 MotiveWave™ Software Page 183 of 212



MotiveWave™
User’s Guide

5 Desktops

motivewave'

Desktops provide a convenient way to organize charts and other panels in one window. A Desktop is
essentially another Console window and uses the same docking framework to layout pages.

Choose File -> New -> Desktop from the Console menu bar to create a Desktop window.

Create Desktop Window

-
File | Edit

| New
Cpen

Chart

8! Backup

&t Restore
Disconnact
Shutdown

View

MotiveWave - Console (tradier)
Configure  Window
Q I~ + "5\ T &2~|15min -

Choose File -> New -> New Desktop
from the Console menu bar.

Study Strategy Format Help

' [l New Page
* | = New Watch List
il New De{:}l(top
* | Ll New Chart Window
il New DOM Window
) New Time&Sales Window
Custom Instrument

l T,‘*‘T"'""i

Enter a unique name for the Desktop from the New Desktop dialog and click the OK button to create.

New Desktop Dialog
[l New Desktop x

Desktops can be used to organize, charts, watch lists etc
together into a single window. Enter the name of the Deskiop
below and press the OK button. . me
already exists, it will be opened| Enter a name and
click the OK button

I

MName:

OK Manage Cancel

The follow screen shot shows the default layout for a Desktop window when it is first created. The
default layout includes two pages: Charts and Charts 2.
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Desktop Window — Default Layout

(Y Desktop - My Charts 2 o- X
File Edit WView Study Strategy Format Window Help
B CQlE S A s-@0) ClREwr @ §v + T[Tl@[5mn - | LW e % G »
AAPL 15m X | + (B
AAPL - 15 min
*'“Thﬂ‘l’llii‘* i L *““.J. 131.75
! IIT1“1"""1-*--."'.-... T*ﬂ!i‘"lﬂ-***al i
‘ 131.2
'T J131.00
Ll
n - -.l“
!“wl ..-l '!+u5*li'**""'— """" - {
l i J130.00
sobimmtenmsateel J129.00
|ll’l J'.*'rv-“"
"va)'é\’fave
| . . L L L L L . L L L L . . . L
14:00 16:00 18:00 Feb-06 9:00 12:00 14:00 16:00 18:00 Feb-07 900 12:00 14:00 16:00 Feb-08 9:00 12:00 14:00 16:00 1800
1mn 5min 10min [15min  20min  30min  45min  1hour 2hour 6hour 1day 1week 2week 1month 3month = @iy @ ¢ 2
MSFT 15m x | + = .”|[1BM 15m x | + = 7
MSFT - 15 r (6381 | 1BM - 15 nfin i .
] Volume +J-+T" -
Click here to add E ' + * | ll 1178 00
* - - ||@newpaneltab E '|' TTI, **l
I S o Hs380 l ' A
l Il * ] i Lyl
‘ * | ”‘ ﬂ H ] Ii J177.00
‘ - w T ] ",
*‘ Im L|+1 LI G T*W“ e
4 il
I*+u||'
| Default layout s i _IhI-I-I-I — e _ -
Motive has two pages. . . ) . . H“ III"I"“I'“"-II - lll'illl'illl-ll!“- .
2:00 1400 ——Eebh0a ___12:00 14:00 16:00 Feb-07 12:00  14:00 Feb-08 10:00 12:00 14:00 16:00
1min_Ain__10min__15min 20 m Click here to add = v @ [+~ 2|[1min 5min 10min  15min 20 min 30 min g = vy @ |4~ 2
Lbl Charts  Lul Charts2 | + anew page. m O

Feb-08 14:52:4T7

To open or manage existing Desktops, select File -> Open -> Open Desktop from the Console menu bar:

Open/Manage Desktops

[

(- MotiveWave - Console
File | Edit View Study Strategy Format Configure Window Help

New - Aol X 2@~ Q i~ + "B ET|&~[15mi
o Open : ; gggz ‘[:JZStELOE% Choose File -> Open -> Open Desktop
Chart p ; to manage existing Desktop windows
B Backup i . |
B Restore | ! I
Disconnect i * s i
Shutdown i I 'i

L J'

When you close a Desktop (by clicking on the ‘X’ button in the top left corner), the group is not deleted
but still exists in the repository. If you want to permanently remove a Desktop, select it in the Manage
Desktops dialog and click the Remove button.
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Manage Desktops Dialog

— Manage Desktops

The list below contains all of the available Desktops that you have created. Select a row and
press Remove to permanently remove a Deskiop. Rename allows you to change the name of

the selected Desktop.

Select a Desktop and use the
buttons below to open, copy rename
or delete the Desktop window.

Cpen Copy Rename Delete Close

5.1 Changing Desktop Layout

Since a Desktop is essentially another Console window, see the section: Changing the Default Layout for

details on how to configure a custom layout.
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6 Scanner

MotiveWave™ has a built-in scanner for looking for trade setups across a given set of instruments and
bar sizes. There three types of patterns that you can search for:

1. Elliott Wave — Elliott Wave patterns such as Wave 2, 3, 4, 5 and Wave E (in a triangle)
2. Gartley — Harmonic patterns including all XABCD type patterns, AB=CD, 5-0 and Alternate AB=CD
3. Study Conditions — Criteria based on study values

When you first start MotiveWave™ you will see a page at the bottom of the window named Scan. Click
on the page tab to show the screen below.

Scan Page
~ MotiveWave - Console (google) I
File Edit View Study Stralegy Format Configure Window Help
ORCL v | K S Wi w8 b0~ + [ I &2~ 15min - LN CHODCR
& --Choose Scan— x | + il & IS " ||l —Choose Scan- x | + = k ,"
—~Choose Scan—_ ~ A\ || -choose scan- -
sy ‘ool Bar Size Scan Time & BarlIndex Click here to Symbol Bar Size Scan Time This button links the

results produced in this
panel with the active
chart at the bottom.

create a new scan.

Alternatively, choose

--New Scan-- from
the drop down

\_ORCL15mx\+ = 7
ORCL-15 mm i 1040
Volume | l el
- e i =
1 w e ﬂ' i H”
" : APl T ™
.l ! This chart may be used to * i -
i ¥ il
l display a result from one of J" * * “ I' l““l l!"* Ly
nr ! iy | W,
h i. | H i i I the scanners above. T i!
' L
| l 3 "l I, gt
ir ||H+ | f *i i " i |* " ln
I LTI |
m l'I!" I'III' apunlliallantas II'I Iill Click on Sean Page [unsals Ipani-sanphin III'I II'|I|I1|I y Isj iy apulinany |'I Ena - AN A=y "||I L T ey T . g&
1400 Jan-31 12:00 Feb- 201TL‘ b 12:00 14 00 Feb-03 12:00 1400 Feb 06 12 00 14 00 Feb-07 12 00 14:.00 Feb 08 12:00 14:00 18:00 1800
imin 5min 10min | 15min 20 min SMn 45min 1hour 2hour Ghour 1day 1week 2week 1month 3 month = iy @ |+ B
Ll Home bl Charts 8 Account [ Scan x {lf Optimize News =+ LK)

Feb-08 15:09:11

6.1 Creating a Scan (Gartley Scanner)

If you would like to create a new scan, choose —New Scan—from the —Choose Scan—drop down or
press the New Scan button on the right hand tool bar of the scanner panel. This will open a wizard that
will guide you through the process of creating a scan.

New Scan
|&# —Choose Scan— x | + - I IC e
—New Scan-- - l /\_
—Choose Scan— Bar Size Scan Time A Bar Ind{ Or, press re *

this button
Select -New Scan--

from the drop down.

The screen shot below shows the first page of the scanner wizard. Enter a name for the scan and select
the type of scanner from the drop down below. In this example, we will choose Gartley as the type.
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Scanner Wizard Page 1
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New Scanner

New Scanner

This Wizard will enable you create a scannner to scan for specific patterns or conditions across a number of different
instruments

1. Specify Name and Type of Scan

2. Specify Instruments to Scan
Enter a name for
the scanner.

3. Specity Criteria
Click "Next' to continue

Name: r Gartley XABCD Patterns

Elliott Wave
Gartiey A Select the type from
Study the drop down

Press the Next
button to continue

to the next page

Next =

Cancel

On the next page of the wizard, you will be prompted to select 1 or more instruments and/or watch lists.
If a watch list is chosen, all of the instruments that are in the watch lists will be included in the scan. The
order of the instruments and watch lists will be considered when the scan is executing.

Scanner Wizard - Instruments

Specify Instruments

Scan for Gartley Patterns

Add instruments below by clicking on the "Add' (+ sign) or 'Search' (magnifying glass) buttons below. Alternatively you can
add a WatchList by clicking on the 'Add Watch List' button. Motive\Wave will scan the instruments in the order specified

below. Use the Up and Down arrows to adjust the order.

- g=
NY%E

-Choose Symbol-

NASDAQ Optionally add watch
Use this control to add rsd;ges lists to the scan list
specific instruments. Top 50 Stocks

Key Stocks

The next button will
activate when 1 or more
instruments/watch lists
are added.

Total Instruments: 0

< Back

Cancel

Click on the Add button to add a bar size to the list box. Any size linear bar or non-linear bar (ie Range,

Renko, etc) may be added. Check the Extended Data box at the bottom of the dialog to use data that is
outside of regular trading hours.
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Scanner Wizard — Bar Sizes
[ Scan for Gartley Patterns x
Specify Bar Sizes

Add/Remove bar sizes below by clicking on the Add (green '+') or Remove (red "X") buttons below. Motive\Wave will scan the
instruments (see previeus panel) using each bar size in the order specified below. Use the Up and Down arrows to adjust
the order.

+
A

Click here to add a
bar size to the list.

+ Add Bar Size X

Select the type of bar size and parameters below.
Bar Size: | Linear A

. ) You can choose any
Interval Type:" SRS bar size, even Range,

Interval: Renko etc
Cancel

Next button will be
activated when 1 or more

if this is checked, data
outside of regular trading
hours will be included.

bar sizes are added.

Extended Data

< Back Cancel

The final page of the Gartley scanner wizard enables you to choose the type of Gartley pattern to search
for as well as the historical data range where the pattern may occur. If you would like to search for all
forms of the XABCD pattern (ie Gartley, Bat, Butterfly, Shark, etc) then choose XABCD (All) as the
pattern.

Scanner Wizard — Gartley Pattern
L2 Scan for Gartley Patterns X
Specify Criteria

Select your scanning criteria below. The Pattern determines the type of Gartley pattern that you would like to find. For
example, Butterfly will search for Butterfly Pattern that is nearly complete.

Minimum and Maximum bars may be used to help constrain the timeframe.

Pattern: | XABCD (All) - Choose the Gartley Pattern
] i from the drop down.
Minimum Bars:

Maximum Bars: Use All Available Data

Min/Max bars may be used to define
the historical range where the pattern
may be identified. All available data
will use all of the data that is currently
available in the local database.

Finish button will
create the scan and
make it available in
the drop down.

Cancel

6.2 Executing a Scan

The following screen shot shows the new scan ‘Gartley XABCD Patterns’ that we created above and the
results from running executing it on the latest available data. If you would like to execute this scan,
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select it from the drop down and press the Start button (see below in the upper left scanner panel). The
progress bar will show how far the scan is progressing (see upper right scanner panel below).

Results will display in the table area of the scanner panel as they are found. This table will display:

1. Symbol — instrument where the pattern was found

2. Bar Size — Bar Size the pattern was found on

3. Scan Time — When the pattern was found

4. Pattern — The specific pattern that was found

5. Score — Score rating: Fair, Good, Very Good, Excellent

To display a scan result in the chart panel below left mouse click on the table row. Note: this will only
work if the Link button is selected (see top right button area for the scanner panel below)

The results displayed in the scanner table are unnamed analyses that are kept in computer memory. If
not explicitly saved, these analyses will disappear the next time you execute the scan or if MotiveWave™
is restarted. When one of these results is opened in a chart window or panel, you may save the analysis
to the repository by clicking on the Save button (see tool bar).

You may find that the full pattern that was found is not entirely visible when you display it in the chart.
Click and drag the time axis to the right to zoom out or select a higher bar size.

Scanner Results

"~ MotiveWave - Console (google) Ho- A X
File Edit View Study Strategy Format  Configure  Window  Help
cosT ~ O |E = 8 = 61 W el 1> + I | &~|15min - Progress Indicator | .3 m @ |3 5 i © & &
i Gartley XABCD Patiens x | + = e «”|[li Gartley XABCD Pattems x | + \/ = s >
V

Gartley XABCD Patterns ~ ~ | Start Gartley XABCD Patterns ~ | Restart | [ Scan Complet%

Link Button If

3 Scan Time A Pattern Click here to edit Symbol Bar Size Scan Time A Pattern

the selected scan. DU 15 min 15:34°01 Bat Good l

BIDU 15 min 15:34.01 Alternaip-== Very Good

BIDU 15 min 15:34:01 Crab ery Good
atin|

BIDU 15 min 15:34:01 Shark £ Excellent

COSsT 15 min 15:34:03 Shark Excellent

FSLR 15 min 15:34:06 Bat
FSLR Selecting a row in the results will 15:34:06 Alternaty SPecific
FSLR show the pattern in the chart panel 15:34-06 Crab Pattern found

below (provided the link button is

New scan is now Click the Start button to

available in the begin search for patterns
that match the criteria.

Fol D AR-2A-NE Chark Fair
Ll COST 15m* x | + enabled above) [E
. T q
i L
X SRET TR = 16844
By default :he analyide? lE:re in ‘ l; !‘V“‘lll ; ] ,..nl'l*"ma*“T : B @m. Py o 16.
memory. If you would like to o T 1 o
save this specific analysis for TT Tll W 'ﬂi N ul 167.50
later use, click the B, SEEELD . 53
Save button on the tool bar. A C 1166.00
I
i
I
H164.00
-
J i
ool " 4
\ ._!ﬁ " ﬁli-n“ ) ! * *""_1_..,‘“.*'*
S ae | i H1e2.00
1 : i 1 1 : : 1 1 ; : 1 1 ; : 1 1
14:00 Jan-31 12:00 Feb-2017 12:00 14:00 Feb-02 12:00 14:00 Feb-03 12:00 14:00 Feb-06 1200 14:00 Feb-07 12:00 14:00 Feb-08 1200 14:00 Feb-09 12:00
imin 5Smin 10min [ 15min  20min 30min 45min 1 hour 2hour 6hour 1day 1week 2week 1month 3 month = ey @ |+ |
il Home Ll Charts  J® Account & Scan X {lf Optimize News  + m O

Feb-08 15:40:55

6.3 Editing a Scan

You can edit a scan to change its instruments, bar sizes or criteria. Select the scan from the drop down
in the scanner panel and click the Edit button from the button area in the top right corner of the panel.
Alternatively, click on the Manage Scans button to open the Manage Scans dialog.
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Edit Scan
|t Gartley XABCD Patterns x | + =i
Gartley XABCD Paltemns v || Start "\
Symbol Bar Size Scan Time 4 Pattern AU

Select the scan from the drop
down and click the Edit button.

Manage
Scans button

The Manage Scans dialog enables you to create, open, edit, rename or remove existing scans. Select a
scan from the list area and use the buttons on the tool bar to open, edit or delete existing scans.

Manage Scans Dialog

o Manage Scans
The list below contains all of the available

and press Remove to permanent
name of the selected scan.

+i= X

(|a

Select Scan and use
these buttons to
open, edit or delete

rtley XABCD Patterns

Click here to
create a new scan

ou have created. Select a row
allows you to change the

Close

Edit Scan Dialog

Edit Scan: Gartley XABCD Patterns
Instruments Bar Sizes Criteria

Optionally, change the name of the scan below.

Adjust other properties
from these tabs.

Name: [bartley XABCD Patterns %‘ o

ptionally change
Type: - | the name here

Click the OK button
when you are finished.

OK | Apply || Cancel
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6.4 Elliott Wave Scanner

The example shown above is for the Gartley scanner. You can also search for Elliott Wave patterns by
choosing Elliott Wave as the type when you create a new scan. Selecting instruments and bar sizes is
the same for all scan types.

New Elliott Wave Scan — Page 1

[ New Scanner X

New Scanner

This Wizard will enable you create a scannner to scan for specific pattemns or conditions acress a number of different
instruments.

1. Specify Name and Type of Scan
2. Specify Instruments to Scan
3. Specify Criteria

Click 'Next' to continue.

Name ( Elliott Wave 2| ‘

Type:  Elliott Wave

Choose Elliott
Wave as the type

Next > Cancel

On the Specify Criteria page you can choose the Elliott Wave pattern that you are searching for. The
following patterns are currently supported:

1. Wave 2 — This will search for an Elliott Wave pattern when the top level wave is currently in a
Wave 2. Wave 2s are commonly used as trading setups since wave 3 tends to be the longest
wave.

Wave 3 - Finds patterns where the top level wave is currently in wave 3

Wave 4 - Finds patterns where the top level wave is currently in wave 4

Wave 5 - Find patterns where the top level wave is currently in wave 5

Wave E (Triangle) — Finds patterns where the top level wave is in wave E of a triangle

vk wnN

The Decompose Levels specify how many levels down the top level wave should be decomposed in to
smaller waves. Choose Decompose All to decompose the wave to all possible levels.

The Minimum and Maximum bar settings can be used to define the historical data range. If you check
Use All Available Data MotiveWave™ will load all data from the local database.
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Elliott Wave Scan Criteria
[ Scan for Elliott Wave Patterns X
Specify Criteria

Select your scanning criteria below. The Pattern determines the high level wave pattemn that you would like to find. For
example, Wave 2 will search for a top level Impulse Wave that is currently in Wave 2.

Minimum and Maximum bars may be used to help constrain the degree of the top level wave. Optionally, the results may be
decomposed to 1 or more levels.

Patten: | Wave 2 - Select the type of pattern
T T (e from this drop down
Maximum Bars: Use All Available Data
Decompose Levels: Decompose All

< Back Cancel

The following screen shot shows the results of searching for a Wave 2 pattern. To view a particular
result, click on the row in the results table. You may need to zoom the chart out to see the full pattern
depending on how much data you specified in the scan criteria.

Elliott Wave 2 Search Results

~ MotiveWave - Console (google) 2 - A Xx
File Edit Wiew Study Strategy Format Configure  Window  Help
acom  ~QE A E sr@ CIK B ey Q i~ + [T|IT &v|1day e | LW OCmOSR
it Elliott Wave 2 X | 4 = E I© «” ||l —Choose Scan— x | + =N 7
Elliott Wave 2 ~ | Restart [N Scan Complete —Choose Scan— | Start
Symbol Bar Size Scan Time rs Pattern Score + Symbol Bar Size Scan Time rs Bar Index Score +
FSLR 15 min 17:10:08 Wave 2 Fair l
FSLR 15 min 17:10:08 Wave 2 Good
17:10:24 Wave 2 Good
SBUX 15 min 17:10:25 Wave 2 Fair
SBUX 1 day 17:10:27 Wave 2 Fair
TXN 13 min 171043 Click on a row to show
Ll QCOM 1D* % ‘ + the pattern below. E
T
QCOM -1 day W) |
(5) | d7500
: ®
3 W2 é AC o2
3) l l c ! ~70.00
2@ ok |
3 @ 5 I*Lnl! @ i*ﬂi |+il+l II#T-TTWM +l|§ Hlmw \ | @(:D@
) D) 1 'I'ThTr ' 'I**H‘J““ +i 165.00
@ (aJ-H s Logh*L g @ 1 @ 1 ®) ' 7
[T AEPRTRYE i et b @ 4 3 4 6)
* ‘-f 'l |
Ly (b) (&) ! J60.00
4 | ; 4
I
Mtaasd i 4 i This is the top level 1155.00
. " +Hn .
J i @ Thyutrh wave 2 that we were 52.89
I > .
! D searching for. 150,00
w 3
! i
WMotiveWave ' @ :
Aug-2016 Sep-2016 Oct-2016 Nov-2016 Dec-2016 Jan-2017 Feb-2017 Mar-2017 Apr-2017 May-2017
imin Smin 10min 15min  20min  30min  45min  1hour 2hour 6&hour 1day 1week 2week 1month 3 month =S gy @ ¢+ 8
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6.5 Study Scanner

The study scanner enables you to search for study conditions that include 1 or more studies. When you
create a new scan, choose Study as the type from the Type drop down. Selecting instruments and bar
sizes is the same for all scan types (see Creating a Scan (Gartley Scanner) section for details).

Study Scanner — Page 1
[y New Scanner X
New Scanner

This Wizard will enable you create a scannner to scan for specific patterns or conditions across a number of different
instruments.

1. Specify Name and Type of Scan

2. Specify Instruments to Scan

3. Specify Criteria
Click 'Next' to continue

Name: ( Trade Setup |

Type:  Study s Choose Study
as the type.

Next = Cancel

On the Choose Studies panel, you can select one or more studies to include as part of the scan. Click on

the add study button to add a study to the list box below. When you click this button, you will be able

to search for the study that you want to add and configure its settings (see following screen shots).
Choose Studies Panel

[ Scan for Study Conditions X
Choose Studies

Specify the studies (and their settings) that you want to include in this scan.

Minimum Bars
+

Click here to add and
configure a study for

the scanner

= Back Cancel
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Add Study Dialog
[~ Add Study %
The following table contains all available studies. Select the desired study below and choose OK to configure the settings.
Filter: | RSI Type the study name Type: | All -
to filter the list R Overlay Signal .
Fast&Slow RSI false frue
Laguerre RSI false false
RS| Bars true frue
RSI Divergence false true
Relative Strength Index (RSI)
Reversing MACD false true
Stochastic RSI false true
Select the study and click
OK below to configure its
parameters
OK || Import | Cancel
Configure Study
Relative Strength Index (RSI) X

RS is a momentum oscillator that measures the velocity and magnitude of directional price movement
by comparing upward and downward movements. Developed by J Welles Wilder in 1978.

e

Inputs

Input: | Close -

Method: | SMMA

Period (bars): 14 3
Lines
Rsitine: DM ~ —10~ — ~
Top Fil: | gegmmes - ||/ Display
Bottom Fill: | "g™gs"s®™s ~ v Display
RS Indicator: ~ || I - Line v Display

Update | Cancel

In the screen shot below, we have added one study to the scan, RSI(C,14). Additional studies could be
added by clicking the add button. In this example, we are just going to work with one study.
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Choose Studies

This the RSI
study just added

Scan for Study Conditiens

This is the minimum
number of bars to
load when evaluating
the studies

Specify the studies (and their settings) that you want to include in this scan.

Minimum Bars:

< Back

Next = Cancel

The last page of the scanner wizard asks you to define the criteria for evaluating the scan. Click on the
add condition button to add a condition to the list. There are two types of evaluation methods:

1. All-In this method, all conditions defined on this page must be met in order for it to be
considered a match. This is the default evaluation method.

2. One or More — In this method, only one of the conditions defined on this page must be met for it
to be considered a match for this scan
3. Lookback Bars — Number of bars to look back and evaluate the study criteria. 0 indicates the
most current bar.
Study Criteria
Lt Scan for Study Conditions x
Study Criteria
Specify scanning criteria based on the studies entered in the previous panel.
Eval Method: Al ~ | Lookback Bars: Number of bars to look back
when evaluating. '0" will
+ just look at the latest bar.
]
. Two options here:
Cllck.h.ere toadda All - aﬁtcomditims must be met
Cond'tm? haseé on One or More - only one of the
the stud!es defined on study conditions need to be met
Lthe previous page.
<Back
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In the Study Condition dialog (see below) you can define a condition based on a variable that is
generated from one of the studies you defined. A variable may be compared against a specific value or
compared against another variable. The fields in this dialog are as follows:

1. Study — Choose the study that you configured on the Choose Studies page

2. BarIndex — In most cases the comparison is done with the current bar, but you may choose
historical bars by choosing a specific index

3. Variable — This field will be populated when you choose the study. Each study will export 1 or
more variables. You can see these variables in the Cursor Data Window/Panel

4. Operator — This is the comparison operator for comparing the variable to the value. Valid
options include: > (greater than), >=, < (less than), <=, =, Crosses, Crosses Above, Crosses
Below

5. Relative Comparison — Indicates if the variable should be compared against a specific value or
against another variable.

6. Value - If not a relative comparison, this field will contain the specific value you are comparing
against.

Add Study Condition Dialog
[ Study Condition x

This dialog allows you to specify a condition to evaluate as part of the
scan.

Study: | RSI(C,14) ~ Choose the study

Bar Index: v/ Use Current Bar

Variable: | RSI « These are output
variables generated
by the study

Relative Comparisorr

Operator. | =

Add Cancel

If you checked the Relative Comparison option, the dialog will change to allow you to choose a study and
variable for comparison. The Price Bar option allows you to compare to the Open/High/Low/Close
values of the price bar. In the example below, two EMAs were added to the studies list and its
comparing the EMA(C,20) value to the EMA(C,50) value to see if the first value is above the second.

Add Study Condition Dialog — Relative Comparison
[ Study Condition b4

This dialog allows you to specify a condition to evaluate as part of the
scan.

Study: | EMA(C,20) ~
Bar Index: v'| Use Current Bar
Variable: | EMA -
Operator: | = v
v/| Relative Comparison

Study: | EMA(C,50) ~

Bar Index: v/| Use Current Bar
Variable: | EMA -]
Add Cancel

The screen shot below shows the results of running this scan. In this case we only found one result
where the RSl value is greater than 80.
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Study Scanner Results

motivewave

~ MotiveWave - Console (google)
File  Edit Format  Configure Window Help

1K 2w~ Q i~ + [T &~|15min

View Study Strategy

XSmO SR
=i i E]
l— - [ 4

0 Excellent

acoM | ~Q|E A B =~ 6
let Trade Setup x | + il M [
Trade Setup ~ | Restart I  Scan Complete —Choose Scan—  « | Siart
Symbol Bar Size Scan Time 4  Barlindex Score * Symbol Bar Size Scan Time Bar Index Score *

Ll JCP 15m* x | + \

JCP - 15 min ' ‘
EMA(C,20) EMA(C,50) In this case we found 1 result

where the RSl value is above 80

T

P
J i

l#

i
I
L I
4l TI! |
IWotive |
14:00 Jan-31 1200 Feb-2017 12:00 14.00 Feb-02 1200 1400 Feb-03 1200 14:00 Feb-06 12:00 14:00 Feb-07 1200 1400 Feb-08 12:00 14:00 Feb-OB"H
RSI(C,14) | 84.1
N, O\ I
TN
- ' i A 50.00
- 3000
| i
Amin S5min 10min [ 1Smin 20min 30 min 45min  1hour 2hour 6&hour 1day 1week 2week 1month 3month = @y @ [ B2
i b o

|l Home LWl Charts .8 Account [af Scan X {lf Optimze &) News +
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7 Strategy Back Testing

Strategy back testing is a special type of historical testing that allows you to determine how a strategy
would have performed if it had actually been run during past historical time periods and market
conditions. It does not guarantee how your strategy will perform in future market conditions, but will
allow you to identify any potential issues or vulnerabilities against past market conditions. This allows
you to ‘test’ and tweak your strategy without having to place actual trades. See the Wikipedia page on
strategy back testing for more information.

MotiveWave™ has highly advanced strategy back testing options through our Strategy Optimizer. The
default layout of the MotiveWave™ Console has a page called Optimize (see bottom of the console
window). Click this tab to show the strategy optimizer page.

Optimizer Page - Console
% MotiveWave - Console (google) S I

File  View Configure Window Help
1§ Untitied | + [

Symbol Parameters Start End Net Profit Gross Profit Gross Loss Executions Commissions ax Drawdown *
Click here to create a
new strategy analysis

Cham Repoits Periods Trades Executions

Metric All Trades Long Trades Short Trades *

No content in table

This is the Optimize page
that comes with the default
layout of the Console

il Home LWl Charis .8 Account  [&! Scan  {}f Optimize x =, News  + m
Feb-09 9:33:26

7.1 Creating a Strategy Analysis

From the Optimize tab of the Console, click on the New Analysis button (see screen shot above). This
will launch a wizard that will walk you through the process of creating an analysis of your selected
strategy.

MotiveWave supports 3 types of Strategy Analysis:

1. Back Test - This option enables you to execute your strategy with specific settings over a given
set of instruments and a specific bar size/time frame. This can be useful to determine how your
strategy may have performed with past data and specific settings.

2. Optimize - The profitability of a strategy will vary depending on how it is configured. This option
will enable you to specify a range of settings for the strategy and test many different
combinations of these settings to determine which combination is "optimal".

3. Walk Forward - Sometimes knowing the optimal settings for a specific range of data is not
enough. Just because a strategy performed well for a specific bar size and time frame does not
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guarantee that it will continue to perform well in the future. Walk forward testing helps to
mitigate this problem by stepping forward in time after every iteration of a time frame.

The following screen shot shows the first panel of the New Strategy Analysis wizard. From here you can

choose your strategy and specify the type of analysis you wish to perform.

New Strategy Analysis — Page 1

settings over the given range of data.
Optimize - Run several combinations of the
strategy over the given range of data

Walk Forward - Optimize strategy and move
the data range forward after every iteration.

Optimize
Walk Forward

ih MNew Strategy Analysis
New Strategy Analysis
This Wizard will enable you to create and configure a new Strategy Analysis to optimize a strategy across 1 or more
instruments.
1. Choose Strategy
2. Specify Instruments Click here to choose
3. Specify Criteria your strategy
Click 'Next' to continue.
r
Strategy: Choose Strategy
Type: | Back Test N
Back Test 3 Back Test - Run the strategy with specific

7.1.1 Strategy Settings Panel

Once you have chosen the strategy and analysis type, click on the Next button to specify the settings for
the strategy. If you chose Back Test, then you will just need to specify the specific settings for this

strategy (see below). In this case we have chosen the "MA Cross Strategy":
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MA Cross Strategy Settings
i Strategy Settings (MA Cross Strategy) X
MA Cross Strategy

The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses the slow
moving average.

Trading Options

Fast Input | Close -

Fast Method | EMA b

Fast Period 10 5
Back Test - These settings are
specific to the strategy that you chose
Slow Method | EMA - on the previous panel. In this case
we just need to choose what we want
for the MA Cross Strategy

Slow Input | Close -

Slow Period 20 =

< Back Cancel

Alternatively, if you chose Optimize or Walk Forward as the type, the next page of the wizard will look
more like the following screen shot. This panel will enable you to specify the range of possibilities for the
configuration of the strategy. MotiveWave™ will build combinations of the strategy settings based on
this input.

Optimize/Walk Forward Strategy Settings

il Strategy Settings (MA Cross Strategy) X
MA Cross Strategy
The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses the slow
moving average.
Trading Options
Fastinput | open l
Hold Ctrl (Cmd on OSX)
Midpoint to select multiple options
High
Low
Fast Method SMA
EMA l
SMMA Use this panel to define the range
MEMA of parameters to use for this
WMA study. MotiveWave will generate
Fast Period Min- | 10 ¢| Max: | 10 ¢| Step: | 1 ¢| combinations based on this input.
Slow Input | open l
Midpoint
High
Low
Slow Method SMA
EMA l
< Back cancel
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7.1.2 Choose Instruments Panel

The next page of the wizard allows you to choose the set of instruments (symbols) for the analysis. A
specific set of instruments may be chosen by clicking on the Add Instrument button or the Search

Instrument button. Additionally, you may specify one or more watch lists to specify a group of
instruments.

Choose Instruments Page
i Strategy Settings (MA Cross Strategy) X
Instruments

Add instruments below by typing the symbol in the search box or by clicking the "Search’ (magnifying glass) button below.
Alternatively you can add a WatchList by choosing one from the Watch List drop down. MotiveWave will backtest the
strategy on the instruments in the order specified below. Use the Up and Down arrows to adjust the order

-Choose Symbol- , >y QB =

= NYSE NYSE

= NASDAQ nASDAQ

_.] AAPL - AnDle Indices L\\, Optionally select a watch

= “APPY ASX list from the drop down
Top 50 Stocks

Type a symbol in here Key Stocks

and press Enter to
add it to the list.

This panel allows you to choose 1
or more instruments for the
analysis. Optionally, you may
choose one or more watch lists
that contain a set of instruments.

Total Instruments: 57

< Back Next = Cancel

7.1.3 Data Settings Panel

If you choose Back Test or Optimize as the analysis type, then your data settings panel will look like the
following. This panel allows you to choose the range of data and bar size for the analysis. Ideally you
should use historical tick data (see Source Data field) for the analysis since will give the closest
approximation of a real world test. Unfortunately not all brokers or data services provide this data (or
enough of it). In these cases you can generate ticks from either the source data or 1 minute bars.
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Data Settings
i Strategy Settings (MA Cross Strategy) x

Data Settings

The settings below allow you to specify the time frame and bar size for analysis. If historical tick data is not available, you
can generate tick data from the source bars.

Bar Size: | 1 day - Select the bar size
Start Date: |11/8/2016 B Choose the date range
End Date: |2/82017 @ for this analysis.

¥ \gular Trading Hours (RTH) Data

Source Data: Generate Ticks

Ideally historical tick data
Bar Data - Use the source bar size to should be used (if available).

generate an Open, High, Low and Close ticks Alternatively ticks car.1 be ]
Minute Data - Load minute data and generate.d from the historical
generate OHLC ticks from those bar or minute bars

Tick Data - Use historical tick data (if
available from your data service/broker)

< Back Next = Cancel

The walk forward data settings are a little bit different. Two more parameters are available to define the
Optimize Period and Walk Forward Period. Optimize Period defines the size of the optimization
window (the number of days to include in each walk forward iteration). If the Anchor option is enabled,
the Start Date will remain fixed for each iteration. Effectively, this means that the optimize period will
increase by the walk forward period each walk forward iteration (ie: 60, 90, 120 etc days in this
example).

Data Settings — Walk Forward Testing
ik Strategy Settings (MA Cross Strategy) X

Data Settings

The settings below allow you to specify the time frame and bar size for analysis. If historical tick data is not available, you
can generate tick data from the source bars.

These are the data settings for Walk
Forward optimization.

Start Date: | 11/8/2016 |E Optimize Period - defines the
number of days included in each
walk forward iteration.

Source Data: | Bar Data - Generate Ticks Walk Forward Period - Defines how
many days to move forward in each
iteration.

Bar Size: | 1 day -
End Date: | 2/8/2017 BB
Regular Trading Hours (RTH) Data

Optimize Period (Days): Anchor

Walk Forward Period (Days) 30 5

This option will keep the original
start date in each iteration
instead of moving forward by the
walk forward period.

<Back cancel
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7.1.4 Execution Settings Panel

Execution settings specify the runtime behavior for the analysis. Commissions can be included in the
profit/loss calculation and can be configured from the Console menu bar (Configure -> Commissions).
Slippage can also be enabled to account for market orders. During periods of lower volume market
orders may not be filled at the current bid/ask prices. This parameter assumes that the order will be
filled the given number of ticks away from the bid/ask price.

Execution Settings
il Execution Settings (MA Cross Strategy) x

Execution Settings

The options below allow you to specify order and account settings when the sirategy is optimized.

Initial Account Value: 100000 3

Include Commission:

Fill On Bid Ask: This panel is used to specify the account

Slippage (Ticks): and execution settings. Optionally,

commissions may be included.

Slippage enables you to account for
market orders that are not always filled at
the bid/ask price. This can enable you to
get more realistic results.

< Back Cancel

7.1.5 Optimizer Settings Panel

If you chose Optimize or Walk Forward as the analysis type, then you will see the Optimizer
Settings panel as the last panel in the wizard. MotiveWave currently supports two types of optimizer
algorithms:

1. Exhaustive - this algorithm will evaluate all combinations of the strategy settings to find the
optimal result. This algorithm will find the optimal settings for the strategy. This is a good option
if the number of combinations is relatively low.

2. Genetic - employs a natural selection approach to find an optimal combination without having
to evaluate all possible combinations of the strategy settings. For more details on how this works
see Wikipedia: Genetic Algorithm.

7.1.5.1 Exhaustive Optimization vs. Genetic Optimization

There are many types of optimization. The most common types used for strategy optimization are
Exhaustive Optimization and Genetic Optimization. Both types of optimization have benefits. It’s just a
matter of figuring out which type of optimization is most appropriate for the results you’re looking for.
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7.1.5.2 Exhaustive Optimization

Exhaustive Optimization will run through and test every possible combination of inputs to determine the
absolute best possible performance solution. But, because it will run through every possible
combination, running an exhaustive optimization can take a very long time. The time required to run an
exhaustive optimization is dramatically increased when a large number of inputs or parameters are used
in the search.

To reduce the amount of time required to run the exhaustive optimization, you can limit the number of
inputs or parameters used to a small number, or use genetic optimization instead.

7.1.5.3 Genetic Optimization

Genetic Optimization (or Genetic Algorithm Optimization) is based on the concept of biological
evolution, or natural selection. In relation to trading strategy optimization, genetic optimization will start
by randomly selecting a number of combinations to test. From those selected, it will determine which of
those combinations have the best potential and discard the rest. Then it will continue to test the
remaining ‘best potential’ combination candidates until it arrives at the close-to-best input or parameter
performance solution.

Because genetic optimization does not test every possible combination, it will not arrive at the absolute
best possible performance solution, like with exhaustive optimization, but the time it takes to arrive at a
close-to-absolute best performance solution is dramatically shorter.

Genetic Optimization is best suited for running an optimization with many inputs or parameters. The
larger the sample size is, the longer it will take to complete the optimization, but if the sample size is too
small, the genetic optimization results may be less accurate.

Optimizer Settings
it Optimizer Settings X
Optimizer Settings
The options below allow you to configure how the optimizer behaves

Max Results:

Optimize Metric: | Net Profit -

Optimizer Algorithm: This panel is applicable to Optimize and
; K Walk Forward Testing types.
Exhaustive

Genetic Exhaustive will evaluate all possible

combinations of the strategy settings.

Genetic optimization applies a genetic
algorithm to find an optimal combination
(without evaluating all possible
combinations).

< Back Finish Cancel
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7.2 Strategy Analysis

Once you have created and executed a strategy analysis, you can look at the results in the strategy
optimizer (see below). The analysis will contain one or more execution instances in the summary table at
the top of the window. Select the instance that you want to view and it will be displayed in the panel
below the table.

Strategy Analysis Metrics
(*] MotiveWave - Console (google) ey - k@ X

File  View Configure i

11} Untitieg™ When you save the analysis, [
you can specify a name.
Walk Forward /\

Symbol Parameters Start End Net Profit Gross Profit Gross Loss Executions Commission g:LCZ::I;ES:; SEVE b o
AXP C,EMA 16,C,EMA, 20 (Fast Input F Mar/03/14 Mar/03/115 8 S og
AXP C,EMA 14,C,EMA,20 (Fast Input F Apr/02/14 Apr02/15 ( 10 $0.00 $195.0
AXP C.EMA,12,C,EMA 24 (Fast Input F May/02/14 7 $0.00 $54.0

$0.00 $62.0

C.EMA 10,C,EMA, 26 (Fast Input FJun/01/14
AXP C.EMA 14,C,EMA, 20 (Fast Input FJul/01/14
AXP C.EMA 16,C,EMA, 22 (Fast Input FJul/31/14
m Chart Reports Periods Trades (11) Executions (12)
Date Jul/01/14

il instance from the table to
a see the details below.

$0.00 $226.0

Strategy MA Cross Strategy

Type Walk Forward
Symbol AXP These tabs show EMA,20 (Fast Input,Fast Method,Fast Period, Slow Input, Slow Method Slow Period)
. different information
Bar Size 1day N
about the analysis.

Metric—J All Trades Long Trades Short Trades =
Total Net Profit (Inc Commissions) $1,319.00 ($130.00) 51,449.00
Total Profit {(Gross - Loss) $1,319.00 ($130.00) $1,449.00
Gross Profit $1,851.00 $285.00 $1,566.00
Gross Loss ($532.00) (5415.00) ($117.00)
Commission $0.00 $0.00 50.00
Profit Factor 3.479 0.687 13.385
Max. Drawdown $337.00 $277.00 $60.00
Max Drawdown (%) 0.33% 0.28% 0.06%
Total # Trades 1" 5 6
Percent Profitable 36.36% 20.00% 50.00%
# Winning Trades 4 1 3
P —— ES 1 2
Ll Home bl Charts  f8 Account @ Scan {lf Optimize % =)\ News  + m N O

Feb-09 10:53:15

The following screen shot shows an example of the Chart tab of the strategy analysis. This tab displays a
visual representation of the executed trades that occurred for the selected execution instance.
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Strategy Analysis Chart
~ MotiveWave - Console (google) = X
File View Configure Window Help

i Untitied| + s e s
Walk Forward

Symbol Parameters Start End Net Profit Gross Profit Gross Loss i c issi Max Drawdown *
C.EMA,12,C,EMA,24 (Fast Input F May/02/14 May/02/15 7 $0.00 554.0‘.
C.EMA,10,C,EMA,26 (Fast Input F Jun/01/14 Jun/01/15 $62.0

AXP C.EMA,14

,20 (Fast Input,F JuliC
AXP C.EMA,16,C,EMA 22 (Fast Input F Juli’31/14 Juliz1ms

5 $0.00 $226.0
AvD CRAA 4C A~ CLAA 90 ICack lnmid £ ALAMAM A AunionMe = cnnn c4 noo o
Metrics Reports Periods Trades (11) Executions (12)
AXP -1 day ‘ : :
Volume *Tm”"h it This chart shows a visual i H95.00
representation of the trades
that occurred during the | End time F*
1|" execution of this iteration.
il 150,00
g M-
! el
* * |
' .
! ;&\ 3 el H85.00
1 o : e
H .
| | Hover over trade | T |
! to see details ey |11/ N T Aljl l'lﬁlﬂ
1 W li § 1| Entry Time: Jan-05 04-0) | 80.00
Start time for , 'I'rl M Sell 100@91.44 ' 7514
. . Exit Time: May-14 04:00 2
the iteration ! e Buy 100@80.34 I'li Y‘ Py ‘
T 1 FiL: 1,110.00 Tl h
' ! Pips: 1110.0 I l 475.00
: I Cumulalive PIL: 1,611.0
i ! Gum. Net PiL: 1.611.00
i H Max Price: 91 81
N | f Win Price; 76.53 TN
Jun-2014 Jul-2014 Aug-2014 Sep-2014 QOct-2014 Nov-2014  Dec-2014 Jan-2015 Feb-2015  Mar-2015 Apr-2015 May-2015 Jun—l2(l1 5 Ju|-2lﬂ15 Aug-2015
1min Smin 10min 15min  20min 30min 45min 1hour Zhour 6hour 1day 1week 2week 1month 3month = v @ ¢+ B
il Home Ll Charis .8 Account  [2&! Scan  f}f Oplimize x =) News  + im Ny O

[ ] Jan-12 2015,91.36 0:90.50 H:90.94 L:89.08 C:89.50 V:3.2M R:1.86 Feb-09 10:55:56

Several visual reports are available under the Reports tab. The available report types can be found in the
Report dropdown.

Strategy Analysis Reports

~ MotiveWave - Console (google) o I S
File View Configure Window Help
flf untitied*| + E=m & -
Walk Forward
Symbol Parameters Start End Net Profit Gross Profit Gross Loss E i Commissions Max Drawdowr *
AXP C,EMA12,C,EMA 24 (Fast In May/02/14  May/02/15 7 $0.00 ss40i0
C.EMA,10,C,EMA, 26 (Fast In Jun/01/14 Juni/01/15 7 $0.00 $62.01
C.EMA,14,C,EMA 20 (Fast In Julf01/14 Julio1/15 51,3 2 $0.00 $337.0

AXP C,EMA,16,C EMA 22 (Fast In Jul’31/14 Jull31/15 5 $0.00 $226.01
AXP C.EMA 16,C.EMA .22 (Fast In Aug/30/14 Aug/30M15 7 $0.00 $1,093.0t
Metrics  Chart Periods Trades (11) Executions (12)
Report: | Net Profit ~ | Period: | Day OfWeek  ~ Long/Short | Both = This panel contains various visual
o L reports for the selected execution
$1,500 MG - - - ---- e e ey o instance. Choose the report type |p----------
Cumulative Profit i from the Report drop down.
§1,250, Trades ProfitfLoss ~ f----—-—mmmmmdmmmm oo S

Entry Efficiency
$1.000. Exit Efficiency

Efficiency
$750.

$500.00
$250.00 -----------4--—-—----- - - |, - - - - - - - -- -

$0.00

($250.00) 2 —————-

($500.00) ! !
Sunday Monday Tuesday Wednesday Thursday Friday Saturday

Ll Home  Lul Charts g Account

@0 Scan {lf Optimize X =) News  + Tl TR
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The Periods tab groups trades together based on the selected period (hourly, daily weekly etc). Each
row in this table displays summary information.

~ MotiveWave - Console (google) - W x
File View Configure Window  Help
i} Untitied*| +
Walk Forward
Symbol F'aramelers Start End Net Profit Gross Profit Gross Loss E: ions (o] issi Max D |+
AXP C.EMA,12,C.EMA 24 (Faﬁl Inpul Fa: MayIDZiM May/02/15 T $0.00 $54 (l'.
C.EMA,10,C,EMA 25 (Fast Input Fa: Jun/01/14 Jun/01/15 7 $0.00 $62.0
C.,EMA,16,C,EMA 22 (Fast Input,Fa: Jul'31/14 Juli31/15
AXP C.EMA 16,C.EMA 22 (Fast Input Fa: Aug/30/14 Aua/3015 7 $0.00 $1,093.00
Metrics Chart Reports Trades (1) Executions (12)
Period: Longishort | Baoth =
Peric 30 Min Interval Gross Profit Gross Loss # Trades % Winning ... Avg Trade Avg Winni... Avg Losing... LargestWi... LargestLo... MFE MAE ETD % of Trades +
Hour Interval
Sep-08 $411.00 $0.00 1 10000% $411.00 $0.00 $411.00 $0.00 $776.00 $5500  $365.00 9.09%
Day Of Week
Sep-10 Y b 1 0.00% $0.00 ($130.00) $0.00 ($130.00) $43.00 $165.00 $173.00 9.09%|
Dail .
Sep-23 Iy This report groups 1 0.00% $0.00 ($45.00) $0.00 ($45.00) $122.00 $258.00 $167.00 9.09%
Weekl
sep2q oY trades based on the 1 0.00% $0.00 ($8.00) 50.00 (58.00) $7100 $3200  $79.00 9.09%
| Monthly selected period
Oct-30 B a—— 1 0.00% $0.00 ($12.00) $0.00 ($12.00) $1,006.00 $52.00 $1,018.00 9.09%]
Jan-08 L 1 100.00% $285.00 $0.00 $285.00 $0.00 $630.00 $65.00 $345.00 9.09%
May-14 1 100.00% $1,110.00 $0.00 $1,110.00 $0.00 $1,491.00 $37.00 $381.00 9.09%
Jun-17 1 0.00% $0.00 ($70.00) $0.00 ($70.00) $126.00 $154.00 $196.00 9.09%
Jun-18 1 0.00% $0.00 ($60.00) $0.00 ($60.00) $18.00 $122.00 $78.00 9.09%
Jun-30 1 0.00% $0.00 ($207.00) $0.00 ($207.00) $168.00 $250.00 $375.00 9.09%
Jul-01 1 100.00% $45.00 $0.00 $45.00 $0.00 $52.00 $24.00 $7.00 9.09%
il Home bl Charts {8 Account  |& Scan  fl{ Optimi News  + m

The Trades tab shows all of the trades that occurred. A trade includes the entry into the trade as well as
the exit out of the trade. This allows you to see the profit/loss that occurred with each trade.

~ MotiveWave - Console (google) M o g %
File View Configure Window  Help

#4i Untited* | + = 5 E
Walk Forward

Symbol Parameters Start End Net Profit Gross Profit Gross Loss i Ci ission Max D T *
o NI O WIS - G T NPT e ar T S > B vero
AXP C.EMA 16,C EMA 22 (Fast Input,Fa Aug/30/14 Augi30/15 7 $0.00 $1,093.01
AXP C.EMA 14,C EMA 20 (Fast Input Fa Sep/29/14 Sep/29/15 9 $0.00 $1,125.0
AXP C,EMA 16,C,EMA 22 (Fast Input,Fa Oct/29/14 Oct29/15 9 $0.00 $1,741.00
C.EMA 16,C EMA 26 (Fast Input,Fa Nov/28/14 Now/28/15 8 $0.00 $1,480.0
A A 8 £000 $1.450.01_|
Metrics  Chart Reports Periods Executions (12)
Trade # Sym.. Quantitya Entry Price Exit Price Entry Time Exit Time PiL Pips Commission Cumulativ... Cum. Com... MAE MFE ETD Bars *
1 AXP 100 93.51 89.40 Jul-14 4:00:005ep-14 4:00:00 50.00 50.00 $5500  S$77600  $365.00 3

2 AXP 100 89.40 88,10 3ep-14 4:00:005ep-14 4.00.00 $0.00 $0.00 $165.00 $43.00 $173.00

3 AXP 100 88.10 8855 sep-14 4:00:003ep-14 4-00:00 (D) EEE $0.00 $0.00 $256.00 $122.00 $167.00 |
4 AXP 100 88.55 88.47 sep-14 4:00:005ep-14 4:00:00 (56 ) m s0.00 IS $0.00 $32.00 $71.00 $79.00 |

5 AXP 100 88.47 88.59 5ep-14 4:00:00 Jct-14 4:00:00 $0.00 $0.00 $5200  $1,00600  $1,018.00 2
6 AXP 100 88.59 91.44 Jct-14 4:00:00 }an-15 4:00:00 $0.00 $0.00 $65.00  $63000  $34500 4
7 AXP 100 91.44 50.00 50.00 $37.00  §1491.00  $381.00 g
8 AXP 100 80.34 79.64 fay-15 4:00:00 Jun-15 4:00:00 P 51,541.00 $000  $15400  $12600  $196.00 2

9 AXP 100 79 64 80 24 wn-15 4-00-00 n-15 4:00:00 [JPETR m s0.00 [IEREED 5000 512200 $13.00 578.00 ‘
10 AXP 100 80 Tabular view of all the trades in-15 4:00:00 [T s0.00 [IEEZLD $0.00 525000  $168.00  $375.00 i
11 AXP 100 7g| (entry and exit) that occurred 115 4-00-00 ([ IS IR 50.00 50.00 $24.00 $52.00 $7.00

in this execution

lul Home Ll Charts & Account Scan {lf Optimize x =\ News  + L]
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The Executions tab displays all of the filled orders.

motivelwave

£

(W) MotiveWave - Console (google) M o & &
File View Configure Window Help
il Untitied* | + =B A
m Walk Forward
Symbol Parameters Start End Net Profit Gross Profit Gross Loss Co Max Drawdown +
e e e R s ’ s suvu seeuy
AXP C.EMA,16,C EMA 22 (Fast Input Fa Aug/30114 Augi30/15 (81 ) 7 $0.00 5100300
AXP C.EMA,14,C,EMA 20 (Fast Input,Fa Sep/29/14 Sep/29/15 $1,600.00 9 $0.00 $1,126.0
AXP C.EMA.16,C,EMA 22 (Fast Input Fa Oct/29/14 Oct/29/15 $1,232.00 9 $0.00 $1.741.0
AXP C.EMA,16,C.EMA 26 (Fast Input,FaNovi25/14 Novi28/15 0 ($1,480.00) 8 $0.00 $1,450.0
AXP MA.16 MA._26 (Fast Inp Dec ( 8 $000  $1.4800 |
Metrics Chart Reports Periods Trades (11) I3
ID Symbol Time Action Quantity Avg Price Entry Price Type PIL Pips Commission Position +*
162035 Axp 22140400  SELL 100 93.51 93.51 Entry 0.0 $0.00 -100
162036 axp 08-Sep-14 04:00 BUY 200 89.40 93.51 SAR 4110 $0.00 100
162037 AxP 10-Sep-1404:00  SELL 200 8510 89.40 SAR -130.0 $0.00 -100
162038 Axp 23-Sep-14 04:00 BUY 200 88.55 88.10 SAR 45.0 $0.00 100
162039 AxP 24-Sep-1404:00  SELL 200 88.47 8855 SAR -8.0 $0.00 -100
162040 AxP 30-Oct-14 04:00 BUY 200 88.59 88.47 SAR 2.0 $0.00 100
162041 Axp 08-)an-150400  SELL 200 9144 88.59 SAR 0 285.0 $0.00 -100
162042 AXP 14-May-15 04:00 BUY 200 80.34 91.44 SAR 1110.0 $0.00 100
162043 Axp 00 SELL 200 7964 80.34 SAR ($70.00) 70.0 $0.00 -100
162044 AXP Tabular view of all the b(] BUY 200 8024 7964 SAR -60.0 $0.00 100
162045 AXP executions that occurred gy SELL 200 7817 8024 SAR (32070 -207.0 $0.00 -100
(executed orders). ) =
162046 Axp 0o BUY 100 7772 7817 Exit $45.00 450 $0.00 0
il Home  lul Charts [ Account  [2f Scan  {lf Optimize x =)\ News  + B O
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8 Custom Instruments

ave

MotiveWave™ allows you to create custom instruments that are based on 2 or more existing
instruments. There are 3 types of custom instruments:

1. Spread — Displays the difference between two instruments
2. Ratio — Displays the ratio by dividing the price of one instrument by another

3.

Index — Allows you to combine the prices of 2 or more instruments into an index

To create a new custom instrument, choose File -> New -> Custom Instrument from the Console menu

bar:
& MotiveWave - Console
File | Edit WView Study Strategy Format Configure Window  Help
New » B New Page & 1~ + EEE 2
Open | = New Watch List
il MNew Desktop H
Chart * | Ll New Chart Window Ctri+N ||
& Backup il New DOM Window :
Bt Restore D) New Time&Sales Window .
Disconnect Custom Mstrument Choose File -> New ->
Shutdown Custom Instrument
i |
L-.

This will open a wizard to guide you through creating a custom instrument. You will need to enter a
unique symbol for the instrument (it cannot match any existing instrument in the workspace). In the
following example we are going to create a custom index (US Dollar Index). The minimum tick value
specifies the minimum amount for each change in the instrument price.

»

Symbol:
Type:
Title:

Description:

Minimum Tick:

Create Custom Instrument

Custom Instrument

A custom instrument allows you to combine and display live and historical data from multiple instruments. Enter a unigque
symbol for your instrument and choose from the following types:

1. Spread - Displays the difference between two instruments
2. Ratio - Displays the ratio by dividing the price of one instrument by another
3. Index - Allows you to combine the prices of 2 or more instruments in to a unified index.

Symbol must be unigue
among all instruments
in your workspace

r
US Index

Index

-

US Dollar Index

F

Next =

Cancel
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The US Dollar Index measure the relative value of the US Dollar vs a set of foreign currencies. For more
information see the definition on Wikipedia: https://en.wikipedia.org/wiki/U.S._Dollar_Index. In this
case we need to include 6 different currency pairs and use the exponent option to assign a weight to
each one (Note: EUR/USD and GBP/USD need to be inverted):

1.

ke wnN

6.

EUR/USD - 57.6% weight (inverted) (Euro dollar)
USD/JPY — 13.6% weight (Japanese Yen)

GBP/USD - 11.9% weight (inverted) (British Pound)
USD/CAD — 9.1% weight (Canadian Dollar)
USD/SEK — 4.2% weight (Swedish Krona)

USD/CHF - 3.6% weight (Swiss Franc)

These values are multiplied together and then multiplied by 50.14381 (see link above for the reason for
this number).

(Y Edit Custom Instrument - US Index (Index) x
Choose Instruments (Index)

Click the Add button to add instruments to your custom index (minimum 2). When adding an instrument, you can optionally
specify a multiplier to adjust (or normalize) the price. The index will be calculated using the sum of each instrument muliplied
g: (M1=(INSTRIAEXP1)) + (M2*(INSTR2"EXP2)) + (M3*(INSTR3*EXP3))...).

vert to invert the final calculation (ie: INDEX = 1 / INDEX) and optionally adjust the final price by an

Operation: | Multiply — ~ Multiply the
r
Multiplier: | 5014348 values together

Click here to
add a symbol

((1/ EUR/USD)*0.576)

(USD/JPY™0.136)

((1/GBP/USD)"0.119) Inverted

(USD/CAD"0.091)

(USD/SEK"0.042)

(USDICHF*0.036) (Y] Instrument Dependency X
Select an instrument from the drop down and optionally
specify a multiplier to adjust the weighting for the index.

r
Multlpller
Exponent is used to
Inverts the t: 0.576 assign the weight
value V| Inverted
Cancel

< Back Finish Cancel

The following chart shows daily candles for the custom index that we created above. Incoming price
updates will also be calculated using the formula that was defined for the instrument.
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il US Index - Primary Analysis - 1 day 2 o- T x

File Edit View Study Strategy Format Window Help
ok E R s G [ W~ 2w~ & i~ f-'l'+"’:i'2'lﬂday
US Index - 1dﬂy
Velume " n
| 1 Incoming ticks are
*l | i Eaudild L;sing tlhe same
1 incex rTormula
J J |
IT |
l i H99.00
lIIITT' || !' i Hes.00
J'IIIIII'I l | .i i H97.00
ey |'I ! i |
ar | | . : i
‘ |“ I i 96.00
i lll ||!+| Ih | n |T.“i. ,
|m" i || Hos.00
i 2.1M
:ﬂllﬂlllmllnllluu|.||||.|||Inin|u|||ﬂ||l|||l|u|m||ll.ndullllmlullllllﬂlll MG il ||||II||||III|

Aug-2016
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2016
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Dec-2016

Jan-2017

Feb-2017

imin 5min 10min 15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4

v @ |-~ 3B
Feb-09 12:44:54

Custom instruments can be edited/managed from the Manage Instruments dialog (Configure ->
Instruments from the Console menu bar). The easiest way to display all custom instruments in the
workspace is to sort the table by the Type column (ascending). If you double click on a custom
instrument, the Custom Instrument Wizard will be opened allowing you to edit the instrument.

/

L 4
File

USDollar + +13 min

MotiveWave - Console (fx2)

£} Preferences

{= Save Configuration

(' Clear All Local Data

Order Presets
Commissions

[Z] update License

&Y Choose Language
il Layout

Edit WView Study Strategy Format | Configure | Window  Help
UsDolla RN © B G | % & workspaces roiMw [+ "B T 2~ |15 min
Ll EUR/GBP 1h [l USDollar 15m X |Lul USOIl 15 & Instrynents Choose
-8 Acli _Tl(:KerS Configure -> Instruments
£ Repository

ks
e

o

Version 5.0

©2019 MotiveWave™ Software

Page 212 of 212



MotiveWave™
User's Guide

motivelave

The following table c
these instruments. (

Sort by type
ascending

nts that currently exist in the local database. From this dialog you can add, remove or edit
L key to select multiple rows).

Manage Instruments X

Symbol: — Type: | All ~ | Exchange: | All -

Symbol Type v Currency Exchange Description Source *
CAD Oil Custom uspD NOMNE Canadian Dollar Vs US Oil Ratio FXCM .
US Index Custom US Dollar Index
USDollar CFD
JPN225 CFD Double click or select FXCM
GER30 CFD and press the Edit EXCM
oo e I(;Usft':szents button below. —

ITA40 CFD FXCM
SUI30 CFD EUR FXCM FXCM
ESP35 CFD EUR FXCM FXCM
HKG33 CFD HKD FXCM FXCM
AUS200 CFD AUD FXCM FXCM
NAS100 CFD usD FXCM NASDAQ 100 FXCM
SPX500 CFD UusD FXCM S@ b Ron FXCM
Us30 CFD USD  FXCM | Clickhere to FXCM
USOil CFD USD  EXCM Sj:'tr;;al ::::J et FXCM
Total Instruments: 468
Q, Search || & Import || Define | Custom | + Edit ¥ Delete || Advanced | Cancel
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